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1 Introduction

With HP Access Control (HP AC), an HP JetAdvantage Security Solution, you can protect confidential information, 
enhance device security and management, while improving company-wide printing policies. Providing a cost-
effective way to create a more secure and efficient imaging and printing environment, HP Access Control 
Solutions transforms imaging and printing practices while reducing costs and keeping data and devices secure.

1.1 Solution benefits
It is now easier than ever to protect print jobs and devices, improve workflows, and monitor printing practices — 
all while reducing costs and supporting organization-wide security, compliance, and environmental initiatives. 
Designed to integrate easily with HP and other printing devices, you can select specific HP Access Control Printing 
Solutions to address your needs.

Some of the benefits you can experience with the HP Access Control Solution include:

● Secure Authentication: Access Control Secure Authentication offers a variety of authentication options—
including Windows authentication, HP proximity card readers, PIC/PIN codes—to protect your devices and 
prevent unauthorized use.

Learn more about Secure Authentication

● Secure Pull Printing: HP Access Control Secure Pull Printing reduces unclaimed prints and increases 
efficiency. Users can print to a secure network, authenticate with ease, and retrieve jobs when necessary—
even on the go.

Learn more about Secure Pull Printing

● Job Accounting: HP Access Control Job Accounting makes it easy to accurately track and gather data, 
analyze the results, and then create and send reports. Apply mined data to allocate print costs, motivate 
employees to print smarter, and provide IT with the necessary information to improve fleet-wide forecasts.

Learn more about Job Accounting

● Intelligent Management: HP Access Control Intelligent Management solutions help you control device 
usage, modify behavior, reduce costs, and enforce security goals.

Learn more about Intelligent Management

1.2 Solution components
HP Access Control (HP AC) software is comprised of the components and corresponding tasks listed in the 
following table.

Component Type Task

Enrollment Service (IRM Authentication 
Web Service)

IIS Web Service Match user’s credentials to a PIN or Badge number and store 
details in Active Directory or SQL.

Authentication Service (IRM 
Authentication Web Service)

IIS Web Service Match user’s previously stored PIN or Badge number to user 
authenticating at the device allowing secure access to the 
function requested (i.e. secure print, email, copy).

User Rights (IRM/DRA Authorization Web 
Service)

IIS Web Service Validates user rights to access MFP walk-up functions (i.e. copy 
in color).
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Licensing Service IIS Web Service Validates device licensing for pull printing & authentication (24 
hours for FutureSmart devices, every hour for non-FutureSmart 
devices). Validates user licensing for job accounting (checks 
every 24 hours).

OXPd Professional Service (OPS) IIS Web Service Hosts printer configurations for OfficeJet Pro devices.

Intelligent Print Management (IPM) 
Enterprise Bundle only

IIS Web Service Manages and controls printing processes by setting conditions, 
actions and notifications (i.e. force to monochrome).

Print job list retrieval (SPPE/SPP Web 
Service)

IIS Web Service Build a print job list for the authenticated user for job selection 
or deletion.

Print job retrieval (SPPE/SPP Web 
Service)

IIS Web Service Retrieve requested print job and send to the device the user is 
authenticated at.

Print job submission (Enterprise Spooler) HP AC Enterprise Service Submit print job to be stored in the spool directory for future 
retrieval.

Print job submission (Express or 
Enterprise with shared queues)

HP AC Port Submit print job to be stored in the spool directory (for future 
retrieval).

Job Accounting Statistics Service IIS Web Service Collects XML files from HP FutureSmart devices.

Job Accounting Data Collector IIS Web Service Collects XML printer data from devices (push) via FTP, HTTP, or 
HTTPS.

Job Accounting Web Server IIS Web Service Queries the Job Accounting Database server to access the data 
and enables navigation through the application via web browser.

Enterprise License Windows Service Allows for a centralized license server without having to 
duplicate licenses on additional servers. The license service will 
communicate to the license database.

1.3 HP AC installation bundles
HP Access Control is a suite of modules that provide authentication, authorization, tracking, rules based printing, 
and secure pull printing capabilities. HP Access Control has two different bundles designed to provide the 
capabilities for your organization’s requirements:

● HP Access Control (HP AC) Express

● HP Access Control (HP AC) Enterprise

1.3.1 HP Access Control (HP AC) Express

The HP AC Express bundle includes Job Accounting and Secure Pull Print Express. Secure Pull Print Express is a 
printing solution that allows users to securely print stored jobs from a server to any printer or MFP using a 
wireless mobile device, Web page, or at the print device. HP Access Control (HP AC) Secure Pull Print Express 
helps any organization decrease costs by reducing the amount of unclaimed documents on the printer’s output 
tray and increase security by requiring authentication to release jobs.

The Secure Pull Print Express solution includes the following components:

● Authorization (Intelligent Rights Management): Provides individual or group-level access to use device 
functions (i.e. copy, email, etc.)

● Authentication:

– PIN/PIC (numeric or alphanumeric user ID code)*

– Proximity Cards
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– Touch-to-Sign-In from mobile devices with NFC support

– Windows authentication (alternative authentication for proximity cards)*

● Secure Pull Print Express: Installs the Secure Pull Print Express component to securely release print jobs 
from a mobile device or from the front panel of the device.

– Authorization for access to device functions (Intelligent Rights Management)

– Alias Printing

– Encryption

– Multivendor device support

– Touch-to-Release (from mobile devices)

● Job Accounting: Track print device usage and generate detailed reports.

– Job Accounting Server: Install the Job Accounting component to generate detailed reports of print 
device usage information.

– In-Device tracking: Through an agent component or as part of the device's firmware for in-printer 
tracking of printer usage.

– Quota (copy and digital sending) and Allocation

*not supported on non-FutureSmart single function printers

1.3.2 HP Access Control (HP AC) Enterprise

The HP Access Control Enterprise bundle includes all of the features of HP Access Control Express and provides 
these additional features:

● Intelligent Print Management (IPM): Create conditions, actions, and notifications for rules-based printing.

● Device Analysis: Gathers information about networked printers and creates detailed analysis reports.

● Secure Pull Print Enterprise: Install the Secure Pull Print Enterprise component to securely release print 
jobs and for remote printing.

– Enterprise Spooler

– Pull printing including Roaming

– Delegate Printing

– Assured Job Delivery

– Client-based pull printing (with local job storage)

● Job Accounting: Track print device usage and generate detailed reports.

– Print Server: Installs the Printer Configuration component to configure printers for tracking, quota, or 
rules-based printing (IPM) for devices that do not support in printer agents.

– Direct Tracking Module (DTM) This allows HP print devices to send job accounting tracking information 
to the server through confirmation traps (on supported devices) that contains basic job information 
and print job status.

1.3.3 Server installation

Server installation allows you to choose which options are to be installed on the target server. This allows IT 
administrators to install only the functions needed in a multi-server environment to support pull printing, 
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authentication, and job accounting requirements. This is most useful when the customer environment requires 
separate, dedicated servers. For example, some customer environments require one dedicated authentication 
server, a separate dedicated pull printing server, and yet another dedicated job accounting server.

1.3.4 Stand-alone print server installation

Stand-alone server installation allows you to install either Job Accounting or rules based printing (IPM) on 
separate servers. This allows IT administrators to install print server functions needed in a multi-server 
environment to support print server tracking, or rules-based printing from a print server.
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2 Solution requirements

The HP Access Control (HP AC) installation detects what components are required to run HP AC on your system, 
and then automatically installs the required components. The following sections list the required components 
for HP AC, according to the installation bundles.

2.1 Minimum server hardware requirements
● CPU:

– Dual-core 1.6GHz recommended

– Medium size production servers (500,000 to 1 million pages/month): 4 x CPU

– Large size production servers (+ 1 million pages/month): 8 x CPU

● Memory:

– Medium size production servers: 8-12 GB RAM is recommended (500,000 to 3 million pages per 
month)

– Large size production servers: 12-16 GB RAM is recommended (beyond 3 million pages per month)

– Additional 2 GB RAM if SQL is running on the same server as HP AC.

● Disk Space:

– Job Storage: 100 MB plus the expected average storage space by user multiplied by number of users 
(50 MB x 10 users = 500 MB).

NOTE: If print storage is unknown then a good reference number for planning is 50 MB/user.

● Network Connectivity:

– 1NIC with TCP/IP and UDP supported, minimum 1 Gbps recommended

2.2 Server requirements
NOTE: Ensure you consult with HP before installing HP Access Control on a server hosting any other software 
applications.

● Operating system (64-bit):

– Windows Server 2008 (32 and 64-bit)

– Windows Server 2008 R2

– Windows Server 2012

– Windows Server 2012 R2

– Windows Server 2016

● Job Accounting:
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– For non-FutureSmart HP devices, Microsoft Internet Information Service requires that either HTTP 
upload (port 80 with basic authentication) or FTP upload (with basic authentication) be allowed.

– For Job Accounting tables and charts to display, Microsoft Excel 2007 or newer is required.

● Other:

– Server joined to the same domain as the end-users, or to a domain with a trust relationship with the 
end users.

– Static IP address

– All security patches up to date (as per Windows Update)

– HP AC Enterprise: LPD Service or Unix Printing service disabled, or you will be required to change the 
default ports HP AC Enterprise Spooler uses.

– v3 supported printer drivers

– Microsoft UrlScan (or any similar port/protocol blocking tool) must not be installed on the same 
server as HP AC.

– Antivirus: If configured on the server, it should not disable network communication through the 
required ports. Best practice is to set an exclusion for the pull print files directory.

– Microsoft .Net Framework and IIS must be installed manually on a Windows Server 2012 or 2016, if 
the server does not have internet access.

– HP AC cannot be installed on a server with Windows Server Update Services (WSUS) installed.

– Windows Firewall: To ensure reliable connections between the server and printing devices, it is highly 
recommended to turn off the firewall on the HP AC server. If the firewall cannot be disabled:

NOTE: The Windows Firewall recommendations apply when connecting to HP FutureSmart devices 
with firmware older than version 3.2.1, and when connecting to HP non-FutureSmart devices with 
firmware older than version 13.3.5.

1. Configure the server to accept inbound packets from devices that have passed through the 
firewall by changing the World Wide Web Services properties. On the HP AC server, go to Control 
Panel > Windows Firewall > Advanced Settings > Inbound Rules. Right-click the World Wide Web 
Services (HTTP traffic-in) and select Properties.
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2. In the Advanced tab, under Edge Traversal, select Allow Edge Traversal and click OK.

Section 2.2   Server requirements 7



3. Allow the server to accept inbound packets from devices that have passed through the firewall 
by changing the Spooler Service properties. On the HP AC server, go to Control Panel > Windows 
Firewall > Advanced Settings > Inbound Rules. Right-click File and Printer Sharing (Spooler 
Service – RPC) and select Properties.

4. On the Advanced tab, under Edge Traversal, select Allow edge traversal and click OK.

2.2.1 Virtualization

HP AC will function in any virtualized environment (e.g. VMWare or Microsoft Hyper-V) capable of running any of 
the supported operating systems. Virtualization is transparent to HP AC.
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2.3 Database server requirements
Database server requirements are as follows:

● Microsoft SQL:

– 2008, 2012, 2014, 2016

● Sysadmin or dbcreator role for the Windows account used to run the installer or for the SQL account.

– After installation, the account can be changed to be a member of the db_owner database role or a 
member of the db_datareader and db_datawriter database roles. The db_owner database role can 
perform all configuration and maintenance activities on the database. The db_datareader database 
role can run a SELECT statement against any table or view in the database. The db_datawriter 
database role can add, delete, or change data in all user tables.

IMPORTANT: If the Login is a member of the db_datareader and db_datawriter database roles, Execute 
permissions (in database Properties) must be granted to the user.

NOTE: If Job Accounting is installed, a SQL account named HPACJA is created. After installation, the HPACJA 
account has Public rights, so it cannot be used to create new databases, such as for enrollment or license 
databases. If you want to use the HPACJA account to create other databases, you must assign dbcreator rights to 
the account via SQL Management Studio.

2.3.1 Job Accounting database server requirements (remote)

For a remote SQL Server running SQL 2005 or later, the database must be created using a SQL login. The setup 
does not create a SQL login for HP AC Job Accounting, and a trusted connection will be used with named pipes. 
The Job Accounting Agent must be started with a domain account, to connect to the remote database.

2.4 Infrastructure requirements
Infrastructure requirements are as follows:

● Information to connect (for user authentication) to Active Directory or LDAP server that contains user 
details:

– Multiple Domains

– User codes/Badge IDs: If storing in AD, an AD attribute (indexed) with a service account that has write/
edit privileges to that attribute.

– User Rights: If storing in AD, an AD attribute (indexed) with a service account that has write/edit 
privileges to that attribute.

● DNS server to resolve hostnames of the HP AC servers and hostnames of the printers and MFPs.

● Domain account to run solution services:

– Has local admin rights on the HP AC server.

– Has logon as a service rights.

– Has a process to renew password prior to expiration time or set not to expire.

● SMTP gateway to send notifications and Job Accounting reports.

● Required ports open (see Appendix A: Network Ports Required)

● To create a queue for Job accounting, IPM, or Pull Printing, a Windows v3 driver must be used. Windows v4 
print drivers are not supported.
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2.5 Supported operating systems for Pull Printing

2.5.1 Pull Printing using a Shared Server Queue

Prerequisites

● Shared pull print queue on the HP AC server (Enterprise or Express).

Operating System

● Microsoft Windows 7 (32 or 64 bit)

● Microsoft Windows 8 (32 or 64 bit)

● Microsoft Windows 8.1 (32 or 64 bit)

● Microsoft Windows 10 (32 or 64 bit)

● Macintosh 10.6.5 or newer

● Citrix

– Print job must include the user's identification in order to associate the job to the Windows user

– Auto-created shared pull print queues using the SPP Enterprise Port

● Non-Windows clients

– Must be able to print to a Windows queue that contains a unique username that is not defaulting to a 
standard service account.

2.5.2 Pull Printing using a Local Queue (Enterprise only)

Operating System

● Microsoft Windows 7 (32 or 64 bit)

● Microsoft Windows 8 (32 or 64 bit)

● Microsoft Windows 8.1 (32 or 64 bit)

● Microsoft Windows 10 (32 or 64 bit)

● Mac OS 10.6.5 or newer

● Citrix

– Auto-created Pull Print queue with the Citrix UPD and LPR queue

– XenApp Server with local HP AC LPR queue

2.6 Client requirements for HP Access Control Print client
Operating System

● Microsoft Windows 7 (32- or 64-bit)

● Microsoft Windows 8 (32- or 64-bit)

● Microsoft Windows 8.1 (32- or 64-bit)

● Microsoft Windows 10 (32- or 64-bit)

Other
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● To create a queue for Job accounting, IPM, or Pull Printing, a Windows v3 driver must be used. Windows v4 
print drivers are not supported.

● The HP AC Express Print client installs Microsoft .NET framework 2.0 on the client workstation.

● The HP AC Enterprise Print Client requires .NET Framework 4.6 on the client workstation.

● Client PC connected to the domain, and logged in as an authenticated user.

Permissions

● HP AC Enterprise: To create a local port and queue.

● HP AC Enterprise/Express: To connect to shared printer queue on HP AC server.

2.7 Client requirements for card enrollment application
Operating system

● Windows 7, 8, 8.1, 10

● Microsoft .NET Framework 2.0

Other

● Users in Active Directory.

● Card reader connected to a client PC connected to the domain, having access to the HP AC server.

2.8 Card Masking utility requirements
Prerequisites

● Microsoft .NET Framework 4.0

● Windows 7, 8, 8.1, and 10

● Card reader connected to a PC connected to the domain, having access to the AD Authenticator server

2.9 Mobile device requirements
● Smart phone connected to the same network as the HP AC server.

● HP ePrint Enterprise app installed. App can be downloaded from:

– iOS: http://itunes.apple.com

– Windows Phone: http://social.zune.net

– Android: https://market.android.com

– Blackberry: http://www.blackberry.com/appworld

2.10 HP Printer and MFP requirements
● Device supported by HP AC - with recommended, supported firmware versions.

– DNS server configured

– FutureSmart firmware version 3.7 or newer is highly recommended
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– Static or dynamic IP configured (DHCP reservation preferred)

– SNMP v1/v2 enabled (default “public” is sufficient), or SNMP v3 enabled

– Security settings:

○ EWS password required for installation and configuration

○ Remote firmware updates enabled

○ File Access and PJL Disk Access enabled

○ PJL password not set

○ Information tab requires administration access needs to be disabled.

○ PJL Device Access Commands enabled.

○ 9100 Printing, WS-Discovery, OXPd Services, and Web Services print must be enabled.

○ Installation of legacy packages signed with SHA-1 hashing algorithm allowed

○ File System Password not set

○ Command Load and Execute enabled (non-FutureSmart devices)

○ IPPS enabled if requiring encryption between the HP AC server and the device

○ FTP (for non-FutureSmart HP devices) must be enabled to push tracking files from the devices

○ Required if disabling device ping in the HP AC configuration utility which forces telnet 
communications only

2.11 Server components required
The HP AC installation detects what components are required on your system and then automatically installs the 
required components. The following table lists the required components for HP AC, for each bundle.

 HP AC Express HP AC Enterprise

Crystal Reports for .Net Framework 2.0 ✓ ✓

Internet Information Services (IIS) ✓ ✓

Microsoft Visual C++ 2005 Redistributable ✓ ✓

Microsoft SQL Server Express 2014 ✓ ✓

Microsoft SQL Server Compact Edition 3.5 SP2 ✓ ✓

Windows Installer 4.5 ✓ ✓

Microsoft .Net Framework 4.0 ✓ ✓

Microsoft ADO.Net Entity Framework 4.1 ✓ ✓

Microsoft Visual C++2008 Redistributable ✓ ✓

Microsoft Visual C++ 2010 x86 Redistributable ✓ ✓

Apache CouchDB 1.2.0 ✓ ✓

GneWin32: OpenSSL-0.9.8h-1 ✓ ✓

Microsoft SQL Server Compact 4.0 SP1 ✓ ✓
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 HP AC Express HP AC Enterprise

HP OPS ✓ ✓

Microsoft .Net Framework 2.0 ✓ ✓

Microsoft .Net Framework 3.5 ✓ ✓

Microsoft .Net Framework 4.6 ✓ ✓

NOTE: If you download the Microsoft .Net Framework 4.6 offline installer, you must have the latest Windows 
updates installed on the server. Specifically, Windows updates KB3045562 and KB3045563 are required for 
Microsoft .Net Framework 4.6.

2.11.1 IPM requirements

The installation prerequisites for HP Access Control (HP AC) Intelligent Print Management are:

● If IPM is installed on a 64-bit OS, make sure the 64-bit version of Microsoft Office is installed. This is 
required because Microsoft Access Database Engine x64, which is installed with IPM, works only with the 
64-bit version of Microsoft Office.

● .NET Framework 2.0

● Internet Information Services (IIS) with ASP.NET

● A logon with administrative rights

● The print driver set to Start printing after last page is spooled

Figure 2-1  Spool settings

● Internet Information Services (IIS) with ASP.NET

– Verify that IIS is installed correctly by performing the following procedure:
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○ Open your Internet browser and type http://localhost in the Address field.

○ The IIS home screen will display.

NOTE: If you are using a proxy server, you may be unable to see this page even if IIS is installed properly. To 
bypass the proxy server in the web browser select Tools > Internet Options and select the Connections tab. 
Select LAN Settings and check the box to Use a proxy server for your LAN. Check Bypass proxy server for local 
Addresses and click OK.

If you are still unable to see the page, it may be necessary to restore the browser or default settings in Internet 
Options. Open a web browser and select Tools > Internet options. Select the Security tab and click Default Level. 
Select the Advanced tab and click Restore Defaults. Click OK.

2.12 Supported HP devices
NOTE: For a list of supported multi-vendor devices, please refer to the LRS MFPsecure document.

Table 2-1  Supported HP FutureSmart devices

HP Color LaserJet Enterprise CM4540 MFP series HP LaserJet Enterprise Flow MFP M525 series

HP Color LaserJet Enterprise CP5520 Printer series HP LaserJet Enterprise Color Flow MFP M575

HP LaserJet Enterprise 500 Color Printer M551 series HP LaserJet Enterprise M4555 MFP series

HP LaserJet Enterprise 500 Color MFP M575 HP LaserJet Enterprise MFP M725 series

HP LaserJet Enterprise 500 MFP M525 series HP LaserJet Enterprise MFP M830 series

HP LaserJet Enterprise 600 Printer M601 / M602 / M603 series HP LaserJet Enterprise M806 Printer series

HP LaserJet Enterprise 700 Color MFP M775 series HP Color LaserJet Enterprise Flow MFP M880 series

HP LaserJet Enterprise 700 Printer M712 series HP Color LaserJet Enterpriser M855 Printer series

HP Color LaserJet Enterprise M750 Printer series HP Color LaserJet Enterprise MFP M680 series

HP Color LaserJet Enterprise M651 series HP Officejet Enterprise Color MFP X585 series

HP Officejet Enterprise Color X555 series HP LaserJet Enterprise MFP M630 series

HP Color LaserJet Enterprise M552/M553 series HP LaserJet Enterprise M604, M605, M606 series

HP Digital Sender Flow 8500 * HP LaserJet Enterprise M506 series**

HP LaserJet Enterprise MFP M527 series** HP Color LaserJet Enterprise MFP M577 series

HP PageWide Enterprise Color 556 HP PageWide Enterprise Color MFP 586

* The HP Digital Sender Flow 8500 requires the HPAC-SPPE-Agent-FutureSmart-10.bdl file

** The M506 and M527 devices require an HP internal USB port (F2A87A)

Table 2-2  Supported HP non-FutureSmart devices

HP Color LaserJet CM3530 MFP series HP LaserJet 5200 series*

HP Color LaserJet CM4730 MFP series HP LaserJet 9050 series

HP Color LaserJet CM6030/CM6040 MFP series HP LaserJet M3035 MFP series

HP Color LaserJet CP3525 Printer HP LaserJet M4345 MFP series
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Table 2-2  Supported HP non-FutureSmart devices (continued)

HP Color LaserJet Enterprise CP4525 Printer series HP LaserJet M5035 MFP series

HP Color LaserJet CP6015 Printer series HP LaserJet M9040/M9050 MFP series

HP LaserJet Enterprise P3015 Printer HP LaserJet P4015 Printer series

* The LaserJet 5200 must have 128MB memory to load the HPAC-SPPE-Agent

Table 2-3  Supported HP S900 series devices

HP Color MFP S951dn HP Color MFP S962dn

HP Color MFP S956dn HP Color MFP S970dn

HP MFP S965dn HP MFP S975dn

Table 2-4  Supported HP Officejet Pro devices

HP Officejet Pro 251 Printer HP Officejet Pro 276 MFP

HP Officejet Pro X476/X576 color MFP series HP Officejet Pro X551 Printer

Table 2-5  Supported HP PageWide Pro devices*

HP PageWide Pro 477 HP PageWide Pro 577z

HP PageWide Pro 577 HP PageWide Pro 522

HP PageWide Managed P57750 HP PageWide Managed P52250

* With a minimum firmware version of 1629F

NOTE: Please refer to the product release notes for the most up to date list of supported devices.
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3 Installation

This chapter provides steps for the following:

● Installing HP AC Express

● Installing HP AC Enterprise

● Upgrading HP AC

● Installing HP OPS (required for HP OfficeJet Pro Printers)

3.1 Installing HP AC Express
Complete the following steps to install HP Access Control (HP AC) Express. During the installation, you may be 
prompted to restart. The installation will automatically resume after reboot.

1. Launch the installer as an administrator by right-clicking the HPAC.exe file to start the HP AC installer. 
Select the language for the InstallShield Wizard, and then click OK.

NOTE: The regional settings of the server will determine the language displayed in the HP AC 
configuration utility.

2. Click Install to begin the installation of the required components. This may take several minutes.
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3. Read the End User License Agreement, and click Yes to accept the terms.

4. Click Browse to select a folder for the installation, and then click Next.
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5. On the Setup Type page, select HP AC Express. A description of the setup type displays on the right side, 
listing the components associated with Express. Click Next.

6. Leave the default options checked and select Next.
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7. On the data directory screen, select the folder location to store pull print jobs. The default folder is Program 
Files\HP\HP Access Control\spool. Click Next.

8. Choose the SQL setup required for your environment, and click Next.

NOTE: This prompts only if Job Accounting was selected to be installed, which is bundled with HP AC 
Express.

SQL Server installation — Database options:

● Install a named Instance of SQL Server Express 2008 R2: 

Automatically installs SQL Express 2008 R2 SP1 on the local server and will name it HPACEXPRESS. A 
user HPACJA with password HPACJA will also be created. On the sa password screen, enter a 
password for the SA account in SQL. The password must meet the Microsoft SQL Server Strong 
Password requirements:

Section 3.1   Installing HP AC Express 19



– Does not contain all or part of the user's account name.

– Is more than eight characters in length.

– Contains characters from at least three of the following categories:

○ English uppercase characters (A through Z)

○ English lowercase characters (a through z)

○ Base 10 digits (0 through 9)

○ Nonalphabetic characters (for example: !, $, #, %)

For more information, please see Microsoft SQL Server Strong Password Guidelines (http://
msdn2.microsoft.com/en-us/library/ms144284.aspx).

● Install a named instance of SQL Server Express 2008 R2 (Advanced Mode):

Installs SQL Express 2008 R2 SP1 and stores the SQL server data in a different location. When 
prompted, enter the location to store the data. SQL credentials with sysadmin rights are required. The 
user running the installer should be added to the SQL instance permissions as sysadmin during the 
installation.

● Connect to an existing SQL Server:

Allows you to browse to an existing SQL server. SQL credentials with sysadmin rights are required. 
The current user launching the installer should be added to the SQL instance permissions as 
sysadmin during the installation.

If connecting to an existing SQL server,

a. Click Browse to select the Database server on the network.
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b. Select a database server from the list and click OK. Choose the connection method. — Windows 
authentication or SQL Server authentication.
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9. Select a Program Folder and click Next.

10. Click Next to begin the installation of HP AC. This may take several minutes.
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11. When all the components are installed, the Installation is complete message will display. Click Finish.

12. To start HP AC after setup is complete, go to Start > All Programs > HP Access Control, and right-click 
Configuration Utility, then select Run as administrator.

NOTE: It is recommended to set the HP AC configuration utility shortcut to always run as administrator.

3.2 Installing HP AC Enterprise
Complete the following steps to install HP Access Control (HP AC) Secure Pull Print Enterprise. During the 
installation you may be prompted to restart. The installation will automatically resume after reboot.

1. Launch the installer as an administrator by right-clicking the HPAC.exe file. Select the language for 
InstallShield Wizard, and then click OK.

NOTE: The regional settings of the server will determine the language displayed in the HP AC 
configuration utility.

2. Click Install to begin the installation of the required components. This may take several minutes.
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3. Read the End User License Agreement and click Yes to accept the terms.

4. Click Browse to select a folder for the installation, and then click Next.
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5. On the Setup Type, select HP AC Enterprise. A description of the components installed displays on the right 
side.

6. Leave the default options checked. The installation features are pre-selected with check marks.
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7. On the data directory screen, select the folder location to store pull print jobs. The default folder is 
\Program Files\HP\HP Access Control\spoolroot. The installer will prompt you to create the directory. Click 
Next.

8. A SQL server is required for Job Accounting. For SQL Server installation, choose the SQL setup required for 
your environment and click Next.

SQL Server installation — Database options

● Install a Named Instance of SQL Server Express 2008 R2: This will automatically install SQL Express 
2008 R2 SP1 on the local server and name it HPACEXPRESS. A user HPACJA with password HPACJA is 
also created.
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On the sa password screen, enter a password for the SA account in SQL. The password must meet the 
Microsoft SQL Server Strong Password requirements:

– Does not contain all or part of the user's account name

– Is more than eight characters in length

– Contains characters from at least three of the following categories:

○ English uppercase characters (A through Z)

○ English lowercase characters (a through z)

○ Base 10 digits (0 through 9)

○ Nonalphabetic characters (for example: !, $, #, %)

For more information, please see Microsoft SQL Server Strong Password Guidelines (http://
msdn2.microsoft.com/en-us/library/ms144284.aspx).
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● Install a Named instance of SQL Server Express (Advanced Mode): This will install SQL Express 2008 
R2 SP1 and store the SQL server data in a different location. When prompted, enter the location to 
store the data. SQL credentials with sysadmin rights are required. The user running the installer 
should be added to the SQL instance permissions as sysadmin during the installation.

● Connect to an existing SQL Server: This will allow you to browse to an existing SQL server. SQL 
credentials with sysadmin rights are required, and the current user launching the installer should be 
added to the SQL instance permissions as sysadmin during the installation.

9. Click Browse to select the Database Server on the network.
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10. Select a database server from the list and click OK. Choose the connection method — Windows 
authentication or SQL Server.

11. Select a Program Folder and click Next.
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12. Click Next to begin the installation of HP Access Control.

13. When all the components are installed, the Installation is complete message will display. Click Finish.

14. To start HP Access Control after setup is complete, go to Start > All Programs > HP Access Control, and 
right-click Configuration Utility and select Run as Administrator.

NOTE: It is recommended to set the HP AC Configuration utility shortcut to always run as administrator.

3.3 Multi-server installation
For environments that require the use of multiple servers, individual HP AC components can be installed on 
different servers. For example, one server can be dedicated for authentication and pull printing, while another 
server can be dedicated for IPM rules-based printing. On the server, select Server Installation during the HP AC 
installation process, and then select the individual components you want to install on that particular server.
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3.4 Modify or Remove HP Access Control

3.4.1 Modify an HP AC installation

Complete the following steps to modify features of an existing HP AC installation:

1. Launch the installer by right-clicking HPAC.exe and run as administrator. From the Modify/Remove page, 
click Modify and then click Next. The Select Features page displays.

2. Check marks are displayed next to features that are already installed. Unselect the features you wish to 
uninstall, and select any additional to add. Click Next.

If you select to install Job Accounting, the following page displays to allow you to install SQL Server Express 
2008 R2 or to connect to an existing SQL Server. For more information, follow the instructions in Section 3.1, 
Installing HP AC Express or Section 3.2, Installing HP AC Enterprise.
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3.4.2 Removing HP Access Control (HP AC)

Selecting Remove from the Modify/Remove page allows you to uninstall HP AC and all installed features. To do 
this, complete the following steps.

Prerequisites

● Ensure the correct uninstallation PRN file is displayed on the Settings tile > Agent tab.

Complete the following steps:

1. Launch the installer by right-clicking HPAC.exe and run as administrator. From the Modify/Remove page, 
click Remove and then click Next.

2. The following confirmation displays. Click Yes to confirm uninstalling of HP AC.

3. If all printers have been unconfigured, click OK to confirm.
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4. If all printers have NOT been unconfigured, click Cancel, go to the HP AC Configuration Utility and 
unconfigure all configured printers.

For non-FutureSmart devices: Go to the HP AC Configuration utility > Devices, then select the device and 
click Remove HP Agent.

For FutureSmart devices: Either perform a partial clean to remove all non-firmware data stored on the 
device (refer to the device documentation for instructions on performing a partial clean) or remove the 
agent via the EWS > General > Solution Installer page.

5. When the database question page displays, click Yes to keep the database or No to delete the database.
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6. When the uninstall completes, you may be asked to restart the server. Select Yes if you want to restart the 
server. Click Finish.

3.5 Upgrading HP Access Control
NOTE:

● Before upgrading your HP Access Control server please contact HP to ensure your version can be upgraded. 
It is highly recommended to receive technical consultation prior to upgrade.

● For servers with Card ID Masking enabled, it is highly recommended to back up the 
DataDecodeDefaults.xml files prior to upgrading. The AD-Authenticator DataDecodeDefaults.xml file is 
located in the \HP Access Control\AD-Authenticator\ folder. The XT device DataDecodeDefaults.xml file is 
located in the \HP Access Control\DPR\ folder.

An upgrade of HP AC upgrades all HP Access Control (HP AC) components currently installed on the server. 
During an upgrade, all HP AC processes are stopped. Move the latest HP AC installation file to the server where 
the older version of HP AC is installed. Complete the following steps:

1. Right-click the HP AC installation file and select Run as administrator.

2. Click Next to begin the upgrade.
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3. If the HP AC server is connected to a SQL database on a different server using SQL credentials, you may be 
prompted to enter your SQL credentials to restore the connection. Enter the correct SQL login and 
password, then click Next.

4. Click Finish. After upgrading the HP AC configuration tool, make sure to upgrade the agent files on devices. 
Upgrading of a new agent version can be installed over an older agent version.

5. In the HP AC configuration utility click Devices.

6. Select the devices you want to update.

7. Click Install to push the HP AC agent to the device. Choose Yes when prompted.
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NOTE:

● FutureSmart devices will display Receiving Upgrade. Non–FutureSmart devices will display Disk 
Operation Failed. This is expected behavior.

● Installation will fail if device EWS password is not set.

● After upgrading a FutureSmart device, make sure to reapply the Sign-In Method in the device EWS > 
Access Control page.

● After upgrading a non-FutureSmart device, right-click the device and click Update selected to reapply 
authentication.

● For non-FutureSmart devices, in order to use pull printing, OXPd 1.6 must be enabled so that the HP 
AC button will display on the front panel. Right-click the device and choose Enable OXPd 1.6.

8. Wait for the device to reboot.

9. For HP AC Enterprise, go to the HP AC admin console > Settings > SPP Enterprise and click Update printer 
definition.

10. For both HP AC Secure Pull Print Enterprise and HP AC Secure Pull Print Express, it is highly recommended 
that the following settings be re-applied in the HP AC admin console:
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a. In the HP AC configuration utility, go to the Settings tile. Click the Device tab, and enter the 
Administrator password (in the Device section). Click Apply.

b. On the Settings tile, go to the IIS tab. Under each section, click Test to test the connection and click 
Apply.

● If Job Accounting and IPM were previously installed, go to Settings tab > Database tab. In the Database 
configuration section, click Test to test the connection to the Job Accounting database and click Apply.
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NOTE: When using Windows authentication to connect to the Job Accounting database, ensure that for the 
Agent Configuration section the LocalSystem account is unchecked, and the correct Windows Domain\User and 
Password credentials are entered. This is required for access to the database. Select to Restart services after 
update and click Test and Apply.

● If Job Accounting was installed, go to the Settings tile. Go to IIS tab. In the Push mode section, click Test and 
Apply.

3.6 Installing OXPd Professional Services (OPS) for OfficeJet Pro 
devices

1. OXPd Professional Services (OPS) is required for OfficeJet Pro devices to communicate with the HP AC 
server. Click Install.
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NOTE: OPS (OXPd Professional Services) is a web-based service required for OfficeJet Pro devices. OPS 
hosts all printer configurations for OfficeJet Pro devices.

2. If required, you will be prompted for OPS pre-requisites. Click Install.
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3. Read and accept the End User License Agreement. Click Next.

4. Choose the default installation location, and click Next.

5. On the OPS Instance Details screen,

a. For OPS Details. The Port field will automatically be populated with the default port. This can, 
however, be changed by entering a new port.

b. For OPS and Apache CouchDB Admin User Details, the default DBName and Port information will 
automatically be populated. Enter a Password to protect the OPS database.

c. Click Next.
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6. Once the OPS server is installed, ensure Launch OPS is checked. This will start the OPS service.

7. Click Finish. A pop-up will confirm the OPS Server is listening at https://<HPACServer>:8081.

Section 3.6   Installing OXPd Professional Services (OPS) for OfficeJet Pro devices 41



NOTE:

● On a 32-bit server, OPS does not start automatically when Launch HP OPS is selected. You must 
configure the OPS service manually to start with a domain account through Administrative Tools > 
Services.

● If OPS installation fails, you can launch it later from \Program Files\HP\HP Access Control\Misc
\OPSsetup.

● Make sure the port displayed in the Port field is open on the firewall. The default port that the OPS 
server uses to communicate with HP OfficeJet devices is port 8081. This port can be changed.

● If the password is changed after installation, OPS will need to be reinstalled.

● If the OPS Server is listening pop-up does not launch, the OPS service can be started manually. On the 
server, go to Administrative Tools > Services, and Start the HP OPS service.
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4 HP Access Control Configuration utility

4.1 Overview
The following chapters explain how to use the HP Access Control (HP AC) configuration tool and introduce you to 
the process of configuring HP Access Control (HP AC) solutions on print devices.

To open the HP AC Configuration tool, go to Start > All Programs > HP Access Control, then right-click HP AC 
Configuration utility and choose to Run as Administrator.

The HP AC Configuration tool consists of components organized as tiles on the home screen.

NOTE: If an administrator is managing access to the HP AC Configuration utility then not all tiles may be shown, 
and access to some features and functionality may be view only. Please refer to Managing access to the 
Configuration Utility (see Section 9.1, Managing access to the Admin console). Tiles showing may vary depending 
on what components/bundle has been installed on the server.

Figure 4-1  Home screen

IMPORTANT: Tiles and tabs highlighted orange indicate items that are recommended to be completed. It is 
highly recommended to complete all the orange items before using HP AC. See Section 4.2, Configuring general 
settings. 

NOTE: The IRM tile does not have fields highlighted orange.

4.1.1 Navigation and Help

Click a tile from the HP Access Control (HP AC) home screen to use the component. Return to the home screen at 
any time by clicking the back button in the top left corner, or by clicking on the HP Access Control icon.
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4.1.1.1 Menus and Tabs

Within Tiles, the application has Menu items and Tabs for easier navigation.

Menus

Menus will appear at the top of the screen, in the gray bar.

Tabs

Tabs appear at the top, beneath the menu bar. You can click on the word to navigate to that tab.

4.1.1.2 Help menu

To view the HP AC Administrator manuals, click on the ? to open the Help document. HP AC documentation can 
be accessed from two locations: the HP AC documentation web site or the documentation folder on the server.

4.1.1.3 Device tile

The Devices tile allows you to manage devices in your printing environment. Organize devices into groups and 
see what is installed on each printer. From the Devices tile, you can easily install and configure printers for 
tracking, quota, pull printing, authentication, or rights managements.
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1. Device groups: In the device groups section you can create groups to better organize your printer 
environment. Right-click a group name to Add, Delete, or Rename a group.

2. Device list: The device list section displays device information, such as the device model, IP address and 
configuration status. When a component is configured on a device, an X displays under the Pull Printing, 
Tracking, Authentication, Authorization, Quota or Trap column, depending on the component that is 
enabled.

3. Device details: The device details section allows you to view more information about a device and the 
solution installed. Click the License field to view a drop-down list of components that are enabled and 
licensed. The Location field displays location information from a FutureSmart EWS. For a non-FutureSmart 
device or XT device, type information in the Location and Comment fields, hit Enter, then reconfigure the 
device. The device details may vary, depending on what is installed on the device.

4. Status bar: The status bar allows you to view error messages and the status of scans or configurations. 
Right-click in the status bar and click Clear to delete the log information.

5. Tracking bar: The tracking bar displays data from devices configured for Confirmation Trap or from 
FutureSmart devices configured for Tracking.

Device rows in the device list may be highlighted, indicating the following:

● Yellow - The Agent file is installed but not configured for tracking.

● Grey - The device is an XT device. See Section 5.7.6, XT devices and Section 6.5.5, XT devices.

● Red - The solution is installed, but not licensed. On HP non-FutureSmart devices, red also indicates the 
solution is installed, but not configured correctly to push tracking data to the Job Accounting server.

NOTE: When importing HP FutureSmart devices from a CSV file or manually adding HP FutureSmart devices, 
device information is retrieved using OXPd. This allows for SNMP V1 or V2 to be disabled on devices, if needed.
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NOTE: To update the device list, right-click the device group and click Update. This is recommended in case 
another user using the web console modified the device list.

4.1.1.4 Print server tile

The Print server tile displays all print queues installed on the server, allowing you to configure print queues for 
tracking, quota or IPM. The columns may vary, depending on if Job Accounting, IPM or both are installed.

The check boxes under the columns indicate what features are enabled for the print queue.

4.1.1.5 Server Information tile

The Server Information tile displays valuable information to help you manage HP AC on your server. This tile 
displays information about the server and the ability to enable and view the HP AC logs. This makes it easy to 
check if your HP AC components are up to date, and view valuable information about your server, such as hard 
drive space available. Click Help > About to view copyright information about HP Access Control (HP AC). See 
Section 15.3, Server information.
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4.2 Configuring general settings
Prerequisites

● HP AC Agent and HP AC Secure Pull Print Express/Enterprise must be installed on the server.

● HP AC Job Accounting server installed on a local or remote server on your network.

NOTE:

● For security reasons, Windows authentication passwords (such as those in the License tile and Database 
tile) do not display after the HP AC configuration utility is closed and reopened. The password is saved but 
does not display.

● This must be performed prior to configuring devices.

Complete the following steps:

1. After installation the HP Access Control configuration utility will highlight in orange the general 
configuration options that must be configured prior to configuring a device for use with HP Access Control. 
The Devices tile and Settings tile (including the SPP Enterprise, Database, Device, IIS, and License settings) 
are highlighted orange. After the configuration changes have been made the highlighted areas will return 
to normal color indicating the change has been made once you navigate to a new tab or tile.

Section 4.2   Configuring general settings 47



2. To send tracking data from devices to the Job Accounting server (if Job Accounting has been installed), the 
transfer protocol must be configured. This is used by non-FutureSmart devices to upload job Accounting 
tracking files. It is also used in a multi-server environment to point the Job Accounting data collectors to the 
main Job Accounting server.

To configure the server for tracking data, complete the following steps:

a. Go to the Setting tile > IIS tab.

b. Under Push mode, select the protocol to transfer the data.

● Hypertext Transfer Protocol (HTTP) connections are usually terminated after a particular 
request has been completed. If HTTP is selected, Windows credentials are required in the Login 
and Password fields. Also, if IIS 7 or newer is installed on the server, Basic Authentication needs 
to be enabled. Devices require Basic Authentication to pass data via HTTP when IPA sends 
tracking data to the Job Accounting Print Server. The default Port is 80.

● File Transfer Protocol (FTP) is best for uploading data to an internal database server. If FTP is 
selected, any credentials can be used in the Login and Password fields. By default, both Login 
and Password are "Anonymous." The default Port is 21. Select the PASV checkbox to enable 
passive mode FTP if you want to allow data to transfer more easily through firewalls.

c. Set the Interval (minutes) to specify how often tracking data is pushed from the devices to the Job 
Accounting server.

d. Click Test and Apply.

NOTE: When accessing the Push Mode settings from a Job Accounting server, the Push Mode 
settings apply to HP non-FutureSmart devices and is used to push IPA tracking files from the device 
to the server. HP non-FutureSmart devices support FTP and HTTP protocols only, so if HTTPS is 
selected, the settings will revert to HTTP when the HP AC admin console is reopened.

3. The Web service configuration is used for the following:

● For devices to communicate with the Job Accounting website to determine quotas for copies and 
digital send jobs.

● To send IPM notifications to client desktops.

● For users to access pull print jobs from a device, mobile device, or web page.
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● For communication between the server and the IRM license Web service.

● For central management of print devices. When multiple servers are entered in the Web service 
settings, and when devices are configured in the Devices tile, a drop-down list displays in the 
Configure window allowing you to select the server you want to configure the device to. From one 
central server you can configure print devices to be managed by a different server.

To do this, complete the following steps:

a. In the HP AC configuration utility, go to the Settings tile.

b. Click the IIS tab. Under the Web service section you will see the Server name and IP address of the 
server containing the Quota, IPM, and Pull Printing web services.

c. To add additional servers, double-click in the fields and enter the Fully Qualified Domain Name (FQDN) 
of the additional server(s) and the IP addresses. Hit the Enter key and click Test. The Status column 
should display OK.

NOTE:

● When configuring HP AC there may be a requirement to set the device to look at multiple IIS 
servers. When multiple IIS servers are in the Settings > IIS area, then the option to configure for 
a different IIS server will appear for the Pull Printing, Tracking, and Authentication/Authorization 
options in the Devices > Configuration window. The Authentication and Authorization options 
must be configured to the same server.

● When using multiple IIS servers, ensure that the server certificates are configured properly. 
Refer to Section 4.2.4.3, Creating certificates in a multi-server installation.
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d. By default, Encrypt all web communication (devices) is enabled. This will enable HTTPS protocol for 
communication between the devices and the servers. For some web communications HTTPs is 
already enforced and not configurable.

e. If using a certificate that was issued to a server name then you must check Use server name instead 
of IP (devices).

NOTE: If using server name, ensure the device’s DNS entry is properly configured.

The status should return as OK.

4. Certificates are required for security to confirm the identity of a web server before sensitive data is 
transferred. See Section 4.2.4, Configuring server certificates. To generate self-signed v3 certificates, 
complete the following steps:

a. Click on the Settings tile > IIS tab.

b. Click Create Certificate. Two certificates are created for the server: one based on the server name and 
one based on the IP address. The certificates are created in the \Program Files\HP\HP Access Control 
folder. The certificates are also created in \Program Files\HP\HP Access Control\Open SSL and are 
used for communication between multiple HP AC servers. A message will appear in the messages 
pane showing successful creation:

c. Click Apply. This will automatically bind the certificate to the default web site.
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To view assigned certificates in IIS:

a. Go to IIS Manager.

b. Select https and click Edit

c. In the SSL certificate field you will see the certificate.
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5. Under Database configuration click Test and Apply to verify and test the connection to the Job Accounting 
database.

A message will appear in the messages pane showing successful creation.

6. In the Device menu enter the admin password for the device.

NOTE: All devices must be configured with this password before configuration. Please refer to product 
documentation on how to set the Embedded Web Server password on the device.

7. Go to the License tab and choose the mode of licensing. Refer to Section 4.2.7, Configuring the server for 
licensing for more information. To use the default licensing mode click Apply.
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8. Go to the SPP Enterprise tab and under Pull Print queues click Add to add a pull print queue. Refer to Pull 
Printing for further configuration options for pull printing.

9. Go to the Devices tile to add a device by entering in the IP address of the device and click Add. For more 
details and options see Section 4.2.1, Adding devices.

NOTE: Default configuration for IRM (authentication) is set to code with LDAP as the storage option. Please 
refer to Section 5.4.2, Authentication method and data storage options.

4.2.1 Adding devices

Adding devices to the HP AC configuration utility can be done either individually, by scanning for devices over the 
network, or by importing.

Prerequisites

● Printers and devices must be turned on and connected to the network.

● Device’s EWS password has been set.

● Device’s EWS username and password is entered in the Settings tile > Device tab.

4.2.1.1 Adding devices individually

Complete the following steps to add devices individually:

1. In the HP AC Configuration utility, click on Devices.
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2. Enter the device IP address and click Add.

4.2.1.2 Adding multiple devices

You can add multiple devices either through an SNMP discovery or by entering an IP range.

To scan devices over SNMP:

1. Choose Snmp discovery from the Devices drop-down menu. This will send a broadcast over the network to 
discover available devices.
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2. The progress of the scan displays in the status section at the bottom and the device data appears in the 
device list.

To enter an IP range:

1. In the Devices menu, enter the IP addresses in the Start and End fields. To add multiple IP ranges, enter the 
IP range in the Start and End fields and click Add to add additional ranges. To load a previously saved IP 
range, click Load.

2. Click Start to scan the network.

3. The progress of the scan displays in the status section at the bottom, and device data appears in the device 
list.

4. Click Save to save the IP range list.

4.2.1.3 Discovering devices using SNMP v3

Prerequisites:

● To use SNMP v3 to discover devices, make sure SNMP v3 is enabled in the device EWS > Networking > 
Network Settings page.

NOTE: If SNMP v3 settings are set in the HPAC > Settings > Device > SNMP section, then SNMP v3 will be used 
to discover devices. If SNMP v3 settings are not set, then SNMP v1/v2 is used. If the server attempts to but 
cannot connect to a device using SNMP v3, then SNMP v1/v2 is used.
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The SNMP v3 information entered on the device must match what is entered in HPAC. Complete the following 
steps:

1. In the User name field, enter the user name on the device for authentication.

Figure 4-2  SNMP information

2. Select the Authentication protocol based on the Message Digest Algorithm 5 (MD5) or Secure Hash 
Algorithm (SHA). Enter the Passphrase to match what is entered on the device.

3. Select the Privacy protocol based on the Data Encryption Standard (DES) or AES-128. Enter the Passphrase 
to match what is entered on the device.

4. For HP devices, keep the Context name as “Jetdirect”.

5. Click Apply.

4.2.1.4 Adding XT devices

The XT device is an external device with an attached card reader that allows for pull printing at any printer or 
multi-function device. A user simply presents his or her card at the XT card reader and all of his or her stored 
jobs are printed at the connected printer.

Prerequisites

● XT devices must be connected to a power source, connected to the network, and connected to a printer.

● If your server has a firewall and you want to scan the network using SNMP discovery, make sure UDP 
11000 is open.

● Card reader connected to the XT device.

To Scan over SNMP:

1. In the Devices tile, go to the Devices menu and select SNMP discovery (XT). A broadcast will be sent over 
the network.
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2. The progress of the scan displays in the status section at the bottom and the device data appears in the 
device list.

To Scan over IP:

1. In the Devices tile, go to the Devices menu and select IP range (XT).

Section 4.2   Configuring general settings 57



2. In the Devices menu enter the IP addresses in the Start and End fields. To add multiple IP ranges, enter the 
IP range in the Start and End fields and click Add to add additional ranges.

NOTE: To Load a previously saved IP range, click Load.

3. Click Start to scan the network.

4. The progress of the scan displays in the status section at the bottom, and device data appears in the device 
list.

5. Click Save to save the IP range list.

4.2.1.5 Importing device data

Device data can be imported in an ASCII or CSV format.

To import a list of IP addresses/host names in ASCII or CSV format, complete the following steps:

Prerequisites

● The CSV file must be exported from Web Jetadmin first.

● In the TXT or CSV file, each device must be listed on a separate line.

Refer to the HP Web JetAdmin documentation for instructions on how to export a CSV file.

To import device data from a CSV file:

1. Go to the Devices menu and select Import WJA file....
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2. Browse to the location of the file, and click Open.

The progress will display in the status section at the bottom, and device data appears in the device list.

To Import device data from an ASCII file:

1. Go to the Devices menu and select Import ASCII file....

2. Browse to the location of the file, and click Open.

3. The progress will display in the status section at the bottom, and device data appears in the device list.

4.2.1.6 Block device with no licenses

If the limit of the number of IRM licenses has been reached, then the administrator will not be allowed to add 
more devices in the Devices tile. When attempting to input a new device in the Devices tile, a check will be made 
against the number of IRM licenses. If the licenses are completely used, then a new device will not be added. If 
standard licenses are used (Section 4.2.7.1, Standard Licensing), then the check for the agent will be made to 
where the agent license is defined (e.g. a central server or local licenses). If Enterprise licenses are in use (Section 
4.2.7.2, Enterprise Licensing), then the check will be made from each server to the central SQL database when a 
device is added to the list. In the case of an SNMP broadcast or IP range, then once the number of devices has 
been reached, no more will be added.

4.2.1.7 Organize and manage devices

If you want to organize devices by groups, complete the following steps:
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1. Right-click the HP AC device group and click Add. Give the new group a unique name.

2. Click and drag devices from the device list to the new group name. This moves the device data from the HP 
AC group to the new group.

TIP:

● Create multiple groups to better organize your printer environment. For example, create a group for 
single-function printers named SFPs to manage the installation and configuration of only single-
function printers.

● Drag multiple columns to the drag and drop area for better organization. Rearrange the order of the 
columns from left to right to change the order of information displayed.

If you want to better organize the information displayed in the device list, click and drag column headings 
to the Drag and drop columns area.

Click the filter icon in any column to sort or filter device data.
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4.2.1.8 Devices drop-down menu

When in the Devices tile, you can right-click on a device to display a drop-down menu of possible actions:

● Click Go to printer EWS to go to the device’s Embedded Web Server page.

● Click Update selected to refresh the device data.

4.2.2 Email

For information about configuring the server to allow users to email jobs for pull printing, please see Section 6.2, 
Set up the HP Access Control (HP AC) Secure Pull Print server for email printing 

4.2.2.1 Set SMTP Server parameters

This section describes how to set the AD-Authenticator SMTP Server parameters. The AD-Authenticator uses the 
SMTP server to email users their assigned codes and access rights.

1. Click SMTP Server in the IRM tile > AD Configurator tab to select the SMTP server parameter page.
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2. Set the SMTP Server address. The AD-Authenticator can usually detect your SMTP server automatically. 
Select Automatically detect SMTP server to enable this feature. To disable the feature, uncheck the box and 
enter the network name or IP address of your SMTP server.

3. Specify the username and password to be used to access the SMTP server if the server requires 
authentication.

4. Codes sent by email to users are automatically sent from the address “no-reply@domain.com”, where the 
domain is automatically populated using the user’s email address. When using multiple domains, it is 
required to enter the email address to be used in the “SMTP sender reply-to email address” field. This is the 
“FROM” email address that users will see when they receive a code through email.

4.2.2.2 Configuring for email notification

Perform the following steps to configure the HP Access Control server to send email notifications to end users, 
all of which contain information that can be sent via email:

● Job Accounting reports

● Device analysis scheduled scans.

● IPM notifications (when using email notification).

● Notification from the Secure Pull Print Express or the Secure Pull Print Enterprise if a user’s job cannot be 
processed.

● AD User Editor information, AD Group Manager information, and User List Editor PINs.

● HP Access Control Enterprise license notification.

Prerequisites

● Email attribute configured in the IRM tile > AD Configurator > Users tab.

Complete the following steps:

1. In the Settings tile select the Email tab.
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2. Under the SMTP section, enter the Server name (name or address of your company’s email server).

3. If required, change the email Server port (default is 25). Click the TLS checkbox to enable Transport Layer 
Security protocol to encrypt and deliver mail securely.

4. Enter the domain user / password having access to the email server in the Login and Password fields.

5. In the Sender email address field, enter the email address you want to appear in the “From” field of emails. 
If you are submitting jobs for email printing to the HP AC server it is recommended to use the same email 
address that the users submit their jobs to, so that users receive notification emails from that address. See 
Section 6.2, Set up the HP Access Control (HP AC) Secure Pull Print server for email printing 

6. In the Recipient email address field, enter an email address to test the connection between the email 
server and the recipient. Click Test.

7. In the Email subject field, enter the subject of the notification email. The default is HP AC Secure Pull 
Printing.

8. In the Email body field, enter the message you want to appear in the body of the notification email. The 
default is The file {0} can’t be processed where {0} represents the name of the job.

NOTE: For device-based user lists you will be prompted before sending user the PINs to enter the SMTP server 
information again.
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4.2.3 Configuring the server for device communication

Before configuring devices you must enter the device administrator password in the HP AC configuration utility. 
The device password must be the same password for all print devices.

Prerequisites

● HP Access Control (HP AC) Agent and HP Access Control (HP AC) Secure Pull Print Express/Enterprise must 
be installed on the server.

● Before installing any solution on HP devices, make sure the correct PRN installation file displays in the 
installation file field in the Settings tile > Agent tab.

Complete the following steps:

1. In the HP AC configuration utility, go to the Settings tile.

2. Click Device tab and enter the Administrator password (in the Device section).

NOTE: All device's must be configured with this password before configuration. Please refer to product 
documentation on how to set the Embedded Web Server password on the device.

a. Disable device ping — Select this check box if pinging between devices and server is NOT allowed. 
Disabling this will force it to perform telnet communications only if ping is disabled on your network. 
By default, the box is not selected – meaning that ping is used to detect the presence of a device IP, 
and then telnet is used to verify that the device is a printer.

b. Click Apply.

3. Go to the Settings tile and select the Device tab. Under the Concurrent connection, set the maximum 
number of network devices you want to install and configure at one time. The maximum number of 
concurrent connections allowed is 50.

4.2.4 Configuring server certificates

The servers need to be configured to use certificates. Server certificates are used for security purposes, to 
confirm the identity of a Web server before sensitive data is transmitted, and to establish a secure HTTPs 
communication to exchange data. With HP AC, certificates are required to exchange authentication/authorization 
data through HTTPs, and to establish (for OfficeJet Pro devices) to use OPS for the initial configuration of the 
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print devices. These are also useful in order to optionally encrypt other communications between servers and 
between servers and devices.

IMPORTANT: It is not recommended to use a self-signed certificate in production environments. It is 
recommended that you use a certificate that is issued and signed by a trusted certification authority or create a 
v3 certificate from within the HP AC configuration utility. It is not recommended to use the certificate created by 
the OPS installer in production environments.

The following diagram illustrates how certificates are used when a communication from a device to a server is 
established for an HTTPs communication, related for example to an authentication event.

4.2.4.1 Configuring Web services

The Web service configuration is used for the following:

● For devices to communicate with the Job Accounting website to determine quotas for copies and digital 
send jobs.

● To send IPM notifications to client desktops.

● For users to access pull print jobs from a device, mobile device, or web page.

● For communication between the server and the IRM license Web service.

● For central management of print devices. When multiple servers are entered in the Web service settings, 
and when devices are configured in the Devices tile, a drop-down list displays in the Configure window 
allowing you to select the server you want to configure the device to. From one central server you can 
configure print devices to be managed by a different server.

Prerequisites

● HP Access Control (HP AC) Agent and HP Access Control (HP AC) Secure Pull Print Express or HP Access 
Control (HP AC) Secure Pull Print Enterprise must be installed on the server.

To do this, complete the following steps:

1. In the HP AC configuration utility, go to the Settings tile.

2. Click the IIS tab. Under the Web service section you will see the Server name and IP address of the server 
containing the Quota, IPM, and Pull Printing web services.
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3. To add additional servers, double-click in the fields and enter the Fully Qualified Domain Name (FQDN) of 
the additional server(s) and the IP addresses. Hit the <enter> key and click Test. The Status column should 
display OK.

NOTE:

● When configuring HP AC there may be a requirement to set the device to look at multiple IIS servers. 
When multiple IIS servers are in the Settings > IIS area, then the option to configure for a different IIS 
server will appear for the Pull Printing, Tracking, and Authentication/Authorization options in the 
Devices > Configuration window. The Authentication and Authorization options must be configured to 
the same server.

● When using multiple IIS servers ensure that the server certificates are configured properly. Refer to 
Section 4.2.4.3, Creating certificates in a multi-server installation.

4. By default, Encrypt all web communication (devices) is enabled. This will enable HTTPS protocol for 
communication between the devices and the servers. For some web communications HTTPs is already 
enforced and not configurable.

5. If using a certificate that was issued to a server name then you must check Use server name instead of IP 
(devices).

NOTE: If using server name, ensure the device’s DNS entry is properly configured.
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4.2.4.2 Generating self-signed v3 Certificates

To generate self-signed v3 certificates, complete the following steps:

1. Click the Settings tile > IIS tab.

2. Click Create Certificate. Two certificates are created for the server: one based on the server name and one 
based on the IP address. The certificates are created in the \Program Files\HP\HP Access Control folder. The 
certificates are also created in \Program Files\HP\HP Access Control\Open SSL and are used for 
communication between multiple HP AC servers.

3. Click Apply. This will automatically bind the certificate to the default web site.

To view the assigned certificates in IIS:

1. Go to IIS Manager.

2. Go to the Sites > default Web Site and select Bindings in the Actions pane.

3. Select https and click Edit.
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4. In the SSL certificate field, you will see the certificate.

4.2.4.3 Creating certificates in a multi-server installation

In a multi-server installation, all servers must contain certificates for all servers. Certificates must be created 
from one server and copied to the other remote servers. Do not create certificates on each remote server.

1. On the central server go to Settings>IIS and add the hostname and IP address of the other servers to the 
list. Press the <Enter> key.

2. Click Create Certificate.

3. Go to \Program Files\HP\HP Access Control\Open SSL and copy the two personal information exchange 
files created for each server.
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4. On each remote server copy the corresponding certificates for each server and paste them into the 
\Program Files\HP\HP Access Control\Open SSL directory.

5. On each remote server launch mmc and open the Certificates snap-in for the Computer Account.
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6. Right-click on the Personal folder and under All Tasks choose Import.

7. Browse and import both the hostname and the IP certificate from the OpenSSL folder.

8. When prompted enter the password: HPAC.
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9. Expand the Trusted Root Certificate Authorities, right-click Certificates and choose Import under All Tasks.

10. Import both the hostname and IP address certificate from the OpenSSL folder. When prompted enter HPAC 
for the password. Now when devices are configured from one server to use another server for 
authentication, secure communication between the devices and all the servers can be established.

4.2.5 Using the customer’s signed certificate

If the customer has their own certificate that was issued and signed by a trusted certification authority, then use 
these certificates instead of the v3 certificate created by the HP AC configuration utility. HP Access control 
requires both the *.PFX and the *.CER certificate.

1. Copy the certificate (personal information exchange file) to the \Program Files\HP\HP Access 
Control\Open SSL folder.

NOTE: After the customer certificate is added to the Microsoft Management Console and HTTPS bindings, 
the certificate will be pushed to a device at the time the device is configured for authentication and/or pull 
printing. Certificates can also be pushed using HP Web Jetadmin.
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2. Launch MMC and under the file menu choose Add/Remove Snap-in. Select Certificates snap-in for the 
Computer Account.

3. Right click on the Personal folder, navigate to All Tasks, and choose Import.

4. Browse and import the *.pfx certificate from the OpenSSL folder.
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5. When prompted, enter the password for the certificate.

6. Go to IIS Manager.

7. Go to Sites > Default website, navigate to the Actions pane and select Bindings.
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8. Select https and click Edit.

9. In the SSL certificate field, select the customer’s certificate.

10. The *.CER certificate that the customer has supplied you must be renamed in the format of "IIS x.x.x.x.cer" 
or "IIS FQDN.cer", where "x.x.x.x" is the IP address of the server and "FQDN" is the FQDN of the server.

11. Copy the renamed file into the \Program Files\HP\HP Access control directory.

IMPORTANT: If using a certificate that was issued to a server name then you must check "Use server name 
instead of IP (devices) in the Settings > IIS > Web Services section in the configuration utility. Ensure that 
the device's DNS entry is properly configured.
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4.2.6 Configuring the Agent license service

The Agent license service allows you to assign IRM licensing to a different server. By default, the field is 
populated with the IP address of the current server.

NOTE: This must be performed prior to configuring devices.

Prerequisites

● HP Access Control (HP AC) Agent and HP Access Control (HP AC) Secure Pull Print Express/Enterprise must 
be installed on the server.

Complete the following steps:

1. Go to the Settings tile. Under the IIS tab, enter the Hostname or IP address of the server that is hosting the 
license service.

2. Click Apply.

4.2.7 Configuring the server for licensing

4.2.7.1 Standard Licensing

By default the server will use standard licensing. In this licensing model, the server is required to have the 
corresponding number of licenses for each device that will be configured from that server.

4.2.7.2 Enterprise Licensing

Prerequisites

● For email notifications, email settings must be configured in the Settings tile > Email tab > SMTP area. See 
Section 4.2.2, Email

When installing in a multi-server installation it is recommended to use enterprise licensing. One server will be the 
central license server and all other servers will become clients communicating to the central server for licensing 
of the devices. A database is created to store all component license keys. This database can be on the central 
server or stored off server in a SQL database.

4.2.7.2.1 Central License Server

1. Select Type Server on the server that will be the central licensing server.

2. Enter the SQL server name and instance if applicable where the database will be stored.

3. Enter the database name you want to create or connect to. If creating a database the name can be 
anything (i.e. License).

4. Choose the authentication method - SQL or Windows. The account must have db_creator rights or 
sysadmin rights in order to create the database. After the database is created the account can use 
db_owner.

5. The default port the clients will use to communicate with the license server is 50080. The port must be 
open inbound and outbound on the central license server.
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6. In the recipient email addresses field, enter the email addresses of the HPAC administrators that will be 
notified when there is an error communicating with the databases or when licenses are about to expire.

a. In the Email body for license server error you can customize the notification that will be sent out.

b. In the Email body for license expiration you can customize the notification that is sent regarding the 
expiration of licenses.

7. Click Test and then Apply. After clicking Apply the HP AC License Service will install in the background. After 
installation is complete you can view the service in the services console.

NOTE:

● The specified port must be opened on the server for the client servers to communicate with the central 
server.

● Notifications apply to individual component licenses.

● Notifications will be emailed on the following schedule: 90, 60, 30, 15, 7, 6, 5, 4, 3, 2, 1 day(s) before the 
expiration date. On the expiration date and every day after emails will be sent.

● Using Enterprise licensing will change the license ID key to be the name of the server.

● The HP AC License Server service allows for communication to the license database and only runs on the 
central server.

● If there is a loss of connection to the SQL database, the pull printing license pool will be available for 7 
days. After 7 days, the pull printing license will be released from the assigned devices and users will not be 
able to pull print from the devices.

4.2.7.2.2 Client License Server

These steps need to be performed on each server that will be communicating with the central license server.

Prerequisites

● SMTP settings must be configured. See Section 4.2.2, Email

Complete the following steps:

1. In the Settings tile go to the License tab.

2. Select Enterprise as the mode and under Type, choose Client.

3. In the License Server name:Port enter the server name and port (HPAC-A-1:50080). The default port is 
50080. The port specified must match the port set on the central server. The port must be open inbound 
and outbound on the client license server.

4. In the recipient email addresses field, enter the email addresses of the administrators that will be notified 
in the event that there is an error communicating to the central server.

5. In the email body for license server error you can customize the notification that is sent when a connection 
error occurs.

4.2.8 Set user parameters

This section describes the procedure for configuring AD-Authenticator to access read-only user information from 
your Active Directory.
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Complete the following steps to configure your user information:

1. Click Users to select the user parameter page.

2. Enter the correct LDAP attribute names for each of the listed user properties. The default values are 
appropriate for most Active Directory installations.

3. Once all attributes are correct, press the Apply button to store any changes you have made.

4.2.9 Configuring Job Accounting general settings

4.2.9.1 Configuring database access when using a remote SQL server

Prerequisites

When the HP AC Job Accounting database is installed on a remote server, the database connection must be 
configured for the following:

● Allow Job Accounting to process job accounting files

● Allow end users to connect to the Job Accounting website to schedule and view reports

● Authentication method set correctly

4.2.9.1.1 Authentication methods

There are two methods available to connect to the remote database:

● Windows authentication

● SQL authentication

4.2.9.1.1.1 Windows authentication

When Windows Authentication is used, anonymous authentication must be enabled in IIS using a Windows 
account with database access to the Job Accounting Database. The Job Accounting Agent service must be 
started with the same account.

1. Create or use a Windows account with dbo access to the Job Accounting database.

2. Log onto the Job Accounting application server using the Windows account login created in step 1.

3. Launch the HP Access Control Configuration utility.

Section 4.2   Configuring general settings 77



4. Go to the Settings tile and in the Database tab, under Database configuration select Windows 
authentication. Select Test and Apply to verify and test the connection to the job accounting database.

5. Uncheck LocalSystem account. Enter the account user name and password. This login account will be used 
to start the HP Access Control Job Accounting Agent service and for Anonymous Authentication in IIS. Select 
Enable IIS anonymous authentication which assigns the IIS anonymous user identity to the username 
entered in the Domain\User field. This allows only domain users to access the Job Accounting website. Click 
Restart services after update.

NOTE:

● This allows for automatic import of domain users/groups into the JA server.

● If using windows authentication for SQL this is required for access to the Job Accounting database.

4.2.9.1.1.2 SQL authentication

When SQL authentication is used, the SQL password will be stored non-encrypted in the HP Access Control Job 
Accounting Agent service configuration file (Agent.exe.config). The HP Access Control Job Accounting application 
will store the SQL password encrypted in the registry.

1. Create or use a SQL user and password on the remote SQL server and give this account dbo access to the 
HP Access Control Job Accounting database.

2. Launch the HP Access Control Configuration utility.

3. Go to the Settings tile and in the Database tab, under Database configuration, select SQL Authentication.

4. Enter the user name and password for the SQL account.

5. Select Test and Apply to verify and test the connection to the Job Accounting database.
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4.2.9.2 Configuration for User tracking

The following steps must be completed when using Job Accounting.

1. The first time a user prints they will be automatically added to the database, or you can perform a network 
scan. Go to the Job Accounting tile and log in with the default Job Accounting Administrator account: admin/
Admin (case sensitive).

2. On the left menu, click Administration and then the Active Directory menu. Select Retrieve User Data.
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3. Enter the DNS name for the domain and the User name and Password having read rights to that domain.

NOTE: The domain name is required before the username. This user will be used to search the network 
and must have administrator rights in each domain the scan is performed in.

4. Click the Play  button.

5. To see the data, navigate to another page and then back to the Active Directory tab to see the new data.

6. Click to select user options. Enter email address that will receive Job Accounting reports and click on the 
arrow button to save.

7. Go to the Settings tile > Device tab. Under Tracking, select the device information to be displayed in Job 
Accounting reports (this applies to HP FutureSmart devices only).

● Network name: Displays host names of devices in the Job Accounting reports.

● Device name: Displays model names in Job Accounting reports.

NOTE: If you have many of the same models in the environment then it is recommended to select 
Network name to avoid duplication.

8. Under SNMP, do the following:

a. Ensure the Get Community name entered has read access to read the network/host name of the 
device. The default GET community name for HP devices is public. The SET community name is not 
used by HP AC is this version.

b. If using Traps, in the Trap level field, select the type of traps you want to track with Direct Tracking 
Module (DTM). Before configuring a device for Confirmation Traps, make sure the device supports 
SNMP traps. A trap is a packet of information provided by the printer that indicates basic job 
information and print job status, and is supported on HP print devices only. It is recommended to use 
the in-printer agent for tracking and not the Direct Tracking Module.

● Print confirmation traps is the default Trap level. With Print Confirmation traps selected, only 
printed job traps are sent from the device. This is used to reduce the network traffic with 
unwanted traps.

● All traps are to track all jobs, printed, copied, or digitally sent. Some versions of HP JetDirect 
require that All traps mode is selected.
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The UDP port field is the port used by the trap service. By default, the Trap service uses UDP port 162. 
If the port is used by another application or service on the same server, the Job Accounting Trap 
service can use another port. If the port is changed, the Job Accounting Trap service 
(HPACJA_SnmpTrap) needs to be stopped and restarted. Printers also need to be reconfigured using 
the new port.

The Filter delay (ms) field is the port used by the Trap service. By default, the Trap service uses UDP 
port 162. If the port is used by another application or service on the same server, the Job Accounting 
Trap service can use another port. If the port is changed, the Job Accounting Trap service 
(HPACJA_SnmpTrap) needs to be stopped and restarted. Printers also need to be reconfigured using 
the new port.

NOTE: To test a device, in the Devices tile, right-click on a device to display a drop-down menu. Select Test trap 
to test the device with the Confirmation traps component enabled. 

4.2.9.3 Configuring the server for tracking data

To send tracking data from devices to the Job Accounting server, the transfer protocol must be configured. This 
is used by non-FutureSmart devices to upload job accounting tracking files. It is also used in a multi-server 
environment to point the Job Accounting data collectors to the main Job Accounting server.

NOTE:

● This must be performed prior to configuring devices.

● When accessing the Push Mode settings from a Job Accounting server, the Push Mode settings apply to HP 
non-FutureSmart devices and are used to push tracking files from the device to the server. HP non-
FutureSmart devices support FTP and HTTP protocols only, so if HTTPS is selected, the settings will revert 
to HTTP when the HP AC Admin console is reopened.

Prerequisites

● HP AC Agent and HP AC Secure Pull Print Express/Enterprise must be installed on the server.

● HP AC Job Accounting server installed on a local or remote server on your network.

To configure the server for tracking data, complete the following steps:

1. Go to the Settings tile and select the IIS tab.

2. Under Push mode, select the protocol to transfer the data.

● Hypertext Transfer Protocol (HTTP) connections are usually terminated after a particular request has 
been completed. If HTTP FTP is selected, Windows credentials are required in the Login and Password 
fields. Also, if IIS 7 or newer is installed on the server, Basic Authentication needs to be enabled. 
Devices require Basic Authentication to pass data via HTTP when IPA sends tracking data to the Job 
Accounting Print Server. The default Port is 80.

● File Transfer Protocol (FTP) is best for uploading data to an internal database server. If HTTP / FTP is 
selected, any credentials can be used in the Login and Password fields. By default, both Login and 
Password are "Anonymous". The default Port is 21. Select the PASV checkbox to enable passive mode 
FTP if you want to allow data to transfer more easily through firewalls.

3. Set the Interval (minutes) to specify how often tracking data is pushed from the devices to the Job 
Accounting server.

4. Click Test and Apply.
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4.2.9.3.1 Enable Tracking of Pull Print jobs

For print devices that do not support in-printer tracking, to track the number of pages that are pull printed. This 
applies to devices such as HP OfficeJet Pro, HP S900, and multi-vendor devices that do not have an embedded 
agent.

1. Go to the Settings tile and go to the SPPE or SPP Enterprise tab (depending on installed bundled).

2. Under Options select Enable Tracking of printed jobs.

NOTE: Enable tracking of printed jobs with local job storage is not supported. This is because jobs must be 
stored on the server for Enable tracking printed jobs to work correctly.

4.2.9.3.2 Enable Tracking of Purged jobs

If there is an HP Access Control Job Accounting server in your environment, you can enable tracking of expired 
Pull Print jobs in Job Accounting reports. Tracking of expired pull print jobs can be enabled. This will create an 
XML file for each job that is purged. The XML file includes information such as the purged job name, the date the 
job was submitted, and the date the job was purged:

Prerequisites

● HP AC Job Accounting server configured in the environment

Complete the following steps:

1. Go to the Settings tile and select SPPE or SPP Enterprise tab.
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2. In the Job Account section select Enable tracking of purged jobs.

3. If Job Accounting is installed on the same server as Secure Pull Print Express, the XML files are created in 
the following folder:

Program Files\HP\HP Access Control\temporary\DTM

4. If Job Accounting is installed on a different server, the XML files are created in the following folder:

Program Files\HP\HP Access Control\temporary

5. When purging is complete, the XML files are pushed to the Job Accounting server in the Temporary\DTM

4.2.9.4 Quota management

Quota is an optional Job Accounting feature that allows the administrator to set limits on how much each user is 
permitted to print, copy, or digital send. Quota is not intended to suddenly stop business, especially during a 
print job. If a user needs to print a job, and it goes over the quota limit, the purpose is to allow the job to 
continue. The intent with quota is to limit the amount of use of the printing infrastructure overall, not to restrict 
at a page level for a given print job.

Quota is controlled at the device level (on supported devices) and at the queue level for printing.

Prerequisites

● For quota to work within a pull print environment, in-printer tracking is recommended for better accuracy 
of Job Accounting tracking data.

● For quota tracking for copy and digitally send jobs, the device must support in-printer tracking (HP AC 
Agent)

For more information about controlling quotas for users in Job Accounting, please see Job Accounting.

IMPORTANT: In order for Quotas to be tracked, Tracking must be configured at the print queue or at the device. 
Either go to the Print server tile and configure the print queue for Tracking, or go to the Devices tile and 
configure the device for Tracking.

To configure Quota for glass activity on a device, complete the following steps:

1. In the Job Accounting Quota module, go to the Defaults page. Select Enable quota for copies and/or Enable 
quota for digital sending.
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2. Go to the Settings tile > Agent tab. Select Enable quota for copies. Click Apply.

3. Go to the Devices tile. Install Agent on the device and configure the device for Quota and Authentication.

4. Set the sign-in method on the device to control Quota when users use functions at the device.
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a. Go to the device’s embedded Web server (EWS). Open a Web browser and enter the following in the 
address bar:

http://deviceaddress
Where deviceaddress is the IP address of the device you configured for Quota.

b. For non-FutureSmart devices, go to the Settings > Authentication Manager page.

● For the Copy function, select HP AC Local List - Copy Quota.

● For the Color Copy function, select HP AC Local List - Copy Quota Color.

● For the Send to Email, Send Fax, and/or Send to Folder functions, select HP AC Local List - Digital 
Send Quota.

Then click Apply.

c. For FutureSmart devices, go to the Security > Access Control page. For the Copy, Fax, and/or Email 
functions, select HPAC - IRM Server. Then click Apply.
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4.2.9.5 Tracking management

Tracking is supported by HP Access Control (HP AC) In-Printer Agent (IPA), and HP Access Control (HP AC) 
Individual Rights Management (IRM).

HP Access Control (HP AC) Agent Tracking captures usage data directly from network printers and MFP devices. 
This section describes the configuration of the tracking feature.

NOTE: HP Access Control (HP AC) Agent must be installed on the device before beginning this configuration 
procedure.

To install or configure a device, go to the Devices tile. Select a device, click Configure, then select Tracking. Click 
OK.

NOTE: When configuring HP AC there may be a requirement to set the device to look at multiple IIS servers. 
When multiple IIS servers are in the Settings > IIS area, then the option to configure for a different IIS server will 
appear for the Tracking option in the Devices > Configuration window. 

4.2.9.6 Print Server tracking

In the Settings tile > Print Server, you can configure methods of gathering print server tracking data.

● Port monitor creates a new port monitor for printers. This is the preferred method to gather tracking data.

● Print processor replaces the existing print processor with the Job Accounting print processor. This method 
may not work with all printer drivers.

In the Print server quota web service section, click to enable features of the quota web service:

● Click the Skip quota control if network failure checkbox to allow users to print after the server loses 
connection to the web service. If this feature is not enabled and there is a network failure, then quotas 
cannot be determined and all printing stops.

● Click the End user notification checkbox to enable notifications on client workstations of remaining user 
quotas.

In the Snmp tracking section, click to enable features:
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● Click the Track copies checkbox to enable tracking of copies at multi-function printers.

● Click the Track digital sending checkbox to enable tracking of digital send jobs at multi-function printers.

In the Encoding section, click the Double byte encoding checkbox to track print jobs with job names containing 
double byte characters.

In the Encryption section, click the Encryption checkbox to encrypt tracking data on the print server and when 
data is sent to the Job Accounting server.

4.2.10 Configuring connection to a SQL Server with AlwaysOn

If the Job Accounting, IRM or License databases are connected to a SQL Group Listener with SQL AlwaysOn 
enabled, make sure to select the AlwaysOn checkboxes in the HPAC Settings. HPAC utilizes the SQL Group 
Listener to connect to the HPAC databases. When installing and configuring HPAC, enter the SQL Group Listener 
address in place of the physical SQL Server instance. The AlwaysOn checkbox changes the connection string to 
the SQL Server. The AlwaysOn checkboxes can be found in the following locations:

● For Job Accounting database, go to Settings > Database > Database Configuration.

● For IRM database, go to Settings > Database IRM Database Configuration.

● For License database, go to Settings > License > Enterprise.

NOTE: Following are the connection strings used by HP AC:

● SQL authentication: 
Server=xxxx;uid=sqllogin;pwd='sqlpassword';Database=HPACJA

● SQL authentication with AlwaysOn: 
Server=xxxx;uid=sqllogin;pwd='sqlpassword';Database=HPACJA;MultiSubnetF
ailover=True

● Windows authentication: Server xxxx;Trusted_Connection=true;Database=HPACJA
● Windows authentication with AlwaysOn: Server 

xxxx;Trusted_Connection=true;Database=HPACJA;MultiSubnetFailover=True

4.2.11 HP AC Configuration Utility Web Console

Prerequisites

● Internet Explorer minimum version IE 11 with Microsoft Silverlight installed
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Add http://servername/ and https://servername/ to the list of Trusted Sites in Internet Explorer

● Microsoft .NET Framework 4.6

● TCP port 445 has to be opened on the client and on the routers/switches between the server and the client

The HP AC admin console can also be accessed via Internet Explorer from any workstation on the network.

Complete the following steps:

1. To access HP AC, open Internet Explorer and enter http://<servername>/hpac, where <servername> is the 
FQDN or IP address of the HP AC server. On the page, click Run.

2. This will install the Windows Presentation Foundation Host required to run the admin console within the 
web browser. If prompted with a security warning select Run.
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3. If login is required you will be prompted to enter your credentials. See Section 9.1, Managing access to the 
Admin console

4. The console will display.
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NOTE:

● The localization for the web console is using the regional settings of the client workstation accessing the 
web app, not the regional settings of the server.

● The HP AC web console can connect to one HP AC server at a time. To switch the connection to a different 
HP AC server, open a command prompt and run: Rundll32 %windir%\system32\dfshim.dll 
CleanOnlineAppCache

This is to clear the cache of the old server on the PC and run the new one.
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5 Authentication

HP Access Control requires authentication to know who the user is. Knowing who the user is allows the solution 
to track the details on the activity of the user, associate print jobs to the user, and allow for user rights 
management (assignment and control) by individual user or by AD groups.

The base requirements are that the user login name (i.e. sAMAccountName or UserPrincipalName) and login ID 
(proximity badge ID or code ID) are matched together initially.

If you chose to use the TCPIP/IPPS protocol in the HP AC configuration tool > Settings tile > SPP Express or SPP 
Enterprise tab, make sure IPPS-SSL is enabled on the device. Go to the device web page > Security Settings > 
SSL Settings. In the Setting of SSL section, make sure IPP-SSL is set to Enable. Click Submit.

Authentication options are:

● Card or Windows

● Code (PIN/PIC)

● Card and Code (two-factor) or Windows

● Touch to Sign-In (with an Android smartphone with NFC support and the HP ePrint Enterprise app)

● Card or Code

5.1 Agents
The HP Access Control (HP AC) Agent can track MFP device or printer usage, manage access to MFP device 
functions, or institute printing and copying quotas.

Prerequisites

● The HP AC Job Accounting Server must be installed to use HP Access Control (HP AC) IPA and HP Access 
Control (HP AC) IRM functions.

The following agents are available:

● HPAC-IPA: In-Printer Agent for device tracking

● HPAC-PIC: Authentication

● HPAC-DRA: Authentication and Authorization to access walk-up device features by user or group

● HPAC-IRM: Authentication, Authorization to access walk-up device features by user or group and with Quota

NOTE: Features may vary across devices. Refer to Section 5.7, Configuring devices.

5.1.1 Configuring the Agents

Complete the following steps to set the AD-Authenticator parameters:

1. Click on the IRM tile, and go to the AD-Configurator tab.

2. On the General page, select the HP Access Control Agents that will be used. Each Agent provides different 
levels of user authentication and rights control. Place checkmarks next to the Agent products you are 
using.
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3. If required, select to Encrypt configuration of the AD-Authenticator file. The configuration is stored in the 
web.config file. IIS will prevent the file from being viewed through an HTTP connection. This will also protect 
the passwords and other sensitive information.

5.2 Authentication methods
There are five different methods of authentication.

● Code authentication (PIN/PIC)

● Card authentication or Windows authentication

● Card and code (two-factor) authentication

● Card or Code

● Touch to Sign-in (with an Android smartphone with NFC support and the HP ePrint Enterprise app)

NOTE: Please see Section 5.7, Configuring devices to see what methods are supported on each device type.

5.2.1 PIC authentication

Personal Identification Code (PIC) authentication is used to provide access to copy, fax, and scan capabilities. To 
utilize these functions, users enter a pre-determined personal authorization code using the device keypad. 
Codes can be stored in either SQL or AD.

5.2.2 Card authentication

Users can present a proximity card reader to authenticate at the device. When storing the data in a SQL 
database, you can enable multiple cards so users can enroll more than one card.

5.2.3 Card and code (two–factor) Authentication

Two-factor authentication means that users will use their proximity badge and a PIN for an additional layer of 
security.

Go to the IRM tile > AD Authenticator and under device authentication choose Card + Code (two-factor). Click 
Apply.
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NOTE:

● When using Card and Code, if the user enters their Windows credentials it will not prompt the user for a 
code.

● Enabling two-factor does not require re-configuration of the device.

5.2.4 Card or code authentication

At a device, if a user swipes their badge, it will assume card is the chosen option and the user will be logged in as 
per the normal proximity card option. If the badge is not recognized, then user enrollment will be activated as 
per normal. If a user presses the function requiring authentication, they will be prompted for a code.

NOTE:

● On HP S900 Series, when set to Card or Code, they will work like Card Only.

● When this option is chosen there is no option to use Windows credentials.

5.2.5 Touch to Authenticate

Prerequisites

● HP Mobile Print Accessory installed on supported devices

● HP AC authentication installed and configured

● Android smart phone with the HP ePrint Enterprise App and is NFC enabled

Complete the following steps:

1. In the HP ePrint Enterprise application on the mobile device open the application settings screen.

2. Touch HP Access Control.

3. Follow the wizard to provide the server address and your user credentials.

4. Present your mobile device with the ePrint Enterprise application open to the HP Mobile Print accessory on 
the print device.

5. The first time you present your smartphone it will prompt you to register (just like you would for a 
proximity card). The app will provide an unique ID through the NFC connection which will be used for 
authentication.
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5.3 Enrollment options
HP AC offers two different options for storing user data:

● Active Directory

● SQL and Active Directory

Both options will always use Active Directory. The difference is where the data is stored. Stored metadata is used 
for identifying a user to an enrollment method (i.e. PIC or Proximity ID) and user rights assignment (i.e. ability to 
copy in color).

There are advantages to using either method.

Active Directory SQL Storage

Avoids an additional connection and dependency to a database 
during authentication

Additional to the AD query

Requires write access to the selected attribute(s) in AD Only requires read access to AD

Multiple domains requires writing to an attribute in a global catalog 
is not supported (read-only)

Supports multiple domains in the same forest

n/a Supports Delegate/Group Printing or Alias

One ID per use One or more IDs per user

n/a

AD is normally replicated across servers automatically Requires connection to a central SQL database for authentication 
roaming

● SQL replication is an option

n/a Registers last time of authentication

5.4 Active Directory Authenticator
Use the HP Access Control (HP AC) Active Directory Authenticator to store HP Access Control (HP AC) code or 
badge ID and device feature access rights directly in AD.

The Active Directory Authenticator provides the following capabilities:

● A configuration utility used to tailor the Authenticator to your specific environment.

● A Web service to authenticate users at the device.

● The User Editor that allows a user’s PIC and device feature rights to be reviewed and/or changed. This can 
also be accessed at http://<servername>AD-Authenticator/AD-User-Editor.aspx. See Section 9.3, AD User 
Editor

● The Group Manager that performs operations on an entire group of users. This can be used to set PIC and 
device feature rights for the entire group (of users). The members of each group are selected by an LDAP 
query. This can also be accessed at http://<Servername>AD-Authenticator/AD-Group-Manager.aspx. See 
Section 9.4, AD Group Manager

● A website that may be configured to allow users to view, email, change, or choose their authentication 
codes.

● An enrollment application to allow users to enroll their card at a PC. See Section 8.4, HP Access Control 
Card Enrollment application.
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The Configuration Utility, User Editor, Group Manager, and Enrollment applications are implemented as 
password-protected Web pages for security reasons.

NOTE: To view the web pages with best results, it is recommended to have Internet Explorer 11 on the server.

5.4.1 Configure the AD-Authenticator

The AD-Authenticator is designed to operate with a minimum of configuration. The AD-Authenticator supports 
two methods of controlling user access to device features: individually by user, or by Active Directory Groups.

Prerequisites

Make sure the following information is available before beginning the AD-Authenticator configuration:

● Method to control user access to a device. It is possible to either control each user's rights individually or 
use existing Active Directory groups.

● If storing in AD: Names of the two AD attributes used to hold users’ PIC or card and access rights. The 
administrator may use data that already exists in the Active Directory for user PIC. (For example, an 
employee number or phone extension.) In this case, the attribute can be designated as read-only and 
cannot be changed by the AD-Authenticator. When the administrator uses group (rather than individual) 
device feature control, the attribute containing user assigned groups also already exists in the Active 
Directory (as the memberOf attribute). The AD attributes need to be indexed in order to ensure there is no 
delay during the authentication process.

● The IP address or domain name of the AD server.

● A user account with “write” privileges to AD (must be a member of the Account Operators group, Domain 
admin group, or enterprise admin group, or have the account assigned the appropriate rights).

● SMTP configured. See Section 4.2.2.1, Set SMTP Server parameters.

NOTE:

● The AD-Authenticator package does not allow creation of new users, and does not permit modification of 
any AD attributes except the two dedicated for its use. It is not intended as a substitute or replacement for 
the standard AD user management tools.

● By default, the AD-Authenticator is configured for individual user rights control, and stores the PIC values in 
extensionAttribute14 and feature rights in extensionAttribute15. These attributes are added to the AD 
schema when Microsoft Exchange is installed. They are not used by Exchange itself, and are provided only 
for use by other products. If Microsoft Exchange is installed, these attributes may be available; otherwise, 
two different unused attributes must be selected, or the AD schema must be extended with two attributes 
explicitly for this purpose.

● AD-Authenticator is configured using a Web-based application – the AD-Configurator. To view the AD-
Configurator page do one of the following:

a. Launch the HP AC configuration utility. Click on the IRM tile and go to the AD Configurator tab.

OR

b. Enter the following URL into your Web browser: http://localhost/AD-Authenticator/AD-
Configurator.aspx
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5.4.2 Authentication method and data storage options

NOTE:

● If you are not currently logged into the server where the AD-Authenticator is installed, substitute its host 
name or IP address for localhost in the URL.

● If you want to view AD-Configurator in a 32-bit Web browser, you must use Internet Explorer, Mozilla 
Firefox, or Google Chrome. Other Web browsers are not supported.

Follow the steps below to set the AD-Authenticator General parameters.

1. In the IRM tile > AD Configurator, click General to select the General settings.

2. Select the HP Access Control (HP AC) Agent products you are using. Each Agent product provides different 
levels of user authentication and rights control. Place checkmarks next to the Agent products you are 
using. This will disable the setup options for any AD-Authenticator features that are not supported by your 
products.

NOTE: You can select and configure support for features provided by HP Access Control (HP AC) Agent 
products that you have not purchased. The features themselves are enabled by the Agent licenses in the 
devices and will remain unavailable until licensed.

3. Select whether to encrypt the AD-Authenticator configuration file. The AD-Authenticator configuration is 
stored in its web site Web.config file. IIS prevents this file from being viewed through an HTTP connection. 
You can further protect the passwords and other sensitive information by checking the Encrypt 
configuration option.

4. Select one of the following Device authentication methods:

● Select Card only if you want users to use a proximity card reader to authenticate at the printer or

● Select Code only if you want users to use a Personal Identification Code (PIC) to authenticate at the 
printer or MFP.

● Select Card or Code to have users authenticate with their card or a code

● Select Card + code (two-factor) if you want users use a proximity card reader and a PIC to 
authenticate at the printer or MFP.

5. Select a Data storage option:

a. Select LDAP Server to store user card and code data on the LDAP server. Then select the Codes or 
Cards button (depending on the device authentication method) and enter in the LDAP attribute to 
store the user data.
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b. Select Database to store user card and code data on the database. Click the Multiple cards per user 
checkbox to allow users to enroll multiple cards for authentication.

6. Click Apply to save any changes you have made.

5.4.3 Set LDAP Server parameters

This section describes how to set the AD-Authenticator LDAP server parameters. The AD-Authenticator makes 
an LDAP connection to your Active Directory to authenticate your users and determine their assigned rights.

NOTE:

● In a single domain environment it is recommended to leave this on auto-detect for automatic failover.

● If the HP AC server is not in the same domain as the users, do NOT select the option to Automatically detect 
LDAP server option.

● If you do not want user information to be exchanged between the HP AC server and the AD server to be 
communicated unsecurely you can force the connection to use LDAP which will use port 636. Append :636 
to the LDAP server name. Requires valid certificates for communication between the AD server and the HP 
AC server.

● To configure the LDAP settings for a global catalog server enter GC://<domain name> and ensure that the 
LDAP username and password has read writes to the global catalog. Typically writing to a global catalog is 
not supported.
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1. To select the LDAP server parameter page, click LDAP Server in the AD-Authenticator in the IRM tile.

2. Set the LDAP Server address. The AD-Authenticator can usually detect your Active Directory server 
automatically when run on servers that are members of an Active Directory domain. Check Automatically 
detect LDAP server to enable this feature. To disable the feature, uncheck the box and enter the network 
name or IP address of your Active Directory server.

3. Specify the username and password to be used to access the Active Directory server. If you are using both a 
pre-existing LDAP attribute to store the user’s PIC and Active Directory groups to manage user rights, this 
user needs read-only access to those Active Directory attributes. If the AD-Authenticator tools will be used 
to manage your user’s PIC or to set individual rights, the user must have read-write access to the necessary 
Active Directory attributes. Enter the username in domain/username format.

4. Click Apply to save any changes you have made.

5.4.3.1 Configuring multiple domains

To enable multiple domain support, complete the following steps:

1. Open the \Program Files\HP\HP Access Control\AD-Authenticator folder and 
open the AD-Configurator.aspx file in Notepad.

2. Find the line: var enableMultiDomainSupport = false;.

3. Change the line to var enableMultiDomainSupport = true; to enable multi-domain support.

4. Save the file.

5. Refresh any AD-Configurator browser or Configuration Utility window that was open.

6. Click the + icon tab at the top of the page to add a new domain. Enter the LDAP server information and click 
Apply.

NOTE:

● Go to AD Configurator > Users page and verify the Username Attribute. When looking for users in the AD 
User Editor, make sure the correct format is entered for the username. For example, if UserPrincipalName 
is used for the Username Attribute, make sure to look for the user in AD User Editor using 
UserPrincipalName format.

● To store jobs under the username using the correct Username Attribute, the "Change job identifier" settings 
must be set and the Enterprise Print Client must be installed on workstations. See the "Configure Print Job 
Identifier" section of this guide.

● Deleting a server from this page does not delete any stored data associated with that domain. Any card, 
code or rights data stored in LDAP will remain, as will any users stored in the database.

● All domains share the same settings on the “AD-Configurator/Users” page. For example, if you are 
configured for AD-Only, the cards/codes/rights must be stored in the same attributes in all active 
directories. A “real” LDAP Server and an Active Directory cannot be combined.

5.4.3.2 Testing Proximity Badges with the HP Common Card Reader

The default setting for proximity cards is HID/iClass. Depending on the card, this may have to change to support 
other/additional protocols. Additionally, it is sometimes necessary to adjust the way a proximity badge is read so 
that it can match existing values that may be stored in AD or SQL.

Prerequisites
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● A PC connected to the same domain as the HP AC server

● A domain user account

● A card reader

To test Proximity badges with the HP common card reader, complete the following steps:

1. Connect the reader to the PC.

2. From Internet Explorer, enter/access the following URL: http//<servername>/AD-Authenticator/AD-
Configurator.aspx where <servername> is the server where HP Access Control is installed.

3. If prompted, enter the network credentials to access the server.

4. Click Proximity Reader button (on left side of screen).

5. You can now change the reader type under Card type (primary) and Card type (secondary) – if required.

6. The reader will automatically start scanning on the selected frequencies.

7. The values will be populated under the Last Card read section.

NOTE:

● You may be prompted to install an IE plugin which contains the driver for the card reader

● You cannot view the Proximity Reader page of the AD-Configurator from the Configuration Utility if you are 
using a 64-bit server, or from a 64-bit Web browser. The Proximity Reader page can only be viewed from 
the Configuration Utility on a 32-bit server or from a 32-bit Web browser.

● There are certain combinations of primary and secondary cards that will cause the reader to become 
unresponsive. For unique card types, please contact your HP representative for further investigation.

5.4.3.3 Card Masking

Card Masking is an administrative tool that allows you to change the way proximity card ID values are stored in 
Active Directory or the database when users enroll their cards. The card mask is saved in an XML file and stored 
on the HP AC server. This is so that when card masking is enabled, the mask is applied at the time the users 
enroll their cards.
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NOTE:

● Do not enable card masking in a production environment, as it will cause the value being read to be 
changed, and therefore existing user’s cards will be unrecognized and they will be forced to re-enroll.

● You cannot view the Proximity Reader page of the AD-Configurator from the Configuration Utility, if you are 
using a 64-bit server, or from a 64-bit Web browser. The Proximity Reader page can only be viewed from 
the Configuration Utility on a 32-bit server or from a 32-bit Web browser.

Prerequisites

● Card reader

● Domain user account

● PC connected to the same domain as the HP Access Control server

To use the Card Masking feature, complete the following steps:

1. Copy the Card Masking installation file to your local PC hard drive from \Program Files\HP\HP Access 
Control\client setup directory on the HP Access Control server.

2. When the installer launches, click Next.
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3. Select the installation Folder and choose whether to install for Everyone to use or Just me.

4. Click Next to finish the installation.

5. Connect a card reader to the PC.

6. Open the Card Masking Tool via the shortcut created on the desktop.

7. Enter the name of the HP Access Control server in the AD-Authenticator server name field. Click Connect to 
connect to the server.

8. Click Scan. The card reader will beep once. Hold your card over the card reader. The reader will beep twice 
when the scan is completed.
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The following data displays:

● Reader: The card value read by HP Access Control. The first 6 digits include the card type and the 
decimal value of the card data bits. The remaining digits contain the card number.

● RAW: The card RAW number read by HP Access Control.

● Type: The card type value and card type name.

● Bits: The number of card data bits.

● ID: The masked card value.

9. Modify any of the following parameters to change the masked card value:

● Leading Parity: Strip this many bits from the most significant bits of the raw data. This happens 
before any FAC/ID processing.

● Trailing Parity: Strip this many bits from the least significant bits of the raw data. This happens before 
any FAC/ID processing.

● FAC Digits: If Fixed FAC/ID is enabled, this is the number of digits to use for the FAC. If Send FAC is not 
enabled, the FAC will not be sent ID Digits.

● ID Digits: If Fixed FAC/ID is enabled, this is the number of digits to use for the ID. If Send ID is not 
enabled, the ID will not be sent ID Digits.

● ID Bits: Decode this many bits as the ID. Use the remainder as the FAC. If Send ID is not set, this 
setting is ignored.

● FAC/ID Delim: Output this character between the FAC and ID when Send FAC is enabled.

10. Select any of the following parameters to change the masked card value:
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● Send FAC: Output the facility code. If Send ID is not set, this setting is ignored.

● FAC Hex: Output the facility code as a hexadecimal number.

● Fixed FAC/ID: Output a fixed number of digits for the FAC and ID. If more characters are needed, the 
output is leading zero padded. If fewer characters are specified that are in the FAC or ID, then the FAC 
or ID is truncated.

● Send ID: If set (Yes), the ID will be separated from the Facility Code using ID bits for the ID. If not set 
(No), the Facility Code will not be separated and all of the data will be considered ID independent of 
the number of ID bits.

● ID Hex: Output the ID in hex.

● Read Only Card Size: When enabled, only cards of Card Size bits are recognized by the reader.

● 64 Bit Math: When enabled, the reader performs 64 bit math on the FAC, ID or entire card. On some 
card readers this setting causes the reader to process 80 bits rather than 64. For Card Sizes where 
the ID or FAC can be greater than 32 bits. Enabling this option is recommended. Use of 32 bit math for 
data longer than 32 bits was handled by converting the most significant 32 bits and least significant 
32 bits separately, and then padding the most significant digits with 10 zeros and then concatenating 
with least significant digits. For example, a card ID with 0x10379052B4 would be output as 
160932205236 with 64 Bit Math disabled, and 69651681972 with 64 Bit Math enabled.

● Invert Wiegand Data: In some older Wiegand installations the Wiegand lines were reversed, resulting 
in inverted data. Due to backwards compatibility with older legacy readers, this is normally enabled.

● Reverse Wiegand Bytes: When enabled, data bytes are reversed before FAC/ID processing (after 
leading and trailing parity have been removed). This is mutually exclusive with Reverse Wiegand Bits.

● Reverse Wiegand Bits: When enabled, data bits are reversed before FAC/ID processing (after leading 
and trailing parity have been removed). This is mutually exclusive with Reverse Wiegand Bytes.

11. Click Save to save the DataDecodeDefaults.xml file to \Program Files\HP\HP Access Control\AD-
Authenticator folder on the HP Access Control server.

12. On the HP Access Control server, in the IRM tile > AD-Configurator > Cards, select Card ID masking and click 
Apply.

5.4.4 Set Proximity Reader parameters

The Proximity Reader page allows you to configure the card reader parameters.
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NOTE: The Cards menu displays only if Card only or Card + code (two-factor) is selected on the General page. 
See Section 5.4.2, Authentication method and data storage options for more information.

TIP: If you want to view this page from a computer or workstation, instead of from the server, plug the reader 
into the computer or workstation and then open a Web browser. Enter the following, where “servername” is the 
name or IP address of the server containing the HP Access Control (HP AC) Configuration Utility:

http://servername/ad-authenticator/ad-configurator.aspx

Viewing this page from Web browser requires the installation of an extension. If a window pops up, prompting 
you to download the extension, click OK to download and install.

This page allows you to use a computer or workstation to configure card readers to read specific card types, view 
status information about the card reader, and view information about a card if a card type is unknown.

Follow the steps below to set the Proximity Reader parameters.

1. Click the Proximity Reader button to go to the Proximity Reader parameter page.

2. You can configure HP Common Card Readers or RFIDeas RDR-80583AKU card readers to read two different 
types of cards. The new HP HIP2 card readers can be configured to read up to four different card types. The 
following table contains card types which are supported:

NOTE: The HP HIP2 card reader provides additional card type and volume control information. The HIP2 
reader is intended to function as a standard HP Common Card Reader in devices that have older in-printer 
agents installed. When used with in-printer agents older than version 20160509, the HP HIP2 reader 
supports two card types and the volume is not adjustable.

2Smart Key Farpointe Data NXT UID Indala ASP 26 Bit KeyMate RDR-6E8X Compatible

Advant CSN (Legic) GProx-II UID Indala ASP UID MiFare CSN RDR-6H8X Compatible

Awid HID Indala ASP+ UID MiFare Ultralight CSN RDR-6K8X Compatible

Cardax UID HiTag 1 and 1S Primary Infineon my-d CSN Nexkey RDR-6Z8X Compatible

Casi-Rusco HiTag 2 Alternate IoProx (Kantech) Nexwatch ReadyKey PRO UID

Deister UID HiTag 2 and 1S 
Alternate

ISO 14443A CSN NXP Rosslare

DESFire CSN HiTag 2 Primary 
(RDR-6H

ISO 15693 CSN Phillips Russwin UID

DIGITAG Honeywell I-tag CSN Pyramid NXT UID Secura Key -02
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EM/Marin EM410x 
Primary/>

iClass CSN Keri NXT UID QuadraKey Tag-It CSN (Texas 
Instruments)

Etag CSN (Secura Key) I-Code CSN Keri UID Radio Key  

3. Under Card type (primary), use the drop-down list to select a card type.

4. Under Card type (secondary), use the drop-down list to select a second card type.

5. If you are using HP HIP2 card readers, select a third and fourth card type from the drop-down menus.

6. Under the Card Read Beep Volume drop-down menu, select the volume of the beep sound when cards are 
presented at the reader.

NOTE: If you are using HP Common Card Readers or RFIDeas RDR-80583AKU card readers on HP 
FutureSmart or non-FutureSmart devices, the card beep volume can be set to OFF or Maximum only. If 
Minimum or Medium are selected, the Maximum setting will be used for HP Common Card Readers or 
RFIDeas RDR-80583AKU card readers.

NOTE: The card reader volume level applies to all devices in the environment. The card reader volume 
cannot be adjusted for individual devices.

NOTE: The highest volume of the HP HIP2 readers is very quiet and the lowest volume is virtually 
inaudible. 

NOTE: When the Card Read Beep Volume is set to OFF, the reader still beeps at full volume when it is 
connected, and beeps at the minimum volume when accessed by the solution.

7. Do one of the following:

● If you want to configure a card reader connected to the PC to read the selected card types, click the 
Install Reader Plug-in button to install the browser plug-in. This updates the connected card reader 
with the card type configuration, allowing you to use the card reader with any printer to read the 
selected card types. The plug-in works only with Internet Explorer and Firefox. After making changes, 
click the Update Reader button to configure the connected card reader.

● If you want to configure your printers or MFPs to read the selected card types, click Apply. This applies 
the card type configuration to your printers or MFPs, allowing you to use any card reader to scan the 
selected card types.

8. In the Reader Connected section, view the model name and status of the connected card reader.

9. In the Last card read section, view information about the proximity card that was last used. If you want to 
view information about a specific card, scan the card and the page displays information about the scanned 
card.

10. Click Apply to save any changes.

5.4.5 Set Cards parameters

Prerequisites

● “Card Only” or “Card and Code” set in IRM tile > AD Configurator > General tab.

● Data storage set to LDAP Server or Database in the IRM tile > AD Configurator > General tab.

To set parameters for using proximity cards, complete the following steps:

1. Enter the name of the LDAP attribute to be used to contain your users’ card values into the Cards attribute 
field. If storing in a database than this is not required.
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2. Click the Card attribute is read-only checkbox to disable the AD-Authenticator utility’s ability to change 
cards.

3. The AD-Authenticator User Editor provides the ability for authorized users to examine and change a user’s 
card number. Uncheck the Cards visible in user editor check box to configure the User Editor so that cards 
may be changed (only to new random values, unless specified as read-only) and emailed to their 
associated users, but not viewed.

4. If you want users to be able to self-enroll than select Permit user card self-enrollment.

5. To allow for alternative authentication using Windows credentials, select Permit user network credentials 
instead of cards.

6. Select Card ID masking if you want Active Directory or the database to read the card ID number, instead of 
the card raw number, when a card is enrolled. See Section 5.4.3.3, Card Masking.

7. Click Apply to save any changes you have made.

NOTE:

● The Cards menu displays only if “Card only” or “Card or code” or “card and code (two-factor) is selected as 
the storage option on the IRM tile > AD Configurator > General page.

● The Card attribute field displays only if LDAP server is selected as the data storage option on the General 
page.

● If enabling Card ID masking, any cards that were enrolled before Card ID masking was enabled needs to be 
re-enrolled.

● If your printing environment has multiple types of card readers it is recommended to enable card ID 
masking. This allows all cards to be read the same way.

5.4.6 Prevent Alternate Windows Authentication when using Card Only Authentication

In some environments, customers do not want users to enter network credentials at the device as an alternative 
method of authentication if the user forgets their card.
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Prerequisites

● IRM tile > AD Configurator > General set to Cards

NOTE: Failover authentication via Windows is not supported with Card or Code. If a user Card is not available, a 
Code can be used. If Code is forgotten, user can go to mycode website to change/reset it.

Set Card Parameters

1. Go to the IRM tile > AD Configurator and select the Cards page.

2. Uncheck “Permit user network credentials instead of cards” and click Apply.
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3. Press the Pull Print button on the device. You will be prompted to present your card with no option to 
provide network credentials.

5.4.7 Prevent User Enrollment at the Device

In some environments, customers do not want users to enroll their cards at the device as the card data may 
already exist in AD or SQL database.

Prerequisites

● IRM tile > AD Configurator > General set to Cards

Set Card Parameters

1. Go to the IRM tile > AD Configurator and select the Cards page.
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2. Unselect “Permit user network credentials instead of cards” and click Apply.

3. The device will give an error with no option to enroll the card.

5.4.8 Code parameters when storing in Active Directory

The AD-Authenticator provides a number of options for managing user Codes. This section describes how to 
configure those options.

To set the Code parameters, complete the following steps:

1. Go to the IRM tile > AD Configurator tab and under the Device Authentication Method change to Code.
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2. Go to the IRM tile, and select the AD configurator tab. Select the Codes page.

3. If the code is to be stored in LDAP, as specified in the IRM tile>AD configurator tab>General section>Data 
Storage: LDAP Server, then you will need to enter the name of the attribute that the code will be stored in.

● If the code already exists in the specified attribute (i.e. an employee number) then check the Codes 
are read-only box to prevent overwriting of codes. This will also disable all other options on the page 
when read-only is specified.

NOTE: Ensure the attribute is indexed to prevent any delays during authentication.

4. Select the settings that meeting your organizations environment:

● Codes are visible in user editor: Unchecking this will allow for codes to be changed (only to new 
random values, unless specified as read-only) and emailed to their associated users, but not viewed.

● Users can view own codes: Allow users to view their code through the MyCode website (http://
<servername>AD-Authenticator/MyCode.aspx)

● Users can email own codes: Send their active code to their email address (obtained from active 
directory lookup) through the MyCode website.

● Users can change own codes: Allow users to change their codes to a new random value through the 
MyCode website.

● Users can choose own codes: Allow users to choose their own code. The code must still meet the 
minimum and maximum length, as well as only allowed character set can be used.

5. By default, code values generated by AD-Authenticator are exactly six numeric digits in length. You can 
change them to be shorter, longer, variable length, and/or change the character set from which they are 
made (for example, make them alphanumeric).

a. Enter the minimum length for generated codes in Minimum length.

b. Enter the maximum length for generated codes in Maximum length.

c. Enter all the characters that can be used for generating codes into the Character set field. By default, 
this field contains 0123456789 which allows the generation of full numeric codes. You can change it 
to any combination of alpha-numeric characters.
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6. By default, user codes are saved in clear text in Active Directory. If your codes have not been specified as 
read-only, you can cause all future codes to be encrypted by placing an encryption passphrase in the Code 
encryption passphrase field. Once you have specified an encryption passphrase, you should immediately 
use the Group Manager application to encrypt all codes saved previously.

7. Click Apply to save any changes you have made.

8. Still in the AD-Configurator click on SMTP server and either select to Automatically detect SMTP server, or 
specify the server and enter a username and password that has access to the server.

Section 5.4   Active Directory Authenticator 111



NOTE:

● Do not directly change the code encryption passphrase from one value to another. This will cause an 
irrecoverable situation where some of your codes are encrypted using the old passphrase and some with 
the new. Instead, with the old passphrase still in place, use the Group Manager application to decrypt all 
existing codes, use the Configuration application to change the passphrase, and then use the Group 
Manager application to encrypt the codes with the new passphrase.

● If PIC values contain alphabetic characters, it is important to know that, because of the way LDAP queries 
work, the alphabetic comparisons of PIC values are performed in a case-insensitive manner.

● To assign codes to individuals or groups please see Section 9.3, AD User Editor and Section 9.4, AD Group 
Manager.

5.4.9 Code Parameters when storing in SQL

● To email codes to users the SMTP server must be configured. See Section 4.2.2.1, Set SMTP Server 
parameters.

● For assigning codes to individuals review Section 9.3, AD User Editor or Section 9.6, DB User Editor.

● To assign codes to groups review Section 9.4, AD Group Manager.

● Code only, card or code, or card and code (two factor) set in the IRM tile > AD Configurator > General page.

Complete the following steps:

1. In the IRM tile > AD Authenticator > Codes page select the minimum and maximum length for the code (i.e. 
in the screenshot below the minimum length the code can be is 4 and the maximum length can be 8).

2. Enter the character set that can be used when generating a code. These values can be numeric or alpha 
characters.

3. To encrypt the codes follow the steps in 5.8.4 Encrypt or decrypt users PICs.
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4. Go to the Filters button and click on the Activated users filter.

5. Delete the following text:

6. Click Edit and Apply.

7. Click Candidate users.

8. Delete the following text:

9. Click Edit and Apply.
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NOTE:

● Activated users filter will select all users who have an email address and have been assigned previously a 
code and access rights.

● Candidate users selects all users who have an email address but have not yet been assigned a code or 
access rights.

● The AD Authenticator will ensure that an email address is included in both filters to ensure that only 
accounts that are used by people (and not system accounts) are included and that the HP AC server can 
email users their assigned code and rights.

5.5 Database storage
To configure HP Access Control to store user enrollment data (i.e. card, code, or card+code), select Database as 
the storage method.

1. Launch the HP Access Control Configuration Utility.

2. Select the IRM tile. Under the AD configuration tab, click the General button.

3. Under Data storage, select Database. If you want to allow users to enroll multiple cards to be associated 
with their Windows login, select Multiple cards per user.

4. Click Apply.

5.5.1 Common SQL enrollment database

In a multiserver environment, a common enrollment database is required so users do not have to enroll on each 
HP Access Control server.

Prerequisites

● The SQL server must be configured to accept mixed mode authentication and to have a SQL user 
previously created with dbcreater rights.

● Database is selected as the data storage method (IRM tile > AD Configurator tab > General page)

NOTE:

● SQL enrollment is required if using delegate/alias printing.

● The login account must have enough rights on the SQL server to create and modify databases (dbcreator 
or sysadmin)

● SQL Server can be installed on the local server or a remote server.
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1. Go to Settings tile > Database tab.

2. To connect or create a database on a SQL server, select SQL Server.

3. Enter the server name and instance (if required) using the server name or IP address.

4. Enter a name to identify the new database. This can be anything (i.e. HPIRM).

5. Select either Windows authentication or SQL authentication.

6. Enter the login credentials of an account with enough rights on the SQL server to create and modify 
databases.

7. Once the database is created, you will see a message in the message pane.

IMPORTANT:

● To create a new database, you must have the sysadmin or dbcreator role for the credentials entered. To 
make changes to the IRM database, the credentials entered must be a Login in SQL Server that is either a 
member of the db_owner database role or a member of the db_datareader and db_datawriter database 
roles for the IRM database. The db_owner database role can perform all configuration and maintenance 
activities on the database. The db_datareader database role can run a SELECT statement against any table 
or view in the database. The db_datawriter database role can add, delete, or change data in all user tables.

● If the Login is a member of the db_datareader and db_datawriter database roles, Execute permissions (in 
database Properties) must be granted to the user.

5.5.2 Import to IRM database

The ImportUser tool allows administrators to import user name/card/code/rights/alias information into a SQL 
Server database, or export data from SQL to a CSV file. This tool is intended to be used with HP AC 14.1 or newer.

Below is a sample CSV file. To import, the CSV file must contain a header with fixed values and at least two 
columns: a user column and a card or code column. Other columns, such as rights or alias, are optional.

Section 5.5   Database storage 115



NOTE: The ImportUser.exe file will get the database connection from the AD-Authenticator web service and 
read if the server is configured for Code, Card, or Card + Code authentication. The file will also check if the CSV file 
contains the appropriate columns.

Running the ImportUser.exe file with no parameters will display the following optional parameters:

● -multicard enable multicard support

● -update update existing users card and/or code

● -deleteuser delete all users and alias from the database before processing CSV

● -deletealias delete all alias from the database before processing CSV

● -export export the configured database to a CSV file

IMPORTANT: If Multiple cards per user is enabled on the server (in the HP AC admin console > IRM > AD 
Configurator), the parameter –multicard must be entered in the command line.

NOTE:

● Optional parameters do not need to be entered in a specific order.

● If the ImportUser.exe file is not run on the same server as the AD-Authenticator web service, the 
ImportUser.exe.config file (|program files\HP\HP Access Cotrol\client setup\ must be edited to add the 
correct server name. Open the ImportUser.exe.config file and edit the <endpoint address="http://
localhost/ad-authenticator/ad-authenticator.asmx" line, where localhost is the name of the server 
containing AD-Authenticator.

● If Multiple cards per user is enabled on the server (in the HP AC admin console > IRM > AD Configurator), the 
parameter –multicard must be entered in the command line.

5.5.3 Importing data

To import data into a SQL Server database, perform the following steps:

1. Navigate to \Program Files\HP\HP Access Control\Client setup from a command prompt.

2. You can check that the users have been imported by going to the IRM tile > DB User Editor tab. Click Search/
Refresh.

NOTE: You may have to change the grid page size to view the entries.

For example, the following command line is valid:

ImportUser.exe users.csv -update -deleteuser -deletealias -multicard

5.5.4 Exporting data

To export data from a SQL Server database to a CSV file, perform the following:
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1. Open a command prompt and navigate to \Program Files\HP\HP Access Control\client setup.

2. Type importuser.exe c:\<path to where the file will be stored\<filename> - export (i.e. importuser.exe c:
\temp\users.csv - export.<insert pic export users>.

3. The CSV file will be created and placed in the specified directory.

For example, the following command line is valid:

ImportUser.exe c:\users.csv -export

NOTE: The exported CSV file can also be imported. For example, if you want to switch from SQL CE to SQL 
Server and avoid re-enrollment, export the data to a CSV file from SQL CE, change the IRM database to use SQL 
Server (go to the HP AC admin console > Settings > Database > IRM Database Configuration), and then import 
the same CSV file into SQL Server.

5.6 Authorization
AD-Authenticator can be used to manage authorization to access walk-up functions of the print device.

See Section 5.7, Configuring devices to see what features are supported on print devices.

The AD-Authenticator provides two different methods of rights control:

● Individual rights control: This method allows you to choose exactly which rights each user has.

● Group rights control: This is a batch-control method, based on users' membership in pre-defined Active 
Directory Groups. This method is ideal when your Active Directory has been populated with groups that 
represent a user's role in your organization and that role maps directly to the device functions its users 
should be permitted to use.

You will need to determine which rights-control method is appropriate for your organization before continuing to 
complete this section.

5.6.1 Configuring individual rights control

This section describes the procedure for configuring AD-Authenticator to control rights for an individual user.

1. In the IRM tile, click Rights on the AD Configurator tab to select the rights parameter page.

2. Select Individually by user.
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3. If you selected LDAP as the data storage (IRM tile > AD Configurator > General), then the User rights 
attribute field displays. Enter the name of the LDAP attribute to be used to contain your users' assigned 
rights.

4. Complete the following process for each device feature listed in the Features drop-down box:

a. Select a device feature in the Features drop-down box.

b. Select Feature is protected if the feature should only be available to specific users. Clear the box to 
allow all users to access the feature. All features are protected by default.

The specific users who can access this feature will be specified later using either the User Editor or Group 
Manager. See Section 9.3.2, Change a user’s device feature rights.

5. Click Apply.
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6. Browse to the AD User editor in the top menu. The page will now show the functions that are protected.

7. Search for the user by entering the username, email, or * and click Find.

8. Select the functions you want to restrict the user from accessing. You can select them individually or select 
Deny all.

9. Click Update.
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10. In the device's EWS go to Security > Access Control and ensure the authentication method is set to HPAC-
DRA or HPAC-IRM. Ensure the guest user is locked out (it will show a lock icon). Click Apply.

11. At the print device, when a user tries to access a function that they are not permitted to use, they will 
receive a message (message may very depending on device).

5.6.2 Configuring group rights control

This section describes the procedure for configuring AD-Authenticator to control user rights using Active 
Directory groups.

1. In the IRM tile in the AD Configurator tab, click the Rights tab to select the rights parameter page.

2. Select By group membership.

3. In the User group membership attribute field, enter the name of the LDAP attribute that contains the list of 
groups your users are members of.

120 Chapter 5   Authentication



NOTE:

● The default memberOf value is correct for most Active Directory installations.

● Ensure the field entered is indexed to avoid authentication delays.

4. Complete the following process for each device feature listed in the Features drop-down box:

a. Select a device feature in the Features drop-down box.

b. Select Feature is protected if the feature should only be available to specific users. Clear the box to 
allow all users to access the feature.

c. If you have protected the feature, click Modify. A page will appear that allows you to select the groups 
in your Active Directory that will have access to this device feature.
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d. The feature you are modifying is listed at the top of the page. Select groups from the Available groups 
pane and move them to the Permitted groups pane to allow members of those groups access to the 
feature. Select groups by clicking on them (user shift-click and control-click to select multiple groups 
at once). Move the groups by clicking the arrow buttons.

e. When all groups that should be allowed access to this feature are listed in the Permitted groups pane, 
click OK.

f. Repeat this process for each device function you wish to protect.

5. Once you have completed the protection settings for each device feature, press Apply to save the changes 
you have made.
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6. In the device EWS go to Security > Access Control and select either HPAC-DRA server or HPAC-IRM server 
for the feature. Ensure the guest user is locked out and click Apply.

7. At the device control panel, authenticate and try to use a feature that is protected. A message will appear 
advising the user that access is denied.

5.6.3 Set Filter parameters

The AD-Authenticator Group Manager operates on sets of users selected by pre-defined LDAP queries (filters). 
The filters can be used, for example, to assign different default individual access rights to different groups of 
users. This section provides instructions for defining those filters.

NOTE: If you selected to use Database storage, the {0} LDAP attribute for codes and the {1} LDAP attribute for 
rights no longer apply to filters. The {0} and {1} macro values must be deleted from the Activated Users filter 
expression and the Candidate Users filter expression in order for the AD Group Manager to correctly use the 
filters.
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TIP:

● Three special macro values are available when defining the LDAP filters. {0} will be replaced with the LDAP 
attribute name configured to hold the AD-Authenticator code. {1} will be replaced with the user rights 
attribute name. {2} will be replaced with the email attribute name. These macros allow the default filters to 
be appropriate for many installations even if the LDAP attribute names have been changed.

● Two filters are defined by default. The Activated Users filter selects all users who have an email address 
and have been assigned both a code and access rights. This filter is intended to select all users who are 
currently setup to use AD authentication. The Candidate Users filter selects all users who have an email 
address but have not yet been assigned a code or access rights. This filter is intended to select users for 
the Group Manager to assign initial codes and default access rights. The test for an email address is 
included both to help to filter out user accounts that are not used by people (e.g. defined only for system 
use) and to insure the group manager can email those users their assigned code and rights.

Use the following steps to define or change the LDAP filters:

1. Click Filters button in the IRM tile >AD Configurator tab to select the filter parameter page.

2. The filters currently defined for use will be displayed under the Filters heading.

3. Three operations are available:

a. Add a new filter by entering its Name and LDAP query Expression and then click Add.

b. Edit an expression by clicking it, changing its LDAP query Expression, and then click Edit.

● Click the Activated Users filter. Activated users will select all users who have an email address 
and have been previously assigned a code and/or access rights. In the Expression field, delete 
the following text:

({0}=*)({1}=*)
● Click the Candidate Users filter. Candidate users selects all users who have an email address but 

have not yet been assigned a code and/or user access rights. In the Expression field, delete the 
following text:

(|(!({0}=*))(!({1}=*)))
● The Expression field of the Activated Users filter and the Candidate Users filter must display the 

following:

(&(objectClass=organizationalPerson)({2}=*)(!
(userAccountControl:1.2.840.113556.1.4.803:=2)))
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c. Delete an expression by clicking it and then click Delete.

4. When the filters are defined correctly, click Apply to save any changes you have made.

5.7 Configuring devices
In order to allow users to authenticate on a device, the device must be configured for authentication from the HP 
AC Configuration utility.

Prerequisites

● HP Access Control Agent must be installed on the server.

● The correct PRN installation file displays in the Installation file field in the Settings tile > Agent tab.

● A device administrator password is set on the device and matches the device administrator name and 
password in the Settings tile > Device tab, and the IRM tile > AD Configuration tab > General page.

● HP AC IRM is configured. See Authentication.

● Certificate installed and configured.

● HTTPS is required for communication on the web server and with all printers.

● Communication to the device exists (ping hostname/address) and is defined in DNS for reverse lookups.

● Device is listed as a supported device.

● Device is running the correct firmware.

● If you chose to use the TCPIP/IPPS protocol in the HP AC configuration tool > Settings tile > SPP Express or 
SPP Enterprise tab, make sure IPPS-SSL is enabled on the device. Go to the device web page > Security 
Settings > SSL Settings. In the Setting of SSL section, make sure IPP-SSL is set to Enable. Click Submit.

NOTE:  If the authentication method is set to card or code in the IRM tile>AD Configurator > General page the 
device will function as if card only has been selected.

5.7.1 HP Multifunction devices

Supported Features
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● Secure Pull Printing

● Authentication

– Card or Windows Authentication

– Card+Code (two-factor)

– PIC

– Card or Code

● Authorization for device functions

● Job Accounting

– Quota

– In-printer tracking

● Enrollment

Complete the following steps:

1. In the HP AC configuration utility, go to the Devices tile and do one of the following:

a. Select the device from the device list.

b. Scan for devices on the network.

c. Enter the IP address of the device.

See Section 4.2.1, Adding devices.

2. When reconfiguring the device(s), place an X in a component checkbox to resend the configuration file. 
Place a / in a component checkbox to not resend the configuration file and leave the current configuration 
status as is. Clear a component checkbox to disable the component on the device.

3. Click Install to send the installation file to the device if this is a new device.

NOTE: The device may reboot during the installation process. Please wait for the device to return to the 
"Ready" state.

4. Select the device from the device list and click Configure.
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5. In the Configure window, select Authentication and/or Authorization. Click OK.

NOTE:

● When configuring HP AC there may be a requirement to set the device to look at multiple IIS servers. 
When multiple IIS servers are in the Settings > IIS area, then the option to configure for a different IIS 
server will appear for the Authentication/Authorization options in the Devices > Configuration window. 
The Authentication and Authorization options must be configured to the same server.

● When using multiple IIS servers ensure that the server certificates are configured properly. Refer to 
Section 4.2.4.3, Creating certificates in a multi-server installation.

6. Configuration will be complete in about 30 seconds. Configuration results will appear in the message pane.

7. Go to the device EWS to set the authentication method at the device.
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FutureSmart devices

● For FutureSmart devices, go to Security > Access Control page of the EWS. Click Access Control (HPAC 
IRM) in the left pane, and select Enabled check box for the required authentication method.

● Click Access Control (in left pane). Scroll down to HP AC Secure Pull Print and choose the authenticator 
(I.e. HPAC – IRM Server). Set the HP AC authentication method for each device function to be 
controlled by HP Access Control.

● Set the lock icon in the Device Guest column for the chosen options.

128 Chapter 5   Authentication



Non-FutureSmart devices

● For non-FutureSmart devices, go to Settings > Authentication Manager page of the EWS. In the HP AC 
Express row, select HPAC Server as the Log In Method. Click Apply.

5.7.2 HP single-function printers

Supported features

● Secure Pull Printing

● Authentication

– Card or Code or Windows authentication

– Card+Code (two-factor)

– PIC

– Card or Code (on FutureSmart devices with a 4.3" display)

● Job Accounting

– Quota

– In-printer tracking

● Enrollment

NOTE: HP Non-FutureSmart single-function devices only support card authentication.

NOTE: Enrollment and Windows Authentication only available on FutureSmart devices with 4.3” display.

Complete the following steps:

1. In the Devices tile, select the device from the device list if this is a new device and do one of the following:
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● Select the device from the device list.

● Scan for devices on the network.

● Enter the IP address of the device.

See Section 4.2.1, Adding devices.

2. Click Install to send the installation file to the device. The device may reboot during the installation process. 
Please wait for the device to return to the "Ready" state.

3. Select the device from the device list, then click Configure. In the Configure window, select Authentication. 
Click OK.
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NOTE:

● When configuring HP AC there may be a requirement to set the device to look at multiple IIS servers. When 
multiple IIS servers are in the Settings > IIS area, then the option to configure for a different IIS server will 
appear for the Authentication/Authorization options in the Devices > Configuration window. The 
Authentication and Authorization options must be configured to the same server.

● When using multiple IIS servers ensure that the server certificates are configured properly. Refer to Section 
4.2.4.3, Creating certificates in a multi-server installation.

5.7.3 HP Officejet Pro printers

OfficeJet Pro devices do not need an agent installed. This is because the OfficeJet's configuration is stored on the 
HP AC server and not on the device.

Supported features

● Secure Pull Printing

● Authentication

– Card or Code or Windows Authentication

– Card+Code (two-factor)

– PIC

– Card or Code

● Authorization for device functions

● Job Accounting

– Printer Server tracking

– Print tracking (with “Enable Tracking of Printed Jobs” enabled)

● Enrollment

Prerequisites

For OfficeJet Pro devices, ensure that the following additional prerequisites are enabled:

● Make sure Rights are enabled in IRM.

● Agent and Secure Pull Print Express/Secure Pull Print Enterprise must be installed on the server.

● Make sure the correct OPS certificate or customer certificate displays in the Certificate field in Settings tile > 
Device tab.

● HTTP activation needs to be enabled on the server (.NET 3.5.1)

● Ensure the correct username and password is entered (that was specified during the installation of the OPS 
server). If the password needs to be changed, please see Section 15.18, Reinstalling HP OPS

● If the device was previously configured on a different server, you must enable the following setting to be 
able to configure the settings from the new server:

a. Go to the Settings tile.

b. Under the Device tab, check Override OPS settings.

c. Click Test and Apply.
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Complete the following steps:

1. Select the device from the device list, then click Configure.

2. In the Configure window, select Authentication and Authorization to enable IRM authentication and device 
rights.

3. Click OK.

5.7.4 HP PageWide Pro printers

Supported Features

● Secure Pull Printing

● Authentication
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– Card or Windows authentication

– Card or code

– Card and code (two factor)

– PIN/PIC

● Authorization for device functions

● Enrollment

● Job accounting

– Print server tracking

– Pull print tracking (via server)

– Glass activity tracking

Prerequisites

● Device firmware is 1629F (VR 1.2 release) or higher

● PageWide Pro will use OPS only if the firmware requires OPS and will prompt for the installation files

● User database/LDAP/Active Directory is properly configured

● Rights are properly configured in the IRM tile if authorization is required

● Agent and Secure Pull Print Express/Secure Pull Print Enterprise are installed and configured

● HTTP activation is enabled on the server (.NET 3.5.1)

NOTE: The following is currently unsupported:

● Quota for glass activity

● Allocation

● Local list authentication

5.7.5 Configure the device

Authorization controls access to device features by individual user or through AD groups. Before the device is 
configured the server must be configured for authorization (rights management).

Rights Management Setup

When a device is configured with OPA, all device functions are managed by IRM. This means that authentication 
changes for a specific feature are made within IRM. Rights can be setup individually by user or by group 
membership. For most customers configuration will be done by group membership, as configuring rights 
individually can be a time consuming administrative task with a large number of users to manage.

Rights control by group membership

1. Go to the IRM tile > AD Configurator > Rights and select By group membership. When using groups instead 
of individuals, the attribute containing user assigned groups already exist in AD as the memberOf attribue. 
Select the desired feature (such as copy) and verify “Feature is protected” checkbox is selected, and click 
Modify.
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2. Select Domain Users and click the right arrow to move it to the Permitted group’s box. Click OK.

3. Click Apply.

NOTE:

● To require authentication for a specific device feature, make sure the Feature is protected checkbox is 
selected in the IRM > AD Configurator > Rights page. When the Feature is protected checkbox is not 
selected, the feature will not require authentication at the device control panel.

● The previous steps must be completed for each feature individually.

● This setup cannot be completed through the device EWS or other tools, such as HP Web Jetadmin.

Rights control by individual user

1. Go the the IRM tile > AD Configurator > Rights and select Individually by user. If storing user details in AD, 
then enter the AD attribute that the user’s rights will be stored in. Make sure this attribute has write 
permissions and that it is indexed to ensure there are no delays in authentication. If storing in SQL, then 
this field does not appear.
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2. Select the desired feature (such as “copy”) and verify that the Feature is protected checkbox is selected. 
Click on Apply.
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3. Go to the AD User Editor tab. Search for the user by entering the username or email and click Find.

4. Select functions to restrict the user from accessing. Select individually, or select Deny All. Click Update.

NOTE: To change a user’s device feature rights using AD Group Manager, refer to Section “9.3.2 Change a user’s 
device feature rights” in the HP AC Administrator Guide.

Configuring devices

To configure the device, complete the following steps:

1. In the device tile enter the printer IP or hostname into the IP field and click Add.
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2. Select the device from the list and click Configure.

3. Select Authorization and Authentication and click OK. Configuration will complete in about 30 seconds. 
Configuration results will appear in the message panel.

5.7.6 XT devices

The XT device is an external device with an attached card reader that allows for Pull Printing at any printer or 
multifunction device.

XT boxes provide no tracking capabilities. If print tracking is required you will need to configure Pull Print tracking 
or print server tracking.

Supported features
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● Secure Pull Printing

● Job Accounting

– Print server tracking only

– Print tracking (with Enable Tracking of Printed Jobs enabled)

Prerequisites

For XT devices, ensure that the following additional prerequisites are enabled:

● Make sure the XT device is connected to a printer and to the network.

● If your server has a firewall, make sure TCP 2000 is open to send configuration files.

● If your server has a firewall, make sure UDP 11000 port is open for device discovery.

● Make sure the IRM authentication method is set to Card Only in the IRM tile > AD Configurator > General 
section..

● Make sure the IRM Proximity Reader settings and Card settings are correct.

● Make sure Card ID masking is enabled.

NOTE: The XT device must be rebooted or power cycled after the card type configuration changes. To power 
cycle the XT device, unplug the power cord from the device and then re-plug the power cord. Or, go to the 
Devices tile, right-click the XT device and select Reboot device.

Complete the following steps:

1. Select the XT device from the device list, then click Configure.

2. In the Configure window, select Pull printing. Click OK.

3. The device reboots and then beeps five times, indicating the device is configured.

5.7.7 HP S900 series devices

Supported features

● Secure Pull Print

● Authentication

– Card or Windows

– Card or Code

– Card+Code (two-factor)

– PIC

● Authorization for device functions

● Enrollment

● Job Accounting

– Quota

– In-printer tracking

Prerequisites

For the S900 devices, ensure that the following additional prerequisites are enabled:
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● Make sure IRM licenses are available on the HP AC server. An IRM license is required for each device to allow 
for walk-up authentication.

● If you want to use a front panel QR code for pull printing with a mobile device, make sure to manually 
generate a QR code prior to configuring the device.

● If you will be using SPP Enterprise on an HP S900 series device, make sure to go to the HP AC configuration 
tool > Devices tile and configure the device for Pull Printing. This will create a printer definition file, which is 
required to use SPP Enterprise.

NOTE:

● If you change the IRM authentication method to Code Only, you must recycle the HPACWS application pool 
in IIS before authenticating at the device. If an error message displays on the front panel, restart the device.

● By default, card readers are configured to read HID and iClass card types. If you want the card reader to 
read different card types, update it before connecting to the printer. Specific parts/kits along with part 
numbers are required for HIP reader integration on the S900 devices.

Complete the following steps:

1. Open a web browser and enter the IP address of the device to go to the device's web page to configure the 
device. The default username for the device web page is "admin" and the default password is "admin.”

2. To install a card reader for card authentication, select User Control followed by Card Type / Card Reader 
Settings. Select the Use IC Card for Authentication checkbox. Make sure the Card Type / Card Reader value 
is set to 200. Click Submit.

Figure 5-1  Card Reader settings

3. At the device, tap Settings > User Control > Card Reader Device Registration. Then tap Read.
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4. When prompted, plug in the card reader. The card reader will beep twice. Tap OK. The card reader Product 
ID and Vender ID displays on the screen.

Figure 5-2  Insert card reader prompt

5. Tap Submit to save the card reader registration.

Figure 5-3  Card reader registration
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6. To configure the device for card authentication, select User Control followed by Default Settings. Scroll 
down to the Card Setting section. Select the Automatic Login with a Card checkbox. Select the Card/Front 
Panel Operation Authentication Approved checkbox. Specify Enable in the Card ID Registration/Change 
Authority drop-down.

Figure 5-4  Default settings

7. On the device web page, select System Settings followed by Operation Settings followed by Home Screen 
Settings.
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8. Select the Image tab followed by one of the Not Set links.

Figure 5-5  Home screen settings

9. On the Registration screen, specify the name of the image you wish to associate with the Top Level MFP 
panel for the application. The HP AC icon, named “icon48x44.png”, is located on the HP AC server in the 
Program Files\HP\HP Access Control\DPR folder. Click Submit (U).

Figure 5-6  Home screen registration

10. After adding the custom image, select the Item tab followed by the Apps Home Button link. Scroll to the 
bottom of the page and select the Use Custom Image checkbox. Then specify the image you added in step 
4b. Then select Reboot Now to reboot the device and apply the settings.

Figure 5-7  Custom image
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11. To register HP AC Express with the MFP, select Application Settings followed by External Applications 
Settings.

Figure 5-8  Standard Application settings
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12. From the External Application Settings, select the Add button. Specify the Application Name as AC Express. 
Specify the Address for Application UI as http://serverIP/HPAppsWS/Default.aspx, where serverIP is the IP 
address of the server. On the same page, select the Use Custom Icon checkbox and then select the image 
you wish to associate with the Print Pulling application.

Figure 5-9  Standard Application registration

13. To register the HPAuthWS authentication application with the MFP, select Application Settings followed by 
External Applications Settings followed by External Accounting Application Settings.

● Select Enable in the External Account Control drop-down.

● Select the Set Authentication Server (Server 1) checkbox.

● Select Enable in the Server 1 drop-down.

● Specify an Application Name.

● Specify the Address for Application UI as http://serverIP/HPAuthWS/Default.aspx, where serverIP is 
the IP address of the server.

● Specify the Address for Web Service as http://serverIP/HPAuthWS/MFPSink.asmx, where serverIP is 
the IP address of the server.
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Figure 5-10  External accounting application settings

14. Click Submit. Then select Reboot Now to reboot the device and apply the settings.

15. In the HP AC configuration utility, go to the Devices tile and do one of the following:

a. Select the device from the device list.

b. Scan for devices on the network.

c. Enter the IP address of the device.

See Section 4.2.1, Adding devices

16. Select the device from the device list and click Configure.

17. In the Configure window select Authentication and/or Authorization and click OK.

5.7.7.1 Configuring Guest login

HP S900 series printers require authentication prior to using any device features. But with HP AC 15.2, a new 
Guest button option is introduced that allows users to authenticate as a guest in order to use devices features, 
such as Copy and Email.
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To enable the Guest button feature, follow the steps below:

1. On the HPAC server, go to the HP\HP Access Control\HPWS\Auth folder, and open the Web.config file in 
Notepad.

2. On the line <add key=”GuestButton”, change the value to “true”.

3. Turn off and turn on the printer.

At the printer, when the user selects the Guest button, they will be authenticated as user GUEST.
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IMPORTANT: If the user is logged in as GUEST and then wants to use the Pull Printing app, the user must select 
Logout and then authenticate with their card or code. After authenticating, the user can select the Pull Printing 
app and view their job list.

5.8 Enrolling a card at the device
The first time a user presents a card at a device they will be prompted to enroll their card.

IMPORTANT: The device must support card enrollment for this feature to work.

NOTE: Card enrollment on HP non-FutureSmart single-function devices is not supported.

Prerequisites

● Printer is configured for Pull Printing and Authentication.

● A card reader is connected to the printer.

● Device is either a supported HP MFP, HP S900 series device, HP OfficeJet Pro, or HP single function 
FutureSmart with a 4.2” display.

● Users are in Active Directory.

● Device authentication method is set to Card Only or Card+Code (two-factor) in the IRM tile > AD 
Configurator > General section.

5.8.1 HP FutureSmart MFP

1. Tap your card to the card reader attached to the device.
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2. Since the card is unrecognized, the user will be prompted to enter their network credentials. Click OK.

3. Enter your network Username and Password and press OK.

5.8.2 HP non-FutureSmart MFP

1. Present your card to the card reader attached to the device.
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2. Since the card is unrecognized, the user will be prompted to enter their network credentials. Click OK.

3. When prompted, present your proximity card and tap OK.

4. A confirmation message will display.

5.8.3 HP OfficeJet printer

1. Present your card at the card reader. A message will display indicating that the card is unrecognized (not 
enrolled). Tap OK.

2. Since the card is unrecognized, the user will be prompted to enter their network credentials. Tap OK.
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3. Enter your network Username and Password and tap OK.

5.8.4 HP S900

1. Present your card at the card reader. A message indicating the card is unrecognized will be displayed. Tap 
OK to enroll the card.

2. Enter your network credentials and tap OK.

3. Your card should now be enrolled. If a PIC is required, your PIC will be displayed. Otherwise, you will just be 
logged in. Tap OK after acknowledging the PIC. You will be logged in.

5.8.5 Enrolling a card with Two-Factor Authentication (Card + Code)

Two-Factor Authentication means that users will use their proximity badge + a PIN for an additional layer of 
security. This prevents users from borrowing your card and accessing the device and the pull print jobs. This is 
different from alternative windows authentication, which is designed so that if a user forgets a card they can still 
authenticate at the device.

1. Present your card and when prompted press OK to enter your network credentials.
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2. Since two-factor is enforced and the user is newly enrolled you will be shown a screen indicating your PIC.

3. At the device, present your proximity card.
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4. Since this is a new user, the user will be advised that a PIC is also required and will provide the user's code 
(MFP only).

NOTE:

● In step 1, if the user hits Cancel and authenticates with their Windows credentials they will not be prompted 
for a code, until they present their card.

● The code can be an existing code in active directory, or a random code generated by the application that is 
stored in a SQL database as typically writing to AD is not permitted.

5.8.6 Enrolling a card with Card or Code Authentication

When using Card or Code authentication the first time you present your card you will be asked for your network 
credentials. After associating your card with your network credentials you can use your card to access the device 
functions, or you can press a function and the system will automatically assume you want to use code 
authentication and prompt you for your code.

1. Present your card and when prompted tap OK to enter your network credentials.
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2. Enter your network credentials and tap OK.
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5.8.7 Enrolling a card from a client PC

The Card Enrollment application is a desktop application that allows users to register the cards themselves from 
a computer. Users simply log in and present their card to a connected card reader from a client PC. The Card 
Enrollment application then communicates with the AD-Authenticator server and enrolls the card to that user.

Prerequisites

● HP Access Control Card Enrollment application

● Users contained in Active Directory

● Device authentication method is set to Card only or Card+Code (two-factor) in the HP Access Control 
Configuration Utility (IRM tile > AD Configurator > General tab).

● A card reader is connected to a PC, with the PC on the same network as the HP AC server

● See Section 2.2, Server requirements.

Complete the following steps:

1. Open the Card Enrollment application.

2. Enter your network credentials and click Enroll.

3. The card reader will beep once. Present your card to the card reader and the card reader will beep twice.

4. A message will display confirming card enrollment.

5.8.8 Touch-to-Sign in

Prerequisites

● HP Jetdirect 2800w NFC/Wireless Accessory

● HP AC server installed and configured
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● Mobile device connected to same network as the HP Access Control Server

● HP ePrint App installed on the mobile device

– Android device with NFC

Complete the following steps:

1. In the HP ePrint Enterprise application, open the Application Settings screen in the top right corner.

2. Activate HP Access Control.

3. Follow the wizard to provide the server address and enter your user credentials.

4. Present the smartphone, with the HP ePrint Enterprise app only, to the HP Jetdirect 2800w NFC/Wireless 
Accessory on the printing device.

The first time you will be asked to register your smartphone. A unique ID will be created through the NFC 
connection for future authentications.
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5.9 Authorization to use device features
HP AC can be used to authorize a user's ability to access device features on a MFP. See Section 5.6, Authorization 
for more details.

5.9.1 HP MFPs

When the device is configured to require authorization to use certain features, the user will be required to 
authenticate prior to accessing the device. To authenticate to use a feature do one of the following:

● Authenticate at the device before accessing the feature;

OR

● Press the feature you want to use and you will be prompted to authenticate.

If you are denied access to use that feature you will receive a message stating access is denied.
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5.10 Configuring Scan to Home Directory
Prerequisites

● HP firmware version 3.6 or newer

● Verify folder access enabled in the EWS

● AD attribute where the home directory path is located (i.e. homeDirectory)

● Device's EWS configured for Save to Network folder using a Personal Shared folder

● Sign-in method for the network folder application set to use HP AC as the sign-in method when using the 
In Printer Agent (IPA), and guest access disabled OR Rights control enabled for the Send to Folder in the IRM 
> AD Configurator tab > Rights menu.

1. Go to the IRM tile > AD Configurator tab and select Users.

2. Under the home folder attribute, enter the attribute where the home directory path is stored.
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6 Pull Printing

6.1 Secure Pull Print Express

6.1.1 Configuring Pull Print Settings for HP AC Express

HP AC Express allows users to print jobs to be held in a server print queue then release the jobs from a mobile 
device, the front panel of the device or from a web page after the user has authenticated.

Jobs are stored on the HP AC server in the \Program Files\HP\HP Access Control\spool directory.

Secure Pull Print Express includes:

● Alias printing

● Touch-to-Release (from mobile devices)

● Encryption

Prerequisites

● See Section 2.2, Server requirements.

Complete the following steps:

1. Click on the Settings tile and select the SPPE tab.
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2. In the Pull Printing section, enter the job expiry time (global setting) in hours or days in the Job expires after 
fields. By default, jobs stored on the HP Access Control print server expire after 24 hours. This is a global 
setting that will automatically delete any jobs on the server when the expiry time limit is reached.

● Enable Retain "Print-Keep" jobs beyond expiration if you want to retain released print jobs on the 
server indefinitely, regardless of the global job expiration time set. Jobs that are indefinitely retained 
can be deleted only by users from the mobile release app, by users from an MFP front panel or by 
administrators using the HP AC admin console.

NOTE: Single-function devices will not print retained jobs.

TIP: If "Retain "Print-Keep" jobs beyond expiration is selected and "Enable one-touch release" is 
selected, only jobs with a status of "Waiting" will be printed, and if there is at least 1 "Printed" job in 
the list, the list of jobs will always display.

3. The Stored jobs folder will display the default location for the stored print jobs. Double-click the text field to 
browse to a different folder location. When a user prints a job using the Secure Pull Print Express print 
queue, jobs are stored in the following folder:

Program Files\HP\HP Access Control\spool

a. Enter the domain user name and password that has write access to the network folder, if storing jobs 
on a network drive and not locally to the HP Access Control server. To pull print using a shared 
network folder, the same service account credentials entered in the Domain\Login field must be used 
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for read/write access to the network folder, for the HPACSPPE application pool identity, and for the 
Log On setting in the HP AC SPPE service.

b. Choose the method by which pull print jobs are sorted. You can either select Date submitted or 
Document name. This sort setting applies to the job list view from a mobile device, a printing device 
or through the web page.

4. In the Protocol field, select the way the HP Access Control server will communicate with the printing 
devices. The choice of protocol will depend on the destination device, its capabilities, and the level of 
control and feedback required from the device.

● Before selecting a protocol verify the protocol is supported and enabled on the device. Go to the 
device’s embedded web server and browse to Networking > Management Protocols > Other > Enable 
Print Services and make sure the protocol is listed and enabled.

– TCPIP/9100 is the direct protocol that provides direct communication between the HP Access 
Control server and the printer engine. A connection is established to TCP/IP port 9100 and all 
data sent by the HP Access Control server is passed directly to the printer.

– TCPIP/LPR provides limited feedback from the devices about the success of a print request and 
provides no capabilities for a restart of a failed request.

– TCPIP/IPPS is a secure protocol that allows HP Access Control to encrypt the data stream sent to 
the device.

○ If your organization uses IPPS and it is not listed on an HP device, ensure the device’s 
Jetdirect card is updated, or replace with a Jetdirect card that supports the IPPS protocol. 
Contact your HP representative for more information.

NOTE: If TCPIP/IPPS is selected and IPPS is not enabled on the device, IPP will be used to print 
job and the job will not be encrypted.

5. Click Apply.
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6.1.2 Configuring a Pull Print printer with HP AC Express

With a Secure Pull Print Express pull printer, users can store their documents for future printing.

Complete the following steps to add a Secure Pull Print Express pull printer on the HP AC server:

1. Launch Print Management.

2. Expand the print server and click Drivers. Under the Action menu choose Add Driver.

3. Complete the wizard to finish installing the driver.

4. Select Ports and under the Action menu choose Add Port.

5. Select HP AC Secure Pull Print Express port. Click New Port.
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6. Enter a port Name and click OK.

7. Click on Printers and under the Action menu choose Add Printer.
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8. Choose Add a new printer using an existing port, select the port that was previously created and click Next.

9. Share the printer and finish the installation.
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10. Go to the Properties of the printer and disable bidirectional support. This is because we are not 
communicating directly to a printer but to the HP AC server.
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11. Go to the Advanced tab and select Start Printing after the last page is spooled. This is required when using 
IPM.

6.1.3 Set up print server-less pull printing with Express

Print serverless pull printing feature eliminates the print server from your printing environment and reduces the 
number of overall servers. The SPPE Print Client application is installed on a client workstation, allowing the 
user's pull print jobs to be routed and stored in a shared network folder on the SPPE server.

Storing the user's jobs on a network folder allows for pull printing even if the client workstation is offline. This is 
different from client based pull printing with local job storage, as with that functionality jobs are stored on the 
client PC. Please see Client based pull printing section of this guide.

Follow the steps below to set up client-based pull printing:

Prerequisites

● See Section 2.2, Server requirements.

● Ensure General settings have been configured. See Section 4.2, Configuring general settings.

● Ensure Authentication settings have been configured. See Authentication.

● Ensure devices are configured for authentication. See Section 5.7, Configuring devices.

Section 6.1   Secure Pull Print Express 165



Server setup

When a user prints to the HPACSPPE printer from a client workstation, a folder, named after the user's name, is 
automatically created in the shared network folder on the server. The user's jobs are stored in his or her folder 
on the server and can be pulled from any SPPE configured printer. The administrator can also view users' stored 
jobs in the SPPE tile of the HP AC configuration tool.

1. On the Secure Pull Print Express server, go to the Settings tile of the HP AC configuration tool and click the 
SPPE tab.

2. Under Pull printing, do the following:

a. Double-click in the Stored jobs folder field and browse for a shared network folder on the server. By 
default, the HPACSPPE port will print to the \\servername\sharename folder, where servername is 
the name of the SPPE server and sharename is the name of the shared folder. The shared folder does 
not have to be on the server, it can be on a storage area network (SAN) or network-attached storage 
(NAS).

NOTE: The share is not automatically created by the software, but must be created prior to this 
step.

b. Enter credentials in the Domain\Login and Password fields (Make sure you enter a user credentials 
have read/write access to the shared network folder). Click Apply.
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IMPORTANT: To pull print using a shared network folder, the same service account credentials entered in 
the Domain\Login field must be used for read/write access to the network folder, for the HPACSPPE 
application pool identity, and for the Log On setting in the HP AC SPPE service.

6.2 Set up the HP Access Control (HP AC) Secure Pull Print server for 
email printing

Users are able to store documents for pull printing from Microsoft Office or PDF documents by emailing the 
documents to a designated email address. The email address must be assigned in the admin console > Settings 
> Email tab. See Section 4.2.2, Email for more information.

Before emails and attachments can be printed from the HP ePrint Enterprise app, certain settings must be set on 
the HP Access Control (HP AC) Secure Pull Print server.
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NOTE:

● The following file types are supported for pull printing: DOC, DOCX, XLS, XLSX, PPT, PPTX, VSD, PDF, TXT, 
JPG, JPEG, BMP, GIF, PNG, TIF, and TIFF.

● This feature is supported with both HP AC Express and HP AC Enterprise.

● When printing email attachments, the attachment along with any screenshots, including email signatures, 
print on separate pages, regardless of the size.

● If using SPP Express, files are stored in the spool folder > sender's email address folder.

● If using SPP Enterprise, files are stored in the pull print queue that was created first.

Prerequisites

● You are logged into the server with a domain account with local administrator rights.

● The HP AC SPPE Mail service is started.

● Microsoft Office is activated with each application installed and registered to the current user.

● A local printer is installed with a PCL5, PCL6 or PS driver and set as the default printer.

● On a 64-bit server, validate the OS version of Microsoft Office. Open the Windows Task Manager with the 
Office application open. In the Processes tab, a 32-bit version application displays *32 in the name.

● The settings in the Email tab of the configuration utility are correct. See Section 4.2.2, Email for more 
information.

● If using SPP Enterprise, and if the user's name in the email address' prefix is different than the user's login 
name, an alias must be created for the user.

Complete the following steps to set up the Secure Pull Print server for mobile email printing.

1. Launch DCOM

2. If you are using a 32-bit version of Microsoft Office on a 64-bit server, complete the following steps:

a. Run the following command in Command Prompt: mmc -32
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b. When the User Account Control window displays, click Yes.

c. In the Console window, click the File menu and then click Add/Remove Snap-in.

d. In the Add or Remove Snap-ins window, click Component Services from the Available snap-ins 
section. Click Add. Click OK.

NOTE: If you are using a 64-bit version of Microsoft Office, go to Administrative Tools and open 
Component Services. Change the user login in the DCOM settings for each of the Office applications.
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3. In the Security tab, under Launch and Activation Permissions, select Customize.
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4. Add the user selected to start the HP AC SPPE Mail service. Select Local Launch and Local Activation. Click 
OK. Repeat the same steps in the Access Permissions section.

5. In the Identity tab, select This user and enter the user/password selected to start the HP AC SPPE Mail 
service.

6. After configuring DCOM, log off the server and send an email to validate that the settings are correct.
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7. Configure email settings in Settings tile > Email tab > POP3/IMAP. The email address entered here is the 
one that users will forward emails to.

8. Configure the HP AC SPPE Mail service to start with a domain account (services.mmc). Restart service.

9. Go to the Settings tile > SPPE. Under the Email section, check if you want users to process email 
attachments only or email + body text and have then appear as pull print jobs in their stored jobs folder.
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10. Select a printer to process the files. The driver must be installed locally on the server.

NOTE:

● Email jobs must use the settings and features, such as color or duplex settings, of a printer before they can 
be processed as pull print jobs. Click the drop-down list to select an installed pull print queue created 
locally on the server with the features you want to apply to email jobs. The printer must be a local printer 
with a PCL5, PCL6 or PS print driver.

● If the "Service not started with a domain account" message displays in the Email section, you must restart 
the HP AC SPPE Mail service with a domain account. To restart the service with a domain account, go to 
Administrative Tools > Services. Right-click the HP AC SPPE Mail service, then click Properties. Under the 
Log On tab, select This account and enter the credentials of a domain account. Click OK. Restart the HP AC 
SPPE Mail service.

6.3 Set up Server for Touch-to-Release
Mobile Release allows for releasing of secure pull print jobs using a smartphone. Use of the QR code feature 
allows for easy detection of printers by scanning the QR code on the device, selecting your pending print jobs, 
and releasing the jobs to the device to be printed. Mobile Release is supported on any device.

Prerequisites

● Smartphone connected to the same network as the HP Access Control server

● HP ePrint Enterprise app for your smartphone

● HP AC installed and configured

● QR code enabled on the device if using QR code for job release

● Print device configured for pull printing

● Driver compatible with the print devices

● For Enterprise: the device needs to be added to the Device list and configured for pull printing (no agent 
install required) to create the printer definition (Device tile)

● See Section 6.5, Configuring devices for pull printing

NOTE:

● For iOS devices the identification of the printer can be done through a bar code.

● Android support is NFC only.

● This feature is supported with both HP AC Express and HP AC Enterprise.

Complete the following steps:

1. Tap the HP AC icon on your smart phone in the ePrint Enterprise application.
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2. To select the destination printer, present the smartphone to the HP Mobile Print Accessory.

6.3.1 Configuring the Server and Printing Devices for Touch-to-Release

1. In the Settings tile choose the SPPE/SPP Enterprise tab and under QR code choose the information to 
encode in the QR code. The QR code is used to scan from the mobile device to route stored jobs to that 
printer.

For HP AC Express you can use either network name or IP address as long as DNS resolves correctly.

The order of the information displayed can be changed by dragging and dropping the items in the list to 
change the order.

NOTE: Since HP AC Enterprise uses printer definitions referencing the device’s network name, the QR 
code is set to the network name and cannot be changed.
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2. For single function devices, or any device that cannot display the QR on the front panel, go to the devices 
tile and right-click on a device to display a drop down menu. Choose Generate QR code to create a QR code 
for the printer. Click Print to print the code and affix the label to the device.

3. For HP MFP devices the QR code will display on the front panel of the device when it is configured for pull 
printing.

6.3.1.1 One-touch Release

One-touch release allows HP MFPs and HP OfficeJet Pro devices to print all documents at login with minimal user 
interaction, similar to single function devices. After authenticating at the device and selecting the Secure Pull 
Print application, all jobs are printed, without having to view the job list and selecting Print All.

1. Go to the Settings tile > SPPE tab and under Options select Enable one-touch release.

2. In the "if the number of jobs is less than equal to" enter the number of jobs that will trigger the one-touch 
release action (i.e. if the number entered is 5, if the # of jobs is 5 or less then all jobs will be released. If 
more than 5 jobs then a job list will be presented).
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NOTE:

● If retain "print-keep" jobs beyond is not enabled then all of the users jobs will be printed regardless of their 
status of "waiting" or "printed."

● If retain "print-keep" jobs beyond expiration is enabled than only jobs with a status of waiting will be 
printed.

● If retain "print-keep" jobs beyond expiration is enabled and there is at least one job with a status of 
"printed" then the job list will be displayed.

6.4 Secure Pull Print Enterprise

6.4.1 Introduction

With HP Access Control (HP AC) Secure Pull Print Enterprise, every pull print server can communicate with each 
other to enable remote job capabilities. This means that users can store jobs on one server and then release jobs 
from a different device managed by a different server. Pull print jobs can be released from single-function or 
multifunction printers.

6.4.2 Configuring Pull Print Settings for HP AC Enterprise

Prerequisites

The prerequisites for configuring HP AC Enterprise Secure Pull Print Settings are detailed in Section 2.2, Server 
requirements.

1. Click on the Settings tile and select the SPP Enterprise tab. The SPP Enterprise tab allows you to add 
servers for pull printing, add pull print queues and customize pull printing options. By default the local 
server information is populated. Any servers that will participate in roaming and be queried for print jobs 
should be listed here.

2. In the Options section,
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a. Enter the job expiry time (global setting) in hours or days in the Job expires after fields. By default, 
jobs stored on the HP Access Control print server expire after 24 hours.

b. If you want to retain print jobs after expiry, select the Retain Print-Keep jobs. Jobs that are indefinitely 
retained can be deleted only by users from the mobile release app, by users from an MFP front panel 
or by administrators using the HP AC admin console.

3. The Protocol field defines the way SPP Enterprise will communicate with the printer. The choice of protocol 
will depend on the destination device, its capabilities, and the level of control and feedback required from 
the device. Click Apply and Update printer definition after making any changes.
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● TCPIP/SOCK is a direct socket protocol that provides a simple direct communication channel between 
SPP Enterprise and the printer engine. A connection is established to TCP/IP port 9100 and all data 
sent by SPP Enterprise is passed through directly to the printer.

● TCPIP/PJL implements a bidirectional communication channel with the printer engine using the PJL 
(Printer Job Language) job management language. This protocol provides the most sophisticated 
control of print delivery, including guaranteed delivery of each page to the output hopper, checkpoint 
restart in the event of a failure, and full device status information (i.e., page jam, load paper, etc.). The 
default implementation delivers one document at a time and waits for all pages to be delivered to the 
output tray before commencing delivery of the next document. While this provides the highest level 
of assured delivery, it can introduce a delay between documents caused by the printer engine winding 
down while the paper path is completely cleared. When printing a large number of small document 
this delay between jobs is most noticeable.

● TCPIP/IPPS is a secure protocol that allows SPP Enterprise to encrypt the data stream sent to the 
device.

NOTE: If TCPIP/IPPS is selected and IPPS is not enabled on the device, IPP will be used to print jobs 
and the job will not be encrypted.

a. Before selecting a protocol, verify the protocol is supported and enabled on the device. Go to the 
device’s embedded web server and browse to Networking > Management Protocols > Other > Enable 
Print Services, and make sure the protocol is listed and enabled.

b. Under the ports section you can change the default ports for the following. After modifying the 
default port numbers, click Restart Services:

● TCP/IP API Port: Specifies the local TCP/IP port that SPP Enterprise will open for API requests. 
Port 5501 is the default port.

● TCP/IP LPD Port: Specifies the local TCP/IP port that SPP Enterprise will open for inbound LPD 
request. Port 515 is the default port. If an LPD daemon is already running on the server, shut 
down this process to enable SPP Enterprise to open port 515.
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● TCP/IP QUEUE Port: The port that will open for inbound requests on the server and applies to 
the Enterprise Print Client. This port will also open on client workstations when Enterprise Print 
Client is installed. This is used to transfer job metadata from client workstations to the server 
when you want to use Local Job Storage on client workstations. The default port is 5500.

● TCP/IP IPP Port: Specifies the local TCP/IP port that SPP Enterprise will open for inbound IPP 
request. Port 631 is the default port.

4. If you want to retain print jobs after expiry, select the Retain Print-Keep jobs. Jobs that are indefinitely 
retained can be deleted only by users from the mobile release app, by users from an MFP front panel or by 
administrators using the HP AC admin console.

NOTE: Single-function devices will not print retained jobs. 

TIP: If Retain "Print-Keep" jobs beyond expiration is selected and Enable one-touch release is selected, 
only jobs with a status of "Waiting" will be printed, and if there is at least 1 "Printed" job in the list, the list of 
jobs will always display. 

5. Enabling the tracking of purged jobs will allow any jobs that have been expired or deleted to be tracked for 
job accounting. When the Enable tracking of purged jobs box is checked, an XML file is created for each job 
that is purged.

The XML file includes information such as the purged job name, the date the job was submitted, and the 
date the job was purged. The XML files are created in one of the following locations:

● If Job Accounting is installed on the same server as Secure Pull Print Express, the XML files are 
created in the following folder:

Program Files\ HP\HP Access Control\temporary\DTM

● If Job Accounting is installed on a different server, the XML files are created in the following folder:

Program Files\HP\HP Access Control\temporary

When purging is complete, the XML files are pushed to the Job Accounting server in the \Temporary \DTM 
folder.

NOTE: Requires the installation of the Job Accounting Server component or having a job accounting 
server on the network. 
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6. To enable tracking of printed jobs on devices that do not support in-printer tracking (HP OfficeJet Pro 
devices), select Enable tracking of printed jobs. This will track print job pages after they have been printed.

NOTE: Requires the installation of the Job Accounting Server component or having a job accounting 
server on the network. 

7. When Use device IP address is enabled, this checkbox allows the spooler to identify the printer via IP 
address instead of host name, in case the host name has changed and a printer has not been reconfigured. 
It is recommended that printers have fixed IP addresses.

8. Show local and remote jobs: When enabled, this checkbox allows for pull print queues from all SPP 
Enterprise servers to automatically display on a device front panel after authentication. If this is disabled, 
the user will need to manually select the Remote Jobs button at the front panel to view all pull print 
queues.

9. To improve performance, you can specify the number of jobs that should be delivered to the device 
concurrently. In the PJL overlap field, enter a number from 1 through 9 to determine the number of jobs to 
be released at one time. Overlapping the delivery of multiple documents to the device can prevent delays 
that can occur between documents caused by the device clearing the paper path before confirming job 
completion.

NOTE:

● The value chosen should be the lowest value required to prevent delays between documents, and will 
vary depending on the speed and capabilities of the target printer. A value of 3 should be sufficient for 
most printers.

● When using Point and Print with SPP Enterprise, the SPP Enterprise port monitor must be used to 
enable Encryption at rest. An LPR shared queue does not support encryption at rest. To use 
encryption with an LPR local queue, the HP AC Print Client must be installed on client workstations.

TIP: If you want end-to-end encryption from the user workstation to the printer, install HP AC Print Client 
on user workstations with encryption enabled, enable Encryption at rest on the HP AC server and select 
TCPIP/IPPS as the printing protocol. 

180 Chapter 6   Pull Printing



10. Enable Encryption at rest to encrypt print jobs using AES 256 while they are on the HP Access Control 
server.

NOTE: When enabling encryption, the printer definition files must be updated. Click the Update printer 
definition button on all servers. 

11. The Client Passcode is used for authentication between the server and client workstations, and applies 
when Local Job Storage, via the Enterprise Print Client, is installed on client workstations. The Client 
Passcode uses a cryptographic nonce to establish secure communication between the client and server. 
The Client Passcode and Client Encryption Key must be applied before installing Local Job Storage on client 
workstations. Enter any value between 0 and 254 characters.

IMPORTANT:

● If the Client Passcode is changed after installing the Enterprise Print Client on client workstations, 
users will not be able to release jobs. You must reinstall the Enterprise Print Client.

● After changing the Client Passcode, click Restart Services.

NOTE:

● The Client Encryption Key is stored in the passcode.dat files in the C:\Program Files\HP\HP Access 
Control\bin folder on the server and in the Program Files\HP\HP Access Control Print Client\bin folder 
on client workstations.

● By default, communication between the server and clients are encrypted. The Client Passcode and 
Client Encryption Key are optional if you want to change the default keys.

12. The Client Encryption Key field allows for encryption of job metadata between the server and client 
workstations when Local Job Storage, via the Enterprise Print Client, is installed on client workstations. The 
Client Passcode and Client Encryption Key must be applied before installing Local Job Storage on client 
workstations. Enter hexadecimal characters of 128 bits, 192 bits or 256 bits in the text field.

IMPORTANT:

● If the Client Encryption Key is changed after installing the Enterprise Print Client on client 
workstations, users will not be able to release jobs. You must reinstall the Enterprise Print Client.

● After changing the Client Encryption Key, click Restart Services.
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NOTE:

● The Client Encryption Key is stored in the encryptionkey.dat files in the Program Files \HP\HP Access 
Control\bin folder on the server and in the Program Files\HP \HP Access Control Print Client\bin folder 
on client workstations.

● If Encryption at rest is enabled and Client encryption key is used with Local Job Storage, the 
Enterprise client on the workstation will use the Client encryption key and not the Encryption at rest 
key.

13. If you want to change users' identification format, see the section the Configuring Print Job Identifier 
section of this guide.

14. Click Apply.

15. After making any changes, select Restart Service button to restart the SPP Enterprise Service.

6.4.2.1 IPPS inbound support

Prerequisites:

● Requires IPP printing enabled on the computer.

● The client computers must have the proper certificates installed in the Trusted Root Certificate Authorities 
store.

Follow the steps below:

1. To enable SSL/TLS inbound printing it is first necessary to create a certificate signing request for your 
server and a private key. This can be done using the openssl command line tool (located in the \Program 
Files\HP\HP Access Control\bin folder) using the following command:

NOTE: Substitute hpac_hostname with your server’s fully qualified DNS name.

openssl req -newkey rsa:2048
-keyout hpac_hostname.key
-keyform PEM
-out hpac_hostname.csr
-outform PEM

NOTE: You will be prompted to provide additional details to complete the certificate signing request and 
two files will have been created.

● A certificate signing request file with an extension of .CSR.

● A private key file with an extension of .KEY.
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The certificate signing request file (hpac_hostname.csr) should then be sent to a Certificate Authority (CA) 
who will validate the request and create a PEM format (Base64 encoded) certificate.

The PEM format (Base64 encoded) certificate along with any intermediate CA certificates need to be 
concatenated together into a single file (e.g., hpac_hostname.cer).

2. The certificate (hpac_hostname.cer) and the keyfile (hpac_hostname.key) should be copied to the HPAC 
server.

3. In HPAC > Settings > SPP Enterprise > SSL Options, double-click in the SSL Chain File field and select the 
chain file. This is the public key and will be shared with clients connecting with IPPS. Double-click in the SSL 
Key File field and select the key file. This is the private key. In the Passphrase field, enter the certificate 
passphrase if required.

4. Specify the server port number that HPAC should open for inbound SSL communication. Go to HPAC > 
Settings > SPP Enterprise > Options > TCP/IP IPPS Port field and specify the required inbound IPPS port 
(recommended 5443, but can be changed).

5. Restart the SPP Enterprise service.

6. Under Pull Print queues create a queue to receive the IPPS jobs. This queue is not a pull print queue, but an 
inbound connection for IPP jobs that will route the job to the pull print queue specified in the line 
TCPPRTR=.

7. Go to \Program Files\HP\HP Access Control\spoolroot\ptr folder and open the pull print queue previously 
created in notepad. Replace the contents of the file with the following text, where TCPHOST is the name of 
the HPAC server, TCPPRTR is the name of the pull print queue on the server and FILTER1 is the path of the 
filter.

8. In the Settings tile>SPP Enterprise tab enable encryption at rest and enter an encryption key. Click on apply 
and restart server.

9. Install on the client PCs the IPP printer (for example, https://servername:5443/queue where the port 
matches the port specified in Settings tile > SPP Enterprise > Options > TCP/IPIPPS.
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NOTE: If using your own supplied certificates, then specify the SSL Chain file, the SSL key file and the 
passphrase and the IPPS port field. It is recommended to use a certificate provided by the customer.

NOTE: The queue created that receives the IPPS jobs from the client PCs will no longer be displayed in the Pull 
Print Queue list in the Settings tile > SPP Enterprise tab.

6.4.2.2 Configure Print Job Identifier

6.4.2.2.1 User Identifier

HP Access control requires authentication to know who the user is so that it can track the details on the activity 
of the user, associate pull print jobs to the user, and allow for user rights management. The base requirement is 
that the user identifier is matched against the login ID (proximity badge ID or code ID).

The default user identifier is the sAMAccountName attribute, and changing the print job identifier is not required 
for a multiple domain environment with the following:

● Unique login that is not duplicated in the different domains, and

● Data for all users is accessible from a single entry point with a single LDAP or Global Catalog query that can 
authenticate the user’s credentials and confirm user details. This normally implies that there is a trust 
relationship between domains, which are part of a common forest.

If the print job identifier needs to be changed, because the environment does not support the above 
rquirements, then the print job identifier must be changed on all HP AC pull print servers.

User Identifier for multiple domains with non-unique logins

For pull printing it is requires that the user identifier for the print jobs is unique so that print jobs from one user 
do not appear in the job list for another user. In addition to the default sAMAccountName attribute, HP Access 
Control can store jobs from users as either domain\username (DomainA\jdoe) or as userPrincipalName 
(jdoe@domainA.com) by configuring the Print Job Identifier within HP Access Control.

The same user identifier must be used for both pull printing (Settings tile > SPP Enterprise tab > Client Options > 
Change Print Job Identifier) and for authentication and enrollment (IRM tile > AD-Configurator tab > Users > 
Username attribute).

Figure 6-1  Print job identifier in the SPP Enterprise tab
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Figure 6-2  User identifier in the AD Configurator

sAMAccountName

The sAMAccountName is used to support clients and servers from Windows. The sAMAccountName is set as the 
default attribute within the HP Access Control utility.

The sAMAccountName can be used for authentication and enrollment if it is unique across the domains.

If usernames are not unique in the global catalog, the sAMAccountName should not be used, and 
userPrincipalName is the recommended best practice.

userPrincipalName

The userPrincipalName (UPN) is the recommended login for Windows users, if you have to change the print job 
identifier. At login time a UPN is validated by searching the LDAP server location set in the AD Configurator > 
LDAP Server page.

For authentication and enrollment, when using the userPrincipalName, the entire syntax must be used 
(jdoe@domainA.com). This is also required for usernames entered into the User Editor.

When using the userPrincipalName attribute, the HP AC Enterprise Print client is required, and must be installed 
after server configuration, so that the settings are pushed from the server to the client during installation.

domain\login

When the default sAMAccountName cannot be used, one option is to configure the user identifier to be domain
\login. The login will typically be the sAMAccountName for that user.

One benefit of this choice is that, for a given user, if the login is not repeated for other users in the other 
domains, the user does not necessarily need to enter the domain, but just the login name when enrolling a card 
or using alternate windows authentication at the print device control panel.

If the user has a duplicate sAMAccountName across domains, then the user would be required to enter domain
\login at login.
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NOTE: Using domain\login does not support the following features:

● Multi-vendor devices;

● Delegate, and

● Alias.

When using the domain\login, the HP AC Enterprise Print client is required, and must be installed after server 
configuration, so that the settings are pushed from the server to the client during installation.

6.4.2.2.2 Configuring to use Domain\Login

1. In the HP AC utility navigate to the IRM tile>AD Configurator tab>Users, confirm the username attribute is 
set to sAMAccountName (default) and click Apply.

Figure 6-3  User identifier in the AD Configurator
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2. Go to the Settings tile>SPP Enterprise tab>Client Options. Click on Change print job identifier and select 
Domain\login. Click on Apply.

Figure 6-4  User identifier in the SPP Enterprise tab

3. On the client PC it is required to install the HP AC Enterprise Print client. Note: this must be done AFTER 
configuration of the HP AC server as the server settings for the Print job identifier are applied to the client at 
the time of install.

6.4.2.2.3 Configuring to use userPrincipalName

1. In the HP AC utility navigate to the IRM tile>AD Configurator tab>Users and change the username attribute 
to userPrincipalName and click Apply.

Figure 6-5  User identifier in the AD Configurator
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2. To test, go to the AD User Editor tab and enter the userPrincipalName for a user and click find.

Figure 6-6  Testing resolution using userPrincipalName
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3. Go to the Settings tile>SPP Enterprise tab>Client Options. Click on change print job identifier and select 
userPrincipalName. Click on Apply.

Figure 6-7  User identifier in the SPP Enterprise tab

4. On the client PC it is required to install the HP AC Enterprise Print client. Note: this must be done AFTER 
configuration of the HP AC server as the server settings for the Print job identifier are applied to the client at 
the time of install.

6.4.2.3 Configuring PJL Parsing for Non-Windows Printing

Prerequisites

● HP AC Enterprise installed and configured.

The Enterprise port monitor can use a filter (PJLHeader.exe) to parse the PJL header for non-Windows printing, or 
with HP ePrint Enterprise, getting the username/job name from the PJL. Along with the Enterprise port monitor, 
this is used when printing from a system that does not generate standard PJL information.

1. Click on the Settings tile and select SPP Enterprise tab.

2. In the Options section, select PJL parsing to enable this.

NOTE: Enabling PJL Parsing may affect performance.

6.4.2.4 Configuring PJL Overlap

Prerequisites

● HP AC Enterprise installed and configured.

To improve performance, you can specify the number of jobs that should be delivered to the device concurrently. 
In the PJL overlap field, enter a number from 1 through 9 to determine the number of jobs to be released at one 
time. Overlapping the delivery of multiple documents to the device can prevent delays that can occur between 
documents caused by the device clearing the paper path before confirming job completion.
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NOTE: The value chosen should be the lowest value required to prevent delays between documents, and will 
vary depending on the speed and capabilities of the target printer. A value of 3 should be sufficient for most 
printers.

6.4.3 Adding additional SPP Enterprise servers for pull print remote jobs

Remote jobs allows users to pull jobs from different locations. Users can store a job on one server, then release 
the same job at a different location from a printer configured on a different server. Servers listed here are local 
servers and any remote print servers that will participate in roaming and be queried for print jobs. To add 
additional servers, complete the following steps:

1. In the HP AC configuration utility, go to the Settings tile > SPP Enterprise tab.

2. In the Servers information section, click in an open row, then enter the Fully Qualified Domain Name (FQDN) 
of a server you want to add, including the IPP port number and press <enter> on the keyboard. (Example: 
Servername.Domain.com:631)

3. Click the Test button to test the connection to the server. The Messages pane should display Connection to 
spooler OK. Then click Apply.

6.4.4 Adding pull print queues on the server

SPP Enterprise pull print queues will allow the server to receive jobs printed from client computers. When jobs 
are received from client computers, the jobs are stored in the Program Files\HP\HP Access Control\spoolroot
\spool\Queue folder, where Queue is the name of the pull print queue. Each job is stored as two files, a DAT file 
and an INF file. To add a pull print queue, complete the following steps:

1. In the HP AC configuration utility, go to the Settings tile > SPP Enterprise tab.
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2. In the Pull Print Queues section, click Add.

NOTE: When a pull print queue is created from the HP AC configuration utility, a printer definition file is 
created in the Program Files\HP\HP Access Control\spoolroot\prtr folder. This printer definition file is 
required to allow the print queue to receive print jobs from client printers.

3. In the Queue name field, enter any name for the pull print queue. Click Add.

4. To have all jobs from all servers display automatically on the front panel, select Show local and remote 
jobs. When disabled, the user will need to manually select the Remote Jobs button on the front panel to 
view all pull print queues. When enabled, there is an option to "Stop at first server with jobs". When this 
option is enabled, users will see jobs stored on the first server that was detected with stored jobs, instead 
of jobs from all SPP Enterprise servers.

NOTE: With card authentication and Show local and remote jobs enabled, when a user presents his or her 
card at an HP single-function device, all jobs will be printed at once.

5. To have all jobs display in one job list, select Display all jobs. When disabled, the user will have to select the 
pull print queue first, prior to viewing the job lists.

6.4.5 Assured Job Delivery

HP AC Secure Pull Print Enterprise offers assured job delivery when using TCPIP/PJL as the communication 
protocol from the HP AC server to the print device.

Assured Job Delivery offers the following benefits:

NOTE:

● TCPIP/PJL is required.

● Not supported with encryption.

● This is supported only with HP AC Enterprise.
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● The Enterprise spooler assures that the delivery of all the pages of the document are successfully sent 
prior to sending the next document to the print device.

● Validation of the delivery of each page is done, by verifying that each page has been successfully delivered 
to the output tray of the print device. Only after the validation that all pages have been delivered for the 
current document will the next document be sent for printing.

● Print data is immediately suspended if the print device reports an OFFLINE error before or during data 
delivery. Sending of the print data will not resume until the printer reports an ONLINE status.

● If a device fails during printing, HP AC will continue to print that document once the failure is cleared, unless 
the printer has been rebooted or the job has been canceled by the user.

Complete the following steps:

1. Go to the Settings tile and select SPP Enterprise tab.

2. Under the options section change the protocol to TCPIP/PJL.

3. Click Apply.

6.5 Configuring devices for pull printing
In order to allow users to pull jobs from the pull print queue to a device, the device must be configured for pull 
printing from the HP AC configuration utility.

Prerequisites

● HP Access Control (HP AC) Agent and HP Access Control (HP AC) Secure Pull Print must be installed on the 
server.

● Before installing any solution on HP devices, make sure the correct PRN installation file displays in the 
Installation file field in the Settings tile > Agent tab.

● The device has been configured for authentication. See Section 5.7, Configuring devices

● Make sure a device administrator password is set on MFPs and matches the device administrator name and 
password in the Settings tile > Device tab and the IRM tile > AD Configurator tab > General page.

6.5.1 HP multi-function printers

1. In the HP AC configuration utility, go to the Devices tile.

2. Do one of the following:

● Select the device from the device list

● Scan for devices on the network
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● Enter the IP address of the device

● See Section 4.2.1, Adding devices

3. Click Install to send the installation file to the device if the device has not already been configured for 
authentication. See Authentication. The device may reboot during the installation process. Please wait for 
the device to return to the "Ready" state.

4. Select the device from the device list, then click Configure. In the Configure window, select Pull printing. If 
you want to use IRM authentication and rights management, also select Authentication and Authorization. 
Click OK.
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NOTE:

● When configuring HP AC there may be a requirement to set the device to look at multiple IIS servers. 
When multiple IIS servers are in the Settings > IIS area, then the option to configure for a different IIS 
server will appear for the Pull Printing option in the Devices > Configuration window.

● When using multiple IIS servers ensure that the server certificates are configured properly. Refer to 
Section 4.2.4.3, Creating certificates in a multi-server installation.

5. Configuration will be complete in about 30 seconds. Configuration results will appear in the message pane.

6. Go to the device EWS to set the authentication method at the device.

● For a FutureSmart device, go to the Security > Access Control page of the EWS. Click Access Control 
(HPAC IRM) on the left pane and enable the authentication method required.

● In the left pane, click on Access Control. Then scroll down to HP AC Secure Pull Print and choose the 
authenticator (I.e. HPAC – IRM Server). Set the HP AC authentication method for each device function 
to be controlled by HP Access Control.
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● Set the lock icon in the Device Guest column for the chosen options.

● For a non-FutureSmart device, go to the Settings > Authentication Manager page of the EWS. In the 
HP AC Express row, select HPAC Server as the Log In Method. Click Apply.

Figure 6-8  Authentication manager

6.5.2 HP single-function printers

Complete the following steps:

1. In the Devices tile, select the device from the device list.

2. Click Install to send the installation file to the device if the device has not already been configured for 
authentication. See Authentication. The device may reboot during the installation process. Please wait for 
the device to return to the "Ready" state.

Figure 6-9  Devices install
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3. Select the device from the device list, then click Configure. In the Configure window, select Pull printing. If 
you want to use IRM authentication and rights management, also select Authentication and Authorization. 
Click OK.

Figure 6-10  Devices configure

6.5.3 HP Officejet printers

Prerequisites

These additional prerequisites are required for HP OfficeJet Pro devices:

● Make sure the correct OPS certificate or customer certificate displays in the Certificate field in the Settings 
tile > Device tab.

● Ensure the correct username and password is entered that was specified during the installation of the OPS 
server. If the password needs to be changed, please refer to the Section 15.18, Reinstalling HP OPS section 
of this guide.

● If the device has been previously configured on a different server, to be able to configure the settings from 
the new server you must enable the following setting: Settings tile and under the Device tab check Override 
OPS setting. Click Test and Apply.

Complete the following steps:
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1. Select the device from the device list, then click Configure.

Figure 6-11  Officejet configure

2. In the Configure window, select the following components:

● Select Pull printing to enable the Secure Pull Print Express app button.

● Select Authentication to enable IRM authentication.

3. Click OK.

6.5.4 HP PageWide Pro devices

6.5.4.1 HP PageWide Pro

Prerequisites

● Device firmware 1629F (VR 1.2 release) or higher

● PageWide Pro devices will use OPS only if the firmware requires OPS and will prompt for installation

● User database/LDAP/Active Directory is properly configured

● In the IRM tile, rights are properly configured if authorization is required

● Agent and Secure Pull Print Express/Secure Pull Print Enterprise are installed and configured

● HTTP activation is enabled on the server (.NET 3.5.1)

Prerequisites

● Secure Pull Printing

● Authentication
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– Card or Windows authentication

– Card or code

– Card and code (two factor)

– PIN/PIC

● Authorization for device functions

● Enrollment

● Job accounting

– Print server tracking

– Pull print tracking (via server)

– Glass activity tracking

NOTE: The following is currently unsupported:

● Quota for glass activity

● Allocation

● Local list authentication

6.5.4.2 Configuring devices

To configure the device, complete the following steps:

1. In the device tile, enter the IP or hostname into the IP field and click Add.

2. Select the device from the list and click Configure.
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3. Select Pull printing and Authentication and click OK. Configuration will complete in about 30 seconds. 
Configuration results appear in the message pane.

6.5.5 XT devices

Prerequisites

● Make sure the XT device is connected to a printer and to the network.

● If your server has a firewall, make sure TCP 2000 is open to send configuration files.

● Make sure the IRM authentication method is set to Card Only.

● Make sure the IRM Proximity Reader settings and Card settings are correct. Also, make sure Card ID 
masking is enabled.

NOTE: The XT device must be rebooted or power cycled after the card type configuration changes. To power 
cycle the XT device, unplug the power cord from the device and then re-plug the power cord. Or go to the 
Devices tile, right-click the XT device and select Reboot device.

Complete the following steps:

1. Select the XT device from the device list, then click Configure.
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2. In the Configure window, select Pull printing. Click OK.

The device reboots and then beeps five times, indicating the device is configured.

6.5.6 HP S900 series devices

Prerequisites

● Make sure IRM licenses are available on the HP Access Control server. An IRM license is required for each 
device to allow for walk-up authentication.

NOTE:

● Device configured for authentication. See Section 5.7.7, HP S900 series devices.

● If you change the IRM authentication method to Code Only, you must recycle the HPACWS application pool 
before authenticating at the device. If an error message displays on the front panel, power off and restart 
the device.

● By default, card readers are configured to read HID and iClass card types. If you want the card reader to 
read different card types, update the card reader before connecting to the printer. Specific parts/kits along 
with part numbers are required for HIP reader integration on the S900 devices.

6.6 Submitting jobs for pull print

6.6.1 Submit from a PC

To submit pull print jobs from a PC, complete the following steps:

1. From an application, such as Microsoft Word or Adobe Reader, select File > Print.
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2. From the list of printers, select the pull print printer you would like to use.

3. Click Print.

6.6.2 Submit from email

Prerequisites

● The HP AC SPPE Mail service is started.

● Microsoft Office is activated with each application installed and registered to the current user.

● For Adobe PDF documents, Adobe Reader must be installed on the server

● A local printer is installed with a PCL5, PCL6 or PS driver and set as the default printer.

● On a 64-bit server, validate the OS version of Microsoft Office. Open the Windows Task Manager with the 
Office application open. In the Processes tab, a 32-bit version application displays *32 in the name.

● The settings in the Email tab of the configuration utility are correct. See Section 4.2.2, Email for more 
information.

From the email client send an email to the email address of the HP AC server (as defined in the Settings tile 
>Email tab > POP3/IMAP login field.

NOTE: The following file types are supported for pull printing: DOC, DOCX, XLS, XLSX, PPT, PPTX, VSD, PDF, 
TXT, JPG, JPEG, BMP, GIF, PNG, TIF, and TIFF.

6.7 Pull Printing from the devices
The following sections describe methods to print stored jobs.
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IMPORTANT: When pull printing with SPP Enterprise, if a user has a mix of pull print jobs and shared delegated 
jobs, not all jobs will release at once if Print All is selected at the device. The user will have to select Print All to 
print all pull print jobs and then select Print All again to print all shared delegated jobs.

NOTE: At a device front panel, when Print All is selected, jobs remain visible on the screen until all jobs are 
printed. Tap Refresh to refresh the job list.

6.7.1 HP single-function printers

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● A user has pending jobs in the pull print queue.

NOTE: On devices without a 4.2" display the user must have a card previously enrolled.

Complete the following steps:

1. Present your registered card at the card reader. IRM identifies the registered card, authenticates the user, 
and locates your stored jobs in the spool folder. All of your stored jobs are then pulled from the spool 
folder, printed, and then deleted.

2. Collect your printed documents.

6.7.2 HP single-function printers with a 4.2” display

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● A user has pending jobs in the Pull Print queue.

Complete the following steps:

1. Present your registered card at the card reader, enter your code or Windows credentials.

2. Select the documents to be printed from the list and tap the desired Print button.

3. Collect your printed documents.
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NOTE:

● When Print-Keep is selected, an “R” will display next to the job list to indicate that the job is retained.

● When all jobs in the list are retained, the Print All button is disabled.

6.7.3 HP multi-function printers

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● A user has pending jobs in the pull print queue.

NOTE: The MFP front panel screen may vary, depending on the printer model.

Complete the following steps:

1. At the device front panel, tap the HP AC application.

2. Authenticate at the device using either card, code, or Windows authentication.

3. Select documents from the document list. Tap Print-Delete to print and then delete the document from the 
document list. Tap Print-Keep to print and keep the document in the document list.

NOTE: When Print-Keep is selected, an "R" will display next to the job name to indicate that the job is 
retained.

NOTE: When all jobs in the list are retained, the Print All button is disabled.
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6.7.4 HP Officejet Pro printers

Prerequisites

● For users to pull print remote jobs, make sure the Show local and remote jobs checkbox is selected in the 
HP AC configuration tool > Settings tile > SPP Enterprise tab.

● A user has pending jobs in the pull print queue.

● The printer is configured for Pull Printing and Authentication.

Complete the following steps:

1. After authenticating at the printer, tap Apps.
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2. Tap HP AC Secure Pull Print.

3. Select documents from the document list. Tap Print.

NOTE:

● Due to the limitation of HP Officejet Pro device front panels, the Print-Keep button is not available.

● Due to the limitation of HP Officejet Pro devices, no more than 50 jobs can be displayed in the job list. Also, 
due to a character limitation of the URL (a concatenation of print job URIs that is used to connect to the 
server), not all selected jobs may be printed or deleted. When using SPP Enterprise, and depending on the 
length of the server name and queue name, the maximum number of jobs that can be printed or deleted at 
one time is 10. When using SPP Express, the maximum number of jobs that can be printed or deleted at 
one time is 14.

6.7.5 XT card readers

Prerequisites

● The XT device is connected to a printer and the network.

● The XT device is configured for pull printing.

● Cards are registered to users.

● IRM authentication set to Card only.

● For users to pull print remote jobs, make sure that Show local and remote jobs is selected in the HP AC 
configuration tool > Settings tile > SPP Enterprise tab.

● A user has pending jobs in the pull print queue.
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Complete the following steps:

1. Present your registered card at the XT card reader. The XT device identifies the registered card, 
authenticates the user, and locates your stored jobs in the spool folder. All of your stored jobs are then 
pulled from the spool folder, printed, and then deleted.

2. Collect your printed documents.

6.7.6 HP S900 Series

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● A user has pending jobs in the pull print queue.

Complete the following steps:

1. To log in at the device, present your card at the card reader or enter your PIC to authenticate.

2. Touch Apps. If more than one application is configured on the device, tap the pull printing application.

3. Select documents from the document list. Tap Print All to print all documents in the list. Tap Print- Delete to 
print and then delete the document from the document list. Tap Print-Keep to print and keep the document 
in the document list.

NOTE:

● If the IRM authentication method is set to Card + Code (two-factor) and you log out by presenting a 
proximity card at the card reader, the following message displays: "Authentication failed. Please confirm 
the card." Tap OK to log out.

● If you change the IRM authentication method, you must recycle the HPACWS application pool before 
authenticating at the device. If an error message displays on the front panel, power cycle the device.

● If a user is logged in and another user presents his proximity card at the card reader, the first user will be 
automatically logged out and the second user will be logged in.
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6.7.7 Touch-to-Release

TTR (Touch-to-Release) is supported in all devices with HP AC Secure Pull Printing configured and licensed. On 
iOS devices, the identification of the printer is done through a QR code. Android devices can use either the QR 
code, NFC, IP address, or a previously used/selected printer.

Prerequisites

● HP Access Control server version 14.0 or higher installed and configured

● Mobile device connected to same network as the HP Access Control server

● HP ePrint Enterprise app version 1.11.0 or higher installed on the mobile device. QR code enabled on the 
MFP or Printer (if using QR code for job release)

Complete the following steps:

1. Open the HP ePrint Enterprise application on your mobile phone.

2. Tap the HPAC icon.
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3. Once communication is established with the HP AC server, a list of print jobs will display. Select the ones 
you want to print, then scan the QR code on the printer or MFP. The documents will now print.

6.7.8 Releasing delegate jobs

Prerequisites

● The printer is configured for Pull Printing and Authentication

● A user has a delegate pending jobs in the pull print queue

● IRM must be set to use Database as the data storage

NOTE: The MFP front panel screen may vary, depending on the printer model.

Complete the following steps:

1. At the device front panel, tap the HP AC application.

2. Authenticate at the device using either card, code, or Windows authentication.

3. Select documents from the document list. A delegate job is preceded with a (+) symbol.
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4. Tap Print-Delete to print and then delete the document from the document list. Tap Print-Keep to print and 
keep the document in the document list.

6.7.9 Releasing jobs from a web page

Complete the following steps to use the Secure Pull Print Web page to route jobs from the server to a printer or 
MFP:

1. Open a Web browser and in the address field, enter the following URL, where server is the name or IP 
address of the server:

http://server/mydoc

2. When prompted, enter the user name and password, with the user name in the following format:

domain\username

Then click OK and the HP Access Control (HP AC) Secure Pull Print Express Web page displays:

3. Enter the IP address of the printer or MFP in the Address field.

4. Click a job from the Jobs list and then click the Print button to direct the job to the printer or MFP. To delete 
a job from the Jobs list, click a job from the list and then click the Delete button.

5. To refresh the Jobs list, click the Refresh button.

6. Select Delete to delete the job after it is printed. If Delete job is unchecked, the job will remain in the Jobs 
list after it is printed.
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6.7.10 HP AC Enterprise — Releasing print jobs from remote print server — User 
requested

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● For users to pull print remote jobs, make sure Show local and remote jobs is selected in the HP AC 
configuration tool > Settings tile > SPP Enterprise tab.

● A user has pending jobs in the pull print queue.

Complete the following steps:

1. At the device front panel, authenticate yourself and then tap the HP AC Secure Pull Print application.
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2. If you have stored jobs in more than one pull print queue, select a pull print queue and tap Select. If there is 
only one pull print queue on the primary server, the document list displays.

3. Tap Remote jobs to view stored jobs from other servers. You can tap Local jobs to return to the pull print 
queues or document list on the primary server.

4. Select documents from the document list. Tap Print-Delete to print and then delete the document from the 
document list. Tap Print-Keep to print and keep the document in the document list.

6.7.11 Pull Printing with HP AC Enterprise with Roaming

When users print from client computers to an SPP Enterprise print queue, jobs are stored on the server. Users 
can then go to any configured printer, authenticate and pull print jobs to the printer.
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6.7.11.1 HP single-function printers

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● Cards are registered to users.

● A card reader is connected to the printer.

● For users to pull print remote jobs, make sure Show local and remote jobs checkbox is selected in the HP 
AC configuration tool > Settings tile > SPP Enterprise tab.

● A user has pending jobs in the pull print queue.

Complete the following steps:

1. Present your registered card at the card reader. IRM identifies the registered card, authenticates the user, 
and locates your stored jobs in the spool folder. All of your stored jobs are then pulled from the spool 
folder, printed, and then deleted.

2. Collect your printed documents.

NOTE: When users first authenticate at a printer, all jobs in all pull print queues on the default server are 
printed. If the user authenticates again, and no jobs are on the default server, all jobs in all pull print queues from 
remote job servers are printed.

6.7.11.2 HP single-function printers with a 4.2” display

Prerequisites

● The printer is configured for Pull Printing and Authentication.

● If you want to use proximity cards, make sure a card reader is connected to the printer.

● For users to pull print remote jobs, make sure Show local and remote jobs is selected in the HP AC 
configuration tool > Settings tile > SPP Enterprise tab.

● A user has pending jobs in the pull print queue.

Complete the following steps:
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1. Present your registered card at the card reader. When users first authenticate at a printer, all jobs in all pull 
print queues on the default server are printed. If the user authenticates again, and no jobs are on the 
default server, all jobs in all pull print queues from remote job servers are printed.

2. A list of pending jobs will be presented. Select your job(s) and tap Print.

3. Collect your printed documents.

NOTE: When users first authenticate at a printer, all jobs in all pull print queues on the default server are 
printed. If the user authenticates again and no jobs are on the default server, all jobs in all pull print queues from 
remote job servers are printed.
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7 High availability options

7.1 Network Load Balancing configuration
Network Load Balancing provides high availability for authentication, job accounting data, and releasing pull print 
jobs.

Prerequisites

● Certificates configured for virtual IP

● Network Load Balancing software configured on the HP Access Control servers

IMPORTANT: Network Load Balancing is not supported for queues and requires Microsoft Cluster Service.

NOTE: HP does not certify Network Load Balancing software, and it is the responsibility of the customer and is 
outside the support of HP Access Control.

7.1.1 Configure HP Access Control for NLB

Prerequisites

● Network Load Balancing software configured on HP Access Control servers running IRM web services, etc.

Complete the following steps:

1. Under the Settings tile, go to the IIS tab and add the virtual server FQDN in the Server Name field in the 
form.

2. Click Test and Apply.

3. Do the same on the other server(s).

NOTE: If multiple servers have the same pull print queue name, users jobs will be merged into a single job list 
screen on device front panels, and the queue names will not be displayed. This is to resolve instances where NLB 
server do not have persistence enabled and jobs can be stored on any node.

7.1.2 Citrix NetScaler

The following steps are to be used with HP AC and Citrix NetScaler:

1. Go to Citrix NetScaler > Traffic Management > Load Balancing > Services. There should be two services: one 
using HTTP protocol, and another using SSL protocol.

2. Open one of the services and go to the Advanced tab.
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3. In the Client IP Header field, enter "client-ip".

4. Open the other service and repeat step 3.

7.1.3 Configure Server Certificates

To create a self-signed certificate, see Section 4.2.4.2, Generating self-signed v3 Certificates.

7.1.4 Configure the License Service

1. Navigate to the Settings tile > IIS. Under Agent License service, enter the virtual IP address.
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2. Click Test and Apply.

3. Repeat on all HP Access Control servers.

7.1.5 Configure devices

1. Navigate to the Devices tile. Select the devices to be configured with the virtual server information.

2. Click Test and Apply.

3. Ensure you import Printer Definitions on all servers.
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7.2 Configuring HP AC Secure Enterprise for Pull Printing on a Cluster

7.2.1 Preparing the Cluster Server for HP AC Enterprise

First you will prepare the server for the HP AC installation. You will create a Virtual Server (IP Address, Network 
Name, and physical disk resource that is accessible from both servers) with the SPP Enterprise Spooler service.

NOTE: Do not stop SPP Enterprise through services.msc when working on a cluster. The services are only to be 
managed from the Failover Cluster Management tool by bringing the services online or offline. Stopping a 
clustered component triggers a failover to the other node.

Create a Server Group (Virtual Server)

1. Launch Failover Cluster Management. Expand the cluster and click Roles.

2. Under the Action pane, click Create Empty Role.
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3. Right-click the New Role and click Properties.

4. Name the Role, click Apply and OK.

218 Chapter 7   High availability options



Add Storage

The storage is the location where the HP AC pull print jobs and printer definitions are stored and must be visible 
from both nodes.

1. Right-click the newly created role and click Add Storage.

2. Select the physical disk and click OK.

Add Client Access Point

1. To assign it a virtual IP, right-click the role and choose Add a Resource > Client Access Point.
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2. Enter Network Name and IP Address. Click Next.
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3. On the Confirmation screen, click Next.

4. At the bottom of the screen, click Resources tab.
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5. Select the Server Name. Right-click and select Bring Online.

IMPORTANT: Wait until the server is Online before proceeding

Wait until the server is Online before proceeding.

7.2.2 Installing HP AC Enterprise on Node 1

The following steps explain how to install HP AC Enterprise on the first Node in the Cluster.

IMPORTANT: The node must be the owner of the role in order to install the software – in other words it needs 
to be the Active node in the cluster.

Install HP AC Enterprise

1. Run the installer as administrator.
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2. Leave the destination folder at the default and click Next.

3. Select Server installation and click Next.

4. On the Features page, scroll down to select Secure Pull Print Enterprise and click Next.

NOTE:

● Ensure you do not install any data collectors on the server in an environment where there are pull 
print servers only.

● It is not recommended to install the Job Accounting server in a clustered environment.

● If installing the HP AC Agent, ensure that the OPS server references the cluster’s virtual IP. You would 
only install the agent if not using an Active-Active (NLB) cluster for authentication and authorization.

● When using multiple IIS servers ensure that the server certificates are configured properly. Refer to 
Section 4.2.4.3, Creating certificates in a multi-server installation.
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5. When prompted for the data directory for the spool files, click Browse.

6. The spool directory must be on a folder that can be accessed by either node and resides on the physical 
Disk Resource that was previously created. Browse to the Storage disk on your local drive and click OK.

NOTE: This is a disk resource that will always be available only to the Active node
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7. Enter a name for the directory to be created and click Next.

8. When prompted, click Yes to create the folder.

9. Complete the installation and click Finish.
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10. Expand the Cluster and go to Roles. Right-click the role and select Move > Select Node....

11. Move the role to the other node.

12. Run the installer as an administrator.

13. Do the same steps to install as you did on the first node – ensuring you browse to the same location for the 
spool files. Click OK and then Next.
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7.2.3 Adding the SPP Enterprise Service to the Virtual Server

Complete the following steps to add the SPP Enterprise service as a role and configure the dependencies for the 
role: physical disk, virtual IP, and virtual network name.

IMPORTANT: Creating dependencies ensures that the resources required are monitored by the cluster service 
and if a resource fails the cluster service will first attempt to restart the service or if unsuccessful will move the 
group to another node.

1. Right-click the Role and select Add Resource > Generic Service.

2. Select HP AC SPP Enterprise and click Next. If you want to provide high availability for the HP AC SPP Mail 
Server or the HP AC SPP Purge service then you would add those as well.

HP AC SPP Mail: Used for printing mail and attachments

HP AC Purge: Deletes expired files and reports on same. Monitoring the HP AC SPP Purge server will ensure 
that if this service is down for an extended period that the disks don’t become full.

3. Click Next and Finish once complete.
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4. In the bottom pane on the Resources tab, right-click HP AC SPP Enterprise and go to Properties.

5. On the Dependencies tab click Insert. Add Cluster Disk, the server virtual name, and the IP Address.

6. Click Apply and OK.
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7. Right-click HP AC SPP Enterprise again and select Bring Online. Wait until it is online before proceeding.

NOTE: Now that the HP AC Enterprise Spooler is a clustered service (monitored), we need to use Failover 
Cluster Manager to stop and start the service.

7.2.4 Configuring HP AC Enterprise Settings

Complete the following steps to configure HP AC to reference the virtual server. This must be done on both 
servers, as each server must be configured exactly the same.

1. Launch the HP AC Configuration Utility, and go to the Settings tile.

2. Go to the Device tab and enter the device Administration password. Click Apply.

3. Go to the IIS tab. Under Pull printing web service , modify the local server name by double-clicking an IP 
address. Enter the virtual server name and IP address and hit <enter> on the keyboard. Click Test and 
Apply.

NOTE: The local server cannot be deleted, but can be edited.

4. Go to the SPP Enterprise tab. Under Server information:

a. Modify the local server name with the clusters virtual server name and hit <enter> on the keyboard.
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NOTE: If the environment had additional print servers being used for remote printing, we would add 
those servers here as well.

b. Click Test and Apply.

c. Add the node name and hit <enter> on the keyboard.

5. Select the node name you just entered and hit <Delete> on the keyboard. Click OK.

6. Click Apply.

7. Under Pull print queues, enter the Queue name and click Add.

8. The changes must be made on both nodes. Go to Failover Cluster Manager and right-click the role to move 
it to the other node.
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9. In the HP AC configuration utility, go to the Device tab and enter the Administrator password. Click Apply.

10. Go to the IIS tab and configure the Pull printing web service to point to the virtual server. Click Test and 
Apply.

11. Click the SPP Enterprise tab and modify the name by double-clicking the local server name with the 
clusters virtual server name. Hit <Enter> on the keyboard. Click Test and Apply.

12. Add the node name and click Apply. Wait for the Save Successful message to appear before proceeding.
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13. Delete the node name from the Server information section. Click OK.

14. Click Apply.

15. Go to the Devices and add devices. See Section 4.2.1, Adding devices

16. Click the device row and select Configure. Select Pull printing and click OK.

7.2.5 Install the Enterprise Pull Print Queue on the Client

1. Install the printer with all the features required in your environment (i.e. color, duplex, etc.).

2. After the printer is installed, right-click the printer and select Printer properties. Go to the Ports tab and 
click Add Port.
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3. Choose Standard TCP/IP Port and click New Port.

4. The Add port wizard will start. For Printer Name or IP Address enter the virtual IP of the cluster server. Click 
Next.

NOTE: The virtual IP or virtual server name is used so that the client will still be able to print when the role 
moves from one node to another. If the queue is pointing to a physical node, if the node is passive the 
printing will stop. This configuration is for both point-and-print queues and direct LPR queues on client PCs.
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5. When prompted for additional port information, choose Custom Settings.

234 Chapter 7   High availability options



6. On the Configure Standard TCP/IP Port Monitor screen, do the following:

For Protocol , select LPR

For Queue name, enter the name of the queue created in the HP AC configuration utility (Settings tile > SPP 
Enterprise tab > Pull Print Queues).

Click OK.

7. Complete the port creation.

8. Complete the installation.

9. Change the Properties of the printer to start printing after the last page is spooled and disable bidirectional 
support.
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NOTE:

● We are disabling bidirectional support because it is not communicating directly to a printer, but to the 
HP AC Enterprise spooler.

● We change to Start printing after last page is spooled because it is required when using HP AC IPM.

7.3 Installing HP Access Control (HP AC) Secure Pull Print Enterprise 
on a cluster for high availability and load balancing

7.3.1 Introduction

With Microsoft Cluster Service (MSCS) you can use a failover cluster to safeguard your SPP Enterprise stored jobs. 
A failover cluster is where two or more servers (nodes) are connected so one can take over for the other in the 
event of a hardware or software failure.

IMPORTANT: Make sure the server cluster is installed according to the best practices set forth by Microsoft. Also 
make sure the computers (nodes) in the cluster are identical in hardware and conform to the requirements for 
Microsoft Cluster Service.

NOTE:

● Start the nodes one at a time. Wait until the node is up and running before starting additional nodes. If you 
do not wait, the disk risks becoming corrupted.

● Make sure the NLB is installed according to the best practices set forth by Microsoft. Also make sure the 
servers (hosts) in the NLB cluster are identical in hardware and conform to the requirements for Microsoft 
NLB Service.

With Microsoft Network Load Balancing (MS NLB) you can use NLB servers (also called hosts) in a cluster 
communicate to provide key benefits on the web services such as scalability and high availability. With 
scalability, NLB scales the performance of a server-based program, such as a Web server, by distributing its 
client requests across multiple servers within the cluster. As traffic increases, additional servers can be added to 
the cluster, if needed. With high availability, NLB provide fault tolerance on the web services by automatically 
detecting the failure of a server and repartitioning client traffic among the remaining servers within ten seconds, 
while providing users with continuous service.
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7.3.2 Installing HP AC SPP Enterprise using an existing MS Cluster and a MS NLB cluster

To set up SPP Enterprise on a pre-configured cluster installation, and then use NLB to host all its web services, 
perform all the steps provided below.

7.3.2.1 In the existing MS Cluster, create a service group (virtual server)

First you need to create a service group, also known as an application (virtual server). The server group consists 
of an IP address, a network name, a physical disk, and a number of services that it starts, stops, and monitors.

Create service group

1. Go to Start > All Programs, Administrative Tools, and then click Failover Cluster Management.

2. Expand the console tree under the cluster that you want to configure.

NOTE: The cluster name cannot be the same as the computer name of either node. For example, the 
computer names of the two nodes are HPAC-N1 and HPAC-N2, and the Cluster Name is HPAC-CL.

3. Right-click Services and Applications, then click More actions and Create Empty Service or Application.

4. In the center pane right-click New service and application and click Properties.

5. On the General tab type, in the Name field, enter the service group name. Click OK.

Add storage/physical disk

1. Right-click the service group and click Add storage.

2. Check the physical disk needed and click OK.

The physical disk is now added to the service group.

Add network name and IP address

1. Right-click the service group and click Add a resource and then click 1 – Client Access Point.

2. Configure Network Name and add IP Address resource of the Virtual server.

3. Click Next. Wait for Client Access Point confirmation. This may take a few minutes.

4. Click Next.

5. Click Finish.

6. Use the Failover Cluster Management to bring the SPP Enterprise server online, and move the virtual server 
to the node where you want to install SPP Enterprise server.

NOTE: You can verify the virtual server name by opening a command prompt and ping the name. Make sure it 
responds with the right IP address.

7.3.2.2 Install SPP Enterprise on the active node

To install SPP Enterprise, complete the following steps:

1. Copy the HPAC.exe installer in the active node, double-click the HPAC.exe file to start the installer.

The installation must be Run as administrator.

2. When the installation program is launched, select the language for the installation, and then click OK.

3. Read the end-user license agreement and then click Yes to accept.
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4. On the Setup Type page, click Server installation. Click Next.

5. On the Select Features page, click Secure Pull Print Enterprise. Click Next.

6. Select the location for the data directory. The folder must be one that can be seen by either node, that is, it 
resides on the Physical Disk Resource you created. Click Next.

7. Follow the on-screen instructions, then click Finish.

7.3.2.3 Install SPP Enterprise on the second node

To install SPP Enterprise on the second node, complete the following steps:

1. Log on to the second node.

2. Open the Failover Cluster Management program. If the console tree is collapsed, expand it.

3. Right-click your service group and move the service group to the second node.

4. Install SPP Enterprise as described before on the second node. Specify the same location as you did before, 
for the data files.

7.3.2.4 Add SPP Enterprise service to the virtual server

To add the SPP Enterprise service to the virtual server, complete the following steps:

1. Open Failover Cluster Management.

2. If the console tree is collapsed, expand the tree under the cluster that you want to configure.

3. Expand Services and Applications.

4. Right-click the service group you created, select Add a resource and click 4 – Generic Service.

5. Select HP AC SPP Enterprise and click Next.

6. Click Next.

7. Click Finish.

8. In the center pane, right-click HP AC SPP Enterprise and click Properties.

9. On the Dependencies tab, Insert the Physical disk, IP Address, and Network Name.

10. Click OK.

7.3.2.5 Bring the SPP Enterprise service online

CAUTION: NEVER use services.msc to start or stop the SPP Enterprise service when working in a cluster 
installation. These services are ONLY to be managed (started/stopped) from the Failover Cluster Management 
tool by bringing the services online or offline.

1. Open Failover Cluster Management.

2. Expand Services and Applications, and then click the service group.

3. Right-click Bring this service or application online.

As the service or application moves, the status is displayed in the center pane. Because of the defined 
dependencies this brings the SPP Enterprise service online.
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7.3.2.6 Install HP AC on each server (host) of the NLB cluster

1. Copy the HPAC.exe installer in the server, double-click the HPAC.exe file to start the installer. The 
installation must be Run as administrator.

2. When the installation program is launched, select the language for the installation, and then click OK.

3. Read the end-user license agreement and then click Yes to accept.

4. On the Setup Type page, click Server installation. Click Next.

5. On the Select Features page, click HP AC Agent (NOT the one under Job Accounting) and Secure Pull Print 
Enterprise. Click Next.

6. Keep the default location for the data directory. Click Next.

7. Follow the on-screen instructions then click Finish.

Perform the steps above on every host of the NLB cluster.

7.3.2.7 Configure the Admin Console settings on each NLB host

1. In the HP AC Admin Console go to the Settings tile > SPP Enterprise tab > Server Information section.

2. In the Server URI field, double-click the local server address to edit the Server URI. Replace the local server 
address with the virtual server created in the MS Cluster before (Example: HPAC-CL.domain.com:631). Click 
Apply.

Perform the steps above on every host of the NLB cluster.

7.3.2.8 Configure the Admin Console settings on each node of the cluster

1. In the HP AC Admin Console in the active node, go to the Settings tile > IIS tab > Server Name section.

2. In the Server Name field, double-click the local server address to edit the Server Name. Replace the local 
server name and IP with the virtual server name and IP created in the MS NLB. Click Apply.

3. In the Agent license service section, use the IP address of the MS NLB virtual server. Click Apply.

4. In the HP AC Admin Console in the active node, go to the Settings tile > Device tab > Device section.

5. In the Administrator password field, enter the password used to enter the EWS of devices. Click Apply

Perform the steps above on every node of the MS Cluster.

CAUTION: The PullPrinthost in the \Bin folder should reflect the long and short name of every node in the MS 
Cluster and the MS NLB, this for every node in the MS Cluster configuration and the MS NLB configuration.

Testing the configuration:

● Add the SPP Enterprise printer on client computers and make sure printed jobs are stored in the spool 
folder on the shared drive.

● Make sure the user can release the job on a configured device.

● Stop one of the hosts in the NLB and make sure the user can still authenticate and release his jobs.

● Start the host and stop the other one, making sure the user can still authenticate and release his jobs.

● Move the group that contains the SPP Enterprise Service to the other node in the cluster and repeat the 
testing.
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8 Configuring clients

8.1 HP AC Express

8.1.1 HP Access Control Express print client

See Section 6.1.2, Configuring a Pull Print printer with HP AC Express

The HP Access Control Express Print Client installs print server-less pull printing and enables encryption. The 
SPPE Print Client applies to all currently installed TCP/IP and LPD printers on the client computer.

8.1.1.1 Print server-less printing with HP AC Express

The print server-less pull printing feature eliminates the print server from your printing environment and 
reduces the number of overall servers. The SPPE Print Client application is installed on a client workstation, 
allowing the user's pull print jobs to be routed and stored in a shared network folder on the SPPE server.

Storing the user's jobs on a network folder allows for pull printing even if the client workstation is offline. This is 
different from client based pull printing with local job storage that is available with HP AC Enterprise only. Client 
based pull printing stores the job locally on the client PC. HP AC Express stores the job in a network folder.

Complete the following steps:

1. Copy the HP AC Express Print client file from the server (located in the Program Files\HP\HP Access Control
\client setup folder) to the client workstation.

2. From the client workstation, right-click the installation file and select Run as administrator. Click Next.

3. Verify the selected installation folder and usage rights. Click Next.

4. Enter the SPPE server name or IP address and the encryption key, if using.
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5. Click Next.

6. Confirm installation and click Next.

7. When installation is complete, click Close.

8. Add a physical printer to the client workstation if one is not installed. It is recommended to add a printer 
that has the most features that will be used for printing, such as color, duplex, etc.

9. Go to the Properties window of the physical printer and change the port to the HPACSPPE port. The 
HPACSPPE port allows all print jobs to be stored on the designated server.

8.1.1.2 Encryption

Prerequisites

● Encryption at rest enabled on the HP Access Control server (Settings tile>SPPE/SPP Enterprise>Pull 
printing

● TCPIP/IPPS selected as the printing protocol on the HP Access Control server

● Devices support and have IPPS enabled
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Installing the HP AC Express Print Client will enable end-to-end encryption form the user workstation to the 
printer using AES 256 encryption.

Complete the following steps:

1. Copy the HP AC Express Print client file from the server (located in the C:\Program Files\HP\HP Access 
Control\client setup folder) to the client workstation.

2. From the client workstation, right-click the installation file and select Run as administrator. Click Next

3. Verify the selected installation folder and usage rights. Click Next.

4. Enter the SPPE server name or IP address and the encryption key if using.

5. Click Next.

6. Confirm installation and click Next. When installation is complete, select Close.
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8.1.2 Adding a pull print queue on the client PC

1. Add a direct IP print queue:

a. Open Print Manager: select Start and type Print Management in the Search program and files box.

b. Expand Print Servers, right-click on the local server and click Add Printer.

c. Select Add a TCP/IP or Web Service Printer by IP address or hostname then select Next.

d. Select TCP/IP Device from the drop down.

e. Type the IP address of a LaserJet device.

f. Create a name for the port to reflect an HP AC Pull Print port.

g. Uncheck Auto detect the printer driver to use.

h. Click Next.

i. Select one of the driver options and click Next.

j. Locate your Universal Print Driver and complete the installation.

k. Be sure to share this printer with a name that reflects an HP AC Pull Print Queue.

2. Create an Express port. Once the installation of the direct IP queue is complete, you will create a new 
Enterprise port that points to the HP AC print queue.

a. In Print Management, right-click Ports and select Add Port.

b. Select HP AC Secure Pull Print Express Port and click New Port.

c. Select Next on the wizard prompt.

d. Under Port Name, assign a name that will reflect a pull print port then select OK.

e. Close the printer ports window.

3. Assign the Express port to the Pull Print queue. Now that the port is created, it needs to be assigned to the 
print queue.

a. Right-click on the original TCP/IP printer that was created in the first section of this document and 
select the Ports tab.

b. Place a check mark next to the Enterprise port you created in section 2 then click OK.

c. Select the General tab and print a test page.

d. Verify the test page has printed by navigating to the HP AC SPP Express tile in the HP AC admin 
console.

e. Once again, verify that this print queue is shared.

8.2 HP AC Enterprise
NOTE: If encryption, rules based printing or delegate group printing is required then LPR must be used.

Add printers on client computers using the Internet Print Protocol (IPP) or Line Printer Remote (LPR) protocol to 
connect to pull print queues on the server.

8.2.1 Adding a printer when using Client-based pull printing with local job storage

Prerequisites
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● HP AC Enterprise Print Client installed and configured for local job storage.

When Local Job Storage is installed on the client workstation, a port with the name of the Enterprise pull print 
queue that was created in the HP AC configuration utility > Settings > SPP Enterprise > Pull Print Queue section is 
automatically installed. After the Enterprise Client with Local Job Storage is installed on a user workstation, 
complete the following steps to add a physical printer and then assign the installed pull print queue port to the 
physical printer.

1. Add a direct IP print queue

a. Open Print Manager: select Start and type Print Management in the Search program and files box.

b. Expand Print Servers, right-click the local server and click Add Printer.
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c. Select Add a TCP/IP or Web Service Printer by IP address or hostname then select Next.

d. Select TCP/IP Device from the drop down.

e. Type the IP address of a LaserJet device.

f. Create a name for the port to reflect an HP AC Pull Print port.

g. Uncheck Auto detect the printer driver to use.

h. Click Next

i. Select one of the driver options and click Next.
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j. Locate your Universal Print Driver and complete the installation.

k. Be sure to share this printer with a name that reflects an HP AC Pull Print Queue.

2. Assign the Enterprise port to the Pull Print queue. Now that the port is created, it needs to be assigned to 
the print queue.

a. In the TCP/IP printer properties window, select the Ports tab.

b. Place a check mark next to the Enterprise port named after the pull print queue then click OK.

c. Select the General tab and print a test page.

d. Verify the test page has printed by navigating to the Program Files\HP\HP Access Control Print Client
\bin\pullsvc\spool folder on the client workstation. The spool folder is a hidden folder, so make sure 
to change the folder settings to view hidden folders. Also make sure the jobs display in the HPAC SPP 
Enterprise tile in the HPAC admin console on the server.

NOTE: If Local Job Storage is installed along with Quota or IPM, after assigning the Enterprise port to the pull 
print queue, the port will automatically change to have "HPACJA:" at the beginning of the port name. This shows 
that the pull print queue is also configured to use quota or IPM.

8.2.2 Adding a printer to use Internet Printing Protocol (IPP)

Prerequisites
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NOTE: If you will be using double-byte characters in document names, it is recommended to print using the IPP 
protocol.

● On the client desktop, make sure the Windows Component Internet Printing Client is enabled.

● For use with the enterprise spooler

● Ensure a queue has been previously created on the HP Access Control server under the Settings Tile > SPP 
Enterprise tab.

● To add a printer, you must have local administrator rights.

Complete the following steps:

1. Go to Devices and Printers and click Add a printer.

2. Click Add a network, wireless or Bluetooth printer.

3. Select The printer that I want isn’t listed.
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4. In the Select a shared printer by name field, enter http://ServerName:631/QueueName, where ServerName 
is the name or IP address of the HP Access Control server, 631 is the port used to access the HP Access 
Control server, and QueueName is the name of the pull print queue added through the HP AC configuration 
utility. By default, the port used is 631 but this can be changed. Click Next.

5. Select a printer driver with all features, such as color, duplex, etc., necessary for the printing environment. 
Click Next.

6. After you’ve successfully added the printer, click Next. Then click Finish.

8.2.3 Adding a printer to use Line Printer Remote (LPR) protocol

Prerequisites

● To add a printer, you must have local administrator rights.

● On the HP Access Control server, make sure the Windows Component Print Server for UNIX, which uses the 
LPR protocol, is disabled. The HP AC SPP Enterprise service must be the only service to use the LPR 
protocol. If you still want to use port 515 for regular Windows printing, port 515 can be changed in the SPP 
Enterprise settings.

● Ensure a queue has been previously created on the HP Access Control server under the Settings Tile > SPP 
Enterprise tab.

Complete the following steps:

1. Go to Control Panel > Administrative Tools and open Print Management.
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2. In Print Management, go to Print Servers > local machine.

3. Right-click Drivers and choose Add Driver. The Add printer driver wizard starts.
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4. Click Have Disk and browse to the driver.

5. Go to the Ports node and right-click Ports and then click Add Port.

6. Select Standard TCP/IP Port, then click New Port. Click Next to continue with the Add Port wizard.
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7. Enter Printer Name or IP Address. Enter a name for the Port. Click Next.

8. In the Additional port information required screen, select Custom, then click Settings
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9. Under Raw Settings, select LPR. For Queue Name , enter the name of the pull print queue that was added 
through the HP AC configuration utility on the server. Click OK. Then click Next.

10. Click Finish.

11. Go to the Printers node and select Add a printer.
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12. Choose Add a new printer using an existing port and select the port previously created.

13. Choose Use an existing printer driver on the computer and click Next.

14. After you’ve successfully added the printer, click Finish.
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8.2.4 Add a traditional shared printer on the HP AC server

The purpose of this section is to outline the steps to utilize the HP AC Enterprise spooler in a point and print 
environment. This hybrid configuration is an option for customers who wish to utilize a standard Windows point 
and print queue vs. the Enterprise Print Queue. Implementing this method will restrict the number of supported 
devices to the number of devices supported by the Windows print server.

NOTE: If encryption at rest is required use of the SPP Enterprise Port is required. Please review Section 8.2.5, 
Installing a shared printer with the HP Enterprise Port

1. Add a direct IP print queue.

a. Open Print Manager: select Start and type Print Management in the Search program and files box.

b. Expand Print Servers, right-click on the local server and click Add Printer.

254 Chapter 8   Configuring clients



c. Select Add a TCP/IP or Web Service Printer by IP address or hostname then select Next.

d. Select TCP/IP Device from the drop down.

e. Type the IP address of a LaserJet device.

f. Create a name for the port to reflect an HP AC Pull Print port.

g. Uncheck Auto detect the printer driver to use.

h. Click Next.

i. Select one of the driver options and click Next.
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j. Locate your Universal Print Driver and complete the installation.

k. Be sure to share this printer with a name that reflects an HP AC Pull Print Queue.

2. Once the installation of the direct IP queue is complete, you will create a new LPR port that points to the 
HPAC print queue.

a. In Print Management, right-click on Ports and select Add Port.

b. Select a Standard TCP/IP Port and click New Port.

c. Select Next on the wizard prompt.
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d. Under Printer Name or IP address: type the IP address of the HP AC server.

e. Under Port Name, assign a name that will reflect a pull print port then select Next.

f. Select Custom-Settings on the Additional port information required window.
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g. On the Port Settings tab change the Raw Settings port number to 515.

h. Under Protocol, change to LPR.

i. Under LPR settings, add the HP AC Enterprise queue name that is created in the HP AC Enterprise tile. 
Select OK to complete.

j. Select Next on the Additional port information required window.

k. Select Finish and close the printer ports window.

3. Assign the LPR port to the Pull Print queue. Now that the port is created, it needs to be assigned to the 
print queue.

a. Right-click on the original TCP/IP printer that was created in the first section of this document and 
select the Ports tab.
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b. Place a check mark next to the LPR port you created in section 2 and then click OK.

c. Select the General tab and print a test page.

d. Verify the test page has printed by navigating to the HP AC SPP Enterprise tile in the HP AC admin 
console.

e. Once again, verify that this print queue is shared.

Now the queue is ready for clients to connect to. It will be up to administrators to decide on a particular option for 
client deployment.

8.2.5 Installing a shared printer with the HP Enterprise Port

1. Add a direct IP print queue on the HP AC server.

a. Open Print Manager: select Start and type Print Management in the Search program and files box.
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b. Expand Print Servers, right-click on the local server and click Add Printer.

c. Select Add a TCP/IP or Web Service Printer by IP address or hostname then select Next.
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d. Select TCP/IP Device from the drop down.

e. Type the IP address of a LaserJet device.

f. Create a name for the port to reflect an HP AC Pull Print port.

g. Uncheck Auto detect the printer driver to use.

h. Click Next.

i. Select one of the driver options and click Next.

j. Locate your Universal Print Driver and complete the installation.

k. Be sure to share this printer with a name that reflects an HP AC Pull Print Queue.

2. Create an Enterprise port. Once the installation of the direct IP queue is complete, you will create a new 
Enterprise port that points to the HP AC print queue.

a. In Print Management, right-click on Ports and select Add Port.
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b. Select HP AC Secure Pull Print Enterprise Port and click New Port.

c. Select Next on the wizard prompt.

d. Under Port Name, assign a name that will reflect a pull print port then select OK.

e. Close the printer ports window.

3. Assign the Enterprise port to the Pull Print queue. Now that the port is created, it needs to be assigned to 
the print queue.

a. In the Printer Properties window, select the Ports tab.
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b. Place a check mark next to the LPR port you created in section 2 then Click OK.

c. Select the General tab and print a test page.

d. Verify the test page has printed by navigating to the HP AC SPP Enterprise tile in the HP AC admin 
console.

e. Once again, verify that this print queue is shared.

Now the queue is ready for clients to connect to. It will be up to administrators to decide on a particular option for 
client deployment.

8.2.6 HP Access Control Enterprise Print Client

Prerequisites

New client to install the following features on end-user client PCs:

● Quota

● Intelligent Print Management (IPM) for rules-based printing

● Delegation

● Encryption

● Local job storage for client-based pull printing
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The Enterprise Print Client can be installed on client computers to automatically configure installed printers to 
use IPM rules, quota, delegate printing, local job storage, and encryption with an Enterprise server. The server 
requires IPM, Job Accounting, and/or Pull Printing to be installed. The Print Client applies to all currently installed 
TCP/IP and LPD printers on the client computer. With Local Job Storage, jobs are stored locally (in the Program 
Files\HP\HP Access Control Print Client\bin\pullsvc\spool folder) on client workstations and metadata regarding 
the job is sent to the server.

NOTE: If Encryption at rest is enabled on the server, the encryption key will be automatically copied to the 
client registry upon installation of the Enterprise Print Client.

IMPORTANT:

● If Local Job Storage will be installed, it is required that an SSL certificate is selected in HTTPS bindings. Go 
to the HP AC server > IIS Manager > Default Web Site > Bindings > HTTPS.

● If Encryption at Rest is enabled on the server, Client Passcode and Client Encryption Key are entered on the 
server, and Local Job Storage is installed on the client, the Client Passcode and Client Encryption Key will be 
used to secure job data, and the Encryption at Rest key will not be used.

● The install will convert all existing Standard TCP/IP ports to be compatible for IPM. Only install the client 
after the ports required to be monitored have been created on the PC clients.

● Ensure that Skip rules if network failure is enabled if you want to allow printing in the event that the 
network fails between the client PC and the server the HP Access Control IPM web service is running 
(Settings tile > IPM tab > IPM Web Service).

Prerequisites for IPM

● Intelligent Print Management must be installed on a HP Access Control Server.

● The client will convert Standard TCP/IP ports (LPR). IPP is not supported.

Prerequisites for Quota

● HP Access Control server configured for quota.

● The client will convert Standard TCP/IP ports (LPR). IPP is not supported.

● For quotas to be tracked, devices must be enabled for Tracking.

● Quota for print is enabled on the HP AC Job Accounting Server

● Device is configured for authentication to use quota limits for glass activities (copy and scan)

● Print driver installed as a traditional printer object. If using the HP Universal Print Driver, Dynamic mode is 
not supported as the print client cannot configure the print port for quota and will not know where jobs as 
sent as users choose the output device "on the fly"
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NOTE:

● Ensure that messages are configured in the Settings tile>Agent tab. The message field will display the 
message on the front panel of the device when a user reaches their quota limit. The error message field 
will display on the front panel of the device when there is a communication error with the IRM quota 
webservice.

● The port will change to an HP_ACJA port in the queue.

● Ensure Skip Quota Control if network failure is enabled (Settings Tile>Print Server>Print Server Quota Web 
Service), otherwise users will not be able to print if communication between the device and the HP Access 
Control server is unavailable.

● Quota is checked at the beginning of a print job and not at every page and only updates after the printer 
has sent the job accounting information for the job to the HP Access Control Job Accounting server for 
processing. This means that users may at some point reach a negative quota status, for example when the 
amount of pages in a print job is bigger than the amount of pages in the remaining quota.

● When a user’s quota is exceeded it will require manual intervention to reset if it happens before the quota 
period is reached.

IMPORTANT: If you want to use delegate printing, SQL Server must be used for the IRM database. SQL Compact 
Edition is not supported with delegate printing. To create an IRM database in SQL Server, see Section 5.5, 
Database storage. Also, in order to add delegate users, the users must be in the IRM database.

1. Copy the Print Client setup file from the server (located in Program Files\HP\HP Access Control\client setup
\Enterprise) to the client computer, then run the Print Client setup file.

2. Follow the instructions in the setup wizard. Enter the name(s) of the server(s) in the appropriate field. To 
use quota, enter the Job Accounting server name. To use IPM rules, enter the IPM server name. To use 
delegate printing, enter the Pull Print server name. Click Next.

NOTE:

● JA Server name: used for QuotaIPM Server name: used for IPM (rules) Pull Print Server name: used for 
delegate printing.

● In the server name fields, it is recommended to use the Fully Qualified Domain Name (FQDN) of the 
servers. This is recommended to avoid any issues with DNS resolution or if there are identical server 
names on different domains. If the FQDN is not used and there are communication issues between 
the client and server, the Enterprise client will need to be reinstalled using the FQDN.
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3. On the Configuration screen, select which components you want to configure on installed printers. Click 
Next.

4. After the installation is complete, click Close.
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NOTE:

● Delegate applies to all currently installed LPR printers on the client workstation. Before installing delegate 
on client workstations, make sure LPR pull print queues are installed.

● If you want to add or remove features in the Print Client later, the Print Client must be reinstalled.

● If the encryption key on the server is changed, the Print Client must be reinstalled and the new encryption 
key must be entered.

● The Print Client will automatically install Microsoft .NET Framework 4.0 on the client workstation.

● If Delegate is selected and installed on client workstations, users must log off and then log back on in order 
for the Delegate popup to work.

TIP: The error message that displays on the delegate web page when a user is not registered in the database 
can be edited. On the pull printing server, go to the Program Files\HP\HP Access Control\DelegateWS folder and 
open the web.config file to edit. On the key=“UserError” line, change the value to your preferred message.

8.2.6.1 Delegate printing / Group printing

With delegate printing, users can print to a specified printer and have all print jobs be released by a different user. 
You add delegates through the delegate web page, and select who you want to delegate documents to at the 
time of printing.

8.2.6.1.1 Configuring the Client for Delegate and Group printing

Prerequisites

● HP AC Print client installed on the client workstation. See Section 8.2.6, HP Access Control Enterprise Print 
Client.

● The user must have been previously enrolled before they can be designated as a delegate.

● IRM must be set to use Database as the data storage.

Complete the following steps:

1. After the HP AC Print Client is installed on your workstation, the Secure Pull Print icon displays in the task 
bar. Right-click the icon and select Configure delegate printing to go the Delegate web page.

Before you can add a user for delegate printing, a group must be created. Groups allow for distribution to 
every member of the group, or sharing a copy amongst members of the group - which means the first user 
who deletes the document makes it no longer available to other members of the group.

2. Follow the steps below to create a group and assign users. In the Group field, type a name for the group. In 
the Description field, enter a description to identify the group.
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a. Select the Distribution checkbox if you want every member of your group to receive their own copy of 
your delegated documents.

b. If Distribution is not selected, all members of the group will share your delegated documents. For 
example, if it’s not selected and you delegate a document to the group, as soon as one user deletes 
the document, the document is no longer available to the rest of the members. Click Add.

3. After a group is created, the Users section displays. In the User / Email field, enter the name or email 
address of the user you want to add to the group. Click Test to verify the user exists in the database. Click 
Add to add the user to the selected group.
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4. Right-click the Secure Pull Print icon (in the taskbar), and click Update Local cache.

NOTE: Group information can be changed at any time. Click the Edit icon next to the group to edit the 
group name, description, and/or distribution setting. Right-click the Secure Pull Print icon in the taskbar, 
then click Update local cache.

8.2.6.1.2 Deleting a delegate user or group

To delete a user or group, complete the following steps:

1. Select the user or group you want to delete and select the delete icon.

2. Right-click the Secure Pull Print icon in the task bar and click Update local cache.

8.2.6.1.3 Managing the Display of the delegate web page

1. Click Settings to manage the display settings on the delegate web page. The Rows per page (Groups) field 
determines the number of group names you want to display per page. The Rows per page (Users) field 
determines the number of user names you want to display per page.
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2. Click Update.

8.2.6.1.4 Delegating documents

Once you have assigned users, it is easy to delegate documents:

1. Click Print to print your document.

2. Select a printer recommended by your administrator.

3. Click OK.

4. In the delegate printing dialog prompt, select a user or group to delegate to and then click Print.

5. The user or group you selected can now collect your document at the printer.

NOTE: When the Cancel button is selected, the job will be cancelled and will not print.

NOTE: If a user does not have a delegate group, the popup will not display.
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TIP:

● Enable the Remember selection option if you want the dialog to appear with the last selected user or group 
the next time you print.

● When pull printing with SPP Enterprise, if a user has a mix of pull print jobs and shared delegated jobs, not 
all jobs will release at once if Print All is selected at the device. The user will have to select Print All to print 
all pull print jobs and then select Print All again to print all shared delegated jobs.

8.2.7 Silent installation

To install HP AC Print Client in silent mode, use the Enterprise Pull Print Custom Setup application located in the 
Program Files\HP\HP Access Control\client setup folder.

Complete the following steps:

1. Open the Enterprise Print Client Custom Setup application.

2. Click Load MSI button to locate the HP AC Print Client.msi file. Click Open.

3. To use quota, enter the Job Accounting server name and select the Quota box. To use IPM rules, enter the 
IPM server name and select the IPM box. To use delegate printing, enter the Pull Print server name and 
select the Delegate box. To store jobs locally on the client workstation, select the Local job storage box.

4. Click Apply. The HP AC Print Client.msi file can now be deployed to client computers with the fields pre-
filled with server information.

5. To test the notification on the HP AC server > Settings tile > IPM tab under desktop notification client enter 
the title for the test rule and enter the FQDN or IP address of the client you want to send a notification too. 
Click Apply and Test.

8.2.8 Quota Notification

Notification for end users on their quota status is either through the Quota Client or the MyQuota website. The 
quota client will display a printer icon on the system tray on the client PC to show the quota limit for the currently 
logged in user. The MyQuota website will show remaining quota for the user.

8.2.9 Quota Notification with Quota Client

Prerequisites
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● HP Access Control server configured for quota, see Section 4.2.9.4, Quota management

● HP Access Control Print client installed and configured for Quota

Complete the following steps:

1. Install the HP AC JA Quota Client located in \Program Files\HP\HP Access Control\Client Setup with 
administrator privileges.
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2. Select the installation folder and if the client is for use for everyone, or just the currently logged in user. 
Click Next.

3. Enter the server name or IP address where the HP Access Control Job Accounting Quota web service is 
installed. Click Next.
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4. Click Close.

5. When a user exceeds quota for print the system tray icon will change to show that there are no remaining 
pages, and the user will not be able to print.

8.2.10 MyQuota

Prerequisites

● HP Access Control server configured for quota

● HP Access Control Print client installed and configured for Quota

Users can check their remaining quota limits by accessing the server where the HP Access Control Job 
Accounting quota web service is running – http://<servername>/myquota

8.3 Macintosh Clients

8.3.1 Adding a printer using LPR protocol

Prerequisites

● Make sure a pull print queue is created in the HPAC admin console > Settings > SPP Enterprise tab.

Local queues for pull printing is supported with HP AC SPP Enterprise only. Complete the following steps:

1. On the Mac computer, choose System Preferences from the Apple menu.
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2. Choose Print & Fax from the View menu.
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3. Click the + button to add a printer.
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4. Click the IP tab at the top.
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5. In the Protocol field, select Line Printer Daemon – LPD from the drop-down menu. In the Address field, type 
the name or IP address of the HP AC server. In the Queue field, type the name of the pull print queue.

6. Click Add. A window of installable options for the printer may display. Check these as appropriate for the 
printer.

8.3.2 Adding a shared pull print queue

Prerequisites

● Mac OS 10.6.5 or newer.

● From the HP AC server, make sure the printer is configured for Add tracking PJL attributes in the HP AC tile 
(required to be enabled for the HP Enterprise bundle only. Not required with HP AC Express.).

● On the HP AC server, go to the Printer Properties window > Advanced tab and make sure Start printing 
after last page is spooled is selected.

● Use a printer driver that most closely matches the printer’s capabilities. It is recommended to conduct tests 
before deployment to make sure job information is tracked correctly.

Complete the following steps:

1. On the HP AC server, do one of the following, depending on the pull print method:
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● Secure Pull Print Express: Add a printer on the server according to Section 6.1.2, Configuring a Pull 
Print printer with HP AC Express. Make sure the printer is shared.

● Secure Pull Print Enterprise: Add a printer on the server according to Section 6.4.4, Adding pull print 
queues on the server. Make sure the printer is shared.

2. On the Mac computer, choose System Preferences from the Apple menu.

3. Choose Print & Fax from the View menu.
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4. Click the + button to add a printer.

5. Press the Control key while clicking the "Default" icon (or any other icon on the toolbar), then choose 
Customize Toolbar from the contextual menu that appears.
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6. Drag the Advanced (gear) icon to the toolbar.

7. Click Done.

8. Click the Advanced icon that was added to the toolbar.

9. Choose Windows from the Type pop-up menu.
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10. In the URL field, type the printer's address in one of the following formats:

smb://server/sharename

NOTE: "server" is the name of the server sharing the printer (or its IP address). "sharename" is the shared 
printer's share name. If the share name contains spaces, replace each space with "%20" (without quotation 
marks).

11. In the Name field, type the name you would like to use for this printer in Mac OS X.

12. Choose the appropriate PPD or printer driver from the "Print Using" pop-up menu.

13. Click Add.

8.3.3 Mac encryption

Prerequisites:

● 1 HPAC server with IIS

● 1 HPAC pull printing only server with HTTPS disabled in IIS. This is because printing from a Mac computer 
requires the use of port 443. Therefore, IIS cannot also use port 443.

● The Mac machine has the certificate installed into the system Keychain.

Mac computers will print to the HPAC pull print only server and then will be redirected to another HP AC server 
(running IIS) to be stored in a pull print queue on that server.

1. On the pull print only server, open IIS manager and for the default web site, disable HTTPS.
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2. On the pull print only server, in HPAC > Settings > SPP Enterprise, add a new print queue to receive IPPS 
jobs from Mac computers.

3. On the pull print only server, copy the Encrypt.exe file to the Program Files\HP\HP Access Control\bin 
folder.

4. On the pull print only server, go to the \Program Files\HP\HP Access Control\spoolroot \prtr folder and 
open the pull print previously created queue in Notepad (e.g. PullPrintIPPS). Replace the contents of the file 
with the following text, where TCPHOST is the name of the main HPAC server, TCPPRTR is the name of the 
pull print queue on the HPAC server, and FILTER1 is the path of the filter.

COMMTYPE = TCPIP/LRSQ

TCPHOST = server.domain.com

TCPPRTR = PullPrintQueue

TCPRPORT = 5500

VPSX2VPSX = YES

ENCRYPT = YES

PRTROPTS = 80

FILTER1 = C:\Program Files\HP\HP Access Control\bin\Encrypt.exe

F1DTYPE = all

F1ARGS = “&infile” “&outfile”

5. On the Mac computer, add an IPPS printer to connect to the HPAC pull print only server via port 443 and 
enter the previously created queue name (e.g. PullPrintIPPS).

6. When the user prints from the Mac computer, the job will be sent to the PULLPRINTIPPS queue (as shown 
in this example), and the filter in the printer definition file will route the job to the HPAC server and be 
stored in the pull print queue, where users can retrieve the job and release at a printer.

8.4 HP Access Control Card Enrollment application
Prerequisites

● See Section 2.8, Card Masking utility requirements

Install the Card Enrollment application to allow users to enroll their cards from a client PC.

Complete the following steps:

1. Copy the Card Enrollment installation file from \Program Files\HP\HP Access Control\client setup to the 
client PC.

2. Run the Card Enrollment.msi file from the client PC.
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3. On the welcome screen, click Next.

4. On the Card Enrollment setup screen, enter the FQDN or IP address of the server that has IRM installed and 
click next.

NOTE: Connecting to an IRM server is required to save user card data.
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5. On the Select Installation Folder screen, verify the information is correct and select Everyone to allow all 
users to access the card enrollment application. Click Next.

6. When complete, click Close.

8.5 Job Accounting clients
Table 8-1  Job Accounting Client Notifications

 Client Notifications  

 IPM JA Quota Client 
(systray)

Overview

HP AC Print Client (local IPM/
Quota)

✓ ✓ The HP AC Print Client can be installed on client 
computers to automatically configure installed printers 
to use IPM rules, quota, delegate printing, and/or 
encryption (see Note 4) with an Enterprise server. The HP 
Access Control server requires IPM, Job Accounting, 
and/or Pull Printing to be installed. The HP AC Print Client 
applies to all currently installed enterprise queues using 
TCP/IP using LPR protocol printers on the client 
computer.

HP AC JA Allocation Client ✓ ✓ The HP AC JA Allocation Client can be installed on client 
computers to allow input and collection of allocation 
(metadata) for HP AC Job Accounting. The HP Access 
Control server requires HP AC Job Accounting to be 
installed.

HP AC JA Print Client See Note 3, below See Note 3, below To track local printers connected to client desktops via 
USB, LPT1 or Standard TCP/IP port, install the Job 
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Table 8-1  Job Accounting Client Notifications (continued)

Accounting Print Client. The Job Accounting Print Client is 
installed on client desktops where local print activity is 
tracked and then sent to the Job Accounting Database 
Server.

SPPE Print Client See Note 3, below See Note 3, below The SPPE Print Client can be installed on client 
computers to use encryption (see Note 4) and to allow 
the user's pull print jobs to be routed and stored in a 
shared network folder on the Secure Pull Print Express 
server. The HP Access Control server must have Secure 
Pull Print Express installed.

NOTES:

1 To use client applications, client desktops must have one of the following operating systems: Microsoft 
Windows Vista (32-bit or 64-bit), Microsoft Windows 7 (32-bit or 64-bit), or Microsoft Windows 8 (32- or 
64-bit).

2 Print Stream Clients are NOT designed to be installed or used together on a single workstation.

3 Not applicable unless you have server-based and client-based tracking and server-based IPM/Quota + 
client-based pull printing on different queues, then ✓

4 Delegate printing and/or encryption is available in HP AC 14.2 and above.

8.5.1 Cost Allocation

Prerequisites

● All allocation printers need to be shared on the Print Server.

● All allocation printers need to use Port Monitor on the Print Server.

NOTE:

● Use a Domain User with Local Administrator Rights to install and configure the printer and software. For 
Windows Vista and Windows 7 users, make sure that you run the installer using the Option Run as 
administrator.

● The Job Accounting Allocation Client cannot be used on the same PC that has the HP AC Print Client 
installed.

8.5.1.1 Installation of the Allocation Client

1. Run the HP AC JA Allocation Client file. The InstallShield Wizard will guide you through the installation 
process.

2. Read through the License Agreement and click Yes to confirm, and No to abort the installation.
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3. Select the installation directory or click Next to keep the default. Click Next to keep the default programs 
folder.

4. When prompted, provide the Web address of the HP Access Control Job Accounting Web Server. This is 
typically http://servername/hp acja, where 'servername' is the name of the physical server 
where Job Accounting is installed.

5. Click Finish to complete the installation process.

NOTE: After installation is complete, log off and log back on. When the user logs on, the alloc.exe file, required 
for the allocation pop-up, is started.
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8.5.1.2 Installation and Configuration of the Allocation Printer

1. Open the Printers and Faxes folder and run the Add Printer wizard.

2. Select Local printer and click Next (Uncheck Automatically detect...).

3. Select Create a new port, choose Local Port, and click Next.

NOTE: Do Not Use the Allocation Port. This is a Port extension that the Local Port will be using.

4. For the port name, enter \\printserver\printername where “printserver” is the name of the server running 
the JA Print Server and “printername” is the share name of the allocation printer shared on the print server. 
Click OK to confirm.

5. Select the appropriate driver for the printer and continue to finish the remaining steps in the Add Printer 
wizard.

NOTE: Repeat these steps for each allocation printer to be used on the workstation.
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6. Go to Start > All Programs > HP AC JA Allocation Client, and select Allocation Queue Configuration. Highlight 
the allocation printer in the Windows Printers Pane and click Configure Printer. 

7. The allocation printer configured will move to the Allocation Printers Pane.

NOTE: Repeat these steps for each allocation printer to be used on the workstation.
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8. Open the Properties of the Allocation Printer that you have added in the steps above, and click Print Test 
Page.

9. The Allocation popup window appears displaying an allocation profile created on the Job Accounting Server. 
Click OK to continue with the test.

8.5.1.3 Viewing jobs in the Allocation Job Browser

1. Go to Start > All Programs > Allocation Client > Allocation Job Browser. Enter your Windows Domain, User 
name, and Password, then click the arrow button.
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2. Leave all the parameters as default in the New Query screen and click the arrow button at the bottom.

You will see the test page you printed in the Result Display screen.

NOTE: The job information will be inserted in the database at the next scheduled job retrieval. You will not see 
this result if you run this query before the job has been processed.

8.5.1.4 Configuring a Shared Pull Print Printer for Allocation

When configuring a shared pull print printer from the Server with Allocation Client, please follow the steps below 
to ensure that the correct document name will be displayed on the pull print window:

1. Share the pull print printer from the server.

2. Install a new printer and point it to a physical printer that will be commonly used by the user, using 
Standard TCP/IP as the port type. If possible download and use the same driver as the shared pull print 
printer from the server.

3. Open the Allocation Client Queue Configuration and select the newly created printer from Step 2.
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4. Enter the name of your pull print server into the Print Server Name field. Enter the share name of the pull 
print printer into the Printer Share Name field.

5. Click Configure.

8.5.2 Job Accounting Print Client

The Job Accounting Print Client tracks printers connected to client desktops via USB, LPT1 or Standard TCP/IP 
ports. The print activity from the client is tracked and then sent to the Job Accounting Database Server.

Prerequisites

● HP Access Control Job Accounting Server

NOTE: The Job Accounting Print client is not compatible with any other print clients.

Complete the following steps:

1. Run the HP Access Control Job Accounting Print client with administrative rights.
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2. Select the folder to install the client.
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3. Select the Program Folder to add the program icons to.

4. On the Setup Type screen, select one of the following configuration modes:

● Automatic using print processor for USB printers

● Automatic using port monitor for local connected or Standard TCP/IP ports

● Manual Configuration to manually configure printers with the Printer Configuration Tool
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5. For Novell environment, select to Track the Novell user name.

6. Choose the connection method to push the job accounting information to the HP Access Control server 
running the Job Accounting Server.
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7. Enter the IP address where the accounting data will be auto-uploaded to.

8. Click Finish to complete the installation.
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9. If during the installation you chose Manual configuration, go to Start >All Programs > HP Access Control Job 
Accounting and choose Printer Configuration. Select the printer, and click Configure printer.
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9 Manage users and jobs

9.1 Managing access to the Admin console
The Login tab allows you to control access to the HP AC admin console. With this feature enabled, user 
credentials will be required at the time of starting the HP AC admin console

Users belong to groups, and the groups define the permissions that determine what features are available to 
that group.

NOTE:

● The Power User can view the same settings as the Admin user, but does not have the same permissions to 
make changes.

● By default, the Settings section does not appear under the Admin account to prevent being locked out of 
the console completely.

Permission Admin Power User User

SPP Express/Enterprise

Delete User

Delete Job

View Job

✓

✓

✓

✓

✓

✓

✓

✓

 

Intelligent Print Management (IPM) ✓ ✓  

Device Analysis ✓ ✓  

Job Accounting ✓ ✓ ✓

IRM

AD Configurator (View)

AD User Editor (View)

DB User Editor (View)

AD Group Manager (View)

User List Editor (View)

✓

✓

✓

✓

✓

✓

✓

✓

 

Device

Add (Apply)

Delete (Apply)

Install/Remove (Apply)

Configure (Apply)

Move Devices (Apply)

Manage Device Grouping (Apply)

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

 

Settings

Database (View/Apply)

✓

✓

✓

✓
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Device (View/Apply)

Email (View/Apply)

IIS (View/Apply)

SPP Enterprise (View/Apply)

Alias (View/Apply)

Agent (View/Apply)

Print Server (View/Apply)

IPM (View/Apply)

Login (View/Apply)

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

Print Server

Configure

✓

✓

✓

✓

 

Server Information ✓ ✓  

License

Key Update (Apply)

✓

✓

✓

✓

 

1. Click the Settings tile and go to the Login tab. Select Application login to enable.
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2. The Login box will display showing the default user Admin (password Admin).
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3. Enter information for the New User. You can create a new user, or use an existing user from Active 
Directory.

NOTE: To create a user within HP Access control, enter a User login and password and assign the group it 
will belong to.

NOTE: To add a user from Active Directory, enter User login (sAMAccountName) and select Active 
Directory.
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4. Select the Group the user will belong to. The default groups are Admin, Power User, and User.

NOTE: The Admin group has full access to view and change all features within the HP AC admin console. 
The Power User group has limited access to the HP AC admin console features.

5. Click Apply.

6. When the HP Access Control admin console is launched it will prompt for a user name and password. Enter 
your User Login and Password and click OK.

9.2 Managing users
Go to the SPPE tile or the SPP Enterprise tile to view Secure Pull Print users and to manage user print jobs.
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9.2.1 Clearing the Cache

When a user logs into a device, information is retrieved from Active Directory. This information includes the 
user’s name and email address. This is stored in the cache on the HP Access Control server to enable storing of 
the users printed jobs and emailed jobs in one user folder:

1. Go to the Settings tile and click the SPPE tab.

2. Click Clear cache to delete the cached information linking the user’s login with the user’s email address.

NOTE: When a user logs in at a device, information is retrieved from Active Directory, including the user’s email 
address. The user name and email address are then stored in the cache to gather the user’s printed jobs and 
emailed jobs under one user folder.

9.2.2 Alias

For users printing from non-Windows printing, alias printing allows print jobs submitted from the non-Windows 
system to be linked to your user name in Windows.

Prerequisites

● IRM must be set to use Database as the data storage.

● The user must have been previously enrolled in the system.

Complete the following steps:

1. Open the HP Access Control Configuration Utility and select the Settings tile.
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2. Select Alias on the top menu.

3. Search for your user name (i.e User1) in the search field and click the Alias button.

4. Add the new alias (i.e. unixN). The alias name must be unique to other user aliases and logons. Any number 
of aliases can be entered.
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5. A black dot next to the user name indicates the user has an alias.

6. Jobs submitted by either User1 or unixN will grouped under the same user name in the user’s spool folder.

9.2.3 Deleting users

The AD User Editor is not intended as a replacement or substitute for the standard AD user management tools. 
As such, it works only with users that already exist in the domain. Also, it cannot delete users from the domain. 
Use the standard Microsoft tools to add and delete users in the domain. After a user exists, Agent PIC and 
feature rights can be assigned as described in the following sections.

9.2.4 Look up a user

Complete the following steps to find a user:

1. Go to the IRM tile and open the AD User Editor.
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2. Select Username, Email, or Code from the drop-down list, and click Find.

The upper portion of the screen displays information for the user specified, or an error message displays if the 
user cannot be found.

9.2.5 Auto purge inactive users

In order to delete inactive users in the IRM database, run the following SQL script in SQL Management Studio:

USE [IRM] --Change the value [IRM] to match your database IRM name
GO
IF EXISTS(SELECT 1 FROM sysobjects WHERE type='P' AND name
='P_DeleteInactiveIRMUser')
BEGIN
DROP PROC P_DeleteInactiveIRMUser
END
GO
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CREATE PROCEDURE [dbo].[P_DeleteInactiveIRMUser](@InactiveDate datetime) 
AS
BEGIN
delete from ALIAS where UserId in (select UserId from IRM where ADate < 
@InactiveDate)
delete from IRM where ADate < @InactiveDate
END
GO
After the script is executed, a new P_DeleteInactiveIRMUser procedure is created in the IRM database that can be 
called with one line. For example:

Exec P_DeleteInactiveIRMUser '2016-11-17'
If SQL Server Standard or Enterprise edition is used, you can create a SQL Agent job calling this line in the job 
steps, specifying the date. You can specify a fixed date and change it every once in a while manually, or you can 
use the DATEADD function for the parameter to have a dynamic date value. For example:

DECLARE @Date date = dateadd(month,-1,getdate())
Exec P_DeleteInactiveIRMUser @Date

NOTE: The line dateadd(month,-1,getdate()) is taking the current date and decreasing 1 month. So 
if you want to delete inactive users in the last 3 months, just change the value to be -3.

9.3 AD User Editor
Use the HP Access Control AD User Editor to review or change user PIC, card, and device feature rights.

IMPORTANT: You cannot view the AD User Editor page from the Configuration Utility if you are using a 64-bit 
server, or from a 64-bit Web browser. The AD User Editor page can only be viewed from the Configuration Utility 
on a 32-bit server or from a 32-bit Web browser.

User information displays in the upper portion of the page, and information to find a user is entered at the 
bottom. All fields in the upper portion of the page are read-only until a user is located using the Find function. 
When a user is located, the code and/or device attributes can then be changed.

NOTE: The AD User Editor is not intended to replace or substitute the standard AD user management tools. As 
such, it works only with users that already exist in the domain. Also, it cannot delete users from the domain. Use 
standard Microsoft tools to add and delete users in the domain. After a user exists, Agent PIC and feature rights 
can be assigned as described in the following sections.

9.3.1 Change User Card or Code Parameters

To change a Card or Code parameter, complete the steps provided here.

Prerequisites

● To email users new code information, SMTP must be configured

1. Click the IRM tile and select the AD-User Editor tab.

2. Enter the username, email, or code and click Find.
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3. Click New card or New code to change the attribute.

4. Click Update to save. To email the user of the new code (if applicable), select New code + Update + Email.

NOTE:

● If the code is in use by another user, a message will display.

● If the AD-Authenticator was configured so that a user’s PIC is not visible, the only way to update the code is 
through the New code + Update + Email.

9.3.2 Change a user’s device feature rights

Complete the following steps to change a user’s device feature rights. For more detailed information, see

1. Check the box to the left of a named device feature to enable or disable a user's right to use that feature.

2. Click Update when all features are specified correctly.

3. Click All Clear or All Set to clear or set all function rights at once.

9.3.3 Email a user’s PIC and rights information

Click Email to email PIC and device feature rights to a user. The email is sent to the user’s address stored in AD 
and displayed in the Email box.

NOTE: Only information stored in AD can be emailed. If changes have been made, but not committed, the Email 
button is disabled. 
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9.4 AD Group Manager
The HP AC Active Directory Group Manager performs operations on an entire group of users. It can be used to set 
PIC and device feature rights for an entire group of users. The members of each group are selected by an LDAP 
query.

Figure 9-1  Group Manager

The following group operations are available:

● Assign new random PICs to a group of users.

● Assign the same device function rights to a group of users.

● Email a group of users their PIC and device function rights information.

● Download a CSV file containing the AD-Authenticator information for a group of users.

● Encrypt PICs stored in AD for a group of users.

● Decrypt PICs stored in AD for a group of users.

CAUTION: The Group Manager is powerful; it can alter the PIC and device function rights of all users. The Group 
Manager can be configured so it is available only to a select group of highly qualified personnel.

Groups are defined using LDAP filters in the file AD-Authenticator-Configuration.xml. The groups 
are generally defined upon installation of the AD-Authenticator and do not need to be changed again. Two 
groups, ActivatedUserList and CandidateUserList are defined by default.

● The ActivatedUserList group filter selects only those users who have been assigned a PIC and device 
function rights.

● The CandidateUserList selects those users who have not yet been assigned a PIC or device function rights.

9.4.1 Download User AD-Authenticator information

The Group Manager automatically downloads a CSV file containing the current information for a Group’s users 
following any operation that modifies that group.
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Use the following steps to download the information without modifying the group:

1. Click the group name in the Filter drop-down box.

2. Select Only download users.

3. Click Apply Actions.

9.4.2 Email PIC and device function rights information

Prerequisites

● See Section 4.2.2.2, Configuring for email notification

The Group Manager can send all users of a group an email containing their current PIC and device function rights.

To email PIC and device function rights, complete the following steps:

1. Click the group name in the Filter drop-down box.
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2. Select Only email users.

3. Click Apply Actions.

9.4.3 Assign new PIC and device function rights

Prerequisites

● See Section 4.2.2.2, Configuring for email notification.

The Group Manager can assign new random PIC values and/or device function rights to all users in a group. This 
feature is especially useful for establishing the initial user settings during AD-Authenticator installation. This 
feature can also be used to assign new PICs on a periodic basis, or if a number of new users have been added to 
the AD.

Complete the following steps:

1. Select the group name in the Filter drop-down box.
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2. Select Modify all users.

To assign new PIC values, select Assign new codes.
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3. Select Send emails to send each user an email containing their new information.

9.4.4 Encrypt or decrypt user PICs

At installation, AD-Authenticator may be configured to use either encrypted or unencrypted PIC values in AD. Use 
the Group Manager to migrate between encrypted and decrypted PIC storage. This can be useful if an external 
tool was used to generate unencrypted PIC codes and they now need to be encrypted, or if the PIC codes need to 
be decrypted for use by an external tool. To change the encryption passphrase, decrypt the stored codes and 
then re-encrypt them using a different passphrase.

NOTE: Migrate to encrypted codes and Migrate to decrypted codes are available only if the code Passphrase 
has been set in the AD-Authenticator configuration. For more details, see Section 5.4.1, Configure the AD-
Authenticator.

AD-Authenticator stores the PIC values in AD in a way that it can determine whether the code is encrypted or 
decrypted. When changing between encrypted and decrypted codes, it only changes those codes that are not 
already in the correct state (for example, it does not re-encrypt already encrypted codes, rendering them 
indecipherable).

Use the following steps to change between encrypted and decrypted PIC value storage:

1. Click the group name in the Filter drop-down box.

2. Select Modify all users.

3. Select Migrate to encrypted codes OR Migrate to decrypted codes.

4. Click Apply Actions.
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NOTE: To change from encrypted code storage to decrypted code storage, immediately clear the code 
passphrase value from the AD-Authenticator configuration. If the passphrase is not cleared, AD-Authenticator is 
unable to authenticate against the decrypted codes and all new codes added are stored encrypted. Should this 
occur, run the Migrate to decrypted codes process again and then immediately clear the code passphrase.

9.5 Manage users AD Group Manager
The Active Directory Group Manager performs operations on an entire group of users. It can be used to set PIC 
and device feature rights for an entire group of users. The members of each group are selected by an LDAP 
query.
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The following group operations are available:

● Assign new random PICs to a group of users.

● Assign the same device function rights to a group of users.

● Email a group of users their PIC and device function rights information.

● Download a CSV file containing the AD-Authenticator information for a group of users.

● Encrypt PICs stored in AD for a group of users.

● Decrypt PICs stored in AD for a group of users.

IMPORTANT: The Group Manager is powerful; it can alter the PIC and device function rights of all users. The 
Group Manager can be configured so it is available only to a select group of highly qualified personnel.

Groups are defined using LDAP filters in the file AD-Authenticator-Configuration.xml. The groups are generally 
defined upon installation of the AD-Authenticator and do not need to be changed again. Two groups, 
ActivatedUserList and CandidateUserList are defined by default.

● The ActivatedUserList group filter selects only those users who have been assigned a PIC and device 
function rights.

● The CandidateUserList selects those users who have not yet been assigned a PIC or device function rights.

9.6 DB User Editor
DB User Editor is used to manage users when the user information is stored in a database.

Prerequisites

● Database is selected as the data storage location in the IRM tile > AD Configurator tab.

The DB User Editor tab allows you to edit user card/code numbers and view the last time a user authenticated at 
a device.
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Figure 9-2  DB User Editor

To change a Card or Code parameter, complete the following steps:

1. Click the IRM tile and select the AD-User Editor tab.

2. Enter the username and click Find.

3. Click the Edit  icon.

4. Enter a new card or code number for the user by selecting the card or code. Click Update to update the 
database with the new user data.

9.7 Review and change User Code and device feature rights with DB 
User Editor

9.7.1 Add users to the database

Users can be added automatically by authenticating at a device, or they can be added from Active Directory using 
the AD User Editor.

1. In the AD User Editor tab, find the user you want to add to the database.

2. Enter a new code or card number for the user. Click Update to update the database with new user data.

3. In the DB User Editor, click the Search/Refresh button. The user data displays.

9.7.2 Modify user codes

1. Click the Edit icon.

2. Under the Codes column, edit the user code.

3. Click the Save icon.
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9.7.3 Modify user cards

1. Click the Edit icon.

2. Under the Cards column, edit the user card number.

3. Click the Save icon.

9.7.4 Delete users from the database

1. Under the Select column, click the checkbox on the row of the user(s) you want to delete.

2. Click Delete.

9.7.5 Search for users

1. In the Search users field, enter any part of a user's name, card number, or code number.

2. Click Search/Refresh.

9.8 Device-based User List management

9.8.1 User List Editor

HP AC can be configured to have user information stored locally on the device, so that querying a SQL or AD 
server does not happen at the time of user authentication.

Prerequisites

● HP SF or MFP

● In-printer agent installed and configured

Enter user information in the rows and columns of the editor. Each row represents a user and each column 
represents the information for a specific user. The column definition is as follows.

Table 9-1  User List Editor details

Item Description

Full Name User’s full name (for example, John Smith). This value is used to associate an entry 
with a user.

Username User’s login (for example: jsmith). This value may be displayed by HP ACJA in certain 
reports. This field must be unique and usually matches the user’s Windows login ID.

Domain (optional) User’s Windows domain (for example: HP.com). This field may be displayed by HP ACJA 
in certain reports.

Password/PIN User’s password/PIN. This value is used by the user to authenticate. This field must be 
unique.

Email User’s email address (for example: jsmith@hp.com). This value is used to set the From 
address field when HP AC IRM is used to authenticate email use. This field must be in 
the form of a valid email address.

Group An arbitrary group that the user may belong to (for example: Account Log). This value 
may be displayed by HP AC Job Accounting in certain reports.

Allow Color Access If this box is selected and HP AC IRM Color is correctly configured, users are allowed to 
make color copies on a HP Color LaserJet MFP.
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When information is completed on a line, click the asterisk on the next line to save the information or begin a 
new line.

9.8.2 Manually enter user information

The User List Editor can be used to manually enter user information. In this mode, the editor operates similar to 
a spreadsheet program.

1. Go to the Settings tile and select the User List Editor tab.

2. Click on a row and enter the user’s information

3. Click on the empty row below (designated with the asterisk) to save the information and begin a new line.

4. Upload user list to a device. See

9.8.3 Import users from AD

Users can be imported from an existing AD. This allows for rapid creation of user lists. Complete the following 
steps to import users:

1. Go to the IRM tile and select the User List Editor tab.

2. Click File > Import, and select Active Directory.

3. Supply the LDAP Server login information. If the server is authenticated on the domain you are importing 
from you do not need to enter any information. The logged on user requires the appropriate privileges to 
read from AD.
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Figure 9-3  User List Editor – Import Users

Table 9-2  User List Editor – LDAP Server login information

Item Description

LDAP Server Host name or IP address of the AD server

Username The Windows User ID of an account with privileges to read the AD. If logging into a separate 
domain, the user name takes the form DOMAIN\username (for example: 
YOURBUSINESS\Administrator).

Password Password associated with the Username.

Domain A special field. It will pull the domain value from the users distinguishedName by using the 
first DC= attribute listed in the value. For example: CN=User, CN=users, DC=americas, 
DC=hpsolstr, DC=com. It would pull the DC=americas as the domain name.

Filter Used to restrict users that are imported by the tool. For example, if only users from the 
support department are imported, a filter (&(objectCategory=User)
(department=support)) can be specified. This field follows the standard A String 
Representation of LDAP Search Filters (RFC2254).

TIP: A filter may be so restrictive that it results in no users being imported.

4. Select Column Mapping.

This mapping defines which attribute in the AD maps to which column in the user list. In most cases, the 
defaults suffice. However, in some cases, a different AD attribute may be appropriate. For example, if the 
employeeID attribute in AD is to be used for the Password column, this can be selected or entered into the 
Password selection box.

5. To have a password (Code) generated for each user, select Auto Generate Passwords. Auto Generate 
Password is a special option that causes passwords to be generated for each of the users. A Password 
Option page displays after the import succeeds. For more information, see Section 9.8.5, Generate PINs

6. Click OK to begin the import.
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7. See Section 9.8.7, Upload a list to a device to upload a user list to the device.

9.8.4 Import users from a CSV file

Users can be imported from a CSV file, allowing for rapid creation of user lists.

1. Go to the Settings tile and select the User List Editor tab.

2. Click File and then click Import. Click File (.xml | .csv) and select an existing CSV file.

3. The CSV file should have the following column definition:

pwd-enc,username,password,domain,alias,email,group,allow-color,jsmith,
012345,YOURBUSINESS,John 
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Smith,support@yourbusiness.com,group1,True,admin,
01234,YOURBUSINESS,admin,admin@yourbusiness.com,group2,False

4. Upload user list to a device. See Section 9.8.7, Upload a list to a device to upload a user list to the device

9.8.5 Generate PINs

The User List Editor can generate a unique password/PIN for each user in the list. Use the following steps to 
generate PINs. Click PINs, and then click Generate to access the Generation Options dialog.

9.8.5.1 Alphanumeric Password

This option allows the selection of the types of characters to include in a password. If Alphanumeric Password is 
deselected, only [0–9] passwords are generated. If Alphanumeric Password is selected, both lower-case [a-z] 
(Include, upper Case Letters) characters can be chosen.

9.8.5.2 Password length

This option defines the length (number of characters) of the passwords to be generated.

NOTE: The maximum password length is 32 alpha-numeric characters.

9.8.5.3 Reset All

Select this option to reset and regenerate all passwords.

9.8.6 Email PINs

The User List Editor can email generated PINs to users in the list with valid email addresses.
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Use the following steps to email the PINs to each user.

1. Click PINs, and then click Email.

NOTE: Only users with a valid email address are added to the To: list.

2. Supply the SMTP Server login information. This information is optional if the PC running the editor has been 
configured with an email server (click Control Panel > Mail). Otherwise, the server information must be 
supplied.

Table 9-3  User List Editor — SMTP Server login information

Item Description

Server Host name or IP address of the SMTP server.

Username The Windows User ID of an account with privileges to log in to the SMTP server. This 
field is required only if the SMTP server is protected with a username and password.

Password Password associated with the username. This field is required only if the SMTP server 
is protected with a username and password.

Port Port number for the SMTP protocol associated with the server.

3. Supply the message details. This allows the details of each email message to be customized.

Table 9-4  User List Editor — Message details

Item Description

To A list of user email addresses that will have their PIN emailed to them. To delete or 
view users in the list, click To.
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Table 9-4  User List Editor — Message details (continued)

From Email address displayed in the From: address of each email.

CC If CC is selected, the email address defined in the From: field receives a convenience 
copy of all emails sent. For example, if there are ten users, ten convenience copies are 
sent to the email address defined in the From: field.

Subject The subject of the email sent to the users.

Message This is the message body of the email being sent to the users.

There are two special fields: %pin% and %name%.

The user PIN is substituted in the %pin% field. The user’s full name is substituted in 
the %name% field. These two fields can be used, along with other text, to customize 
the message.

9.8.7 Upload a list to a device

Prerequisites

● HP AC Job Accounting In-Printer Agent must be installed.

● HP MFP or HP SF devices

● Must have either Section 9.8.2, Manually enter user information, Section 9.8.3, Import users from AD, or 
Section 9.8.4, Import users from a CSV file.

After the user list is created, it must be uploaded to the device(s).

1. Go to the Settings tile and select User List Editor tab.

2. Click File > Import and select Upload to devices.

3. You will be prompted to save the user list. Click OK if not already saved.

Section 9.8   Device-based User List management 323



4. Browse to the location to save the file and click Save.

5. The Upload User List to Devices window displays.

Use any of the following methods to add printers to the list:

● Discover Devices: Uses SNMP discovery on the network. All devices discovered on the network are 
automatically populated into the list.

● Manually enter devices.

● Import devices from Web Jetadmin export file: Click Import and select Web Jetadmin file.

● Import devices from text file: Devices can be imported from a text file. Click Import and click Text File. 
The editor reads a single IP address from each line (delimited by <cr><lf> of <lf> of the file.
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6. After printers are added to the list, select to upload by checking the box in front of the IP address.

7. Click Upload List to initiate upload to device. If device is password-protected, enter the device credentials. 
These credentials must match the administrator password of the device. The status at the bottom will 
change to “uploading.”

8. After upload completes, the status of each device displays. If the IP address is green, the upload 
succeeded. If there is an error icon in front of the IP address the upload failed. Retrieve a description of the 
error by hovering over the error icon.

9. Click Done.
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NOTE:

● To remove a list from a device, perform a partial clean on the device.

● The user list can also be uploaded through the device's EWS by navigating to the Security tab > HP Access 
Control (IRM) and under Configuration, browse to the list and click Upload.

Once the upload completes, perform the following steps:

1. Go to the IRM tile > AD Configurator and verify that HPAC-IPA is enabled.

2. Go to the devices tile and configure the device for authentication.

3. Go to the device's EWS and under the Security tab > HP Access Control (IRM) under Authentications select 
HPAC-Local List and click Update.

NOTE: Under the Configuration section you will see the userlist.xml that was previously created and 
downloaded to the device.

4. Go to the Access Control menu and change the sign-in method to HPAC-Local List for the features you want 
to have the users authenticate for. Ensure the guest user is locked out.

9.9 Managing jobs

9.9.1 Deleting jobs

Click the user name to view information about the user's stored jobs in the document list on the right. To delete a 
print job, right-click the job and select Delete.

With HP Access Control Enterprise when there are multiple servers participating in roaming then the job lists of 
users from those other servers can be viewed from the SPP Enterprise tile.

1. Go to the SPP Enterprise tile.

2. Click the Pull print servers drop-down list to view the users and job lists stored on other SPP Enterprise 
servers.
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9.10 Using myCode
This website will allow users to change their codes.

Prerequisites

● Must have enabled in the IRM tile>AD Configurator>codes:

– For users to view:

○ Users can view own codes.

– To allow users to email codes:

○ Users can email own codes.

– To allow users to change or choose own codes:

○ Users can change own codes.

○ Users can choose own codes.

1. On the PC enter http://<servername>/AD-authenticator/MyCode.aspx.

2. Click the New Code button to change the code.

3. To manually change the code, enter the code and click the Update button.

● If the code is already in use the following message will display:
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10 Intelligent Print Management

10.1 Introduction
This chapter provides detailed explanations and procedures for installing, configuring, and using HP’s Access 
Control Intelligent Print Management system (HP AC IPM).

HP Access Control (HP AC) Intelligent Print Manager is a solution product that allows you to implement real 
action plans to meet your corporate initiatives, without being intrusive to the end user community. Intelligent 
Print Management, or rules based printing is bundled with HP Access Control Enterprise software.

Use HP Access Control (HP AC) Intelligent Print Manager to create and control printing processes by setting 
conditions, actions, and notifications.

● Conditions: Administrator sets up conditions to trigger actions

● Actions: IPM analyzes the print job and takes action based on conditions met

● Notifications: Users are notified of changes made to their print jobs
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10.2 General configuration
Before setting up and creating rules, we will first configure the HP Access Control server’s default options for IPM 
for the following:

● Failover

● Notification

● Testing

● Activity logging

● Cost per page assignments

● User Grouping

Prerequisites

● IPM installed and configured on the HP Access Control Enterprise Server.

10.2.1 Failover

1. In the HP Access Control configuration utility go to the Settings tile and select the IPM tab.

2. To allow users to print if the client loses connection to the IPM web server, select Skip rules if network 
failure. If not selected, then rules are unable to be checked against the server and all rules-based printing 
will stop.

3. Click Apply.

10.2.2 Desktop notification settings

Desktop notifications can be sent from the server to the end-users desktop for notifications such as defined 
printing costs or opt-in/opt-out.

Prerequisites

● IPM installed and configured on the HP Access Control server.

● Clients configured for IPM and IPM Notification

● Ports open for communication between the HP AC IPM web service to the client PCs

Complete the following steps:

1. In the HP Access Control configuration utility go to the Settings tile and select the IPM tab.
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2. Under the Desktop notification client, enter the parameters to send notifications from the server to the 
desktop when the IPM Notification Desktop client is installed on the end users PC. The notification will 
display to the user when the rule is applied.

● Title: What will appear in the notification window on client desktops.

● Choose Named Pipe or Direct TCP port as the communication method between the server and the 
client desktops.

● Machine Name: Enter the FQDN or IP address of a user’s desktop to test the connection between the 
server and the desktop.

NOTE:

● If the TCP port is different than the default port, select Direct TCP port.

● If the Opt-in/Opt-out rule is enabled in IPM, select Direct TCP port.

3. Click Apply and Test to send a message to the client PC.

4. On the client PC, a notification will appear in the system tray.

10.2.3 Installing the IPM desktop notification client

1. Run HP AC IPM Notification Desktop Client x64.msi.
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2. Leave the ports set at the defaults and click Next. Do not check No icon in system tray, as this is the only 
way to turn off the client. If that is checked, then in order to turn off the client you must uninstall it.

3. Click Close.

NOTE: This is only the Notification client – this is not required if there are no desktop pop-up notifications 
required.

4. If prompted, click Allow Access to allow the client to communicate through the firewall.

5. An icon will be added to the system tray.
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10.2.3.1 Do not show IPM pop-up if rule is followed

This feature applies to the IPM actions "Print in grayscale" and "Print on both sides". If either or both of the two 
rules are followed at the time of print, the Opt-in/Opt-out pop-up will not display. For example, if the IPM rule 
contains the actions "Print in grayscale" and the "Opt-in/Opt-out" pop-up, and if a user prints a document in 
grayscale, the Opt-in/Opt-out pop-up will not display, because the "Print in grayscale" rule is already followed. 
However, if the user prints a color document, the Opt-in/Opt-out pop-up displays, giving the user the option to 
apply the "Print in grayscale" rule.

NOTE: If any other actions are included in the Opt-in/Opt-out action, such as "Job Stamp" or "Economode", the 
pop-up will always display, regardless if "Print in grayscale" or "Print on both sides" are followed at the time of 
print.

By default, this feature is disabled. To enable the feature, complete the following steps:

1. Go to the Program Files\HP\HP Access Control\IPMWS folder and open the web.config file 
with Notepad started with Run as Administrator.

2. On the <add key="HidePopup" value="false" /> line, change the value from false to true.

3. Save the file.

10.2.3.2 Use client IP address instead of host name for IPM notification pop-up

If there are DNS issues on the network and client host names cannot be resolved, use client IP address for IPM 
pop-ups, instead of using client host names. By default, this feature is disabled. To enable the feature, complete 
the following steps:

1. Go to the Program Files\HP\HP Access Control\IPMWS folder and open the web.config file 
with Notepad started with Run as Administrator.

2. On the <add key="UseClientIP" value="false" /> line, change the value from false to 
true.

3. Save the file.

10.2.3.3 Enable HTML/Rich Text Box for IPM pop-up

With this feature, the Opt-in/Opt-out pop-up message that displays on user workstations at the time of print can 
be customized to include various font sizes, font types and images. Complete the following steps to edit the 
message text:

1. In the Opt-in/Opt-out action properties, double-click in the "Message" text field.

2. In the text editor window, modify the font type, text alignment, or insert an image.

NOTE: The "Size=" field is the size of the message in bytes. The maximum size allowed is 64,000 bytes.

3. When users print, they will see the customized message in the Opt-in/Opt-out pop-up window.

10.2.3.4 Show savings in pop-up when rules are followed

Prerequisites:
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● Costs specified in the HPAC > Settings > IPM > Cost per page section.

● Configure a printer for IPM and IPM cost in the HPAC > Print Server tile, or install the Enterprise Client with 
IPM on a client workstation.

● Create an IPM rule with the Opt-in/Opt-out action and the desktop client notification.

● Install the IPM Notification Client on a client workstation.

When a user prints, the Opt-in/Opt-out pop-up window shows the cost of the print as well as savings if the IPM 
rule is applied.

10.2.4 Cost per page

The cost per page feature to set estimated costs for different features within a print job. The Desktop Notification 
Client uses this data to notify the end user of the cost of a print job. If the Opt-in/Opt-out action is used, the user 
can modify the job to meet an estimated target cost.

Prerequisites

● IPM installed and configured on the HP Access Control Server.

● Clients configured for IPM and IPM Notification.

NOTE: To use IPM costs with the HPAC Print Client on workstations, the first group of IPM Costs Per Page (set in 
HPAC > Settings > IPM > Costs Per Page section) will automatically be used. It is recommended to set the costs 
per page before installing the HPAC Print Client. However, if costs per page are applied or changed after 
installation of the client, recycle the IPMWS application pool or click the Clear cache button in Settings > IPM.

Complete the following steps:

1. In the HP Access Control configuration utility go to the Settings tile and select the IPM tab.

2. Under the Cost per page feature you can set estimated costs for different features within a print job. The 
Desktop Notification client uses this data to notify the end user the cost of a print job, and if the rule was 
created with an Opt-in/Opt-out action, the user can modify the job to reduce the estimated costs.
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3. You can define up to three cost per page profiles to set different cost models to different print queues.

4. Click Apply.

TIP: Values for duplex printing should always be lower than those for simplex printing.

10.2.5 User grouping for Job Stamps

User grouping is applied when the cost center option of an IPM job stamp rule is used. When configured, the 
name of the user’s cost center is printed on all printed pages.

Prerequisites

● IPM installed and configured on the HP Access Control server.

● Clients configured for IPM and IPM Notification.

● HP Access Control Job Accounting server if using job accounting cost centers.

● Rule created using a job stamp.

Complete the following steps:

1. In the HP Access Control configuration utility go to the Settings tile and select the IPM tab.
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2. Choose the Job accounting cost center if you want costs centers previously defined within HP Access 
Control Job Accounting, or select Active Directory if you want to use groups defined in Active Directory.

3. If using Active Directory, click the drop-down list to select an AD field that contains the group names you 
want in the jobs stamps.

NOTE: The Search DN field displays the domain your server belongs to.

4. To test the connection to either Job Accounting cost centers or AD, enter a network username in the User 
name field and click Test. The name of the group the user belongs to will display in the status bar at the 
bottom.

5. Click Apply.

10.2.6 IPM Authentication

IPM authentication contains the credentials to allow the IPM web service to retrieve user grouping information 
and for notifications.

Prerequisites

● IPM installed and configured on the HP Access Control server.

● Clients configured for IPM.

● Device configured for IPM.

● Print driver configured to Start Printing after last page is spooled.
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● User Grouping information configured in the Settings tile > IPM tab > User Grouping section.

● For notifications, a domain account or local account is required with administrative privileges. To send email 
notifications requires a domain account.

Complete the following steps:

1. Go to the Settings tile and select the IIS tab.

2. Under the IPM authentication enter the username and password of a domain user in the form of domain
\username.

3. Restart IIS and click Apply.

4. Messages will appear in the bottom pane confirming the settings are saved and the service has restarted.

10.2.7 Email notification

If using email notification to notify end-users regarding IPM rules, the SMTP server must be configured.

Prerequisites

● IPM installed and configured on the HP Access Control server

● IPM Rule configured for email notification.

Complete the following steps:

1. Go to the Settings tile and choose the Email tab.
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2. In the SMTP section, enter the following information:

● Server Name: Enter the FQDN or IP address of the email server.

● Server Port: type the email server port. The default port is 25. Check TLS to enable Transport Layer 
Security protocol to encrypt and securely deliver the email.

● Login and Password: Enter the username and password that has access to the email server.

● Sender Email Address: Enter the email address that will appear in the “from” field of the email sent to 
users.

● Recipient email: Enter an email address to test the connection between the email server and the 
recipient. Click Test to send the email.

● Email Subject: Enter the subject of that will appear in the notification email.

● Email body: Enter what will appear in the body of the notification email.

3. Click Test and Apply.

10.2.8 Activity logging

The Print Activity log provides a report of jobs printed with defined rules.

1. On the HP Access Control server select the Settings tile and go to the IPM tab.
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2. Under Print activity, select Enable print activity log. Choose how long to keep the log before deletion.

3. Click Apply.

10.2.9 Configuring the Intelligent Print Management (IPM) Archive action

NOTE: Archive is only supported using a shared queue with the SPP Enterprise port and IPM configured on the 
server. Using IPM with the HP AC print client is not supported as jobs cannot be redirected from the client PC.

HP Access Control (HP AC) Intelligent Print Management (IPM) software can be used to create a print policy to 
archive print jobs. Intelligent Print Management generates companion files, which are XML files containing print 
job information.

To generate the companion file in Intelligent Print Management, complete the following steps:

1. In the Intelligent Print Management software, open the Archive preferences window.

2. For Folder, type the archive folder location, or double-click the text field to browse for the archive folder 
location. If the login information is not entered, the folder must allow write access for the "Everyone" 
account.

3. Select Print and archive to send the job to the printer and the archive folder. If the box is not checked, the 
print job is archived but not printed.

4. Select Create subfolder using user name to create a subfolder within the archive folder.

5. Select Companion file. As shown in the graphic below, the following Companion file sub-items must be 
selected to generate the companion file that can be used by Secure Pull Print Express.
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10.3 Using IPM to create rules
The IPM tile is where you define rules and policies to be applied to your printing environment.

The File menu allows you to import/export rules and clear rule processes.

● Click Import rule to import an XML file of rule processes.

● Click Export rule to save the current process as an XML file.

The Database tools menu allows you to repair or backup the database of information in case the server or 
application needs to be reinstalled.

10.3.1 Create a rule

To create a rule, complete the following steps:

340 Chapter 10   Intelligent Print Management



1. Go to the IPM tile and under the Rules tab enter the name for the new rule.

2. Click Create.

NOTE: When multiple rules are listed, use the up and down arrows to rearrange the order of the rules. 
Rules are checked in the order they are listed. The first rule that matches the print job properties is applied. 
If no rule matches the print job properties, nothing will happen.

3. Select a rule from the Rules list.

4. Click the Process tab.

5. Click and drag icons from the Conditions, Actions, and Notifications sections to the process design window 
on the right.

Moving the cursor over icons to view a description display in the help window at the bottom. Click the 
expansion arrow to display a list of parameters of the current rule process.

NOTE: To delete a process element, right-click the icon and select Remove. Click OK to confirm the 
deletion.
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6. Under Conditions, choose what condition is required to trigger the rule by dragging the icon to the process 
design window. Right-click the icon to view the Condition properties.

● Printer Condition: You can create a condition based on Printer name, Driver name, Printer comment, 
or Printer location.

NOTE: Go to the General tab to see printer driver Properties Location and Comment information.
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● Job condition: The following parameters are configurable and choosing one of these parameters will 
allow for additional configuration options (i.e. number of pages is greater than 2):

– Job name

– Number of pages

– Job size (bytes). Job size is measured in bytes and usually varies, depending on the printer 
driver that is used when the job is spooled.

NOTE: When the Equal to parameter is selected, the job size must be the exact size of the 
spooled job. If the job size entered does not match the actual job size the condition will fail. To 
view the actual size of a spooled job, pause the print queue and right-click the print job and click 
Properties. The job size will be displayed.

– Color job

– Application name. To determine the application name print the document to a file and open the 
file with Wordpad. Search for the line @PJL SET JOBATTR-“JobAcct6=” where the application 
name will be located. Use this application name to define the condition or use the following 
application names listed below when using a HP print driver:

○ Microsoft Word

○ Microsoft Excel

○ Microsoft PowerPoint

○ Microsoft Outlook

○ Microsoft OneNote

○ WordPad

○ Notepad

○ Paint

○ Adobe Reader

○ Adobe Acrobat

○ Internet Explorer
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● User condition: The possible parameter is User name and, if HP AC Job Accounting server is installed, 
you will also have Group name.

● Day/Time Condition: You can set a parameter by day of the week or time of day.
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7. Under Actions, you can specify what actions to apply to the job:

● Print to a different printer: Sends the print job to a different queue installed locally on the print server.

● Print on both sides: Creates duplex jobs.

● Economode: Prints the job in economode, thereby utilizing less toner.

● Print in Grayscale: Prints the entire document in grayscale.

● Do not print the job: Cancels the print job.

● Job stamp: Stamps the User name, Group name, and/or Date and time. Group name is the group 
name defined in HP AC Job Accounting . You can also specify the Position and Font size on this page.

NOTE:

● Only available on HP LaserJet printers when using PCL5, PCL XL 3.0, or PS drivers. PCLXL 2.and PCL6 
drivers are not supported.

● Only available on HP Officejet Pro and HP S900 devices when using PCL 5 or PS drivers.

● Double-byte languages are not supported.
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● Opt-in/Opt-out: Marks the process as optional to the end user. When included in a rule, the Opt-in/
Opt-out action provides a message to users, giving them an opportunity to decline.

● Archive: Archives all print jobs to a folder. The folder must be in the form of drivename\foldername 
(i.e. c:\archives) or a UNC path (i.e. \\servername\sharename). Enter the location of the archive folder, 
and make sure the folder has write access for “everyone.”

NOTE: Archive is only supported with HP AC Enterprise when using a shared print queue.

– Print and Archive: When not checked, the job will be archived and not printed.

– Create subfolder using username: Creates a subfolder in the archive folder based on the User 
name who printed the job.

– Companion file: Creates an XML file containing the information selected.
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● Watermark: Prints a watermark on every page. In the Properties window, select if you want to print 
the user name who printed the job, the date and time the job was printed, or custom text.

8. In the Notifications, you can configure how users will be notified that a rule has been applied to their job. 
Any combinations can be used to notify a user of rules that affect a job.

● Pop-Up: Requires messenger service to be started on the server and the end-users desktop to 
receive pop-up notifications. If the Messenger service is not available, the Notification client may be 
used.
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● Email: Sends a notification email to the user. The user email is obtained automatically from Active 
Directory.

NOTE: The email server must be configured to send email notifications.

● Web log: Updates the user log when the rule is used to initiate a print job. The Web log provides the 
user with a view/list of the print jobs that HP AC IPM has processed. To see the list of print jobs, 
connect to http://<HP AC IPM Servername>/myprint where <HP AC IPM Servername> is the name of 
the server where HP AC IPM is installed.

● Client application: Sends a message using the Notification Desktop Client. The Client must be installed 
on the end user desktop to receive notification.
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9. When all the icons have been placed in the Process design window, click Auto-arrange button to align 
them.

10. To determine that the conditions, actions, and notification options are valid for the rule you created, click 
the Check button. A message will display indicating that the rule is valid or invalid. If the rule is invalid, the 
icon representing the part of the process that needs correction or completion will blink. Correct the 
parameters and run the Check function again.

11. To test the rule, go to the Job validation tab. From here you can test the rules without actually creating the 
print job with the specific attributes to trigger the rule.
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12. Select a printer from the drop-down list and enter the parameters for testing. For example, to test a rule 
where number of pages greater than 1 will force duplex, you would enter 2 in the Number of pages and 
click Test. The job validation pop-up will confirm the rule is working.

10.3.2 Notifying users of Cost per page

Prerequisites

● HP AC IPM installed and configured on the HP Access Control server.

● Rule defined using opt-in/opt-out with display cost enabled.

● Cost per page setup in Setting tile > IPM tab > Cost per page section.

The user can set the cost per page in the Cost per page section of the Settings tile > IPM tab. If the Cost per page 
setting is enabled in the Notification Desktop Client application, the user can see the estimated cost impact of a 
rule using the Opt-in/Opt-out feature. This setting is reflected in the Print job cost (the cost per page multiplied 
by the number of pages in the job).

Example: The administrator sets a rule for Economode, Monochrome, and Duplex. The Opt-in/Opt-out feature 
allows the user to override the rule by clicking any or all of the restrictions. When the user clicks a restriction, the 
change is reflected in the Print job cost.
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10.3.3 Configure IPM on a printer

Prerequisites

● IPM installed and configured on the HP Access Control server.

● Rule(s) configured and tested on the IPM server.

● Print driver installed on the server (required for validation and testing of the rules)

● If you will be configuring an HP Officejet Pro device, a PCL5 driver is required. PCL6 and PostScript drivers 
are not supported with IPM rules and HP Officejet Pro devices.

Before applying rules to a printer, you must configure the printer for IPM. Complete the following steps:

1. Go to the Print Server tile.

2. Select a device from the device list. Click Configure.

3. In the Configure window, select IPM. Click OK.

4. An X displays under the IPM column, indicating the printer is configured for IPM and is ready to receive 
printing rules.
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10.3.4 Print activity log tab

Prerequisites

● IPM configured on the HP Access Control server

● Print activity log enabled (Settings tile > IPM tab > Print Activity)

● Rules defined

● Devices configured for IPM

● Print jobs sent and rules applied during the last x amount of days (where x is the number of days the log is 
kept for before deletion).

Complete the following steps:

1. Go to the IPM tile and select Print Activity log tab.

2. Enter information in the fields to define the report:

● In the From and To fields, select the beginning and end dates you want to view in the log.

● In the Rule field, enter a rule name to view print activity information about a specific rule.

● In the User field, enter a user name to view print activity information relating about a specific user.

● In the Printer field, enter a printer name to view print activity information about a specific printer.

● In the Job name field, enter the name of a job to view print activity information about a specific print 
job.

3. In the Applied drop-down menu, select the information you want to see in the report.

4. Click View to see the output, or Export to save it as a CSV file.

10.3.5 Modifying messages to end users

Notifications sent to end user’s can be customized using macros. This applies to Opt-In/Opt-Out, email 
messages, and pop-up notifications.

The following macros are available to customize the message:

● [PRINTERNAME]

● [RULENAME]

● [JOBNAME]

● [DATETIME]

● [USERNAME]
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11 Device Analysis

11.1 Introduction
HP’s Access Control Device Analysis solution allows an organization to quickly determine the performance of a 
networked printer fleet by gathering data and providing detailed analysis with statistical reports. Before 
implementing print initiatives such as cost reduction or environmentally-conscious compliance, you need to 
know how your fleet operates today.

HP Access Control Device Analysis (HP AC DA) provides data organization and analysis to target needs, help focus 
on a real action plan, and then monitor the plan's success.

11.2 Operation
This chapter describes the features and operation of the HP Access Control Device Analysis (HP AC DA) 
application.

11.2.1 Settings

Use the Settings tab to configure the parameters for the scanning process, and to schedule scans.

Make sure to configure additional settings, such as SNMP, email, and license settings, in the Settings tile.

11.2.1.1 Scan settings

Use the Scan tab to enter numbers in the Number of connections and Time—out (ms) fields in the Concurrent 
connections section.

Following are the Scan settings for Concurrent connections, Multicast DNS, and Locally attached scans. Click Save 
after making any changes. Click Default to restore the default settings.

Figure 11-1  Scan settings
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11.2.1.1.1 Concurrent connections

The maximum number of devices scanned simultaneously.

11.2.1.1.1.1 Time-out (ms)

The number of milliseconds the application waits for a printer to respond to a TCP/IP request.

11.2.1.1.2 Multicast DNS

This section only displays if iTunes 10 is installed on the system. Choose whether or not to use Bonjour.

Follow the steps below to start or stop the Bonjour Service:

1. Go to Control Panel, Administrative Tools, Services.

2. Click Bonjour Service. Then click Start or Stop the service.

Figure 11-2  Bonjour service

11.2.1.1.3 Locally attached

11.2.1.1.3.1 Fast scan

This scan quickly scans network neighborhood for devices locally installed on connected PCs.

If not checked, the scan generates a list of all locally attached devices on all PCs on the domain controller. The 
amount of time to complete the scan depends on the size of the domain. Larger domains cause slower scans.

11.2.1.1.3.2 Keywords filter

Filters keywords found in the driver names.

1. Type keywords in the appropriate text box.

2. Click Add to add to the list.
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11.2.1.2 Column settings

Use the Columns tab to set up columns that contain custom device data. Create up to 10 additional columns. 
Choose to display data in text, integer, decimal, or date format.

Figure 11-3  Column settings

Follow the steps below to configure column settings:

1. Enter the preferred number of additional columns in the text box.

2. Enter title names for the columns next to the column numbers.

3. Use the drop-down menu(s) to format the data as Text, Integer, Decimal, Date or Currency.

4. Click Save when finished.

11.2.1.3 Analysis settings

Use the Analysis tab to define the Number of days in a month and year in the appropriate fields. These fields are 
used to calculate the page count. Click Save after making changes. Click Default to restore the default values.
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Figure 11-4  Analysis settings

11.2.1.4 Cost settings

Use the Cost tab to define the per-page costs for Mono and Color printing devices. Click Save if any changes are 
made.

Figure 11-5  Cost settings

11.2.1.5 PDF settings

Customize the data displayed in the PDF report of your scans and analysis. Click Save to save changes. Click 
Default to restore the default settings.
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Figure 11-6  PDF settings

11.2.1.5.1 Display options table

The table under the PDF tab contains the display options for the PDF report. Each row represents a page of 
report information. The following information and options are displayed in the table:

● Generate: Which sub-report pages will be generated in the PDF report. Place a checkmark next to the name 
of each sub-report page you want displayed in the PDF report.

● Name: Name of the sub-report page.

● Type: Graphic display for the sub-report information. Use the drop-down menus to select the graphic 
display.

TIP: The PDF report will generate the sub-report pages in order from top to bottom. Click and drag the heading 
of a selected row up or down to change the order of the sub-report pages in the PDF report. Click the Default 
button at the bottom to restore the default order of the sub-reports. 

11.2.1.5.2 Title

Enter the title of the PDF report in the text field.

11.2.1.5.3 Format

Select the paper size for the PDF report:

● Letter

● A4

11.2.1.5.4 Orientation

Select the page orientation:
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● Portrait

● Landscape

TIP: Use Landscape orientation if the report is a comparison of two scans. This displays the two scan graphics 
on the same page for easy comparison.

11.2.1.5.5 Page number and Page number format

Select Page number if the page numbers should display in the PDF report in the bottom-right corner.

If Page number is selected, the Page number format option displays. Edit the text in the text field to customize 
the display of the page numbers.

NOTE: The variable text “#n#” represents the current page number and “#N#” represents the total number of 
pages. Edit the text to change what is visible in the bottom-right corner.

11.2.1.6 Scheduler settings

Use the Scheduler tab to define future and recurring scans.

Figure 11-7  Scheduler settings

11.2.1.6.1 Create a new schedule

Follow the steps below to create a new schedule:

1. Under the Scheduler tab, click New.

2. Enter a Name for the new schedule in the Name field.

3. Set the Frequency for a recurring scan: Daily, Weekly, or Monthly.

4. Use the up or down arrows to set a Start time.

Section 11.2   Operation 359



5. Click OK to accept the settings.

Figure 11-8  New schedule meeting

6. Click Save to save the schedule.

IMPORTANT: The Scheduler feature will work only if the application is running.

11.2.1.6.2 Modify a schedule

Follow the steps below to modify an existing schedule:

1. Select a scheduled scan in the Settings window of the Sheduler tab.

2. Click Modify.

3. Make any desired changes in the Name, Frequency or Start time.

4. Click OK to accept the settings.

Figure 11-9  Modify a schedule

5. Click Save to save the schedule.
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11.2.1.7 FTP settings

Use the FTP tab to define settings for FTP delivery of scan results.

Figure 11-10  FTP settings

11.2.2 Scanning devices

When the Device Analysis tab is first selected, the default screen is shown. Unless a previous scan is open when 
HP Access Control Device Analysis (HP AC DA) is started, the columns on the default screen do not contain any 
data.

Figure 11-11  Scan tab
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11.2.2.1 Create a new scan

To create a new scan, complete the following steps:

1. Select the Scan 1 or Scan 2 tab.

2. Under the Scan menu, choose the scan function you wish to perform:

● SNMP discovery

● Start multicast DNS discovery

● IP range discovery

● Locally attached discovery

● Rescan all

● Rescan selected rows

11.2.2.1.1 SNMP discovery

SNMP discovery sends a broadcast over a selected network and discovers what devices are available.

Go to the Scan menu and select SNMP discovery.

11.2.2.1.2 Start multicast DNS discovery

Multicast DNS discovery continually scans the network for devices until Stop multicast DNS discovery is selected. 
The scan is ongoing to show any device changes as they happen.

1. Go to the Scan menu and select Start multicast DNS discovery. The progress of the DNS discovery is 
tracked in the activity log at the bottom.

Figure 11-12  Start DNS
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2. To stop the scan, go to the Scan menu and select Stop multicast DNS discovery.

Figure 11-13  Stop multicast DNS discovery

11.2.2.1.3 IP range discovery

Discover devices within a selected range of IP addresses.

1. Go to the Scan menu and select IP range discovery.

2. Enter IP addresses in the Start and End fields.

Figure 11-14  IP range scan

3. Click Add to add the range to the list in the display field.

4. Click Save to save the range for future reports.

5. Click Start to begin the scan.

NOTE: If an IP range includes over 3,000 IP addresses, a pop-up window will inform you of the estimated time 
of completion. Click Yes to continue.
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Figure 11-15  Estimated completion time

11.2.2.1.4 Locally attached discovery

Discover all devices locally attached to PCs, through LPT or USB ports, on either the network or the domain 
controller, depending on your Locally attached settings.

To discover all locally-attached devices, go to the Scan menu and select Locally attached discovery.

NOTE: If the HP Web Jetadmin SNMP Proxy Agent is installed on a desktop where a device is locally attached, 
an SNMP broadcast or IP range discovery will discover the device. 

Go to www.hp.com for more information.

11.2.2.1.5 Rescan all

When a scan is loaded, go to the Scan menu and select Rescan all. This will collect current data and update all 
devices using the same scan parameters in Scan 1 or Scan 2. When the scan has finished, the Scan done 
message will appear.

Figure 11-16  Scan completed

The Last Check column will display the current date.

11.2.2.1.6 Rescan selected rows

To collect current data for one or more selected devices, click on the row(s) you want to rescan. Then go to the 
Scan menu and select Rescan selected rows.
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11.2.2.2 Open a previous scan report

Follow the steps below to load information from a previous scan:

1. Select the Scan 1 OR Scan 2 tab.

2. Go to the File menu and click Open to open a previous scan.

3. Navigate to the scan file (.das) and click Open to load the scan.

11.2.2.3 Insert a scan

Follow the steps below to load information from another scan into the current scan:

1. Click Insert on the File menu.

2. Navigate to the scan file (.das) and click Open to load the scan. The inserted data is included at the end of 
the data currently displayed.

11.2.2.4 Edit menu

Use the Edit menu to edit the data in the selected rows.

● Undo: Undo one previous action

● Copy selected rows: Copy one or more selected rows

● Cut selected rows: Cut one or more selected rows

● Paste selected rows: Paste one or more selected rows

● Delete selected rows: Delete one or more selected rows

11.2.3 Scan data

When a scan is loaded, the columns are populated with data from the devices in the scan range.

Figure 11-17  Scan data
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The following information displays by default for each scan performed:

● Last check: the date the scan was performed

● Manufacturer: the manufacturer of the device scanned

● Model: the device model number

● IP: the device IP address

● Serial number: the device serial number

● Part number: the device part number

● Asset ID: the asset ID number of the device

● Engine count: the device engine count

● Total mono: the total number of monochrome pages

● Total color: the total number of color pages

● Color support: Does the device support color printing?

● Duplex support: Does the device support duplex printing?

● Laser: Is the device a LaserJet printer?

● MFP: Is the device a multi-function printer?

● Manufactured date: the date the device was manufactured (may be entered by user)

● MAC address: the Media Access Control (MAC) address of the device

● Network name: the name of the device network

● Location: the location of the device

● Status: the device status

● Alert: any alerts on the device

● Event log (Event/Cycles/Date and time): last error code recorded on HP devices (includes error code / page 
count / date and time)

● Installed solutions: any solutions installed on HP devices

11.2.3.1 Customize column display

Follow the steps below to customize the columns displayed in a scan:
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Figure 11-18  Customize columns

1. Right-click in any column heading.

2. Clear the check boxes of the columns that should not display.

11.2.3.2 View options

Click View menu and select any additional data columns to display:

● Total

● Duplex

● Format

● Toner

● Supplies

● Cost

● Column
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● Sum/Average

● Default

● Log

11.2.3.2.1 Total

Click Total to display the following columns:

● Total fax: the total number of copies faxed from the device

● Total scan: the total number of copies scanned on the device

● Total mono prints: the total number of pages printed in monochrome

● Total color prints: the total number of pages printed in color

● Total mono copies: the total number of pages copied in monochrome

● Total color copies: the total number of pages copied in color

11.2.3.2.2 Duplex

Click Duplex to display the following columns:

● Print Letter/A4 duplex monochrome – number of A4 + letter pages printed in duplex mode, monochrome

● Print other media size duplex monochrome – number of other media pages printed in duplex mode, 
monochrome

● Print Letter/A4 duplex color – number of A4 + letter pages printed in duplex mode, color

● Print other media size duplex color - number of other media pages printed in duplex mode, color

● Scan Letter/A4 duplex monochrome – number of A4 + letter pages scanned in duplex mode, monochrome

● Scan other media size duplex monochrome – number of other media pages scanned in duplex mode, 
monochrome

● Scan Letter/A4 duplex color – number of A4 + letter pages scanned in duplex mode, color

● Scan other media size duplex color – number of other media pages scanned in duplex mode, color

11.2.3.2.3 Format

Click Format to display the following columns:

● Print Letter/A4 simplex monochrome: Number of A4 and letter pages printed in simplex mode on a 
monochrome setting

● Print other media size simplex monochrome: Number of other media pages printed in simplex mode on a 
monochrome setting

● Print Letter/A4 simplex color: Number of A4 and letter pages printed in simplex mode on a color setting

● Print other media size simplex color: Number of other media pages printed in simplex mode on a color 
setting

● Scan Letter/A4 simplex monochrome: Number of A4 and letter pages scanned in simplex mode on a 
monochrome setting

● Scan other media size simplex monochrome: Number of other media pages scanned in simplex mode on a 
monochrome setting
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● Scan Letter/A4 simplex color: Number of A4 and letter pages scanned in simplex mode on a color setting

● Scan other media size simplex color: Number of other media pages scanned in simplex mode on a color 
setting

11.2.3.2.4 Toner

Click Toner to display the following columns:

● % Black / Cyan / Magenta / Yellow: Percentage of color ink used

● Black / Cyan / Magenta / Yellow serial number: Serial number of color ink cartridge

● Black / Cyan / Magenta / Yellow pages remaining: Number of remaining pages the color ink cartridge can 
produce

● Black / Cyan / Magenta / Yellow pages printed: Number of pages printed with the color ink

● Black / Cyan / Magenta / Yellow install date: Date the color ink cartridge was installed

● Black / Cyan / Magenta / Yellow last use date: Date the color ink cartridge was last used

● Quantity Black / Cyan / Magenta / Yellow cartridge: Number of cartridges used on the device (entered by 
user)

11.2.3.2.5 Supplies

Click Supplies to display the following column:

● Misc. supplies 1 - 25: List of supplies installed on the device

11.2.3.2.6 Cost

The Cost view option will display the total costs of printing, based on the per-page costs set in the Cost settings 
tab.

Click Cost to display the following columns:

● Total cost: total cost of all printing

● Monochrome cost: total cost of monochrome printing

● Color cost: total cost of color printing

11.2.3.2.7 Column

The Column option, when selected, will show any custom columns that have been added in the Columns settings 
tab.

11.2.3.2.8 Sum/Average

The Sum/Average option calculates the sums and averages for all devices scanned and displays the calculations 
below the scan results.
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Figure 11-19  Sum average

11.2.3.2.9 Default

The Default option will remove any other options checked and return the columns to the default view.

11.2.3.2.10 Log

The Log option displays the activity log box at the bottom of the Device Analysis window. The activity log shows 
the timed progress of a selected scan, including information on the found devices.

Figure 11-20  Log option

TIP: Click and drag the top border of the activity log box to adjust the height to view more scan activity on the 
screen.

Right-click anywhere in the log box and click Clear to remove all scan activity information.
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Figure 11-21  Clear activity log

11.2.3.3 Search

Use the Search field to filter scan results.

Figure 11-22  Search field

11.2.3.4 Device options

Right-click a device line to display an option menu for that device.

Figure 11-23  Device options
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● Open printer EWS: Go to the embedded web server for the device

● Start SNMP walk: Gather and report SNMP data for the device in a .txt file

● Copy selected rows: Copy one or more selected rows

● Cut selected rows: Cut one or more selected rows

● Paste selected rows: Paste one or more selected rows

● Delete selected rows: Delete one or more selected rows

● Rescan selected rows: Perform a new scan on one or more selected rows

● Go to Scan 2: Jump to corresponding device line in Scan 1 or Scan 2

● Add asset ID: Add a sequential asset ID for every device in the scan

● Remove asset ID: Remove a sequential asset ID for every device in the scan

● Reboot device: Reboot the selected device

● Set serial number: Change the serial number of HP devices. Type the new number of the HP device under 
the Serial number column before clicking Set serial number.

CAUTION: Adding or removing an asset ID overwrites or removes existing IDs. This action must be verified.

11.2.4 Analysis tab

The Analysis tab will display similarities and differences between the two scans loaded in the Scan 1 and Scan 2 
tabs.

NOTE: If only one scan is loaded, the Analysis tab displays the page count difference between the scan and the 
date displayed in the Manufactured date column. If the Manufactured date column is empty, the device does not 
display in the Analysis report.

Figure 11-24  Analysis report
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11.2.4.1 Added and removed devices

Colored rows indicate added or removed devices between Scan 1 and Scan 2. Added devices are shown in the 
green rows. Removed devices are shown in orange.

11.2.4.1.1 Customize view

Follow the steps below to customize the view:

1. Right-click in any column title to display three view options, allowing you to customize your view of the 
analysis results.

● Common devices: devices found in both Scan 1 and Scan 2

● Added devices: devices found in Scan 2 but not in Scan 1

● Removed devices: devices found in Scan 1 but not in Scan 2

2. Click to deselect the options to not view the data in the analysis.

11.2.4.2 Analysis intervals

When the Analysis tab is selected, an Analysis menu becomes available to select analysis intervals.

The Page Count columns display an estimate value calculated using the Real page count and the Daily, Monthly, 
or Yearly interval selected, as defined in the Settings tab.

NOTE: Use the Settings tab to define the calculations for the Analysis interval options.

11.2.4.3 Analysis data

The following data will be provided in the Analysis report, depending upon the Analysis choices:

● Days interval between scans: Number of days between the dates of the first and second scans

● Difference/Average/Projected engine count: Difference in the engine count between scans, the average 
engine count among scans, or the projected engine count of scans, depending upon whether the Analysis 
interval selection is Real, Daily, Monthly, or Yearly.

NOTE: If Real interval is selected, the column header will display Difference. If the interval between the 
two scans is 45 days and Monthly interval is selected, the column header will display Average. If Yearly 
interval is selected, the column header will display Projected.

● Difference/Average/Projected mono: Difference in monochrome pages between scans, the average 
number of monochrome pages scanned, or the projected number of monochrome pages scanned, 
depending on the analysis interval selection

● Difference/Average/Projected color: Difference in color pages between scans, the average number of color 
pages scanned, or the projected number of color pages scanned, depending on the Analysis interval 
selection

● Difference black: Difference in percentage of black ink used between scans

● Difference cyan: Difference in percentage of cyan ink used between scans

● Difference magenta: Difference in percentage of magenta ink used between scans

● Difference yellow: Difference in percentage of yellow ink used between scans

● Difference/Average/Projected quantity black cartridge: Difference, average, or projected quantity of black 
cartridges used, depending upon whether the Analysis interval selection is Real, Daily, Monthly, or Yearly
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● Difference/Average/Projected quantity cyan cartridge: Difference, average, or projected quantity of cyan 
cartridges used, depending upon whether the Analysis interval selection is Real, Daily, Monthly, or Yearly

● Difference/Average/Projected quantity magenta cartridge: Difference, average, or projected quantity of 
magenta cartridges used, depending upon whether the Analysis interval selection is Real, Daily, Monthly, or 
Yearly

● Difference/Average/Projected quantity yellow cartridge: Difference, average, or projected quantity of 
yellow cartridges used, depending upon whether the Analysis interval selection is Real, Daily, Monthly, or 
Yearly

11.2.5 Stat tab

The Stat tab allows you to display statistics based on the selected scan, in text and graphic formats:

Figure 11-25  Stat display

11.2.5.1 Stat display options

Use the drop-down lists to select what information to include in the scan statistics.

1. Select the data to display.
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Figure 11-26  Statistic data display

2. Select a scan or analysis to display.

Figure 11-27  Statistics scan

3. Select the graphic display.

Figure 11-28  Statistic graphic

11.2.5.2 Statistic menu

Use the Statistic menu to customize the view of the statistic data.

● Legend: displays the legend for the graph

● Split screen: displays two sets of data and graphics for comparison
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Figure 11-29  Statistics display

Save and share the important data from your scans by exporting to a CSV or XLS file, or generating a PDF report.

11.2.5.2.1 Export

Export the scan data, analysis, or statistics to a .csv or .xls file. Use Microsoft Excel to view any exported 
graphics.

Click File. In the Export sub-menu, select one of the two options:

● Export to CSV

● Export to XLS

NOTE: Selecting Export only exports information visible on the screen in the currently-selected tab. Therefore, 
check that all data and graphics on the screen are correct, then export to the preferred file. To export data from 
the Stat tab to an .xls file, Microsoft Excel must be installed.

11.2.5.2.2 Generate PDF report

Follow the steps below to create a PDF report that displays all scan data and graphics in one report.

1. Approve all PDF report settings in the PDF tab under Settings.

2. Go to the File menu and click Generate PDF report.

3. Select a location to save the report, then click Save. A View the report message displays.

4. Click Yes to view the report.
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12 Job Accounting

12.1 Overview
HP Access Control Job Accounting enables you to track the use of devices across your organization. Gain control 
of your imaging and printing environment and costs. Monitor, allocate, and manage resources by tracking usage 
by device, user, project, department, and cost center. Collect data, and analyze the results to identify savings 
opportunities. Create and send reports to communicate the value and impact of printing. Create streamlined 
imaging and printing practices by ensuring the right device is in the right place and being used for the right job.

12.2 HP AC Job Accounting Architecture

12.2.1 HP AC Job Accounting print system overview

The HP AC Job Accounting server consists of three basic software components:

● HP Access Control (HP AC) Job Accounting Database Server

– Collects the tracking data from Job Accounting print servers and from the devices

– The database can be installed locally on the server or on a remote SQL server

● HP Access Control (HP AC) Job Accounting Web Server

– The web server provides an interface through a web browser to access the data from the Job 
Accounting Database Server and administer the server

● HP Access Control (HP AC) Job Accounting print server (HP AC Job Accounting Print Server)

– Contains the Job Accounting tracking engines to track print information reported by the print spooler 
and will forward to the Job Accounting Database server.

NOTE: The modules can be installed together on one server, or split across multiple servers, if required.

To track shared network devices for printing the HP AC control Job Accounting Print server must be installed on 
the server hosting the shares.

12.3 Information flow
HP Access Control can track usage from supported HP devices using in-device tracking or by tracking print jobs 
from a print server. HP FutureSmart Devices: The Job Accounting statistics module receives tracking data and 
creates a XML file to push to the Job Accounting Database Server. HP Non-FutureSmart Devices: FTP or HTTP is 
used to receive tracking files from these devices. Non-HP Devices: support tracking of data from a print server.

12.3.1 In device tracking

HP devices support tracking of page level information at the device level. This provides the most accurate level 
of tracking as it will only count printed pages. If a user deletes or retains and reprints a job, the information will 
be sent to the Job Accounting server.

How it works:

1. After completing a job, the printer sends tracking data to the Job Accounting data collector.
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NOTE: This can be data collectors on the Job Accounting Web server, or installed on a remote server.

2. The Job Accounting web server will record the tracking data in the SQL database through a SQL transaction 
by the HP AC Job Accounting Agent service.

NOTE: The database can be local or remote.

12.3.2 HP Access Control (HP AC) Job Accounting print server

The HP AC Job Accounting Print Server can detect every print job sent to any of these shared printers by 
monitoring the print spooler. HP AC Job Accounting keeps track of all printed documents, as well as their 
characteristics including:

● Document name

● Printer (local and shared name) and its properties (such as color or black and white, or duplex unit)

● Job owner: name, machine name

● Number of sent pages and printed pages for HP devices configured to send printer confirmation using 
SNMP

● The printing mode (Economode, duplex, color)

● The date and time when the print job was sent

● The media used and its size (A3, A4, letter)

NOTE: Print server tracking requires SNMP traps to be configured and working correctly to accurately track 
canceled pages and or retained/reprinted pages. It is recommended to use in-printer tracking.

12.4 Getting started
HP AC Job Accounting interface is easy to use, with its Remote Control panel and user-friendly buttons and icons 
for fast navigation through various functions. Every HP AC Job Accounting icon is context-sensitive. When the 
cursor is positioned for several seconds on an icon, a description of the action associated with the icon will 
appear. Lists and pull-down menus are built dynamically, according to what is declared/registered in HP AC Job 
Accounting. For instance the printers, print servers, media, and currencies are all updated based on information 
contained in other tables. You can use the Ctrl and Shift keys to choose multiple entries in a list.

Specific icons allow you to reach a certain page or service. By clicking on any button in the HP AC Job Accounting 
Remote Control panel, you will be able to access information and to launch certain tasks. When more than one 
page of information is generated, the page navigation bar illustrated in the figure below appears at the bottom 
of each page:

To reach a specific page, click the first page number in the bar and type the number of the page you want to 
reach:
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To select one or more elements in a list, simply check the box on the left of the element, or click the box in the 
title bar to select all elements in the list:

To delete an item, select one or more from the list and click the delete icon in the title bar:

To modify the parameters of an element in the list, click the Modify icon:

NOTE: It is only possible to modify one element at a time.

HP AC Job Accounting has three distinct user categories:

● HP Access Control (HP AC) Job Accounting users

These users have an HP AC Job Accounting account. They can launch queries and get query results (on 
costs, printed documents) and be informed on the print system.

● HP Access Control (HP AC) Job Accounting administrators

These users have an HP AC Job Accounting account and the ability to launch queries or gather statistics 
about the print system. Furthermore, HP AC Job Accounting administrators are able to manage other HP AC 
Job Accounting accounts, currencies, exchange rates, user permissions, etc.

● HP Access Control (HP AC) Job Accounting allocation super user

These users have an HP AC Job Accounting account. They can launch queries and obtain query results (on 
costs, printed documents) and be informed on the print system. They can also view and modify allocation 
information stored in the database.

12.4.1 Login page

To access the HP AC job accounting server do one of the following:

● Open the Job Accounting tile from within the HP AC configuration utility.

OR

● In a web browser, enter http://<servername>HP_ACJA or https://<servername>/
HP_ACJA
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NOTE: Both the default login and password are Admin. The password field is case-sensitive.

The following rules apply to the login page:

● Entering user information on this page allows access to HP AC Job Accounting.

● If the user name or password is invalid, an error message appears.

NOTE:

● For the HP AC Job Accounting Administrator Account: A default account is created when installing HP AC Job 
Accounting, to allow you to access the application for the first time. When you are connected, it is highly 
recommended that you change the password of the Admin account. For more information, see Section 
12.10, HP AC Job Accounting user options.

● For HP AC Job Accounting Users: The HP AC Job Accounting administrator created your account with a user 
name and a password. Only your HP AC Job Accounting administrator can provide you with this information. 
After accessing your account for the first time, you can modify your password. For more information about 
modifying your password, see Section 12.10, HP AC Job Accounting user options.

12.4.2 Information page

When you have successfully logged into HP AC Job Accounting server, the HP AC Job Accounting Information 
page appears:
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The information page consists of two parts: the HP AC Job Accounting Remote Control panel on the left, and the 
larger General Display window on the right. The HP AC Job Accounting Remote Control panel will always be 
displayed and does not change appearance. The General Display will change depending on the selection made in 
the Remote Control panel.

NOTE: What is displayed in the General Display will vary based on the logged in user and the associated rights 
assigned to that user.

The general display window is divided into the following sections:

● The information about your license status. If HP AC Job Accounting is registered, nothing is displayed.

● Information about the current user.

– Completed queries (queries for which a result is available)

– Launched queries (queries running and for which a result is expected)

– Scheduled queries (queries planned but not yet run)

– Errors in queries (queries aborted due to error)

● Information about costs and exchange rates.

NOTE: This information only appears for an HP AC Job Accounting administrator.
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NOTE:

● For the HP AC Job Accounting administrator: Read the information presented on this page carefully. Only 
the proper system configuration will produce accurate query results.

● It is the HP AC Job Accounting administrator’s responsibility to view this page to update the Job Accounting 
configuration on a regular basis. Users are not notified to update parameters surrounding elements added 
to the print system.

12.4.3 License

This section provides information about HP AC Job Accounting license status.

1. Click the Help button on the remote control panel and click View License Information.

License information will display.

2. To view the License Agreement, click License Agreement.

NOTE: You can also view Job Accounting licensing details by accessing the License tile in the HP AC 
configuration utility.

12.4.4 Database Manager

The Job Accounting Database Manager is a simple tool for managing the Job Accounting database. It is not 
intended to replace any SQL Management Tools that are included with SQL Server.

WARNING! Please make sure the database is backed up prior to applying any changes to the database.

The Database manager can be accessed:

● Within the HP AC configuration utility, go to the Job Accounting tile > Database Manager tab;

OR

● Using your web browser, enter the following URL:

http://<servername>/HP_ACJA

and select the Database Manager menu.
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In the Server Name field, make sure to include the instance name if you used a named instance of SQL. Enter the 
correct login credentials. Click OK.

Running SQL queries:

1. To view SQL queries, go to the Database menu and select SQL Query.

2. Enter query and click Run. Results will appear in the results pane.

3. Open Database menu and select Database Manager to exit SQL query menu.

Using Database Manager to delete records:

WARNING! The deletion process cannot be reversed. Once an item has been deleted it will no longer be in the 
database. A complete database restore would be required to restore the deleted items to the database. All 
records associated with the deleted object will also be deleted.

In the Database Manager, select items to delete:

● Select Print servers to delete a selected print server, including all printers and jobs assigned to it.

● Select Printers to delete a selected printer and all jobs assigned to it.

● Select Domains to delete a selected domain, including all users and jobs assigned to it.

● Select Users to delete a selected user and all jobs assigned to the user.

● Select Allocation to delete a selected allocation profile and jobs assigned to it.

● Select Jobs to delete jobs within a selected date range.

Back up the Job Accounting Database:

The Job Accounting database can be backed up using any of the following methods:

● In the HP AC configuration utility go to Job Accounting tile > Database Manager. Under Database menu, 
select Back up Database. Choose the directory or a UNC path to save the backup to.

● In a web browser, enter the following URL:

http://<servername>/HP_ACJA

In the Database Manager tab, under Database menu choose Back up Database. Choose the directory path 
or a UNC path to save the backup to.

● Back up the HP_ACJA database using standard SQL tools.

12.5 HP AC Job Accounting administration
Use the HP AC Job Accounting Administration page to add, delete, or modify HP AC Job Accounting functions and 
parameters. All administration operations are performed from this menu. HP AC Job Accounting administration is 
divided into two parts:

● The HP AC Job Accounting administrator assigns and configures individual accounts; including HP AC Job 
Accounting accounts, currencies used in the application, and email system.

● The HP AC Job Accounting administrator defines the costs and prices (such as printers and media), which 
will affect query results.

NOTE: The Administration menu only appears in the HP AC Job Accounting remote control if you have 
Administrator rights.

Access the Administration screen by clicking Administration on the HP AC Job Accounting remote control:
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12.5.1 Account options

This page provides information on the various accounts in the system, and allows the administrator to create 
new accounts or modify existing ones. To access the HP AC Job Accounting Accounts options, click Accounts on 
the Administration screen.

12.5.1.1 Create an account

1. Click Create an account.

2. Enter a unique user name.

3. Enter your password and then confirm it by entering it again. For security reasons, passwords are masked.

NOTE: Passwords are case sensitive

4. Check the group you want the user to belong to:

User: Allocation Super

User: Quota Super

User: Administrator

5. Click the Go  icon to validate the account, or the Cancel  icon to reject it and stop the operation.

Figure 12-1  Go and Cancel icons

This account has the language and currency attached by default to the Admin account. For more information on 
changing the language and currency, see Section 12.10, HP AC Job Accounting user options.

12.5.1.2 Modify an account

Administrators can modify the password or the access rights attached to a user name. You may find this function 
useful when reinitializing an account password.

NOTE: It is possible to modify only one account at a time.

● To modify account information, click the Modify  icon.

● To change the password, enter the password, and then enter the password again to confirm it.
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● To grant or withdraw administration rights, check or uncheck the Administrator box.

NOTE: The access rights of an Admin account cannot be changed.

● Click the Go  icon to accept the modification, or the Cancel  icon to reject it and stop the operation.

12.5.1.3 Delete an account

To delete an account, check the box corresponding to the user account you want to delete. Click the Delete icon. 
You will be asked to confirm the deletion before the account is removed.

TIP: You can delete several accounts in one operation.

12.5.2 Currencies

To view defined currencies, add a currency, or define a currency exchange rate, click Currencies on the 
Administration page.

This page lists all currencies defined in HP AC Job Accounting and provides their acronym. These currencies may 
be used in HP AC Job Accounting to display costs for elements such as printers, media, or jobs.

A currency will ultimately express a cost associated with a given printer. Each time a new cost is entered by an HP 
AC Job Accounting administrator, the default currency for this cost is the same as the currency associated with 
the current administrator. You can modify the currency, which is attached by default to each HP AC Job 
Accounting user and administrator in the User options. For more information, see Section 12.10, HP AC Job 
Accounting user options.

HP AC Job Accounting contains the following default currencies:

● US dollar

● European Euro

● British pound

NOTE: You may delete any currency, as long as it has not been used to express a cost.
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12.5.2.1 Add a currency

Forms of currency are entered in Add a currency. To add a currency, complete the following steps:

1. From the Currencies page, click Add a currency.

2. Specify the new currency name and acronym (Example: USD for a US dollar).

3. Click the Go  icon to add the currency, or the Cancel  icon to stop the operation.

12.5.2.2 Define an exchange rate

An exchange rate must be associated with each currency. All exchange rates are set to “0” by default.

NOTE: You must define an exchange rate for the new currency, or all costs expressed in the new currency will 
be incorrect.

Use the following steps to define an exchange rate:

1. On the Currencies page, check the box beside a currency to select it.

2. Click Define an exchange rate.

Figure 12-2  Define exchange rate
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3. Enter the exchange rate for the currency.

4. Click the Go  icon to accept the defined exchange rate, or the Cancel  icon to stop the operation.

12.5.3 Delete an exchange rate

To delete an exchange rate, complete the following steps:

1. On the Currencies page, check the box beside a currency to select it.

2. Click Define an exchange rate.

3. Enter 0 in the field beside the currency, for the exchange rate you want to delete.

12.5.4 Modify a currency

To modify a currency name or acronym, complete the following steps:

NOTE: You can modify only one currency at a time. On the Currencies page, check the box beside a currency to 
select it.

1. Click the Modify  icon to access Modify a currency screen.

Figure 12-3  Modify a currency

2. Enter a New currency name or New local name in the designated fields.

3. Click the Go  icon to save the modifications, or the Cancel  icon to stop the operation.

NOTE: You do not have to redefine the exchange rate for a modified currency.

12.5.5 Delete a currency

Use the following steps to delete a currency:

1. On the Currencies page, check the box beside a currency to select it.
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2. Click Delete .

3. Click the Go  icon to delete the currency, or the Cancel  icon to stop the operation.

TIP: You can delete several currencies at a time.

NOTE: The exchange rates attached to a deleted currency are automatically deleted.

12.5.6 Active Directory

Information regarding users, groups, domains, and computers is collected the first time a user is detected in the 
database. If no network scan has been performed, only the users printing with the HP AC Job Accounting print 
server will be stored in the database. After a network scan has been launched, the information pertaining to 
users, groups, domains, and computers is stored in the database.

On the Active Directory screen, the administrator can create new HP AC Job Accounting groups, which are 
processed like standard network groups. If a user belongs to several groups, assign the user to a group and 
obtain user information through various queries.

To access the Active Directory options, click Active Directory on the Administration page.

The Active Directory displays the total number of users, computers, domains, and groups that are currently 
tracked. These numbers will change according to the data detected on your network. The data is refreshed once 
every 30 seconds.

From Active Directory, the administrator can perform the following tasks:
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● Click Retrieve user data to launch the search.

● Click Group organization to add, delete, or organize groups.

● Click Group management to manage groups and user assignments to groups, to charge them based on 
printing activity.

● Click Customize report to add and define columns in your queries. The summary report is not affected.

HP AC Job Accounting allows you to retrieve and use data regarding individual print system users. This data, also 
called Active Directory in the Windows system (ADSI), reports the user’s group and domain, if any. Data such as 
the user’s first and last name, the name and operating system of the machine, and the user’s declaration in the 
system are also given based on information previously entered by an administrator.

This user data enables accurate monitoring of print costs over a network. Individual users are charged for 
printing costs, rather than costs associated with a particular workstation. For companies with a large user base, 
individual accounts should be placed in different groups or domains, depending on the internal organization. 
User queries can be launched by specifying a Windows domain, limiting the scope of your query. Using this 
method produces faster, more precise results.

NOTE: Active Directory only supports Domain Controller on Windows 2000, 2003, and 2008. pDC on Windows 
NT 4.0 is not supported.

You can add this data to your HP AC Job Accounting database using automatic or manual retrieval. To enable 
automatic database updates you should have the necessary network permissions, which can only be applied by 
the network administrator. These rights should be registered before any printing or manual data retrieval.

12.5.7 Retrieving user data

User data can also be manually retrieved by the HP AC Job Accounting administrator.

1. Click Retrieve user data to launch this operation.
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Figure 12-4  Retrieve user data

2. Choose a specific Affected domain to scan.

You can also specify the login and password of an HP AC Job Accounting administrator for the defined 
domain of your print system. For security purposes, the password is encrypted and not visible.

NOTE:

● Passwords are case-sensitive.

● HP AC Job Accounting uses this identification to research users on the network. The user performing 
the scan must have administrator rights in each affected domain—be aware of any firewalls that may 
block the scan.

● If no login or password is entered, HP AC Job Accounting verifies the network authorizations of the 
machine from which the search was initiated.

3. Limit the scope of information scanned by choosing Computer or Group in the options list of the Scan type 
field.

The Computer option allows the retrieval of various computers and users. The Group option allows retrieval 
of various groups, as well as all attached users. Complete scan retrieves all information related to your 
domain by taking into account all levels of your system. This last option is selected by default.

4. Click the Go  icon to accept the process, or the Cancel  icon to stop the operation.

NOTE: This operation must be performed for each domain of the print system. Each new user or group in any 
domain is automatically added to the HP AC Job Accounting database. All lists and drop-down menus that 
summarize end users, machines, groups, and domains existing in the NT system are automatically created and 
updated in the HP AC Job Accounting interface, if the user has printed. For more information on these 
parameters, see Section 12.11.3, Parameterize queries.
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12.5.8 Group Organization

Group Organization defines which Active Directory property to use to query group activity and costs for each user. 
The three options for organization are Primary Group, Organizational Unit, or Active Directory Properties.

Figure 12-5  Group Organization

Primary Group and Organizational Unit (default OU is Users) are the standard Active Directory properties.

Active Directory Properties allow for the selection of available AD properties; or a property can be specified by 
entering a valid AD property as text. If the option is configured on the HP AC Job Accounting Server, and security 
has been configured to disable Anonymous access on the HP AC Job Accounting web site in the IIS console, a list 
of AD properties populates a drop-down list. Otherwise, only an input field displays and the property must be 
supplied as text input.

NOTE: A complete network scan must be launched to update the database if Organizational Unit or Active 
Directory Properties is selected.

12.5.9 Group management

Group management defines how print jobs are allocated to the groups of your network, which affects the result 
of some queries and modifies the printing cost charges per group user.

A single user may belong to several groups. For example, a user can belong to the Development group, the 
Accounting group, and the Management group. The user can be attached to one specific group or several, if 
desired. Each user could be assigned to a favorite group. In this manner, all printing activity related to a user is 
counted only once, and not twice or three times, as is the case when the user belongs to several groups. To set 
up this feature you will first need to choose a domain. Use the following steps to manage groups:
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1. Click Group management on the “Active Directory” page.

2. Choose a Domain.

3. Click the Go  icon to continue to the Group selection menu:

Figure 12-6  Group selection

12.5.10 Group management functions

The Group selection window displays all the groups that have been automatically detected by HP AC Job 
Accounting, and new groups that have been created manually. These new groups appear highlighted in light 
blue.

Use icons to manage groups:
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Figure 12-7  Group management icons

1 The right-arrow icon moves a group from the Unselected groups field to the Selected groups field. You also can 
select many groups by holding the Ctrl key while making selections.

2 This icon moves all groups from Unselected groups to Selected groups.

3 The left-arrow icon moves a group from the Selected groups field to the Unselected groups field. You also can 
select many groups by holding the Ctrl key while making selections.

4 This icon moves all groups from Selected groups field to the Unselected groups.

The Delete  icon is used to delete the manually created groups.

To remove any automatically-detected groups that are unnecessary, select them and click the left-arrow icon. 
They are added to the Unselected groups field. This action allows them to be retrieved later if needed.

The New group field allows the creation of custom groups. Enter the name of the new group and add it to the 
Selected groups window by clicking the right-arrow icon. The new group is highlighted in light blue.

Following are the rules of selection:

● By default, all groups are selected (they appear in the “Selected groups” window).

● You can create and delete groups you have created manually.

● You cannot delete groups detected by the system as active (Active Directory).

● If you delete a group with users still attached, they are moved to the unspecified group.
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● To assign users manually, click Manual assignment in “Group management”:

Figure 12-8  Manual assignment

A list of users is displayed. You can only reveal the users of one particular group at a time, but it is possible to see 
all users of all groups. In this case, the current assigned group is indicated between brackets for each user.

You can choose a new destination group for each user. Select one or many users, and then select a new 
destination group and click the right-arrow icon to assign the selected users to this new group. As a result of 
selecting a specific group, a query is launched including the users who have just been assigned.

NOTE: This assignment is recommended for environments with a small number of users.

12.5.11 Manual Scan

On large networks, performing scans for new users can be a time-consuming process. After adding a new user 
or making a change to an existing user, the Manual Scan option can quickly update the system.

1. Click Manual Scan on the “Group management” page:
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Figure 12-9  Manual scan

To limit the list size, use the drop-down menu to confine the results to specific network groups. Use the 
following steps to perform a “Manual scan”:

2. Select the new user from the list.

3. Click the Update  icon to update the selected user.

12.5.12 Customize reports

Use the Customize Report function to add data from any Active Directory field in a column within a user-
generated report. Only queries reporting the user name see the additional columns.

1. Click Customize report on the “Active Directory” page to add and define new columns in your report.

Figure 12-10  Customize report

2. Define up to five columns:

a. Enter the column name in the Column field.

b. Select from the Active Directory Properties drop-down list to define the column. If the drop-down list 
can be populated, an input field displays (see Section 12.5.8, Group Organization for more details.
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Figure 12-11  Customize report columns option

NOTE: See Section 12.11.4.7, Modify display parameters to display additional columns in the report.

12.5.13 Email

The email system defines both individual email addresses and distribution lists. The system provides all HP AC 
Job Accounting users and administrators with a choice of email recipients. An email server should also be 
configured to send query results using email (a proxy server and the SNMP port associated).

To create addresses and lists and configure the email server, click Email on the Administration page.
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Figure 12-12  Email configuration

The HP AC Job Accounting email system enables HP AC Job Accounting users to send query results using 
electronic mail as the delivery mechanism.

Email data (addresses, lists and server), if already defined, appears on the screen. The SMTP address of the 
email server is displayed. You can create the addresses and distribution lists using the task bar at the top of the 
page.

NOTE: Query results can only be sent in Comma-Separated Value (CSV) format.

To send your query results using email you must have all of the following:

● A properly configured email server.

CAUTION: To configure an email server you need some parameters that may be confidential. Only your 
network administrator may have access to this information.

● A sender. The sender’s address can be defined in the User options. This operation is mandatory. Any HP AC 
Job Accounting user or administrator can define their address. For more information on this operation, see 
Section 12.10, HP AC Job Accounting user options.

● Recipients for query results. For more information on this operation, see Section 12.12, Query results.

NOTE: No verification is performed on email addresses (such as access, validity, or entry). These addresses will 
only be used when results are sent. Contact your system administrator to confirm that email messages have 
been sent and received. If an error occurs, you will have to correct the HP AC Job Accounting addresses.

HP AC Job Accounting contains an address book, which consists of recipient addresses and recipient lists. You 
should first define individual addresses, and then create lists with these addresses.

12.5.14 Create an email address

This operation is not mandatory. Email addresses can be defined when launching a query. For more information, 
see Section 12.11.3, Parameterize queries.

Use the following steps to create an email address:

1. From the Email screen, click Create an address.
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Figure 12-13  Create an address

2. Enter the email address in the usual format: xxxxxx@xxxxxx.xxx

3. Click the Go  icon to accept the address, or the Cancel  icon to reject it and stop the operation.

NOTE: All fields can contain up to 127 characters, symbols, and figures.

12.5.15 Modify an email address

Use the following steps to modify an existing address:

1. On the Email page, select the email address you want to modify.

2. Click the Modify parameters  icon to display the Modify an address page.

Figure 12-14  Modify an address

3. Click the Go  icon to accept the modifications, or the Cancel  icon to reject it and stop the 

operation.

12.5.16 Delete an email address

To delete an email address, complete the following steps:

1. Select the address you want to delete in the Addresses section.
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2. Click the Delete  icon.

NOTE: To avoid an error, confirm that you want to delete the address.

Figure 12-15  Confirm deleted address

3. Click the Go  icon to accept the address deletion, or the Cancel  icon to reject it and stop the 

operation.

CAUTION: This operation cannot be canceled after it has been accepted.

12.5.17 Distribution lists

A distribution list consists of several email addresses grouped together. You can create a list of addresses, and 
assign a name to the list. Then to send an email to all addresses contained in the list, you just need to enter the 
assigned name of this list.

NOTE: This operation is not mandatory. Email addresses can be defined while launching individual queries. For 
more information, see Section 12.11.3, Parameterize queries.

12.5.17.1 Create a distribution list

To create an email distribution list, complete the following steps:

1. From the Email page, click Create addresses from lists.
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2. At the top of the screen, click Distribution lists.

Figure 12-16  Create distribution list

3. Enter a name for the list in the Name field. All existing individual email addresses appear in the Email 
address field.

TIP: You can enter up to 127 characters, symbols, and figures.

4. To create a list, select an email address. To select more than one address, hold down the Ctrl and Shift keys 
while selecting.

5. Click the Go  icon to accept the list creation, or the Cancel  icon to reject it and stop the operation.

12.5.17.2 Modify a list

To modify a Distribution list, complete the following steps:

1. Check the box to select the Distribution list you want to modify.

Figure 12-17  Modify Distribution list
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2. Check Modify parameters  to open the Modify a list page.

Figure 12-18  Modify distribution list content

TIP: You can modify the content of one or several fields by clicking on each field, and then entering the 
relevant information.

3. Click the Go  icon to accept the distribution list modifications, or the Cancel  icon to stop the 

operation.

12.5.17.3 Delete a list

To delete a list, complete the following steps:

1. Click to select the box next to the Distribution list you wish to delete.

2. Click the Delete  icon in the column heading(s).

Figure 12-19  Verify distribution list deletion

3. Click the Go  icon to accept the list deletion, or the Cancel  icon to stop the operation.

CAUTION: This operation cannot be canceled after it has been accepted.

12.5.18 Configuring the email server

When setting up your email server, you must configure the outgoing SMTP mail and the port.
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CAUTION: This information may only be known by the network administrator.

NOTE: You can only create one server configuration.

If the email server configuration has been defined, it will appear on your screen with its SMTP outgoing mail and 
port number. You will be able to create, modify, and delete your server configuration by using the task bar at the 
top of the page.

12.5.18.1 Configure the server

To configure the server, complete the following steps:

1. Click Configure the email server.

At Modify the server configuration,

a. Enter the Outgoing mail (SMTP) information.

b. Enter the Outgoing port number (SMTP).

c. Enter the User name and Password. This user name and password allows you to validate access to 
the email server.

d. If a Domain is required, enter the NETBIOS Domain name.

Figure 12-20  Modify server configuration

2. Click the Go  icon to accept the configuration, or the Cancel  icon to stop the operation.

NOTE: All configuration fields can contain up to 127 characters, symbols, and figures.

12.5.18.2 Modify the server configuration

To modify the server configuration, complete the following steps:

1. Click Configure the email server.
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Figure 12-21  Configure email server

2. On the Configuration screen, modify the content of one or several fields by selecting each field to enter the 
relevant information.

3. Click the Go  icon to accept the configuration, or the Cancel  icon stop the operation.

12.5.18.3 Delete the server configuration

To delete the server configuration, complete the following steps:

1. Click Configure the server.

2. On the Modify the server configuration screen, delete the information entered in the fields.

3. Click the Go  icon to accept the configuration, or the Cancel  icon stop the operation.

CAUTION: This operation cannot be canceled after it has been accepted.

12.5.19 Printer templates

With HP AC Job Accounting printer templates, you can define the costs associated with each model of printer and 
then apply that template to any printers declared on the HP AC Job Accounting print server. Printer costs can be 
managed and updated from one centralized interface.

HP AC Job Accounting allows you to define custom printer templates. A printer template contains various values 
related by default to a specific object type. For instance, a template for the HP LaserJet 9050 printer would 
contain all prices and costs associated with that printer, such as printer price, toner price, total number of printed 
pages, depreciation period, leasing cost, and maintenance cost.

For more information on actual costs, see Section 12.8, Manage print costs.

A template can be allocated to one or several printers. These printers will automatically inherit the values 
associated with this template as actual costs. You can manage your actual costs by clicking Page cost 
management in the HP AC Job Accounting remote control.

Any printer tracked by HP AC Job Accounting can be associated as the default, with a set of predefined prices and 
costs that are used when you launch cost queries.

Section 12.5   HP AC Job Accounting administration 403



To create a template, assign a template to a printer, modify a template, or delete a template, click Printer 
templates on the Administration page.

Figure 12-22  Printer template selections

The templates management task bar allows you to create a template or assign a template to a printer.

12.5.19.1 Create a printer template

To create a printer template, complete the following steps:

1. To begin template creation, click Create a template from the Printer templates page.
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Figure 12-23  Create a template

2. Enter the template name.

NOTE: This is a required field.

3. Enter the costs in fields provided, as desired.

NOTE: Use a decimal point in costs (such as 20.00) and years as the unit of time.

4. Use the drop-down list in the Currency field to define the currency for your costs.

5. Click the Go  icon to accept the data, or the Cancel  icon to stop the operation.

NOTE: You must provide information in the Template name field.

12.5.19.2 Assign a printer template

A single template can be assigned to a single printer or to several printers. However, the opposite is not true; 
several templates cannot be assigned to one printer.

To assign a template to a printer:

1. Select a template to assign.
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2. Click Assign a template to a printer.

Figure 12-24  Assign a template

This page lists all printers tracked by HP AC Job Accounting on your print network. Each line in this list 
represents a printer in this format:

\\print server\printer.

The template name appears at the top of the page.

3. To assign the template, select a printer. To select multiple printers, use the Ctrl and Shift keys on your 
keyboard.

4. Click the Go  icon to accept the assignment, or the Cancel  icon to stop the operation.

12.5.19.3 Modify a printer template

You can modify all costs defined in your printer template. You cannot modify the template name. You can only 
modify one template at a time.

1. Select the template to modify.

2. Click the Modify  icon.

3. Modify your data as desired.

4. Click the Go  icon to accept the modifications, or the Cancel  icon to stop the operation.

NOTE: If you entered a new printer price, it will dynamically appear in the printer costs. Any modification to a 
printer template will change the actual costs of this printer. HP AC Job Accounting will automatically re-calculate 
costs.

12.5.19.4 Delete a template

To delete a template, complete the following steps:
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1. From the template management screen, select the template to delete.

Figure 12-25  Select templates to delete

2. Click the Delete  icon in the title bar of the list. The template appears on your screen.

Figure 12-26  Verify template selection

3. Click the Go  icon to accept the modifications, or the Cancel  icon to stop the operation.

CAUTION: This operation cannot be canceled after it has been accepted.

12.6 Configuring data collectors

12.6.1 HP Access Control (HP AC) Agent

The HP Access Control (HP AC) Agent allows you to capture data directly from a network printer, and functions 
even if the HP AC Job Accounting print server direct tracking module is not installed.

12.6.2 HP Statistics

HP Statistics is a method of capturing data directly from an HP FutureSmart printer.

NOTE: All HP FutureSmart device administrator user names and passwords must match the Device 
administrator user name and password in the HP Access Control (HP AC) tool. Go to the Settings tile > Device tab 
of the HP Access Control (HP AC) tool to enter the Device administrator user name and password.

To select what device information you want to display in HP AC Job Accounting reports, go to the Settings tile > 
Device tab.
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● Select Device name to display the device names in job accounting reports.

● Select Network name to display the host names of devices in job accounting reports. Make sure the Get 
community name is entered in the SNMP section to be able to read the network/host names of devices.

Click Apply.

To configure an HP FutureSmart device for tracking, complete the following steps:

1. Go to the Devices tile.

2. Select the HP FutureSmart device from the device list, then click Configure.

3. Select Tracking. Click OK. An X displays under the Tracking column, indicating the HP FutureSmart device is 
configured for tracking.

When multiple FutureSmart devices of the same model have the same device name, only one device is reported 
in Job Accounting. Therefore, devices of the same model must have unique device names for correct tracking. To 
change the device's name to be the device's host name, complete the following steps:

1. Go to the Networking > TCP/IP Settings > Network Identification page of the device EWS to determine the 
Host Name of the device.

Figure 12-27  Device Host Name

2. Go to the General > Device Information page. In the Device Name field, enter the device's Host Name. Click 
Apply.

Figure 12-28  Device Name

After jobs are tracked and the XML files are processed, you will see all your devices listed in Job Accounting.

After the XML files are processed, you will see all your devices listed in Job Accounting.

408 Chapter 12   Job Accounting



12.6.3 HP Access Control (HP AC) Job Accounting print server

This portion of the Administration Module allows you to view the status of HP AC Job Accounting print server 
printers, as well as schedule job retrievals for printers configured as tracked printers on a print server, and 
DesignJet.

To view a list of both Windows printers and HP AC Job Accounting printers for the selected HP AC Job Accounting 
print server, from the Printers List column, click View.

Figure 12-29  Administration / Print server status

The Printers List screen shows the list of installed Windows printers.

Figure 12-30  Printers list

Before HP AC Job Accounting can track a printer, it must be identified by the Print Server tile.

1. Go to the Print Server tile.
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Figure 12-31  Print server tile

2. Select a printer from the printer list, then click Configure.

3. In the Configure window, select the features you want to configure:

● Click Tracking enable tracking of print jobs sent to the selected print queue. The print queue tracking 
method can be either Port Monitor or Print Processor, depending on what is selected in the Settings 
tile > Print Server tab.

● Click Quota to enable the enforcement of Job Accounting quotas for printing.

● Click IPM to apply IPM rules and costs to the printer. See Intelligent Print Management.

● Click Add tracking PJL attributes to insert Job Accounting PJL attributes in the data stream. If an 
application generates a data stream that does not include the PJL header containing the user and job 
information, the user and job name are reported as UNSPECIFIED in Job Accounting reports.

● Click Pause job to automatically pause print jobs in the print queue. Print jobs must be manually 
resumed by an administrator. Pause job is only available when Port Monitor is selected in the Settings 
tile > Print server tab. The Windows service HP ACJA Spool Monitor must be started. Go to 
Administrative Tools > Services to start the HP ACJA Spool Monitor service. Click OK.

If you installed and are running HP Access Control (HP AC) Configuration Utility on a remote print server, you will 
have the following options to configure printers:

1. From the print server, open HP AC Configuration Utility and go to the Settings tile.

2. Click to open the IIS tab.
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Figure 12-32  Print server settings

If desired, printer data can be auto-loaded (pushed) to the HP AC Job Accounting server through one of these 
transfer protocols: FTP, HTTP, or HTTPS.

● File Transfer Protocol (FTP) is a standard for transferring files between computers with different operating 
systems. FTP is best for uploading data to an internal database server.

● Hypertext Transfer Protocol (HTTP) differs from FTP, since connections are usually terminated after a 
particular request (or series of requests) has been completed. HTTP is the preferred method of data 
transfer if your database server is located off-site, or beyond your firewall.

Additional settings include Server Name, which Server Port to use when transferring the data, server Login name, 
Password, and an Initial Folder in which to store the uploaded data.

IMPORTANT: In order for the push mode settings to work properly on Windows Server 2008, WebDAV must be 
enabled on the server. This allows tracking data to be sent to Job Accounting. Add the Web Server (IIS) role to 
your server and select all the IIS components showed in the image below. The WebDAV Publishing component is 
not included on IIS 7 and needs to be installed separately as an additional IIS 7 component on your 2008 server. 
The FTP Server component has to be installed only if you are planning to push the XML or IPA files via FTP. If you 
are planning to push the files via HTTP, the FTP Server is not necessary.
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Then enable Microsoft .NET Framework 3.5 Features.
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If you are planning to use HTTP, you need to enable the WebDAV component. In IIS Manager, in the Connections 
pane, expand the Sites node in the tree, then click the Default Web Site. As shown in the image below, double-
click the WebDAV Authoring Rules feature.

When the WebDAV Authoring Rules page is displayed, click the Enable WebDAV task in the Actions page.
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Once in the WebDAV Authoring Rules section, click Add Authoring Rule... (from the Actions menu on the right). 
From Add Authoring Rule, select All users, and for Permissions select read, source, write. Click OK.

TIP: To validate that a device is pushing files correctly, navigate to the folder in the directory where HP Access 
Control (HP AC) is installed, and locate the Temporary folder for FTP push and Temporary DTM for HTTP push. 
The Temporary folder should contain a set of folders for each device that has successfully pushed a tracking file 
(.xml) to HP AC Job Accounting. The folders are identified by the device IP address. The following figure shows 
the default installation directory Program Files\HP\HP AC\Temporary.
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Figure 12-33  Device folder

FTP mode pushes files in ..\HP AC\Temporary\x.x.x.x folder, where x.x.x.x is the printer IP address.

HTTP and HTTPS modes push files in ..\HP AC\Temporary\DTM folder. The file name starts with the printer IP 
address.

TIP: The push interval can be set to 0 for real-time push.

1. Click the Snmp tab. The default SNMP setting is “public” for Set and Get. If values are changed on the 
devices, all devices must have the same value or no value (public).

The default Trap level is Printer Confirmation traps. In the default mode, only printed job traps are sent. 
This is used to reduce the network traffic with unwanted traps. Some versions of HP JetDirect require that 
All traps mode is selected.

2. Click Save to save the new configuration information.

12.6.4 DesignJet configuration

NOTE: This section applies only to DesignJet printers with built-in Job Accounting.

Some DesignJet models such as the 4000, 4500, Z610, and T1100PS have a built-in tracking function which 
allows HP AC Job Accounting to parse the XML accounting file. To enable this feature, the DesignJet must be 
installed and configured locally on an HP AC Job Accounting print server, allowing HP AC Job Accounting to 
retrieve the IP address and the queue name.

Configure networked DesignJet printers by clicking the Modify  icon in the DesignJet configuration column on 
the HP AC Job Accounting print server Administration screen.
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Figure 12-34  DesignJet configuration

To start tracking a DesignJet printer, simply select the DesignJet from the list on the left and click the right arrow 
between the columns:

Figure 12-35  Add or remove DesignJet printers

To stop tracking a DesignJet printer, select it from the right list and click the left arrow between the columns.

12.6.5 Schedule job retrieval

The HP AC Job Accounting administrator can use the Schedule job retrieval function to determine precisely when, 
how frequently, and by what method (pull or push) HP AC Job Accounting retrieves job data.

NOTE: For large networks, it is recommended that job retrieval be performed outside of regular business 
hours.

To access the schedule parameters, click Schedule job retrieval on the HP AC Job Accounting print server 
Administration page.
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Figure 12-36  Schedule job retrieval

NOTE: If Auto-Upload is selected, the interval may be set to 0 for real-time processing.

12.6.6 Schedule multi-vendor retrieval

In order to track data at multi-vendor devices, the devices must be configured for Tracking from the Devices tile. 
Tracking data is retrieved and processed to Job Accounting when the mvtracking.exe file (located in the \HP 
Access Control\bin folder) is run as an administrator. To schedule retrieval of multi-vendor tracking data, go to 
Job Accounting > Administration > Multivendor Job Scheduler.

12.6.7 Schedule DesignJet retrieval

DesignJet retrieval can be scheduled to occur at a designated start time on one or more days of the week, or 
regularly at a specific time interval.
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To access the schedule parameters, click Schedule DesignJet retrieval on the HP AC Job Accounting print server 
Administration page.

Figure 12-37  Schedule DesignJet retrieval

If Account ID is enabled in the driver, HP AC Job Accounting can report the account ID as the User name. By 
default, the login name is reported.

12.6.8 SAP tracking

SAP must be configured to report the user name in the job name (consult SAP for more details on how to 
configure SAP queues).

To access the SAP user name tracking parameters, click SAP tracking on the HP AC Job Accounting print server 
Administration page.
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Figure 12-38  SAP tracking

If Yes is selected from the Enabled drop-down list, HP AC Job Accounting will search for the user name in the job 
name for all jobs printed by the SAP user name that is defined (the default user name is SYSTEM).

HP AC Job Accounting will extract the user name at the selection position and extract only the number of 
characters selected.

If default parameters are used for all jobs printed by the user SYSTEM, HP AC Job Accounting extracts 8 
characters from the job name, starting at position “8” — and uses this as the user name for the job.

Example: If the job name is “Job_abc_USER1234_xyz” and is printed by user SYSTEM, HP AC Job Accounting will 
report this job printed by user USER1234.

12.6.9 Direct Tracking Module (DTM)

The Direct Tracking Module (DTM) is another method of capturing data directly from a network printer and 
functions even if the HP AC Job Accounting print server module is not installed.

In order for the DTM to work, ALL of the following conditions MUST be met:

● Printer must be manufactured by HP.

● JetDirect should be installed and connected directly to the network (not locally through USB or LPT1).

● Correct/current printer drivers with Job Accounting information must be installed.

● Printer must be capable of sending a trap.

NOTE: A trap is a packet of information provided by the printer that indicates basic job information and print job 
status.

In the Devices tile, select a device from the device list, then click Configure. In the Configure window, select 
Confirmation trap. Click OK.

When the selected printer receives a job, corresponding trap information appears in the Trap section on the 
right.

Section 12.6   Configuring data collectors 419



Figure 12-39  DTM Trap

12.6.9.1 DTM options

To configure the DTM from a DTM server that is not on the same server as the HP AC Job Accounting server, open 
the HP Access Control (HP AC) Configuration Utility and go the Settings tile > IIS tab.

Figure 12-40  DTM options

If desired, printer data can be auto-uploaded (pushed) to the HP AC Job Accounting database server (DS) through 
one of three transfer protocols: FTP, HTTP, or HTTPS. Push features are enabled only if the DTM server is not 
installed on the HP AC Job Accounting database server.

The Device tab provides additional options to configure DTM.
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Figure 12-41  Snmp options

The default setting is “public” for Set and Get. If values are changed on the devices, all devices must have the 
same value for Set and Get, or no value (public).

The default Trap level is Printer Confirmation traps. In the default mode, only printed job traps are sent. This is 
used to reduce the network traffic with unwanted traps. Some versions of HP JetDirect require that “All traps” 
mode is selected.

The trap service is using the default 162 UDP port. If the port is used by another application or service on the 
same server, HP AC Job Accounting Trap service can use another port. If the port is changed, the HP AC Job 
Accounting Trap service (HPACJA_SnmpTrap) needs to be stopped and restarted and the printer reconfigured 
using the new port.

The Filter Delay is used if JetDirect sends the same trap multiple times in a very short interval. This occurs on 
external JetDirect 300x and 500x. The delay value can be set to 50 ms for 300x and 500x. For others devices, 
the default value can remain at 0.

12.7 Viewing the print server
This HP AC Job Accounting function allows you to view the organization of your print system—all HP AC Job 
Accounting print server and all printers linked to each HP AC Job Accounting print server tracked by HP AC Job 
Accounting. This module also automatically corrects print job errors and only tracks actual output.

Click Print organization in the HP AC Job Accounting remote control panel:
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Figure 12-42  Print organization

This page is divided into two parts:

The left lists all print servers. Click the printer name in this column will display all individual printers connected to 
that server on the right.

On the right are all printers managed by the print server selected on the left. If you click on another print server, 
the printer list and the server name on the right will dynamically change.

The following icons may appear on this page:

 When displayed in the Status column, this indicates the HP AC Job Accounting print server is currently 

running. The Duplex or Color columns show if the printer is capable of duplex or color printing.

 The Status column shows that the HP AC Job Accounting print server is not installed; and is also used to 

indicate simplex or black and white printers.

 Indicates that the HP AC Job Accounting is unable to determine the printer's duplex or color capabilities, and 

should be manually configured by the user.

12.7.1 Print servers

Print servers are displayed on the left side of the screen. These servers appear in the order in which they were 
created in HP AC Job Accounting.

Click a print server in this column, and all printers managed by this server will be listed in the right column. This 
list provides the printer’s local name, port name, driver name, and all available functionalists for each printer 
(color, duplex printing). The columns Local name and Sharing name can be sorted in ascending or descending 
alphabetical order if you click on the titles of the columns.
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Figure 12-43  Print server column

12.7.1.1 Printers

Click a printer port to get the characteristics of this printer. This reaches the internal web site of the printer, 
allowing you to determine its status and administer its configuration.

Figure 12-44  Printer internal website

HP AC Job Accounting has an auto-detect feature that determines the type of printer connected and configures 
accordingly. However, it may be unable to auto-detect the printer under the following conditions:

● If the printer is not manufactured by HP, Inc.

● If the printer is offline.

● If the printer is installed locally (LPT1 or USB) and not on the network.
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Figure 12-45  Manually define printer

After specifying the type of printer, click the Go  icon to accept the information, or the Cancel  icon to 

stop the operation.

12.8 Manage print costs

12.8.1 Cost control overview

One of the main HP AC Job Accounting benefits is its ability to produce extremely accurate printing cost 
information and employ enterprise-level print cost control solutions in your organization. The cost of a printer is 
linked to many factors:

● Accessories

● Maintenance

● Technology (such as whether it is a laser printer)

● Color

● Quality

● Speed

● Depreciation time

Each of these factors involves a cost, which determines the cost of each printed page. To secure accurate billing, 
the exact number of printed pages and associated costs must be determined. After this information is compiled, 
the cost of a print job can be calculated. If the cost of any printer, media, or other element is updated or 
modified, the resulting cost of all print jobs related to this printer, media, or other element will also be 
dynamically updated.

CAUTION: The cost of media is independent of the printer. Media cost depends on the price of the paper in this 
particular format and quality. HP AC Job Accounting automatically calculates the cost of a print job according to 
the defined costs and the number of printed pages.

In addition to calculating the actual price of each print job or page, HP AC Job Accounting also enables you to 
assign a fixed cost to a print job or to a printed page. These user-defined costs do not take into account the real 
price involved in the print process, but rather printing characteristics, such as the media or the color mode. For 
more information on these fixed costs, see Section 12.8.4, Define fixed costs.

You must enter the cost of all printers and media if you want to launch queries related to costs. If any of this 
information is missing, all your query results containing cost information will be inaccurate.
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CAUTION: If a printer’s purchase price has been defined for a printer using a printer template, it is not necessary 
to redefine this cost, since it automatically becomes the real purchase price for this printer.

12.8.2 Cost management page

Click Page cost management in the HP AC Job Accounting Remote control panel to reach the printer selection 
page. This page allows the selection of a print server and printer, for which cost information must be entered:

Figure 12-46  Page cost management

The print server/printer list is a dynamic list of all print servers and printers used at least once in your print 
system since the initial HP AC Job Accounting installation. You can select one or more printers, to which common 
costs apply. Hold the Ctrl or Shift keys while clicking to select a range of choices.

The printer selection page appears by default when you click Actual Costs: printers in the task bar at the top of 
the page.

An icon may appear between the task bar and the printer list, as follows:

Figure 12-47  Processing icon

This icon indicates that HP AC Job Accounting is calculating costs. This can happen when new costs are entered, 
or when defined costs are modified or entered.

12.8.3 Actual costs: printers

There are often several costs associated with printers; such as toner/ink, media, maintenance, and warranty. The 
actual cost of a printer is determined by a combination of these variables. These costs are different than 
templates, where a default cost is associated to one or several printers without taking into account the actual 
costs of each printer. These costs are also opposed to fixed costs, where only one of these actual cost 
components is taken into account—for instance, when only the media format of the paper is used to determine 
a document printing charge.
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12.8.3.1 Manual actual costs

To manage your actual costs:

1. Select one or several print servers or printers on the Page cost management screen selection page.

2. Click the Go to open Page cost management page. Actual printer costs may be viewed here.

Figure 12-48  Actual printer costs

The print server and printer you selected appear at the top of the page. Any costs defined for these printers 
appear in the list.

From this screen, you may:

● Create the actual costs attached to a printer by clicking Create a cost.

● Modify the actual cost attached to a printer. Select the cost to modify and click the Modify parameters 
icon.

● Delete the actual cost attached to a printer. Select the cost to delete and click the Delete  icon.

12.8.3.2 Create actual printer costs

To create an actual cost, enter the appropriate information in Create cost as follows:
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1. Choose a name for the cost. The default name is Cost_(the cost number). Enter up to 15 characters, 
symbols, or figures.

2. Choose a cost Type from the drop-down menu: Printer, Toner, Color toner, Warranty, Maintenance, Leasing, 
or Miscellaneous.

3. Enter the Purchase / subscription cost to apply. You can enter up to 8 values. The currency used appears 
next to the cost entry field. This currency is defined in your user options. See Section 12.10, HP AC Job 
Accounting user options.

4. Choose the Depreciation start date. By default, it is today’s date. You can choose a date between 
01/01/1990 and 12/31/2100.

NOTE: Do not enter depreciation start date or period for toners. Only the number of printed pages is 
relevant to depreciation allowances. The printer manufacturer provides this information.

5. Enter the Planned print volume (pages/years). You can enter up to 15 figures. The HP AC Job Accounting 
administrator must estimate this number, except for toner.

6. Enter the Depreciation time (in years). Year is the only available time unit. You can enter up to 15 figures. 
The HP AC Job Accounting administrator must estimate this number.

Figure 12-49  Create a cost

For the first year, enter an accounting evaluation of the depreciation time of your printer. You must also evaluate 
the number of pages to be printed over this depreciation period. For the following years, you will be able to enter 
values based on the information provided by HP AC Job Accounting. The currency used to express this cost is 
defined in your user options.

HP AC Job Accounting defines the cost of your printing jobs according to the number of printed pages per job. 
The cost of a printing job depends on:

● The page-printing mode: is this page printed in duplex or simplex mode? The duplex mode reduces your 
printing cost, since you need less paper to print a document.

● Ink price and the color or black and white printing mode.

● Depreciation time of the various components and costs associated with the printer such as purchase price 
or guaranty.

● Printing quality (such as standard vs. fine quality printing, or ink coverage defined by the user) and the 
media used.
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The following limitations apply when calculating these costs:

● HP AC Job Accounting does not include the ink coverage on the page. A one-line page will be charged at the 
same price as an entire printed page.

● The cost of electricity is not included.

NOTE: HP AC Job Accounting recognizes when a print job is canceled.

12.8.3.3 Modify a printer actual cost

After selecting the cost to modify and clicking the Modify parameters  icon, you reach the cost entry page. 
This page contains all information you previously entered regarding this cost.

NOTE: If you already defined a template for your printer and want to modify your data, you must use this 
section and not add a new cost using Create a printer cost. When you modify any cost, HP AC Job Accounting 
calculates all print job costs in its database. If a toner cartridge must be replaced you should not create a new 
toner cost, which would add to the total toner cost, but modify the cost of the former toner.

To modify costs, as desired, click the Go  icon to accept the modifications, or the Cancel  icon to stop 

the operation.

12.8.3.4 Delete a printer actual cost

You should delete the cost of any component or option which will not be sued again, or which is obsolete.

NOTE: All print jobs in the HP AC Job Accounting database will be recalculated when there is any cost deletion.

To delete a printer actual cost:

1. Select the cost to delete and click the Delete  icon.

2. Click the Go  icon to accept the cost deletion, or the Cancel  icon to stop the operation.

Figure 12-50  Delete printer cost

12.8.3.5 Actual costs: media

The price of a media depends on the paper size and type (for instance glossy, transparent paper, and weight). 
Use the following steps to enter a media price.

1. Click Actual costs: media.
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Figure 12-51  Actual costs: media

The media list which displays consists of all combinations of media size and type used at lease once since 
HP AC Job Accounting installation.

2. Choose a combination and then click the Go  icon.

3. Enter the desired amount on the Media page.

Figure 12-52  Media costs

CAUTION:

● If a printer’s purchase price has been defined for a printer with a printer template, it is not necessary to 
redefine the cost, since it automatically becomes the real purchase price for this printer.

● The price of media is calculated using the price of one sheet of paper in this particular format. It does not 
depend on the printer, or print organization.

All costs are expressed in the currency defined in Section 12.10.1.1, User options. To change the currency type in 
which these costs are expressed, see Section 12.10, HP AC Job Accounting user options.

12.8.4 Define fixed costs

This feature allows you to set a fixed price per page or for an entire document according to its characteristics, 
without taking into account the actual cost of this document.
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For example, assume you want to monitor your company’s printing expenditure. You want every A4 document to 
be charged $0.2, regardless the number of printed pages or the mode used. This price should be set in the fixed 
cost management page.

12.8.4.1 Fixed costs

The Fixed costs management screen contains all defined fixed costs: name, amount of each fixed cost, and 
currency used. Click Fixed costs to open the Fixed costs management page:

Figure 12-53  Fixed costs management

From within Fixed costs you can Create a fixed cost or define the Costs priority rules

Create a fixed cost:

Select one or more elements in one or more criteria. You can combine several criteria by holding the Ctrl or Shift 
keys—an A4 document can cost $0.2, a color document $0.4, and an A4 color document $0.6.

Enter the price for all selected criteria. You can enter up to 8 figures in this field. The currency used appears next 
to the entry field. This currency is defined in your user options.

When your selections and prices are entered, click the Go  icon to accept the information, or the Cancel 

icon to stop the operation.

Actual costs will be assigned to all criteria for which no fixed cost is entered. These actual costs are those 
associated to printers, media, and trays.

As soon as HP AC Job Accounting detects a new element of a criteria (such as a new user or a new printer), this 
element is automatically added to the criteria list. If you want to associate your fixed cost to this new element, 
you should modify your fixed cost by reselecting this element in your criteria. However, if you select All for this 
criteria, it is not necessary to re-select it. All means that all elements in these criteria are automatically 
considered.

NOTE:

● The Name field is required.

● If you define two fixed costs for the same criteria and elements the latest cost is considered.
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Figure 12-54  Create a fixed cost

Costs priority rules: A problem may arise when several costs for a combination of common criteria have been 
defined.

Example: Document A printed in letter format costs $ 0.2, document B printed in color mode costs $ 0.3, and 
document C printed in letter format and color mode costs $ 0.5. At this point, priority must be assigned to these 
fixed costs.

NOTE: The priorities defined in this section apply to all fixed costs. You cannot specifically define a priority order 
to some of your fixed costs.

After fixed costs are defined, click Costs priority rules.
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Figure 12-55  Costs priority rules

The list of criteria appears in default priority order. The criterion at the bottom of the list contains the lowest 
priority. The criterion with the highest priority is at the top of the list. If these priorities do not suit your own 
priority order, you can modify by clicking on a criteria, then by clicking Increase priority or Decrease priority icons 
to move the selected criteria up or down as desired. Repeat this operation for all relevant criteria.

Figure 12-56  Costs priority rules defined

When you launch a cost query, the fixed cost that is first selected corresponds to the criteria with the highest 
priority.

NOTE:

● You must enter priorities when you have more than one fixed cost.

● All criteria have a default priority.

● All criteria for which ALL is selected have the lowest priority.

● Any priority change involves recalculating your costs. Depending on the size of the print jobs database, this 
operation may take several minutes.
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HP AC Job Accounting analyzes the three documents described at the beginning of this section according to their 
characteristics and the priority assigned to these characteristics.

Table 12-1  Media priority

Document Media Printing Mode Cost

C Letter Color $0.5

B All Color $0.3

A Letter All $0.2

As document C matches two criteria, it will be assigned $0.5 as cost. Then the priority is given to the color-
printed document. If no other criterion matches a priority, the document is charged according to its media cost.

12.8.4.2 Modify a fixed cost

Complete the following steps to modify a fixed cost:

1. Select the cost to modify, and click the Modify parameters  icon. The Modify a fixed cost page contains 
information already entered regarding this cost.

Figure 12-57  Modify a fixed cost

2. After you have modified the desired data, click the Go  icon to accept the modification, or the Cancel 

 icon to stop the operation.
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CAUTION: For any modification of your fixed costs, HP AC Job Accounting will recalculate any cost related to the 
modifications. This operation, depending on the quantity of jobs tracked in the database, can take several 
minutes.

12.8.4.3 Delete a fixed cost

1. Select the fixed cost to delete and click the Delete  icon. The name of the cost appears at the top of 

the page.

Figure 12-58  Delete a fixed cost

2. Click the Go  icon to accept the cost deletion, or the Cancel  icon to stop the operation.

NOTE: After a fixed cost has been deleted, the actual cost of each printed page is used to calculate 
printing costs. When fixed costs are deleted, HP AC Job Accounting recalculates any cost concerned with 
these deletions. This operation, depending on the quantity of jobs tracked in the database, can take several 
minutes.

12.8.4.4 Lease costs

The cost of leasing can depend on a monthly lease rate or a per-page rate for color or black-and-white printing, 
faxing, or copying. Use the following steps to manage the lease costs for a printer:

1. Click Leasing costs in the bar at the top of the page.
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Figure 12-59  Leasing costs

2. Choose a Printer from the list. You can select one or more printers to which common costs apply. Hold the 

Ctrl or Shift keys while clicking to select a range of choices, and then click the Go  icon to open the 

table displaying current leasing cost parameters for the selected printer.

Figure 12-60  Modify leasing costs

● To set or change the leasing costs for an entire group of printers, click Modify leasing cost.

● To set or change the leasing costs for a single printer, click the box to the left of the printer name, and then 
click the Modify  icon.
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Figure 12-61  Modify a cost

Add or change monthly lease and per-page costs for the printer in the fields provided. Click the Go  icon to 

accept the changes, or the Cancel  icon to stop the operation.

All costs are expressed in the currency defined in User options. To change the currency type in which these costs 
are expressed, see Section 12.10, HP AC Job Accounting user options.

NOTE: The Cost Calculation does not need to be enabled if only Leasing costs is used. The calculation is 
performed when the query is processed.

12.8.4.5 Schedule: Costs calculation

1. Click Schedule costs calculations on the navigation bar.
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Figure 12-62  Schedule: Costs calculation

2. Select Schedule parameters:

Days

Start time

End time

Enabled Allows you to toggle the scheduling feature on or off. When checked, the process is started and 
calculation is done. When unchecked, the calculation is disabled.

If Recalculate costs from is enabled, all the jobs printed after the selected date will be recalculated with the 
current cost information. Jobs printed before the date will not be affected if a cost is changed.

12.9 Cost center

12.9.1 Managing or creating

Cost centers are another method the administrator can use to organize, group, and track output of printers or 
users. After cost centers are created and assigned, you can perform queries to determine individual or collective 
use of cost centers.

To either manage or create cost centers, click Cost center in the HP AC Job Accounting remote control:
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Figure 12-63  Cost center — manage or create

12.9.1.1 Manage a cost center

Cost centers must be created before users or printers can be assigned to them. This process can be performed 
manually by the administrator, or automatically by importing a CVS file. The steps for creating cost centers are 
explained in the following sections.

12.9.1.1.1 Add a cost center

To add a cost center manually:

1. Enter a name for the cost center in the Add a cost center field.

2. Click Add a cost center button to add a new cost center to the list.

12.9.1.1.2 Import a cost center

When adding a large number of cost centers, printers, or users, it is quicker and more efficient to import a 
standard CSV file containing the data. This method also allows for both cost center creation and user/printer 
assignment to occur in a single step.

CSV files can be generated through a spreadsheet program, or simply typed with a text editor and saved as 
shown below:
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Figure 12-64  Import cost center data

NOTE: When importing a CSV file, user names and printer names MUST match those being tracked by HP AC 
Job Accounting.

To import cost centers,

1. Enter the path of the CSV file in the field or click Browse and locate it.

2. Specify whether to use a CSV with header.

3. Indicate in the field which column of the CSV file contains the names of the cost centers you wish to create.

To assign users or printers to the imported cost center automatically, enter the column number that contains the 
user name or printer in the appropriate field.

NOTE: You can assign either a user name or printer to imported cost centers – not both.

12.9.1.1.3 Delete a cost center

Use the following steps to delete a cost center:

1. From the Manage cost center page, select the desired cost center from the list on the right and then click 

the Delete  icon.

2. Click the Go  icon to accept the deletion, or the Cancel  icon to stop the operation.

Figure 12-65  Delete a cost center

12.9.1.2 Assign users to a cost center

After cost centers have been created or imported, use the following steps to assign user names to them.
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1. Click Assign users to cost center to access the following page:

Figure 12-66  Assign users to cost center

2. Select from the list of Available users in the left column.

TIP: The list of available users can be filtered by using the drop-down menu above it.

3. Choose a cost center from the drop-down menu on the right.

4. Click the Assign icon to assign the user to the desired cost center.

To remove all users, click the Delete icon to delete the all users from the list and then automatically import all 
users tracked by HP AC Job Accounting.

12.9.1.3 Assign printers

Assigning printers to a cost center is very similar to assigning users. After cost centers have been created or 
imported, printer names can be assigned to them.

1. Click Assign printers to cost center to display the following page:
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Figure 12-67  Assign printers to cost center

2. Select from the list of Available printers in the left column.

TIP: The list of available printers can be filtered by using the drop-down menu above it.

3. Choose a cost center from the drop-down menu on the right.

4. Click the Assign icon to assign the printer to the desired cost center.

12.10 HP AC Job Accounting user options

12.10.1 Options

During the initial installation of HP AC Job Accounting, some options are set by default, such as the language and 
the currency used in the application. These default options are set according to the language defined by your 
operating system. When using HP AC Job Accounting you can change the following options:

● Language

● Currency

● Date format

● Number of lines displayed in HP AC Job Accounting lists

● Password

● Email address

The columns of the query table can be accessed by clicking User options in the HP AC Job Accounting remote 
control.

Any modifications performed to these options are only valid for the user whose login is currently being used.
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Click User options in the remote control to reach the general user summary for all user options: language, 
currency, interface, and date format, as well as your electronic address and the number of lines displayed in the 
HP AC Job Accounting lists.

Figure 12-68  User options

From User options you can modify the following:

● Options appearing in the general options page

● HP AC Job Accounting account password

● Information provided for all launched queries

Use the task bar located at the top of the screen to make any of the changes listed above.

12.10.1.1 User options

Click User options in the task bar and the following page appears:

Figure 12-69  Define user options

Your user name appears at the top of the page. To accept one or several modifications performed on this page, 

click the Go  icon, or click the Cancel  icon to stop the operation.
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12.10.1.1.1 Language/currency

Choose a language and a currency from the pull-down menus. The languages already defined in HP AC Job 
Accounting are:

Table 12-2  Language/currency

Czech Korean

Dutch Polish

English Portuguese

Finnish Simplified Chinese

German Spanish

Hungarian Swedish

Italian Turkish

Japanese Traditional Chinese

Currencies already defined in HP AC Job Accounting are:

● US Dollar

● Euro

● British Pound

CAUTION: You can add currencies, but you cannot add languages. For more information regarding currency 
management, see Section 12.5.2, Currencies.

12.10.1.1.2 Number of lines in lists

You can modify the number of lines displayed in all HP AC Job Accounting lists such as the query table, the 
results list of a recurring query, or the list of print servers and printers in the Print Organization menu. The 
default number of display lines in one list is 10.

To change the number of display lines, enter the number you want in the Number of lines in lists lines field.

NOTE: Your data is not affected by this change.

For example, a query table with 10 display lines appears as follows:
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Figure 12-70  Query table with 10 lines

The same query table with 5 display lines appears as follows:

Figure 12-71  Query table with 5 lines

NOTE: You can sort all queries in the query table by ascending, descending, or alphabetical order by clicking the 
column title. To sort all your queries, and not only the queries displayed on the current page, all queries must be 
displayed on one single page. To display all queries on one page, enter 0 in this field.

12.10.1.1.3 Email address

You can forward query results to a specified email address. Any HP AC Job Accounting user or administrator can 
define their email address.

Use the following steps to define an email address:

1. Click in the Email address entry field.

2. Enter/modify your address as desired. You can enter up to 127 characters, symbols, and figures. Your email 
address appears each time you reach this page.

12.10.1.1.4 Data format

Date formats differ depending upon the country/region in which you reside. HP AC Job Accounting allows you to 
configure the date format displayed in the application.

1. Click on the preferred format.

2. Click the Go  icon to accept the configuration, or the Cancel  icon to stop the operation.
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12.10.1.2 Set passwords

The HP AC Job Accounting administrator defines your password when the HP AC Job Accounting account is 
initially created.

Use the following steps to reset the password:

1. Click Change password.

2. Enter the new password in both fields.

Figure 12-72  Change password

CAUTION: Passwords are case-sensitive.

3. Click the Go  icon to accept the new password, or the Cancel  icon to stop the operation.

NOTE: It is highly recommended that you change the password of the Admin account.

12.10.1.3 Queries in progress

Columns

To modify content within the table, from Users options:

1. Go to Queries in progress and select the desired columns.
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2. Click Columns on the User options page to get the list of all displayed columns:

Figure 12-73  Query columns

By default, all options are highlighted.

3. Uncheck the title of the columns you want to hide.

4. Click the Go  icon to accept the selections, or the Cancel  icon to stop the operation.

12.10.1.4 Print organization

To generate a list of all displayed columns, complete the following steps:

1. Go to Print organization.
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Figure 12-74  Print organization columns

2. Uncheck the title of the column(s) you wish to hide.

3. Click the Go  icon to accept the selections, or the Cancel  icon to stop the operation.

12.11 Perform a query

12.11.1 Queries

Use HP AC Job Accounting’s tracking function to get statistical data related to your printed documents, printing 
system, or costs. HP AC Job Accounting only manages print jobs processed by HP AC Job Accounting print 
servers. They are created by end users and can be of any format: text, spreadsheet, word processing, or 
databases.
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While the print job is being processed, the HP AC Job Accounting print server analyzes its characteristics, which 
are then sent to the HP AC Job Accounting Database Server to be stored. This data includes the following 
characteristics:

● End users (name, login)

● Printers (name, model, driver, characteristics)

● Print jobs (document title, printer, number of printed pages, color media, costs per page and per printer 
model)

● Total print number per user, per printer and per day

● Workload for each printer to determine the printer’s efficiency

● Statistics for each printer

● Statistics for each time period

● Statistics for each end user

These characteristics are easily retrieved by running queries. The data is then presented in one or more formats 
(table, chart, or spreadsheet).

12.11.1.1 Initiate a query

Queries can be initiated by clicking New Query on the HPAC Job Accounting remote control. This chapter 
describes the following:

● The various types of queries.

● How to run a query.

● How to modify your query parameters.

12.11.2 HP Access Control (HP AC) Job Accounting queries

The New Query page can be accessed by clicking New Query on the HP AC Job Accounting remote control.
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Figure 12-75  New query

This page is divided into three main areas:

● The query navigation bar at the top of the page.

● The query types in the middle of the page.

● The task icons at the bottom of the page.

The query navigation bar allows queries to be initiated on:

● Users who have printed at least once since HP AC Job Accounting installation.

● Printers that have processed at least one print job since HP AC Job Accounting installation.

● Cost Centers that have been defined and assigned (to printers or users) by the administrator.

● Printing costs generated by the end users or by the printers in your print system.

● Printer options, or the frequency of use per user or per printer of the various printing modes: duplex, color, 
and Economode.

● Allocation information stored in the database.

Click the appropriate icon to choose the type of query you would like to perform. The list of all queries related to 
this theme appears within the general display window. A description of each query type is provided in the 
following section.

12.11.2.1 Query types

12.11.2.1.1 Users

The queries contained within this theme pertain to the printer users. Search restrictions can be any of the 
following: print periods (start date, end date), the user’s name, their groups, their domain, the date when they 
first printed, the document title, and cost. Some queries are limited to only the first n users matching the 
specified criteria. A single user can belong to one domain, and to several groups.
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Figure 12-76  New query — users

Lists of users, groups, or domains

Before launching this query, choose user/domain/group from the pull-down menu. By default, all domains from 
which print jobs were processed since HP AC Job Accounting installation are considered.

Total number of printed pages for the top n users/domains/groups

Lists the first n users/domains/groups for which the greatest number of pages was printed. Before launching 
your query, choose user/domain/group in the pull-down menu. This query allows the greatest number of printed 
pages to be obtained, as well as the total number of pages printed in duplex and in color mode. By default, this 
query provides the 10 domains for which the greatest number of pages was printed since HP AC Job Accounting 
installation. This list allows you to audit your print system, and target the print volume per user.

Total number of printed documents for the top n users/ domains/groups

Lists the first n users/domains/groups for which the greatest number of documents was printed. Before 
launching your query, choose user/domain/group in the pull-down menu. The query then considers all print jobs. 
By default, this query provides the 10 domains for which the greatest number of documents was printed since 
HP AC Job Accounting installation. This list allows you to audit your print system and analyze print volumes.

Total number of documents printed in Economode for the top n users/ domains/groups

Lists the first n users/domains/groups for which the greatest number of documents was printed in Economode. 
Before launching your query, choose user/domain/group in the pull-down menu. This query considers only the 
documents printed in this particular mode. By default, this query provides the 10 domains for which the greatest 
number of documents was printed in Economode since HP AC Job Accounting installation.

Total number of duplex pages for the top n users/ domains/groups

Lists the first n users/domains/groups for which the greatest number of duplex pages was printed. Before 
launching your query, choose user/domain/group in the pull-down menu. Both short-side and long-side printed 
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pages are taken into account. By default, this query provides the 10 domains for which the greatest number of 
duplex pages was printed since HP AC Job Accounting installation. This query also allows the user to obtain the 
total number of printed pages, as well as the total number of pages printed in color mode. This list allows audits 
to be conducted on the print system, and to determine if a duplex printer is being properly used.

Total number of color pages for the top n users/ domains/groups

Lists the first n users/domains/groups for which the greatest number of color pages was printed. Before 
launching your query, choose user/domain/group in the pull-down menu. By default, this query provides the 10 
domains for which the greatest number of color pages was printed since HP AC Job Accounting installation. This 
query also allows the user to obtain the total number of printed pages, as well as the total number of pages 
printed in color mode. This list allows audits to be conducted on the print system, and to determine the 
frequency of the color mode usage per group. It also enables easy identification of how a color printer is being 
used (such as if a color printer is used as a black and white printer).

Job distribution per domain/group/user

Charts the distribution of print jobs per user, group, or domain in percentage. Before launching your query, 
choose user, group, or domain in the pull-down menu. This query generates a comparison of the total print 
volume for all your users, groups, or domains. By default, all documents printed from all domains since HP AC 
Job Accounting installation are considered. This query highlights the usage frequency of your printers per user 
group (departments).

Distribution of printed pages per domain/group/user

Charts the distribution of printed pages per user, group, or domain, in percentage. Before launching your query, 
choose user, group, or domain in the pull-down menu. This query generates a comparison of the total printed 
page volume for all your users, groups, or domains. By default, all pages printed from all domains since HP AC 
Job Accounting installation are included. This query highlights the usage frequency of printers per user group 
(departments).

Number of printed pages per year/month/day/hour

Charts the total number of printed pages per year, month, day, or hour. This query also provides printing dates. 
Before launching this query, choose year/month/day/hour in the pull-down menu. By default, all pages printed 
by all users of all domains since HP AC Job Accounting installation are included.

Number of duplex-printed pages per year/month/day/hour

Charts the total number of pages printed in duplex mode per year, month, day, or hour. This query also provides 
printing dates. Before launching this query, choose year/month/day/hour in the pull-down menu. By default, all 
pages printed in duplex mode by all users of all domains since HP AC Job Accounting installation are included.

Number of color-printed pages per year/month/day/hour

Charts the total number of pages printed in color mode per year, month, day, or hour. This query also provides 
printing dates. Before launching this query, choose year/month/day/hour in the pull-down menu. By default, all 
pages printed in color mode by all users of all domains since HP AC Job Accounting installation are included.

Number of documents printed in Economode per year/ month/day/hour

Charts the total number of documents printed in Economode per year, month, day, or hour. This query also 
provides printing dates. Before launching this query, choose year/month/day/hour in the pull-down menu. By 
default, all documents printed in Economode by all users of all domains since HP AC Job Accounting installation 
are included.

Simplified list of printed documents

Lists all printed documents. This query provides a result regarding general characteristics: document name, 
total/printed number of pages. With this query, all documents are listed according to the user who printed the 
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document. By default all users of all domains, who printed at least once since HP AC Job Accounting installation, 
are included.

This query allows information to be generated on printed documents and their characteristics: the printing 
launch date, the printer driver, the document title, the total number of printed pages and sheets in duplex and 
color mode, the copy number, the domain, the print job cost related to the print server, printer and the currency 
used, the job size and media. You can refine your query by defining a document title (all documents whose title 
starts with a specific string). By default, all print job characteristics are taken into account. Documents whose 
printing is complex can be analyzed and the document cost as near as possible to its actual costs. Results are 
provided in a table.

Detailed list of printed documents

Lists all printed documents. This query provides a detailed result concerning the page: color and duplex pages, 
trays, and media used for printing. With this query, all documents are listed according to the user who executed 
the print spool. By default all users of all domains, who printed at least once since HP AC Job Accounting 
installation, are included.

This query concerns the printed documents helps you control printing costs. The query also allows generation of 
printed document characteristics: the printing launch date, the printer driver, the document title, the total 
number of printed pages and sheets in duplex and color mode, the copy number, the domain, the print job cost 
related to the print server, printer and the currency used, the job size and media. You can refine your query by 
defining a document title (all documents whose title starts with a specific string). By default, all print job 
characteristics are taken into account. Documents whose printing is complex can be analyzed and the document 
cost as near as possible to its actual costs. Results are provided in a table.

Job type summary per user

Lists use information for each user, including user name, number of color printed pages, number of b/w printed 
pages, number of color copied pages, number of b/w copied pages, number of faxed pages, and number of 
scanned pages. Results are provided in a table.

Media type summary per user

Lists for each user the number of pages printed for each media type along with a sum of total cost and fixed cost 
information.

Media size summary per user

Lists for each user the number of pages printed for each color media size and b/w media size along with a sum 
of total cost and fixed cost information.

12.11.2.1.2 Printers

The queries of this theme concern all printers in your print system tracked by HP AC Job Accounting. The default 
search filter is servers. Other search parameters can be:

Printer queues: Printers declared on a print server with a specific monitor port or driver. A single physical printer 
can be declared several times on the same print server with different ports or drivers.

Printer models: Consist of all printers of the same model. For instance, all HP 4500 LaserJet have the HP 4500 
model.

Devices: Refers to the actual, physical printers. Several printer queues can refer to a single device.

Serial numbers : Refers to printer serial numbers.

Depending on the query, results are displayed in tables or charts.
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Figure 12-77  Query printers

List of servers, printer queues, printer models, devices, or serial numbers

Lists servers, printer queues, printer models or printers tracked since HP AC Job Accounting installation. Before 
launching this query, choose servers, printer queues, printer models, serial numbers, or printers in the pull-down 
menu. This query informs you of the date when the device was used and therefore declared in HP AC Job 
Accounting, as well as the supported options (such as color or duplex). By default, all printers used since HP AC 
Job Accounting installation are included.

Total number of printed pages for the top n servers, printer queues, printer models, printers, or serial numbers

Lists the first n servers, printer queues, printer models, printers, or serial numbers on which the greatest number 
of pages was printed. Before launching this query, choose servers, printer queues, printer models, serial 
numbers, or printers in the pull-down menu. This query examines the total number of printed pages, color-
printed pages, duplex-printed pages, and printed sheets. By default, this query provides the 10 printers on which 
the greatest number of pages was printed since HP AC Job Accounting installation. This list is part of your print 
system audit, and allows you to target print volume per server or per printer, and to highlight peaks as well as 
bottlenecks.

Total number of printed documents for the top n servers, printer queues, printer models, printers, or serial 
numbers
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Lists the first n servers, printer queues, printer models, printers, or serial numbers on which the greatest number 
of documents was printed. Before launching this query, choose servers, printer queues, printer models, printers, 
or serial numbers in the pull-down menu. By default, this query provides the 10 printers on which the greatest 
number of documents was printed since HP AC Job Accounting installation. This list is part of your print system 
audit, and allows you to target print volume per server or per printer and to highlight peaks or bottlenecks.

Total number of documents printed in Economode for the top n servers, printer queues, printer models, printers, 
or serial numbers

Lists the first n servers, printer queues, printer models, printers, or serial numbers on which the greatest number 
of documents were printed in Economode. Before launching this query, choose servers, printer queues, printer 
models, printers, and serial numbers in the pull-down menu. This query only includes the documents printed in 
this mode. By default, this query provides the 10 printers on which the greatest number of documents was 
printed in Economode since HP AC Job Accounting installation.

Total number of duplex-printed pages for the top n servers, printer queues, printer models, printers, or serial 
numbers 

Lists the first n servers, printer queues, printer models, printers, or serial numbers on which the greatest number 
of pages were printed in duplex mode. Before launching this query, choose servers, printer queues, printer 
models, printers, and serial numbers in the pull-down menu. Both short-side and long-side printing is 
considered in this query. By default, this query provides the 10 printers on which the greatest number of pages 
was printed since HP AC Job Accounting installation. It also provides the total number of printed pages. This list is 
part of your print system audit, and allows you to verify whether a duplex printer is being properly used.

Total number of color-printed pages for the top n servers, printer queues, printer models, printers, or serial 
numbers

Lists the first n servers, printer queues, printer models, printers, or serial numbers on which the greatest number 
of pages were printed in color mode. Before launching this query, choose servers, printer queues, printer 
models, printers, and serial numbers in the pull-down menu. By default, this query provides the 10 printers on 
which the greatest number of pages was printed since HP AC Job Accounting installation. It also provides the 
total number of printed pages, as well as the total number of duplex-printed pages. This list is part of your print 
system audit, and allows you to validate the use frequency of a printer’s color mode.

Job distribution per server/printer queue/printer model/ device/serial number

Charts the distribution of print jobs per server, printer queue, printer model, device, or serial number. Before 
launching your query, choose server, printer queue, printer model, device, or serial number in the pull-down 
menu. This query generates a comparison of the total print volume for all servers and printers. By default, all 
printers used since HP AC Job Accounting installation are included. This query highlights the usage frequency of 
your printers.

Distribution of printed pages per server/printer queue/ printer model/device/ serial number

Charts the distribution of printed pages per server, printer queue, printer model, device, or serial number. Before 
launching your query, choose server, printer queue, printer model, device, or serial number in the pull-down 
menu. This query generates a comparison of the total printed page volume for all your servers and printers. By 
default, all pages printed from all printers since HP AC Job Accounting installation are included. This query 
highlights the usage frequency of all printers.

Number of printed documents per… 

Charts the total number of print jobs per year, month, day, or hour. Before launching this query, choose a 
technical item (server, printer model, printer queue, device, serial number) and time unit (per year/ month/day/
hour) in the pull-down menu. This query provides the total number of printed documents, as well as printing 
dates. You can select a specific server, printer queue, printer model, or device. By default, all documents printed 
since HP AC Job Accounting installation are included.

Number of printed pages per… 
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Charts the total number of printed pages per year, month, day, or hour. Before launching this query, choose a 
technical item (server, printer model, printer queue, device, serial number) and time unit (per year, month, day or 
hour) in the pull-down menu. You can select a specific server, printer queue, printer model, or device. This query 
also provides printing dates. By default, all pages printed by all users of all domains since HP AC Job Accounting 
installation are included.

Number of duplex-printed pages per… 

Charts the total number of pages printed in duplex mode per year, month, day, or hour. Before launching this 
query, choose a technical item (server, printer model, printer queue, device, serial number) and time unit (per 
year, month, day or hour) in the pull-down menu. You can select a specific server, printer queue, printer model, 
device, or serial number. This query provides the total number of duplex-printed pages, as well as printing dates. 
By default, all pages printed in duplex mode since HP AC Job Accounting installation are included.

Number of color-printed pages per…

Charts the total number of pages printed in color mode per year, month, day, or hour. Before launching this 
query, choose a technical item (server, printer model, printer queue, device, serial number) and time unit (per 
year, month, day, or hour) in the pull-down menu. You can select a specific server, printer queue, printer model, 
device, or serial number. This query provides the total number of color-printed pages, as well as printing dates. 
By default, all pages printed in color mode since HP AC Job Accounting installation are included.

Number of documents printed in Economode per… 

Charts the total number of documents printed in Economode per year, month, day, or hour. This query also 
provides printing dates. Before launching this query, choose a technical item (server, printer model, printer 
queue, device, serial number) and time unit (per year, month, day, or hour) in the pull-down menu. You can select 
a specific server, printer queue, printer model, device, or serial number. This query provides the total number of 
documents printed in Economode, as well as printing dates. By default, all documents printed in Economode 
since HP AC Job Accounting installation are included.

Simplified list of printed documents 

Lists all printed documents. Before launching your query, choose server, printer queue, printer model, device, or 
serial number in the pull-down menu. This query provides a synthetic result regarding general characteristics 
such as document name and total/printed number of pages. With this query, all documents are listed according 
to the printer that processed the print job. By default, all printers used at least once since HP AC Job Accounting 
installation are included.

This query concerns printed documents and helps with your printing costs control. It allows information to be 
gathered on printed documents and their characteristics: the print launching date, the printer driver, the 
document title, the total number of printed pages and sheets in duplex and color mode, the copy number, the 
domain, the print job cost related to the print server, printer and the currency used, the job size and media. You 
can refine your query by defining a document title (all documents whose title starts with a specific string). By 
default, all print job characteristics are included. Documents whose printing is complex can be analyzed and the 
document cost as near as possible to its actual costs. Results are provided in a table.

Detailed list of printed documents 

Lists all printed documents. Before launching your query, choose the server, printer queue, printer model, 
device, or serial number in the pull-down menu. This query provides a detailed result concerning the page: color 
and duplex pages, trays, and media used for printing. With this query, all documents are listed according to the 
printer that processed the print job. By default, all printers used at least once since HP AC Job Accounting 
installation are included.

This query concerns the printed documents and helps with your printing costs control. It allows information to be 
gathered on printed documents and their characteristics: the printing launching date (the date and time, when 
the user launched the print job and was not handled by the print server), the printer driver, the document title, 
the total number of printed pages and sheets in duplex and color mode, the copy number, the domain, the print 
job cost related to the print server, printer and the currency used, the job size and media. You can refine your 
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query by defining a document title (all documents whose title starts with a specific string). By default, all print job 
characteristics are taken into account. Documents whose printing is complex can be analyzed and the document 
cost as near as possible to its actual costs. Results are provided in a table.

Media type summary

Provides a summary of media used by servers, printer queues, devices, printer models, or printer serial 
numbers.

Media size summary

Provides a summary of media sizes used by servers, printer queues, devices, printer models, or printer serial 
numbers.

List of inactive queues, devices, models, or serial numbers

Provides a list of inactive printer queues, devices, printer models, or printer serial numbers.

12.11.2.1.3 Cost centers

This type of query determines the usage and costs associated with users or printers assigned to a specified cost 
center. For more information on creating and assigning cost centers, see Section 12.11.2.1.3, Cost centers.

Figure 12-78  Query cost centers

List of cost centers

Lists all the existing cost centers currently defined within HP AC Job Accounting.

Total number of printed pages for the top n cost centers/users/print queues 

Lists the first n cost centers/users/print queues for which the greatest number of pages was printed. Before 
launching your query, choose cost center/user/print queues from the drop-down menu. This query allows the 
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greatest number of printed pages to be obtained, as well as the total number of pages printed in duplex and in 
color mode.

Total number of printed documents for the top n cost centers/users/print queues 

Lists the first n cost center/users/print queues for which the greatest number of documents was printed. Before 
launching your query, choose cost center/users/print queue from the drop-down menu. The query considers all 
print jobs. This list allows you to audit your print system and to analyze print volumes.

Simplified list of printed documents per users/print queues

Lists all printed documents. This query provides a simplified result regarding the document’s general 
characteristics: document name, total/printed number of pages. With this query, all documents are listed 
according to the cost center that printed. This query allows information to be generated on printed documents 
and their characteristics.

Detailed list of printed documents per users/print queues 

Lists all printed documents. This query provides detailed results concerning the page: color and duplex pages, 
trays, and media used for printing. With this query, all documents are listed according to the cost center 
executing the print spool. This query concerns the printed documents and helps with controlling printing costs.

The query also allows generation or printed document characteristics: the printing launch date, the printer driver, 
the document title, the total number of printed pages and sheets in duplex and color mode, the copy number, 
the domain, the print job cost related to the print server, printer and the currency used, the job size and media. 
You can refine your query by defining a document title (all documents whose title starts with a specific string). By 
default, all print job characteristics are taken into account. Documents whose printing is complex can be 
analyzed and the document cost as near as possible to its actual costs. Results are provided in a table.

Total number of printed pages per printer queues grouped by user's cost centers

Provides the total number of pages printed by each cost center.

Total number of printed pages using user's cost centers grouped by users/ print queues

Lists total pages printed by each user’s cost centers, grouped by either users or print queues.

Total number of printed pages using printer's cost centers grouped by users/ print queues

Lists total pages printed by each printer’s cost centers, grouped by either users or print queues.

Job type summary using user’s cost centers grouped by cost centers, users, or printer queues 

Provides summary of jobs using user’s cost centers; grouped by cost centers, users, or printer queues.

Job type summary using printer’s cost centers grouped by cost centers, users, printer queues, or printer models

Provides summary of jobs using printer’s cost centers; grouped by cost centers, users, printer queues, or printer 
models.

12.11.2.1.4 Costs

This group of queries reports the printing costs of all jobs processed between two dates. The query results are 
displayed in tables. The reports include the total number of jobs, their total size, the total number of printed 
pages and sheets in duplex and color mode, the total costs, and the total printing time. You can also compare 
the actual costs (the amount closest to the real costs) and the fixed costs that you define (this allows you to 
include, for example, consumable expenditures and maintenance). You can also set a limit on the printing time, 
the number of printed pages, and the printing costs. The HP AC Job Accounting queries 93 limit types are: >, =, 
>=, < and <=. They are used to help you define the information queried more accurately.
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Figure 12-79  Query costs

Total printing costs for the top n domains/groups/users 

Lists the top n users, domains, or groups whose printing costs are the highest in a given period. Before launching 
your query, choose user/group/domain in the pull-down menu. This query takes into account the number of 
printed pages, the printing mode, the printer, and the media. By default, this query provides the 10 domains best 
matching these criteria since HP AC Job Accounting installation. This query helps with your costs management, 
by informing you of the costs involved in printing documents between two dates.

Total printing costs for the top n servers/printer queues/printer models/ devices/printer serial numbers

Lists the top n servers, printer queues, printer models, devices, or printer serial numbers whose printing costs 
are the highest on a given period. Before launching your query, choose servers, printer queues, printer models, 
devices, or printer serial numbers in the pull-down menu. This query takes into account the number of printed 
pages, the printing mode, the printer, and the media. By default, this query provides the 10 devices best 
matching these criteria since HP AC Job Accounting installation. You can specify the currency in which to express 
your costs. The default currency is defined in your user options. For more information on this setting, see Section 
12.10, HP AC Job Accounting user options. This query helps with your costs management, by informing you of 
the costs involved in printing documents between two dates.

Evolution of printing costs per domain/group/user per year, month, day, or hour

Charts the total real cost of all printed documents per hour, per day, per month, or per year. Before launching 
your query, choose domains, groups, or users in the pull-down menu. Select a specific domain, group, user, or 
currency. By default, all documents printed by any user of all domains since HP AC Job Accounting installation 
are included. The default currency is defined in your user options. For more information, see Section 12.10, HP 
AC Job Accounting user options.

Printing cost per printer queue, device, model, or serial number

Provides information on the cost of printed documents per hour, per day, per month, or per year. Before 
launching this query, choose a technical item (printer queue, device, printer model, serial number) and time unit 
(per year, month, day, or hour) in the pull-down menu.

Leasing cost per printer queue or printer serial number
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Provides information on the leasing costs per printer queue or serial number, based on the monthly lease 
charge, b/w page price, and color page price defined. For more information, see Section 12.8, Manage print 
costs.

Total printing costs for the top n cost centers, users, or printer queues 

Lists the top n cost centers, users, or printer queues whose printing costs are the highest in a given period.

Job type summary grouped by user 

Provides a detailed table of use information for each user, including: user name, number of color printed pages, 
number of b/w printed pages, number of color copied pages, number of b/w copied pages, number of faxed 
pages, and number of scanned pages.

12.11.2.1.5 Printer options

The queries for this theme enable you to get information on the use frequency of printer options: color, duplex, 
and Economode.

Figure 12-80  Query printer options

Frequency of duplex mode use per domain/group/user 

Charts the percentage of sheets printed in duplex mode compared with the number of simplex-printed pages 
per domain, group, or user. By default, all users of all domains since HP AC Job Accounting installation are 
considered.

Frequency of color mode use per domain/group/user

Charts the percentage per domain, group, or user of sheets printed in color mode compared with the number of 
pages printed in black and white. By default, all users of all domains since HP AC Job Accounting installation are 
considered.

Frequency of Economode use per domain/group/user

Charts the percentage per domain, group, or user of sheets printed in Economode compared with the number of 
pages printed in normal mode. By default, all users of all domains since HP AC Job Accounting installation are 
considered.

Frequency of duplex mode use per server/printer queue/printer model/ device/serial number
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Charts the percentage per server, printer queue, printer model, device, or serial number of sheets printed in 
duplex mode compared with the number of simplex-printed pages. By default, all printers used since HP AC Job 
Accounting installation are considered.

Frequency of color mode use per server/printer queue/printer model/device/ serial number

Charts the percentage per server, printer queue, printer model, device, or serial number of sheets printed in 
color mode compared with the number of pages printed in black and white. By default, all printers used since HP 
AC Job Accounting installation are considered.

Frequency of Economode use per server/printer queue/printer model/device/ serial number 

Charts the percentage per server, printer queue, printer model, device, or serial number, of sheets printed in 
Economode compared with the number of pages printed in normal mode. By default, all printers used since HP 
AC Job Accounting installation are considered.

12.11.2.1.6 Allocation

The queries for this theme enable information to be gathered on allocation capability. For instance, you will have 
the ability to research using various criteria such as the allocation profile and the time period.

Figure 12-81  Query allocation

Simplified list of printed documents with allocation information

Lists all printed documents having a link with an allocation profile.
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This query provides a simplified result with information such as the field values of the allocation profile, the 
domain, the user, and the number of printed pages. Before launching your request, select a profile.

Detailed list of printed documents with allocation information

Lists all printed documents having a link with an allocation profile. This query provides a detailed result with 
information such as the field values of the allocation profile, the domain, the user, the number of printed pages, 
simplex/duplex pages, and the number of printed color pages. Before launching your request, select a profile.

Printing costs per year/month/day/hour

Provides graph and table with total of the real costs of all printed documents that have a link with an allocation 
profile. Before launching your request, select a profile.

Printing fixed costs per year/month/day/hour

Provides graph and table with total of the fixed costs of all the printed documents that have a link with an 
allocation profile. Before launching your request, select a profile.

Number of printed documents per year/month/day/hour

Provides graph and table illustrating the number of printed documents that have a link with an allocation profile. 
Before launching your request, select a profile.

Number of printed pages per year/month/day/hour 

Provides graph and table illustrating the number of printed documents that have a link with an allocation profile. 
Before launching your request, select a profile.

Aggregated allocation

Lists all information included in the fields of a specific allocation profile. This query provides a synthetic result 
regarding the printings related to a profile. Before launching your request, select a profile. This query allows you 
to generate statements on the selected allocation profile.

List of profiles

Lists all allocation profiles. This query provides a table with detailed descriptions of the fields of each allocation 
profile that has been used at least once.

Number of printed pages, cost allocated/not allocated/ per domains/groups/ users

Provides a table indicating billed printings versus non-billed printings, for all printings related to an allocation 
profile. It also provides detailed information on the user/group/domain, number of documents, number of 
pages, and real and fixed costs. This query may allow you to check the correct use of the allocation module.

Number of printed pages, cost with available/not available allocation information per domains/groups/users

Provides a table indicating the printings with allocation information available versus the printings without 
allocation information available. It also provides detailed information on the user/group/ domain, number of 
documents, number of pages, and real and fixed costs. This query may allow you to check the correct use of the 
allocation module.

Distribution of the allocation cost per profile

Graphs the percentage of the real costs in each profile. The result can also be displayed in a table with the total 
amount.

Distribution of the allocation fixed cost per profile

Graphs the percentage of the fixed costs in each profile. The result can also be displayed in a table with the total 
amount.

List of jobs without allocation information per domains/groups/users
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Lists all printed documents without allocation information; all printed jobs that are not linked to an allocation 
profile.

This query provides a simplified result with information such as the domain, the user, and the number of printed 
pages.

This query displays all jobs without allocation information.

Job type summary grouped by allocation information

Lists job types grouped by allocation information provided.

Job type summary grouped by allocation information and user

Lists job types grouped by allocation information and user information.

Job type summary grouped by user and allocation information

Lists job types grouped by user information and allocation information.

12.11.2.1.7 Quota

The queries for this theme enable information to be gathered on allocation capability. For instance, you will have 
the ability to research using various criteria such as the allocation profile and the time period.

Figure 12-82  Query quota

List of user's quota

Lists all values relative to each user.

List of cost center's quota

Lists all values relative to each cost center.

List of user's quota (using quota by printer cost center)

Lists all values relative to each user by printer cost center.

12.11.2.2 Launch a query

Launched queries can be in one of these two modes: default or parameterized. When viewing the New Query 
page, note the three icons at the bottom of the page:
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Figure 12-83  New Query page

12.11.2.3 Default mode

With the Default mode icon, you will be able to launch a query immediately. This mode is mostly used for queries 
for which few resources (such as CPU or memory) are required, or for which an immediate result is necessary. 
The default mode will launch a query with the default parameters. This means the printing date will be between 
1/1/2000 and 12/31/2020, and it will run for all users, printers, and print servers.

This mode must be used for very simple queries such as “list of users,” “list of printers,” or “total number of 
pages printed by…” For complex queries, it is recommended to filter on a date range, a specific user, or a specific 
printer; and the parameterized mode must be used.

For more information on how to view your query results, see Section 12.12.4, Display results.

CAUTION: Some update processes are not synchronized to avoid penalizing printing times and servers—
therefore some results can have incomplete or erroneous data. Wait a short while and then run the query again, 
and your data should be corrected. By launching a query in this mode, you will take all default parameters into 
account. For more information on default parameters, see Section 12.11.3, Parameterize queries.

Use the following steps to perform a query using the Default mode:

1. Select a query.

2. Click the Default mode icon.

A progress message appears to verify that the query is running. The query table appears.

12.11.2.4 Parameterized mode

The Parameterized mode icon provides search parameters that focus the scope of returned information. You will 
also be able to schedule your query so that its launch does not burden processors during peak hours (such as at 
night) or at regular periods (for example, daily or monthly). This mode allows you to benefit from synchronized 
information, using the most recent data available. It is also an advantage for queries that are complex or lengthy 
to perform, or that require a lot of CPU and memory resources.

For more information on query types, see Section 12.11.2, HP Access Control (HP AC) Job Accounting queries.

To perform a parameterized query, complete the following steps:

1. Select a query.

2. Click the Parameterized mode icon.
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Figure 12-84  Parameterized mode

12.11.2.5 Edit results

The various fields (parameters) in this page depend on the query launched. For more information on these 
parameters, see Section 12.11.3, Parameterize queries.

The buttons along the top enable you to:

● Schedule your query by clicking Schedule. For more information, see Section 12.11.4, Schedule queries.

● Launch your query by clicking Go after having parameterized or scheduled your query. For more 
information, see Section 12.12.4, Display results.

12.11.3 Parameterize queries

This page lists parameters used to limit your search scope, to obtain a more precise result that is closer to your 
search objectives. If no parameters are defined, the query will utilize default values.

CAUTION: If you use the default launching mode, only the default parameters will be considered. If no Start 
Date and Start time are specified, the data queried encompasses all documents printed since HP AC Job 
Accounting installation. If no End Date and End Time are specified, the data queried encompasses all documents 
printed until the most recent date (the current date/hour).

The following rules apply to time periods:

● For the year unit, all months for the years specified in the Date fields.

● For the month unit, all weeks for the months specified in the Date fields.
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● For the week unit, all days for the weeks specified in the Date fields.

● For the day unit, all days specified in the Date fields.

12.11.3.1 Name a query

Each user maintains a unique query name in order to initiate queries. By default, the query name consists of the 
query theme followed by the _ symbol and the number of queries you have already launched.

12.11.3.2 Recipient email addresses

Transmitting query results to one or several recipients is accomplished by specifying email addresses or 
distribution lists of recipients.

Click in the field and enter an email address, or click the Recipient email address  icon to open the address 

book containing all predefined addresses and lists (see Section 12.5, HP AC Job Accounting administration). You 
can specify several addresses or lists, which will automatically be separated by a semicolon. This field may 
contain a maximum of 499 characters, symbols, and figures.

NOTE: Lists appear at the bottom of the pull-down menu, in the gray area. Individual addresses appear at the 
top of the pull-down menu, in the white area.

Error messages may appear for the Recipient email address field under the following conditions:

● No sender address defined: no sender address has been specified in the User options section. Any message 
must be identified by a sender.

● No mail server defined: no email server has been configured in the Email system section of the 
Administration menu, which means that no email message can be sent. This message only appears if you 
have administrator rights.

These errors do not prevent a query from being executed, but they highlight the fact that the results will not be 
sent.

12.11.3.3 Select the domain

This parameter enables you to select several users belonging to the same domain to query. Click the arrow to 
get the list of all domains from which documents have already been printed. If you select a particular domain, 
the End user field will automatically be filled with the names of all end users attached to this domain. By default, 
this includes all domains detected by HP AC Job Accounting.

12.11.3.4 Group

Since a domain may contain several groups, users can refer to any end user group attached to the same 
network. Click the arrow to get the list of all groups from which documents have already been printed. If you 
select a particular group, the End user field will automatically be filled with the names of all end users attached 
to the group. By default, all groups are included.

12.11.3.5 End user

Choose which particular end user to query. If you select an end user, the domain to which the user is attached 
appears in the Domain/group fields. By default, all end users that have executed a print command since HP AC 
Job Accounting installation will be considered.
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12.11.3.6 Document titles starting with...

Enables users to select documents whose title starts with a specified string. You can enter up to 64 characters, 
symbols, and figures. If this field is empty, the default returns all documents printed since the original HP AC Job 
Accounting installation.

12.11.3.7 Print server

Choose which HP AC Job Accounting Print Server (HP ACJA PRINT SERVER) you want to query. By default, all print 
servers are included.

12.11.3.8 Printer queue

Choose a printer queue in the list provided by HP AC Job Accounting. A printer queue is a printer declared on a 
server using a specific port monitor or driver. A physical printer can be declared several times on the same server 
using different ports or drivers.

12.11.3.9 Set printer models

A printer model consists of all printers of the same model; for instance, all HP 4500 LaserJet printers. By default, 
all printer models are included.

12.11.3.10 Printer

Choose one printer to query.

12.11.3.11 Date

The Date field enables you to specify a time interval during which documents were printed. This time interval is 
limited by precise start and end dates. Date is the default value for defining a time interval during which 
documents were printed.

12.11.3.12 Printing date from

This parameter enables you to define the start of a time interval— your query will only focus on the documents 
printed from the date and time defined in this field. The possible dates range from 01/01/2000 at 00:00:00 to 
31/12/2020 at 23:59:59. The default date is the current date and time.

Parameterize queries 103 of the database server. All documents printed since HP AC Job Accounting installation 
are taken into account.

12.11.3.13 To

This parameter enables you to define the end of a time interval—your query will only focus on the documents 
printed up to the date and time defined in this field. The date range is identical to the field Printing date from. The 
default date and time in this field are the current date at 23:59:59. All documents printed up to the current date 
are included.

12.11.3.14 Time lapse

This option enables you to collect data related to documents printed during a certain time interval. Date is the 
default value for defining a time interval during which documents were printed.
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12.11.3.15 Printing for the last...

This option enables you to define a time interval in days, months or years, during which documents were printed. 
The last interval day is always the day, when you are launching your query. By default, all documents printed up 
to the current date are included. This parameter appears only if you select the Time Lapse parameter.

12.11.3.16 First n...

This option enables you to define the maximum number of a query parameter (such as user, printer, or printer 
model). The default value in this field is 10. This parameter does not affect all queries.

12.11.3.17 Number of printed pages

Sets a limit (greater than, less than, or equal) regarding the number of printed pages. By default, all documents 
printed since HP AC Job Accounting installation are included.

12.11.3.18 Printing cost

Sets a limit (greater than, less than, or equal) to the actual printing cost (not the fixed cost). By default, all 
documents printed since the HP AC Job Accounting installation are included.

CAUTION: The decimal symbol is a period (.).

12.11.3.19 Currency

Enables you to choose your cost currency in the pull-down menu. The default currency is the currency defined in 
the user options. For more information on user options, see Section 12.10, HP AC Job Accounting user options.

12.11.4 Schedule queries

From this page, you can perform the following actions:

● Change the way you launch queries to obtain more correct and precise results, by benefiting from all 
updates. These updates, for optimization and performance reasons, are not all executed in real time. You 
can also change the way queries are launched so that you do not overload your server.

● Plan your query so that it is launched regularly (such as every week or every month).

● You can reach the schedule page by clicking Schedule. The following prompt appears:
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Figure 12-85  Schedule queries

The following page enables you to schedule your query in detail. The default frequency is Once. You can choose 
among the following frequencies:

Figure 12-86  Query frequencies

When choosing a particular frequency, new fields will appear on the page. The appearance of these fields 
depends on your selection.

12.11.4.1 Once

Use this value to launch your query once, at a time specified by the Start date and Start time fields. By default, 
both fields are defined to the date and time on which you are launching your query. If the query is scheduled to 
be launched at a date and time before the current date (defined in the Start date and Start time fields), the query 
is immediately launched. The parameters are defined in the parameter page.
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12.11.4.2 Daily

This query will run once or several times a day, every day or at a regular interval, during a certain time interval as 
specified in the Start/End Date/Time fields.

Figure 12-87  Query frequency: daily

Frequency interval

Define the day interval—for example by entering 2 in this field, your query will run every 2 days. The default 
value in this field is 1, meaning that your query will run every day.

Daily frequency

Choose how often within one day the query will run. With the default option, at the specified time the query will 
be launched at the time defined in the Start time field. You can also choose to launch your query regularly every 
n minutes or hours.

Daily interval

Specify the actual minute or hour interval. This field only appears if you selected minutes or hours in the Daily 
frequency field. The default value is 1, meaning that your query will generate statistics every minute or every 
hour.

Start/End Date/Time

Specify the actual minute or hour interval. This field only appears if you selected minutes or hours in the Daily 
frequency field. The default value is 1, meaning that your query will generate statistics every minute or every 
hour.

12.11.4.3 Weekly

This query will run once or several times a day, on one or several days, during one or several weeks.
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Figure 12-88  Query frequency: weekly

Daily frequency

Choose how often within one day the query will run. With the default option, the query will be launched at the 
time defined in the Start time field. You can also choose to launch your query regularly every n minutes or hours.

Daily interval

Specify the minute or hour interval. This field only appears if you selected minutes or hours in the Daily 
frequency field. The default value is 1, meaning that your query will generate statistics every minute or every 
hour.

Recurrence

Define the number of weeks between each query launch. The default value is 1, which means that your query 
will generate statistics every week. To generate statistics every 2 weeks, for example, enter 2 in this field.

Start/End Date/Time 

Define the date and time the query will start and end. By default, Start date is the current date and Start time is 
the current time. When no End date is specified, the query will generate statistics until 31/12/2020 at 23:59:59.

12.11.4.4 Monthly

This setting will schedule a query to run once or several times a day, on one day, during one or several months.
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Figure 12-89  Query frequency: monthly

Frequency interval

Select the day of the month when the query is launched. The default value is 1, meaning that your query will run 
on the first day of every month.

Daily frequency

Choose how often within one day the query will run. With the default option, at the specified time the query will 
be launched at the time defined in the Start time field. You can also choose to launch your query regularly every 
n minutes or hours.

Daily interval

Specify the actual minute or hour interval. This field only appears if you selected minutes or hours in the Daily 
frequency field. The default value is 1, meaning that your query will generate statistics every minute or every 
hour.

Recurrence

Define the number of months between each launching of your query. The default value is 1, which means that 
your query will generate statistics every month. To generate statistics every 2 months, for example, enter 2 in 
this field.

Start/End Date/Time

Define the lapse time (date and time) during which the query is launched. By default, Start date is the current 
date and Start time is the current time. When no End date is specified, the query will generate statistics until 
31/12/2020 at 23:59:59.

12.11.4.5 Monthly with relative interval

This setting is the same as the monthly frequency, except you can specify an actual day for the query to run.
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Figure 12-90  Query frequency: monthly, with relative interval

Frequency interval

Select one day (such as Monday or Friday). You can also select the Day, Weekday, or Weekend day options.

Relative interval

Choose the week of the month; such as the first week.

Daily frequency

Choose how often within one day the query will run. With the default option, at the specified time the query will 
be launched at the time defined in the Start time field. You can also choose to launch your query regularly every 
n minutes or hours.

Daily interval

Specify the minute or hour interval. This field only appears if you selected minutes or hours in the Daily 
frequency field. The default value is 1, meaning that your query will generate statistics every minute or every 
hour.

Recurrence

Define the number of months between each launching of your query. The default value is 1, which means that 
your query will generate statistics every month. To generate statistics every 2 months, for example, enter 2 in 
this field.

Start/End Date/Time

Define the lapse time (date and time) during which the query is launched. By default, Start date is the current 
date and Start time is the current time. When no End date is specified, the query will generate statistics until 
31/12/2020 at 23:59:59.

12.11.4.6 Run when idle

When utilizing this process, queries are launched when no other processes are being performed on the database 
server—such as during off hours.

NOTE: This mode is valid only if SQL Server Agent is used. This query frequency helps you manage statistical 
reports requiring a lot of information.
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Figure 12-91  Query frequency: run when computer dies

12.11.4.7 Modify display parameters

Before launching a query, you can get the list of all information returned by your query. You can also hide some 
of this information, such as the columns of the tables in which your results are displayed.

NOTE:

● This function only affects your results display, not the parameters used to obtain these results.

● Although this function is available for all display types (tables, spreadsheets, diagrams) it is not very useful 
when applied to diagrams (pie charts, line charts, columns).

In the Queries in Progress page:

1. Select the query to modify.

2. Click the Edit results icon of the selected query. The information returned by this query appears:

Figure 12-92  Edit query table

By default, all information elements are selected. Click the box in front of any elements you want to hide to 

unselect it. You can unselect multiple elements. Click the Go  icon to accept the selections, or the Cancel 

 icon to stop the operation. When this query is subsequently launched, the results will be displayed without 

including the deselected columns.

12.12 Query results
After a query is launched, the statistics related to that query are pulled from the database. The information is 
retrieved and transmitted back to the HP AC Job Accounting administrator or user in various display formats 
(such as a chart, table, or spreadsheet) available for each query.

The statistical reports generated by launching queries are referred to as “results.” Each query result, whatever its 
format, contains:
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● The query name

● The date and time the query was launched

● Parameters

● The number of pages if the spreadsheet or table contains more than one page

The level of detail you will obtain in your query results depends on the printers managed by HP AC Job 
Accounting, particularly on the printer model, its sophistication level, and the communication language (PCL 5, 
5e, 6).

You can modify the display of your query results by hiding some parameters. For more information, see Section 
12.11.4.7, Modify display parameters.

You can also change the number of lines displayed in your lists. For more information, see Section 12.10, HP AC 
Job Accounting user options.

12.12.1 Query table

To obtain the list of the queries you launched or queries in progress and access their results, click Queries in 
progress in the HP AC Job Accounting remote control. All launched queries are displayed in a table containing 
several columns:

Figure 12-93  Queries in progress

NOTE: You can only view queries attached to your HP AC Job Accounting account.

This table lists the type, status, and schedule of your queries, the date and time when they were launched, the 
date and time when the result was obtained, and various ways to display their results.

The date format in the charts and in the query table is the format defined in your regional settings. To modify 
this format, see Section 12.10, HP AC Job Accounting user options.

You can sort the Themes, Query name, and Status columns in alphabetical order by clicking the column title. You 
can also sort the schedule and result dates by ascending or descending order.

12.12.2 Query status

The Status column displays the status of your queries. The possible status results follow:
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Figure 12-94  Query status — possible results

12.12.3 Viewing schedule parameters

By keeping your mouse cursor on the Modify  icon, all details related to your query schedule and the Schedule 
Parameters page appears and offers the following options:

● The name you gave to the query (or its default name).

● All details concerning its schedule frequency, such as if it is launched only once or regularly, how often, and 
for how long. If the Once frequency appears in these details without any other parameter, it means that no 
schedule is specified for this query.

To modify the query parameters or schedule, see Section 12.12.5.2, Modify parameters.

12.12.4 Display results

You can display your results by clicking on one icon in the Result display or Other display types columns.

These columns are part of the query table, which you access by clicking the Queries in progress icon in the HP AC 
Job Accounting remote control.

Using the icons in these columns, you will be able to display your results in a table or a spreadsheet. To display 
your results in a spreadsheet or a chart, Excel must be installed on your machine. When sending results by email, 
only the results in the spreadsheet format are sent. Your results recipients should have Excel installed on their 
machine.

NOTE: If Microsoft Excel is not installed on the system, the icon will not appear.

12.12.4.1 Information provided

All display types provide you with the following information:

● the name and type of the query

● the date, when the query result was generated

● the parameters (including the printing time range)

This information is listed as in the frame below:
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Figure 12-95  Query information

12.12.5 Display types

Click one icon in the Result display and Other display types columns to display your results. Each icon 
corresponds to a specific display type (such as table, graph, or spreadsheet). The various display types follow:

Figure 12-96  Chart display
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The task bar at the top of the page allows you to choose another chart to display your results. Click directly on 
the display desired, and it will automatically change.

Figure 12-97  Chart display task bar

Click the Pie chart icon to present information in a traditional pie chart, as shown in the figure below:

Figure 12-98  Pie chart

The task bar at the top of the page allows you to choose another type of pie chart to display results. Click directly 
on the display desired and it will automatically change.

Figure 12-99  Pie chart task bar

Click the Table chart  icon to present the information in a table.

Figure 12-100  Table chart
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Figure 12-101  Result display

You can modify the number of lines displayed in a table in your User options. For more information on how to 
modify this number, see Section 12.10, HP AC Job Accounting user options.

NOTE:

● If Copy job appears in the Document name column, the job is a copy job, not a print job.

● The Pull Printing column allows administrator to view the type of print job (e.g if it went via a pull print 
queue or if it went via a direct print queue).
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Clicking the Excel icon formats the information into a standard Microsoft Excel spreadsheet. This is the only 
option that allows you to save your query results. To save, use the Save As command in Excel.

Figure 12-102  Excel spreadsheet

NOTE: To view your results in a spreadsheet, Excel must be installed on your computer.

TIP: You may have to resize some columns to view the complete contents of a cell, such as when ####### 
appears in a cell.

Clicking the Query results icon lists all results generated by a recurring query. The number next to this icon 
represents the number of results generated by this recurring query.

When clicking this icon, a new list containing all results and display icons for this query appears, as shown in the 
figure below:
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Figure 12-103  Query results

12.12.5.1 Manage results

By clicking the Query in progress icon in the HP AC Job Accounting remote control, you reach the query table. This 
table contains the same icons as any HP AC Job Accounting lists.

Figure 12-104  Manage results

12.12.5.2 Modify parameters

Launching parameters can be modified. This function will be used by recurring queries for which you want to 
modify or stop the launching mode. The only parameter you cannot change is the query name.

Click the Modify icon for this query to bring up the parameters page, as shown in the figure below:
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Figure 12-105  Modify query parameters

All parameters (default or defined) appear. For more information on parameters, see Section 12.11.3, 
Parameterize queries.

Modify your parameters as desired. Click Schedule to modify your schedule parameters.

For more information on scheduling your query, see Section 12.11.4, Schedule queries

Click the Go  icon to launch your query with its new parameters or schedule. You directly reach the query 

table.

Your new parameters take effect even though the query name stays the same.

12.12.5.3 Modify the display

When you view your query results, you may decide some information is not relevant. You can deselect this 
information by checking the box in front of a query result in the query table and then clicking the Query display 
icon. The list of the display columns appears. By default, all columns are selected.

Uncheck the box in front of the parameter to remove it, then click the Go  icon to accept your choice. You 

directly reach the query table.

Unlike the result modification available from the New query page as described in Section 12.11.4.7, Modify 
display parameters, this modification only applies to the selected result. In the case of a recurring query, all 
results of this query are modified.

CAUTION: You can only modify the results of one query at a time.
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12.13 Report management

12.13.1 Report management page

Click Summary Report on the HP AC Job Accounting remote control to access the Report Management page:

Figure 12-106  Report management screen

Through the Report Management page, you can quickly generate comprehensive, all-encompassing reports to 
illustrate print usage. Since reports have only a few, basic settings, they are much more convenient and easier to 
run than full queries. Reports can be manually run at any time, or can be scheduled to occur either weekly or 
monthly.

After a report has been requested and compiled, it can be saved in Adobe Acrobat (PDF), Microsoft Excel (.xls), or 
Microsoft Word (.doc) format and can be automatically forwarded through email to a designated individual.

12.13.1.1 Create a report

To create a report:

1. In the field Name of the report, enter the name you wish to appear on the title page of the report.

2. Choose a month from the Month of the report drop-down menu.

NOTE: Reports contain data from a three-month period ending on the requested month.

3. Select a year from the Year of the report drop-down menu.

4. If you wish to forward a copy of the report to someone automatically, enter their email address in the Send 
report by email to field.

5. Schedule the report. Choose an option from the drop-down list:
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● Once — The report will be generated only once, when validated (Step 7).

● Weekly — The report will be generated weekly, according to the Day and Start time parameters 
selected before validation.

● Monthly — The report will be generated monthly, according to the Day and Start time parameters 
selected before validation.

6. Format the report. Choose an option from the drop-down list.

● PDF - The report will be generated in a format compatible for reading with Adobe Acrobat Reader.

● Excel - The report will be generated as a Microsoft Excel spreadsheet.

● Word - The report will be generated as a Microsoft Word document.

7. Click validate to generate the report.

8. Schedule a report. If you choose the Weekly or Monthly option, click Schedule Report after setting schedule 
parameters.

9. Customize a report. Click Customize Report to set specific parameters for your report.

Figure 12-107  Customize report

The amount of time it takes to generate the report depends on the number of jobs printed over the three-month 
period. If you wish reports to run automatically in the future, select either Weekly or Monthly from the Schedule 
drop-down list.

After the report is generated, a link appears on the page.
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Figure 12-108  View report link

Click the link to view and print the report using Adobe Acrobat (.pdf), Microsoft Word (.doc), or Microsoft Excel 
(.xls); or right-click the link and save the report to a location of your choosing.

NOTE: Each new report is saved to the same location with the same name. If you wish to keep a report, save 
the file to another location before requesting a new report.

12.14 Allocation
The allocation feature allows additional information to be linked to print jobs. This can be useful for determining 
billing and expenses.

Figure 12-109  Allocation screen

484 Chapter 12   Job Accounting



12.14.1 Create allocation profiles

Use the following steps to create an allocation profile:

1. From the Allocation page, click Create Profile.

Figure 12-110  Create allocation profile

2. Name the profile you want to create. Be aware that all profiles must have unique titles; two profiles cannot 
share the same name.

3. Enter number of fields you want to attach to the profile. This number must be less than or equal to 5.

4. Click the Go  icon to accept the information, or the Cancel  icon to stop the operation.

Figure 12-111  Allocation profile information

5. Give a name to the fields of the profile and specify their data type and their input type.

Possible data types:

● Numeric

● Text

● Date (day/month/year or month/day/year)

● True/False

Possible input types:

● Free (free input in the field when the popup window appears)

● List (predefined list of values)

● Fixed (a value can be fixed by default)
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NOTE: The names of the fields must be different. You cannot choose the input type for Boolean.

6. Click the Go  icon to accept the information, or the Cancel  icon to stop the operation.

12.14.2 Modify profile structure

You can change the structure of an allocation profile only if it has not been linked to a printed job. Otherwise, the 
structure cannot be modified.

To edit a profile, select any of the following:

● Click Change profile structure:

Figure 12-112  Change profile structure

● Change the Field name, Data type, or Input type of a profile

You can modify a Field name, the Data type, or the Input type.

● Delete one or more fields in a profile

If no job is linked to the allocation profile, you can delete one or more fields.

1. Click the change profile structure icon.

2. Select the field you want to delete, then click the Delete  icon.

Figure 12-113  Verify delete fields

3. Click the Go  icon to accept the deletion, or the Cancel  icon to stop the operation.

12.14.3 Modify field values

In this section we will assign a default value in the fields of a profile.
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1. Click Allocation on the HP AC Job Accounting remote control.

2. Click Modify field values.

Figure 12-114  Modify field value

12.14.4 Modify default value

Complete the following steps to modify default values:

1. Click Modify default value to assign a default value.

Figure 12-115  Modify default value

NOTE: The appearance of this window may vary according to the input type you previously defined in the 
field (Free, List, or Fixed).

2. Select your default value and validate. The selected default value will be displayed in the Default value 
column.

NOTE: The default value is the value that is displayed first when the popup window appears.

3. If you need to remove the default value, click the Delete  icon to delete it.

12.14.5 Modify list

NOTE: You can access this menu only if you have a field with a List as input type.

Use the following steps to create or modify a list of values:

1. Click Modify list:
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Figure 12-116  Modify list

2. Enter the value you want to add to your list in the New value field and click Add value to validate.

3. To delete a value, select one or more and then click the Delete  icon.

NOTE: The names of the values must be different.

12.14.6 Delete allocation profiles

NOTE: You can delete an allocation profile only if no job is linked to this profile.

Use the following steps to delete an allocation profile:

1. Click Allocation on the HP AC Job Accounting remote control.
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Figure 12-117  Select Allocation to delete

2. Select the profile you want to delete.

3. Click the Delete  icon.

Figure 12-118  Verify delete allocation

4. Click the Go  icon to accept the deletion, or the Cancel  icon to stop the operation.

12.14.7 Link a job to an allocation profile

It is also possible to display the list of the printed jobs with or without allocation information and then link them 
to a specific profile, as described below:

1. Click Allocation in the HP AC Job Accounting remote control.

2. Click Job Allocation.
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Figure 12-119  Job allocation

From this screen, you can use the following filters:

● User (Windows login)

● Document name

● Profile name

● Print server

● Printer

● Allocated (Billed) job (Indifferent/Yes/No)

● Allocation information (Indifferent/Yes/No)

In addition, you can specify a date range when the related jobs were printed. The resulting list of printed jobs can 
then be linked to an allocation profile after the following page appears:

Figure 12-120  Result display, allocation

The above example shows a job that is not billed and not linked to an allocation profile. To link this job to an 
allocation profile, use the following steps:

1. Click the Link profile icon.
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Figure 12-121  Add allocation profile parameters

2. You can use the current profile or choose another one by clicking the Modify .icon

Figure 12-122  Allocation profile

Choose ONE of the available profiles:

● Click the Go  icon to accept the profile, or the Cancel  icon to stop the operation.

● Enter the field values for the selected profile.

● Click the Go  icon to accept again.

● The job is now linked to an allocation profile.

12.14.8 Modify allocation information

NOTE: After a job is linked to a profile, you cannot remove this link. However, changes can be applied to the 
field values that make up the profile.

1. Search for the job requiring field value changes.

2. Click the Modify  icon to modify the field.

Figure 12-123  Modify allocation information
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3. Keep the current profile or choose another profile.

4. Change the field values accordingly.

5. Click the Go  icon to accept the modification, or the Cancel  icon to stop the operation.

12.15 Quota module
NOTE: Quota is not supported on USB connected devices.

This optional HP AC Job Accounting feature allows the administrator to set limits on how much each user is 
permitted to print, copy, or digitally send. A customizable warning message will automatically notify the user as 
they approach their quota limit. After a user has exceeded their limit, any additional jobs are automatically 
deleted. Quotas can be automatically renewed after a specified time period has elapsed.

To access the Quota Module, click Quota in the HP AC Job Accounting tab.

Figure 12-124  Quota module

The default Quota screen is the User screen, which provides the following information:

1. Specific user names

2. Total number of pages the user is allowed to print/copy/digitally send

3. Total number of pages the user has printed/copied/digitally sent so far

4. Total number of pages remaining for the user

5. Total number of pages remaining before the user is notified with a warning that they are approaching their 
printing limit

6. Number of color pages the user is allowed to print/copy/digitally send
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7. Number of color pages the user has printed/copied/digitally sent so far

8. Number of color pages remaining for the user

9. Number of color pages remaining before the user is notified with a warning that they are approaching their 
limit of available color pages

12.15.1 Quota defaults

Default quota values are automatically assigned as users are added to the Quota table. After the default quota is 
assigned to a user, it can easily be modified later as needed.

To access the Quota Defaults screen, click Defaults in the menu bar at the top of the Quota page.

The duration of the quota period can be Daily, Weekly, Biweekly, Monthly, or Quarterly. After the specified 
duration has lapsed, Quota Auto Review can be checked to instruct HP AC Job Accounting to renew a user's quota 
automatically upon completion of the specified time period.

CAUTION: Make sure the Quota Auto Review option is checked. If left unchecked, the user will still be unable to 
print after the quota period has ended.

Figure 12-125  Quota defaults

On this page, you can perform the following:
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Quota mode

● Quota by user

● Quota by cost center

● Quota by user and cost center

● Quota by printer cost center

● Enable quota for print

● Enable quota for copies

● Enable quota for digital sending

User functions

● Set a Default page limit (the maximum number of total pages the user can print/copy/digitally send)

● Set a Default total warning flag (total number of pages before quota is reached)

● Set a Default color page limit (the maximum number of color pages the user can print/copy/ digitally send)

● Set a Default color warning flag (number of color pages before quota is reached)

Cost center functions

● Set a Default page limit (the maximum number of total pages the cost center can print/copy/ digitally send)

● Set a Default total warning flag (total number of pages before quota is reached)

● Set a Default color page limit (the maximum number of color pages the cost center can print/ copy/digitally 
send)

● Set a Default color warning flag (number of color pages before quota is reached)

Printer cost center functions

● Set a Default page limit (the maximum number of total pages the cost center can print/copy/ digitally send)

● Set a Default total warning flag (total number of page before quota is reached)

● Set a Default color page limit (the maximum number of color pages the cost center can print/ copy/digitally 
send)

● Set a Default color warning flag (number of color pages before quota is reached)

Text functions

● Create a custom Warning total flag message (message the user receives when they are approaching their 
quota for the total number of printed pages)

● Create a custom No more total pages message (message the user receives after their quota has been 
reached for the total number of printed pages)

● Create a custom Warning color flag message (message the user receives when they are approaching their 
quota for the number of printed color pages)

● Create a custom No more color pages message (message the user receives after their color page quota has 
been reached for the number of printed color pages)

NOTE: Users must have Messenger service enabled to receive quota messages. Messenger service is not 
available on Vista—quota will work, but the end-user will not be notified.
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12.15.2 Quota user

The first time a user sends a job to a printer with a quota assigned, they are automatically added to the table 
using default values. In addition to providing basic information, the User page can also be used to alter quota 
settings on a case-by-case basis.

To access the User page, click User in the menu bar at the top of the Quota page.

Figure 12-126  Quota user

Fields provided:

● Specific user names

● Total number of pages the user is allowed to print/copy/digitally send

● Total number of pages the user has printed/copied/digitally sent so far

● Total number of pages remaining for the user

● Total number of pages remaining before the user is notified with a warning that they are approaching their 
printing limit

● Number of color pages the user is allowed to print/copy/digitally send

● Number of color pages the user has printed/copied/digitally sent so far

● Number of color pages remaining for the user

● Number of color pages remaining before the user is notified with a warning that they are approaching their 
limit of available color pages

The selected user can be removed from the quota list by clicking Delete.
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12.15.3 Quota cost center

To access the Quota Cost Center page, click Cost Center in the menu bar at the top of the Quota page.

Figure 12-127  Quota cost center

Fields provided:

● Specific Cost Center names

● Total number of pages the cost center is allowed to print/copy/digitally send

● Total number of pages the cost center has printed/copied/digitally sent so far

● Total number of pages remaining for the cost center

● Total number of pages remaining before the cost center is notified with a warning that they are 
approaching their printing limit

● Number of color pages the cost center is allowed to print/copy/digitally send

● Number of color pages the cost center has printed/copied/digitally sent so far

● Number of color pages remaining for the cost center

● Number of color pages remaining before the cost center is notified with a warning that they are 
approaching their limit of available color pages

12.15.4 Quota printers

To access this feature, click Printers in the menu bar at the top of the Quota page.
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Figure 12-128  Quota printers

To designate an HP AC Job Accounting Printer as a Quota Printer, select the HP AC Job Accounting Printer in the 
left screen and click the Move right icon to move it to the right screen.

This is used only for printers with the HP AC Agent authentication solution, when Quota for copy/digital sending 
is enabled.

When quota control is done using HP AC Job Accounting Print Server, the quota printer is automatically added to 
the quota list when Quota is enabled and the web service has been configured properly.

12.15.5 Assign quota printers to cost center

To access this feature, click Assign quota printers to cost center in the menu bar at the top of the Quota page.
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Figure 12-129  Assign to cost center

To assign cost centers to a quota printer, select the quota printer in the left screen, select the cost centers in the 
right screen, and then click Assign.

NOTE: This is used only when the mode Quota by printer cost center is selected.

In this mode, the user must be assigned to a cost center to be able to print. A printer can belong to multiple cost 
centers.

● If a user prints to a printer that belongs to the same cost center, the quota cost center will be used.

● If a user prints to a printer that does not belong to the same cost center, the default quota will be used.

Each cost center can have a different renewal period.

12.15.6 Import quota

To access this feature, click Import Quota (CSV) in the menu bar at the top of the Quota page.
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Figure 12-130  Import quota

A CSV file containing the user name, cost center, quota values, and quota renewal can be imported into the 
database.

1. Browse to select the CSV file.

2. Assign the column number to the corresponding field.

3. If the CSV file does not contain the information, leave 0 as the value. Auto-renew values are:

● 0: disabled

● 1: Daily

● 2: Weekly

● 3: Monthly

● 4: Quarterly

● 5: Bi-weekly

4. Select the separator in the CSV file (the default is a comma).

5. Click Import file to import the CSV file.

6. Click View Import log to see a log of the import process.

7. Click the Delete icon to delete the log.
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12.15.7 Assign cost centers to quota account

To access this feature, click Assign cost centers to quota account in the menu bar at the top of the Quota page.

In the administration/account menu, you can create a Quota super user account.

Figure 12-131  Create an account

To assign cost centers to a Quota support user, select Quota super user in the left screen, select the cost centers 
in the right screen, and then click the Assign icon.

Figure 12-132  Assign cost center

When the quota user logs on to the application, they have the same rights as a regular HP AC Job Accounting 
user. The quota user also has access to the quota menu and can manage cost center quotas and the users 
belonging to these cost centers.
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Figure 12-133  Manage cost center quotas

12.15.8 Configure quota for printing using print server

To configure quota for printing on a device using the print server, complete the following steps:

1. Enable quota for print in HP AC Job Accounting.

a. In the HP AC Job Accounting Quota module, go to the Defaults page.

b. Click Enable quota for print checkbox.

Section 12.15   Quota module 501



Figure 12-134  Enable quota for print

2. Go to the Print server tile, select a device, then click Configure. In the Configure window, select Tracking and 
Quota. Click OK.

Figure 12-135  Print server quota

12.15.9 Adding new users to the quota control

The following sections include methods to add users to the quota control.

12.15.9.1 First print

A user is added to the quota control after the user sends his or her first print job to a device configured with 
quota. To view the user’s name in the Quota User list, go to the HP AC Job Accounting Quota module and then 
click User.
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Figure 12-136  User button

12.15.9.2 First access to the MyQuota

A user is added to the quota control after the user sends his or her first print job to a device configured with 
quota. To view the user’s name in the Quota User list, go to the HP AC Job Accounting Quota module and then 
click User.

1. Open a Web browser and enter the following in the address bar:

http://<servername>/myquota

2. Where <servername> is the name of the server that has the HP AC Job Accounting quota web service 
installed.
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Figure 12-137  Welcome screen

12.15.9.3 First install of Quota Client

A user is added to the quota control after the Quota Client is first installed on the user’s desktop. You can install 
the Quota Client on the end-user desktop by running the “HP AC Job Accounting QuotaClient.msi” file from the 
following folder:

Program Files\HP\HP AC\client setup

Installation requires knowledge of the server name where the HP AC Job Accounting quota web service is 
installed.

The quota client will display a printer icon on the tray bar of the desktop that shows the quota limit for the user 
that is logged into the desktop.

12.15.9.4 Import quota

You can also manually import users for quota control. Follow the steps below to import users.

1. Go to the HP AC Job Accounting Quota module.
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2. Click Import Quota (CSV)

Figure 12-138  Import Quota

3. Click the Browse button to browse for and select the CSV file.

4. Click the Use a csv with header checkbox to accurately import a CSV file with a header.

5. Enter the correct values in the following fields to determine the correct locations of information in the CSV 
file: Cost center column, User name column, Total print allowed, Total color print allowed, CSV separator.

6. Click the Import file button to import the CSV file.

12.15.10 End user notification

There are two options are available to notify the end user of their quota status:

● Quota client

● MyQuota website

12.16 Quota Client
You can install the Quota Client on the end-user desktop by running the “HP AC JOB ACCOUNTING 
QuotaClient.msi" file from the following folder:

Program Files\HP\HP AC\client setup

Installation requires knowledge of the server name where the HP AC Job Accounting quota web service is 
installed.

The quota client will display a printer icon on the tray bar of the desktop that shows the quota limit for the user 
that is logged into the desktop.
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Figure 12-139  User quota limit

12.17 MyQuota website
End-users can access the MyQuota website to view their login's quota status. Open a Web browser and type the 
following in the address bar:

http://<servername>/myquota

Where <servername> is the name of the server that has the HP AC Job Accounting quota web service installed.

Figure 12-140  MyQuota web interface

12.18 Job Accounting Print Client
To track local printers connected to client desktops via USB, LPT1 or Standard TCP/IP port, install the Job 
Accounting Print Client. The Job Accounting Print Client is installed on client desktops where local print activity is 
tracked and then sent to the Job Accounting Database Server.

1. Copy the HP AC Job Accounting Print Client application from the server (located in the Program Files\HP\HP 
Access Control\client setup folder) to the client desktop.

2. Run the HP AC Job Accounting Print Client application on the client desktop and follow the on-screen 
instructions.

3. On the Setup Type screen, select one of the following configuration modes:
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● Automatic using print processor configures all printers connected via USB.

● Automatic using port monitor configures all printers connected via Local Port or Standard TCP/IP Port.

● Manual configuration requires you to manually configure printers with Printer Configuration tool.

Click Next.

4. On the Select Features screen, select Track Novell if you want to use the Novell protocol. Click Next.

5. Select HTTP or FTP as the desired transfer protocol to upload print tracking data to the Job Accounting 
Database Server. Click Next.

6. In the Server field, type the name or IP address of the Job Accounting server. Click Next. Click Finish.

If you selected Manual configuration during the HP AC Job Accounting Print Client installation, go to Start > All 
Programs > HP Access Control Job Accounting, then click Printer Configuration. In the Printer Configuration 
application, select installed printers from the Windows Printers list, then click Configure printer.

Figure 12-141  Job Accounting client — Printer configuration

Configured printers display in the Tracked Printers list on the right.

12.19 External reports
Select External report management on the Remote Control to set up the HP AC Job Accounting report server for 
external reporting functions. Use External Reporting to create and distribute reports with the following useful 
features:

● Schedule off-line execution of reports to minimize processing time.

● Maintain a history of executed reports (useful when existing data is changed frequently).

NOTE: A working knowledge of SQL Reporting Services is required to use the External Reporting functions.
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12.19.1 Report activities

The External Reporting process is comprised of three activities:

Report Authoring

The process of defining the report parameters, properties, style, and user interactivity.

Report Management

The administration of the published report.

Report Delivery

Delivering reports to end-users.

The actions required to set up the report server in HP AC Job Accounting are:

1. Set up and validate Source, Model, and Report folders.

2. Create and validate a data source.

3. Upload a model.

4. Assign a data source to the model and validate.

5. Upload a report.

6. Assign a model to the report and validate.

NOTE: The actions above must be performed in the listed sequence to correctly configure the report server.

12.19.2 External report management

Four management functions are available on the External report management screen:

● Manage folders

● Manage data sources

● Manage models

● Manage reports

Figure 12-142  External report management
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12.19.3 Manage folders

The fields for the Data source folder, Model folder, and Report folder must contain a name. Default names are 
provided during installation (Source, Model, Report). Type an alternative name, if desired, in any field and click 

the Go  icon to save the change.

Figure 12-143  Manage folders button

12.19.4 Manage data sources

Use the Manage data sources screen to add or delete report data sources.

Figure 12-144  Manage data sources

● To add a data source, click Add a data source button.

● To delete a data source, click the selection box and then click the Delete  icon.

● To return to the External report management screen, click the Back  icon.

12.19.5 Add a data source

Use the Add a data source page to create, view, and modify a shared data source item. A shared data source 
defines a connection to an external data source. With a shared data source, you can create and maintain the 
settings for the data source connection separately from the reports that use the data source.
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Figure 12-145  Add a data source

● Enter Name for the shared data source, which is used to identify the item within the report server 
namespace.

● Select Windows Authentication if the credentials that the user provides are Windows Authentication 
credentials.

● Select SQL Authentication if you are using SQL Server Authentication.

Complete the following steps:

1. Enter SQL Login information for SQL Server Authentication.

2. Enter SQL Password information for SQL Server Authentication.

3. Click the Go  icon to proceed, or the Cancel  icon to quit.

12.19.6 Manage models

Use the Manage models page to manage report models in the database.

Figure 12-146  Manage models page

Complete the following steps:

1. Click Add a model to upload a .smdl model file.

2. Select a model from the list displayed in the table and click Assign data source to model.
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12.19.6.1 Add a model

Use the Add a model screen to upload a .smdl model file in the application.

Figure 12-147  Add a model

Complete the following steps:

1. Enter the name of the .smdl file to upload, or click Browse to locate the file.

2. Click Overwrite item if exists if the uploaded file will replace an existing file.

3. Click the Go  icon to validate the selection, or the Cancel  icon to quit.

12.19.6.2 Delete a model

To delete a model, click the selection box and then click the Delete  icon.

12.19.6.3 Assign data source to model

If a model is displayed in red on the Manage Model screen, it is not yet linked to a data source.

Use the following steps to assign a data source:

1. Select the model from the list on the Manage Model screen.
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2. Click Assign data source to model.

Figure 12-148  Assign data source to model

3. Select the data source.

4. Click the Go  icon to proceed, or the Cancel  icon to quit.

12.19.7 Manage reports

The table on the Manage reports page displays a list of custom reports available in the database.

Figure 12-149  Manage reports page

12.19.7.1 Add a report

Use the Add a report page to upload a .rdl file from the report server database.
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Figure 12-150  Add a report

Complete the following steps:

1. Enter the name of the .rdl file to upload, or click Browse to locate the file.

2. Enter name of the file as it will appear in the report server namespace. This field is automatically filled 
when a file is selected with the Browse function.

3. Enter report Description.

4. Select the Overwrite item if exists check box if you want to replace an existing item with a newer version. 
To overwrite an existing version, the name of the new item and the existing item must be an exact match.

TIP: Only reports and models are published during a file upload. All other file types are stored as 
resources. The folder from which you initiate the upload operation is the folder that will contain the 
uploaded file.

5. Click the Go  icon to proceed, or the Cancel  icon to quit.

12.19.7.2 Assign model to report

Use the Assign model to report page to assign a model from the database to a report.

Figure 12-151  Add model to report

Section 12.19   External reports 513



Complete the following steps:

1. On the Manage report page, select a report from the list displayed in the table and click Assign model to 
report to assign a report model to an existing report.

2. Select a model from the list displayed.

3. Click the Go  icon to proceed, or the Cancel  icon to quit.

12.19.7.3 Assign data source to report

Use the Assign data source to report page to assign a data source to a report.

Figure 12-152  Assign data source to report page

Complete the following steps:

1. On the Manage reports page, select a report from the list displayed in the table and click Assign data 
source to report to assign a data source to an existing report.

2. Select a data source from the list displayed.

3. Click the Go  icon to proceed, or the Cancel  icon to quit.

12.19.7.4 Delete a report

To delete a report, click the selection box next to the report and then click the Delete  icon.

12.19.8 Launch external report

Select External report button on the Customize report page of the Remote Control to set parameters for your 
report.
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Figure 12-153  External report button

Complete the following steps:

1. Select the report you want to customize.

2. Click Parameterized mode to customize the selected report.

3. Use the Parameterized query page to set parameters for the report. For more detailed information about 
customizing and launching the query, see Section 12.11.3, Parameterize queries

Figure 12-154  Parameterized query

12.19.9 JA reports in SQL Server Reporting Services

Prerequisites
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● SQL Express with Advanced services (to add reporting services)

● SQL Full edition (up to 2016)

NOTE: The default SQL Express version supplied with the HP Access Control installer does not include 
Advanced Services and cannot be upgraded to include Reporting Services. A new instance of SQL Express with 
Advanced Services will need to be installed and used as the database for Reporting services. The Job Accounting 
HPACJA database can be separate from Reporting Services so no data needs to be transferred. The additional 
services required is Reporting Services - Native.

In the HP Access Control\JA Reports folder there are 32 report files that can be uploaded to SQL Server 
Reporting Services (SSRS). This allows users and managers to view JA data from SSRS. Complete the following 
steps to upload the JA reports into SSRS:

1. After configuring SQL Server Reporting Services, open a web browser and go to the address of the SQL 
reports (Example: http://servername/reports). The SQL Reports address can be found through the 
Reporting Services Configuration Manager, under the Report Manager URL or Web Service URL.

2. Create a new folder called HPAJCA.

3. Open the new folder.
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4. Create a new datasource inside the folder that points to the SQL Server where the HPACJA database is 
located. The name of the data source should be HPACJA. Use this line for the connection string: Data 
Source=SQLServerName\SQLInstanceName;Initial Catalog=HPACJA.
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5. Create three new folders in SSRS called Users, Managers, and Global.

6. There are 32 RDL files in the \HP Access Control\JA Reports folder. Upload the 32 .rdl files into 
the Global folder. All files should be in your SSRS and assigned to the HPACJA data source. From the HPAC 
server right-click on the HPAC Report Uploader.exe and run as administrator. This tool is located in \HP 
Access Control\JA Reports folder.
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7. If the SQL Server is installed on the HPAC server, verify the information in the Auto local discovered section. 
If you are running HPAC Report uploader from a remote server, enter the SQL server information in the 
Manual section. Then enter the credentials to access the SQL server. Click Connection Test to connect to the 
SQL server.
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8. Go to Upload HPAC reports. In the Data Source tab verify the information is correct and then click 
Connection Test. This will create the Data Source.
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9. In the Report Files tab, specify the location of the JA Report files in the HPAC Report folder field. By default, 
the JA Report files are located on the HPAC server in the HP Access Control\JA Reports folder. 
When the correct JA Report folder is entered, the list of the report files displays below.
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10. In the Upload tab, click Upload reports.

11. The uploaded reports are displayed on the Browse Content. Reports can now be viewed using the SQL 
Reporting Services web page.
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12. Go to the HPACJA folder > UserReport.rdl > Manage, and click Create linked report. Place the report in the 
Users folder. This is for end users only.

13. Create a linked report for the ManagerReport.rdl and place it in the Managers folder. This is for managers 
only.

14. Create a linked report for the ManagerUserReport.rdl. The name for linked report should be “Report by 
User”, and place it in the Managers folder.
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15. Change the security for the Managers folder and Users folder, to allow the corresponding user you want to 
be Manager, User or Admin. The HPACJA security should be for Admin users only. The group you assign is 
based on AD groups and if the group does not exist an error will be displayed.

16. You can now create http shortcuts in your desktop to call the User report, Manager reports and Main report.

12.20 HP AC Job Accounting Dashboard

12.20.1 Introduction

The HP AC Job Accounting Dashboard is a tool that allows users to monitor detailed printer usage information by 
printer, user, project, department, or cost center. The data can provide meaningful analysis of printer and MFP 
activity and gives you a precise accounting of device usage.

The Dashboard application consists of various tabs that users can use to view and organize printing data. There 
are two types of installation files:

● The User version of the HP AC Job Accounting Dashboard installation file can be found in the following 
folder on the server:

C:\Program Files\HP\HP Access Control\client setup\Dashboard\User

The User version is intended for users with the basic ability to view and organize their printing data, as well 
as the printing data of the people they manage. This installs the Default Dashboard tab, the My Dashboard 
tab, and the Basic Designer tab.

● The Admin version of the Dashboard installation file can be found in the following folder on the server:

C:\Program Files\HP\HP Access Control\client setup\Dashboard\Admin

The Admin version is intended for administrators or managers with the authority to oversee the database 
and printing data of an organization. This version installs the Default Dashboard tab, the My Dashboard 
tab, the Basic Designer tab, and the Advanced Designer tab.

IMPORTANT: The Admin version of Dashboard requires connection to a SQL Server with SQL Analysis Services 
installed and configured.

12.20.1.1 Requirements

HP AC Job Accounting installed and setup on a server.

Any of the following SQL Servers installed locally or remotely:

● Microsoft SQL Server 2008 Express

● Microsoft SQL Server 2008

● Microsoft SQL Server 2012 Express

● Microsoft SQL Server 2012

● Microsoft SQL Server 2016

12.20.1.2 Installation

Follow the instructions below to install HP AC Job Accounting Dashboard on client computers:

1. Double-click the Dashboard installation file. The Dashboard Setup Wizard window displays. Click Next.
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Figure 12-155  Dashboard Setup Wizard
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2. On the Dashboard Setup screen, enter the name or IP address of the job accounting server. Click Next.

Figure 12-156  Server name
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3. On the Select Installation Folder screen, make sure the correct folder path is displayed in the Folder field. 
Select Everyone to allow all users and guests on the computer to use the Dashboard. Select Just me to 
allow only the current user to use the Dashboard. Click Next.

Figure 12-157  Select Installation Folder
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4. On the Confirm Installation screen, click Next.

Figure 12-158  Confirm Installation

5. When the installation is complete, click Close. To open Dashboard, double-click the Dashboard desktop icon 
or select Dashboard from the Start menu.

12.20.1.2.1 Silent mode installation

To install Dashboard in silent mode, use the Dashboard Custom Setup application. Dashboard Custom Setup can 
be found in the following folder on the server that has HP AC Job Accounting installed:

C:\Program Files\HP\HP Access Control\client setup\Dashboard

Follow the instructions below to use Dashboard Custom Setup to edit the DashboardSetup.msi file:

1. On the HP AC Job Accounting server, open the Dashboard Custom Setup application.

2. Click the Load MSI button. Locate the DashboardSetup.msi file in either the Admin folder or the User folder, 
depending on which version of Dashboard you want to install silently on client computers. Click Open.

3. In the Job accounting server name field, enter the name or IP address of the job accounting server you 
want Dashboard users to connect to.

4. Click Apply.
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Figure 12-159  Dashboard custom setup

12.20.1.3 User guide

12.20.1.3.1 Default Dashboard

The Default Dashboard tab allows you to view printing information about yourself and about your group, 
extended information about users’ printing history in your group and graphs of information about the printing 
history of the past three months.

Figure 12-160  Default Dashboard

12.20.1.3.1.1 User(s) area

In the User(s) area you can see your user name, your total number of pages printed, and the total number of 
pages printed by the group you supervise.

The information displayed in the data visuals section and data grid section represents the printing by the user 
listed last in the User(s) section.
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Figure 12-161  users area

12.20.1.3.1.2 Direct Reports area

The Direct Reports section lists users in your group who report directly to you. The user name, the user’s total 
number of printed pages, and the total number of printed pages by the group the user supervises.

To view printing information about a user in your Direct Reports, double-click a user name in the Direct Reports 
section. The following happens:

● This moves the user name up to the User(s) section. The User(s) section now displays the hierarchy of 
users.

● Information about that user’s printing history displays in the data visuals and data grid sections on the 
right.

● The Direct Reports section also changes to display the names of users who report directly to the user 
selected.

Figure 12-162  Direct reports data

12.20.1.3.1.3 Data graphs area

The information displayed in the data visuals section shows the current and previous two month’s printing data 
related to the last user listed in the User(s) section.
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Figure 12-163  Data graphs area

The data visuals section displays two types of visual: a bar graph and pie charts.

● The bar graph illustrates the user’s printing data over the past three months, including the total number of 
pages print, the total number of mono pages printed, the total number of colored pages printed, the total 
number of simplex pages printed, and the total number of duplex pages printed. Each bar represents the 
number of pages printed for each month.

● The pie charts show the user’s printing data for the current month.

– The Mono/Color chart shows the percentage of printed pages that were black and white or color.

– The Simplex/Duplex chart shows the percentage of printed pages that were printed using the simplex 
or duplex printing feature.

– The Copy/Digital/Print chart shows the percentage of printed pages that were printed using the copy 
function, the digital sending function, or were printed directly to the printer.

– The Deleted/Expired/Print chart shows the percentage of print jobs that were deleted before they 
were printed, that expired before they were printed, or were printed.

Click the chart popup icon  to view the data visuals larger in the Chart Popup window.
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Figure 12-164  Data graphs popup icon

12.20.1.3.1.4 Data grid area

The data grid section displays columns with the user’s printing data details for the current month.

Figure 12-165  Data grid area

Arrange data so that it is easier to analyze. Click the column headings to sort the column data in ascending or 
descending order.

In the filter field, under the column headings, you can set the rules for the data that should remain visible after 
the filter is applied. You can type text to filter names or you can type any one of the filter operators below to filter 
numbers:
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For a more customized view of data, click and drag column headings to the Drag and drop columns here section 
above the column headings. This will group the data by the selected columns. For example, the figure below 
shows data grouped by GroupName and then by PrinterModel. The totals of pages appear highlighted in the last 
rows.

Figure 12-166  Group data

Click the Expand groups when grouped checkbox to automatically expand all grouped data when the data is 
grouped.

To export the data as a report, click the Export report to Excel  icon . Select a save destination and save the 

report.

Click the Min/Max icon  to maximize or minimize the data grid.

Click the expand icon  to expand the data grid vertically.

12.20.1.3.2 My Dashboard

Using the My Dashboard tab, you can open multiple reports at one time to review and compare your printing 
data. The My Dashboard tab consists of three areas: the Reports area, the Report Details area, and the report 
viewer area.
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Figure 12-167  My Dashboard

12.20.1.3.2.1 Reports

The Reports area lists saved reports. The reports listed are reports that were saved using the Basic Designer tab 
or the Advanced Designer tab. Double-click one or more report names from the list to view the report data in the 
report viewer area.

Click the Import an XML format report icon to import a report saved as an XML file.

Select a report from the list and then click the Delete  to delete a report from the Reports area.

Click the Reset  to clear the report viewer area.

12.20.1.3.2.2 Report Details

The Report Details area shows information about a selected report. Click a report in the Reports area to display 
information about the report, including the report name, the date and time the report was created, the month 
relating to the report information, and the type of report.

12.20.1.3.2.3 Report viewer area

The report viewer area shows selected report data. Multiple reports can be viewed at one time for easy 
comparison of report information.

Click and drag the report heading to organize the order of multiple reports.

12.20.1.3.3 Basic Designer

The Basic Designer tab allows you to customize your printing data or your group’s printing data.

534 Chapter 12   Job Accounting



Figure 12-168  Basic designer tab

12.20.1.3.3.1 Basic Designer toolbar

Figure 12-169  Basic Designer toolbar

Click the New icon  to clear all data to create new customized data.

Click the Open icon  to open a saved report. Select a report from the list and then click Load.

Click the Save icon  to save a customized report. Type the name of the customized report and then click 

Save.

Click the Delete icon  to delete a saved report. Select a report from the list and then click Delete.

Click the Export grid to Excel icon  to export the customized data as an Excel file.

Click the Export report to XML icon  to export the customized report as an XML file. This feature is intended 

for managers, and displays only if there are users in your Direct Reports list.
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12.20.1.3.3.2 Data checklist

Figure 12-170  Data checklist

Use the checkboxes on the left to select what data you want to see in the columns.

Figure 12-171  My Dashboard Data grid area

At the top, select My Data to view your printing data, or select My Group Data to view your group’s printing data. 
These options are intended for managers and display only if there are users in your Direct Reports list.

12.20.1.3.4 Advanced Designer

IMPORTANT: The Advanced Designer tab displays only if the Dashboard administrator version is installed. 
Please contact your administrator for more information.

The Advanced Designer tab allows you to customize data on an advanced level using multidimensional data.
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Figure 12-172  Advanced Designer

12.20.1.3.4.1 Advanced Designer toolbar

Figure 12-173  Advanced Designer toolbar

The following icons display on the Advanced Designer toolbar:

Click the New icon  to clear all data to create new customized data.

Click the Open icon  to open a saved report. Select a report from the list and then click Load.

Click the Save icon  to save a customized report. Type the name of the customized report and then click 

Save.

Click the Delete icon  to delete a saved report. Select a report from the list and then click Delete Export chart 

to PDF icon :

Click the Export report to XML icon  to export the customized report as an XML file. This feature is intended 

for managers and displays only if there are users in your Direct Reports list.

Click the Export grid to Excel icon  to export the customized data as an Excel file.

Click the graph view drop-down menu to select a graph type to be viewed in the Viewer area.

12.20.1.3.4.2 Report dimensions

Use the drop-down menu to select the job accounting server.

Section 12.20   HP AC Job Accounting Dashboard 537



Figure 12-174  Job Accounting report dimensions - drop-down menu

Click and drag the dimensions to the Columns/Rows/Filter areas to group and customize your data. The data 
appears in the Viewer area.

12.20.1.3.4.3 Columns/Rows/Filter area

Figure 12-175  Columns/Rows/Filter area

Click and drag the dimensions from the Report dimensions area to the Columns, Rows, or Filter area to group 
and customize your data.

After you click and drag the dimensions, do the following:

● Move your cursor over a dimension button to view the dimension options:

– Click the up arrow icon to move the dimension up in the hierarchy.

– Click the down arrow icon to move the dimension down in the hierarchy.

– Click the delete icon to remove the dimension from the hierarchy.

● Click the dimension button to display the Member Editor window. In the Member Editor window, check or 
uncheck the dimension attributes you want to display or not display. Click OK to save your changes.
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Figure 12-176  Member editor

12.20.1.3.4.4 Viewer area

Figure 12-177  Report viewer

Click the Show/Hide Grand Total check box to hide the data totals.

Click the Show/Hide Expanders icon  to display or not display the icon to expand the detailed data.

Click the Toggle Pivot icon 
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Click the Filter/Sorting icon 

12.20.1.3.4.5 Filtering and Sorting window

Click the Filtering/Sorting icon  if you want to arrange data so that it is easier to analyze. In the Filtering and 

Sorting window, you can filter data to quickly see only the printing data that you specify. When you are finished 
making changes, click Update to apply the filter or sort settings.

Figure 12-178  Filter tab

Uncheck the Filter Empty Rows checkbox if you do not want to include rows with empty data in the filter.

Check the Filter 1 checkbox to create a filter.

Select a filter condition from the Condition drop-down menu.

Click the Filter On drop-down menu to select a printing data value to filter by.
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Figure 12-179  Sorting tab

Click the Sort checkbox to turn on sorting.

Click the Sorting On drop-down menu to select the page type that you want to sort the data by.

Select Ascending or Descending to determine the order of sorting.

12.21 Configuring for Print Server tracking
To configure a print queue, select a print queue from the installed print queues list, then click Configure. In the 
Configure window, select features to enable. Click OK.

The Configure window displays the following possible features:

● Tracking: Enables tracking of print jobs sent to the selected print queue. The print queue tracking method 
can be either Port Monitor or Print Processor, depending on what is selected in the Settings tile > Print 
Server tab.

● Quota: Enables the enforcement of Job Accounting quotas for printing.

● IPM: Enables the implementation of IPM rules and costs. Select a cost per page scheme from the drop-
down list. The cost per page schemes can be set in the Settings tile > IPM tab. The IPM Cost column displays 
the cost per page scheme assigned to the selected print queue.

● Add tracking PJL attributes: Inserts Job Accounting PJL attributes in the data stream. If an application 
generates a data stream that does not include the PJL header containing the user and job information, the 
user and job name are reported as UNSPECIFIED in Job Accounting reports.

● Pause job: Automatically pauses print jobs in the print queue. This feature is only possible when Port 
Monitor is selected for print queue tracking and the Windows service HP ACJASpool Monitor is started.
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13 Pull Print Savings

The Pull Print Savings tile allows administrators and users to view the number of printed pages, deleted pages 
and expired pages in as a graph. Click the Chart drop-down menu to view the data as a pie chart or as a bar 
graph. Click the Export button to export the data as a CSV file.

NOTE: The Pull Print Savings can also be viewed in a web browser by going to http://server/PullPrintSavings, 
where server is the name or IP address of the HP AC server.
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14 Licensing

14.1 Licensing the product
The ID key field contains the server license number that identifies your server to the HP Licensing Support team. 
To receive Activation keys for components, you need to contact the licensing customer support center:

1. Go to the HP licensing customer support center at http://licensing.hp.com.

2. Click Contact HP Licensing (on the left).

3. Fill in all required fields. In the Your comments field, make sure to include your server license number. Then 
submit the form.

After your license request is processed, you will receive an email containing Activation keys. Copy the component 
Activation keys and paste into the Activation key fields in the License tile.

14.2 License tile
The License tile shows your server license number ID key and Activation key(s) for installed components and 
expiration dates of licenses.

Figure 14-1  License tile

NOTE:

● Information in the License tile may vary depending on what components of HP Access Control (HP AC) are 
installed on the server.

● The Secure Pull Print Express license resets after 24 hours. This allows for users to pull print at new 
devices every day.

14.3 License expiration
The red highlighted License tile on the HP AC Configuration Utility main screen indicates a component license is 
expired.
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15 Best practices and troubleshooting

15.1 Importing and Exporting settings
Configuration settings can be exported as an XML file, in the event that the server or application needs to be re-
installed. Complete the following steps:

1. Go to the Settings tile and under the File menu, do one of the following:

● Click Import setting to import an XML file of previously saved settings or;

● Click Export setting to save your current settings as an XML file.

2. Enter the path for the file required.

15.2 Backing up the database for re-installation
The Database tools menu allows you to repair or backup the database setting information in the event the 
server or application needs to be reinstalled. The information entered in the settings tile is stored in a database.

Go to the Settings tile and under the Database tools menu, do one of the following:

● Click Compact and Repair database to compact the database

● Click Backup database to save the database as an SDF file

15.3 Server information
The Server information tile displays information to help you manage HP Access Control on your server. This tile 
displays version numbers of installed components, storage and memory of the server, and the HP Access 
Control logs. This makes it easy to check if your HP Access Control components are up to date and view valuable 
information about your server such as hard drive space available. Click Help > About to view copyright 
information about HP Access Control. It is recommended to enable logs when requested by the support team. To 
enable logs for components, click the check box next to the component title. Click the View Log File icon to open 
the log file. Click Clear Log File to clear the log.
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NOTE: Configuration at a device occurs in order, starting at the top of the Configure window list. This means the 
FDT workflow is always configured last on a device.

15.4 FDT tab
The HP Fleet Deployment Tool (FDT) is a standalone tool designed to install and configure your printer fleet.

This FDT tab utilizes the customized workflows created by the HP Fleet Deployment Tool, allowing you to send 
firmware, in-printer agents or configuration files to multiple devices for a more automated deployment.

See the HP Fleet Deployment Tool User Guide included with the Fleet Deployment Tool application for 
instructions to create workflows. You can send workflow files to the device specified in the Settings > FDT tab.
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NOTE:

● FDT tab displays only if the HP Fleet deployment Tool application is installed on the server.

● Configuration at a device occurs in order, starting at the top of the Configure window list. This means the 
FDT workflow is always configured last on a device.

● Double-click the FDT installation folder field to browse to the FleetDeploymentTool folder containing the 
FDTCommandLine.exe file.

● Double-click in the Workflow folder field to browse to the folder containing FDT workflow files.

To configure a device with a FDT workflow, simply select the workflow to apply to the device during 
configuration.

15.5 Limit the AD-Authenticator managerial websites to specific 
users

The Configuration, Group Manager, and User Editor Web pages can be set to limit their use to specific users only. 
By default these pages permit access to any user who can successfully authenticate to your domain. Because 
they are used only for managing the AD-Authenticator, you are encouraged to limit their use to those individuals 
in your organization who have been specifically selected and trained to use them. This section describes how to 
accomplish that.

NOTE: The Configuration, Group Manager, and User Editor pages each perform unique functions. You can allow 
different users access to each page. For example, you may want to give your help desk personnel access to the 
User Editor and limit the Configuration and Group Manager pages to system administrators only.

15.5.1 IIS 7

1. Open Internet Information Services (IIS) Manager.

2. In the Connections pane, go to the local server name>Sites>Default Web Site.

3. In Features View, double-click Authorization Rules.

4. In the Actions pane, click Add Deny Rule.

5. In the Add Deny Authorization Rule select one of the following types of access:
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● All users: specifies that all users, whether they are anonymous or identified, can access the content.

● All anonymous users: specifies that anonymous users can access the content.

● Specified roles or groups: specifies that only members of a certain roles or users groups can access 
the content. Enter the role or user group in the text box.

● Specified users: specifies that only certain users can access the content. Enter the user IDs in the text 
box.

6. Optionally, check Apply this rule to specific verbs if you want to require that the users, roles or groups 
allowed to access the content can only use a specific list of HTTP verbs. Enter those verbs in the text box.

7. Click OK.

15.6 Change user code and device function rights email message
The contents of the email message sent to inform users of their PIC and device function rights can be modified. 
The following is the default email text:

Hello AD-Authenticator Manager,
Your code for accessing our HP MFP devices is:
107
Your device function permissions:
Yes – Copy
Yes – Color Copy
Yes – Send to Email
No – Send Fax
No – Send to Folder
Yes – Job Storage
No – Create Stored Job
No – Digital Sending Service (DSS) Secondary
No – Digital Sending Service (DSS) Workflow
Please contact your supervisor if you have questions regarding this email.

The text of the message, and other information, can be changed. Complete the following steps to modify the 
email:

1. Launch the Windows Notepad utility:

Navigate to Start > All Programs > Accessories > and select Notepad.

2. Open the AD-Authenticator mailer style sheet.

a. On the Notepad menu, click File and then Open.

b. In the Files of type drop-down list, select All Files.

c. Browse to the AD-Authenticator installation directory (by default Inetpub\wwwroot\ADAuthenticator) 
and then to the mailers subdirectory.

d. Select the codemailers.xsl file and then click Open.
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3. Change the mailer style sheet. The mailer file is a standard XSLT style sheet. An extensive tutorial in XSLT is 
beyond the scope of this document. The XSLT standard itself may be found at www.w3.org/TR/xslt and a 
tutorial is located at www.w3schools.com/xsl/. However, a user can make changes by simply comparing 
the contents of a received email to the portion of the style sheet beginning with the line containing Hello 
and ending with the line containing ‘&#10 Please contact your supervisor…‘ Note that &#10is simply the 
XSLT representation of a new line command.

4. When required changes are completed, save the updated file and close Notepad.

a. On the Notepad menu, click File, and then Exit.

b. Click Yes when asked to save the changes. Notepad saves the changes and exits.

15.7 Logs

15.7.1 IPM logs

To enable a list of all jobs printed using IPM rules, the IPM log can be enabled.

Prerequisites

● HP Access Control Intelligent Print Manager installed and configured.

● Devices configured for IPM rules.

Complete the following steps:

1. Go to the Settings tile and click on the IPM tab.

2. Under Print activity, select Enable print activity log.

3. Click Apply.

4. To view the logs to the IPM tile, click Print activity log tab.

5. Enter the following information to define the report required:

● Enter the date range in From and To.

● Rule: Enter the name of the rule to view print activity with a specific rule.

● User: Enter the NT username to view print activity of a specific user.

● Printer: enter the print name to view activity of a specific printer.

● Job name: enter the name of a job to view activity of a specific print job.

● Applied: select the status of job rules to view activity of a specific rule status.
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6. Click View to see the log, or click Export to save as a CSV file.

15.8 Testing the AD-Authenticator
Use the following steps to verify that the AD-Authenticator web service used by HP Access Control (HP AC) MFP 
devices is operating correctly:

1. Select Test Authentication Service.

2. Enter a valid PIC in the Find box.

3. Click Find.

The upper portion of the screen displays the user’s information as provided by the AD-Authenticator web service. 
The information is read-only and cannot be changed.

15.9 Troubleshoot the AD-Authenticator
This section describes various error conditions that may be encountered when configuring and/or using the AD-
Authenticator and how to resolve them.

15.9.1 Internet Explorer cannot display the web page

If this message displays when trying to start the AD-Authenticator Group Manager or User Editor on the server 
where the AD-Authenticator is installed, it is most likely caused either because the URL of the application is 
incorrectly entered, or because the Default Web Site is not started in IIS on the server.

Make sure the URL is correct. For the Group Manager, it should be http://localhost/AD-Authenticator/AD-Group-
Manager.aspx. For the User Editor, it should be http://localhost/AD-Authenticator/AD-User-Editor.aspx.

550 Chapter 15   Best practices and troubleshooting



If the URL is correct, go to the IIS Manager and check to see if the Default Web Site is running. If it is stopped, 
right-click it and select Start

If you encounter this error when trying to start the AD-Authenticator Group Manager or User Editor on a machine 
other than where the AD-Authenticator is installed, it could be caused by either of the conditions previously 
described, or because the firewall on the server (or another firewall between the machine and the server) is 
preventing access.

First, make sure the utility operates correctly when started on the AD-Authenticator server itself. If it does not, 
correct that problem. If it operates correctly on the server, check the server and any other firewall or router 
settings.

15.9.2 No LDAP server configured and unable to obtain one automatically

The AD-Authenticator can often locate the AD server automatically without requiring a specific address. If this 
message displays, it is unable to automatically locate the AD server and one must be specified..

15.9.3 Unable to establish a secure connection with the server

An unable to establish connection with the server error displays text similar to the following:

Server Error in ‘/AD-Authenticator’ Application
Configuration Error
Description: An error occurred during the processing of a configuration 
file required to service this request. Please review the specific error 
details below and modify your configuration file appropriately.
Parser Error Message: Unable to establish secure connection with the 
server
This error can be caused by an error in the connectionUsername and ConnectionPassword attribute strings.

Make sure those strings contain the correct username and password for a user with read-write access to the AD. 
Make sure only a simple username was entered, with no domain prefix.

15.9.4 Unable to auto-detect a SMTP server

If Microsoft Exchange is implemented, AD-Authenticator can often detect the SMTP server automatically without 
requiring its specific address. This message indicates that it is unable to automatically locate the SMTP server 
and one must be specified one. For instructions on setting the SMTP server address, see Section 4.2.2.1, Set 
SMTP Server parameters.

15.10 Reconfiguring devices
When reconfiguring the device(s), place an X in a component checkbox to re-send the configuration file. Place a / 
in a component checkbox to not re-send the configuration file and leave the current configuration status as is. 
Clear a component checkbox to disable the component on the device.
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NOTE: If the IP address of a device changes, delete the device from the device list and then re-add the device 
using the new IP address. This is to update the cached printer information in the admin console.

15.11 Troubleshooting devices

15.11.1 Troubleshooting OfficeJet Pro devices

When configuring OfficeJet Pro devices you may see the following errors in the messages pane:

● Error 401: Check that the OPS Server Password provided during the OPS installation matches the password 
in the HP AC Configuration utility.

– In the Settings tile > Device tab under OPS Server re-enter the OPS password.

● Error 400: There is a communication issue between the OPS server and the device.

1. Remove the OPS certificate from the device. Go to the EWS and under Network > Certificates delete 
the OPS certificate.

2. Reboot the printer.

3. Select "Overridge OPS” setting in the Settings tile > Device tab in the OPS server section.

4. Restart the OPS service.

5. Reconfigure the device.

6. If the error persists, reset the printer to factory defaults and reconfigure the device.

15.12 Slow authentication
If authentication performance is sluggish upon first use, contact the IIS administrator to look into disabling the 
Certificate Revocation List check (CertCheckMode). This has been reported to take 10-15 seconds to complete in 
some cases. Use of SQL Server Express or full SQL in HP AC can eliminate this issue.
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15.13 Blocking disabled AD users
This is useful if accounts are not removed, but only disabled, and you do not wish to allow the accounts access to 
the print devices.

1. Locate the section of web.config file as below. The web.config file can be found here Program Files\HP\HP 
Access Control\AD-Authenticator.

2. Add the LDAP filter expression to the “validate” attribute of the “card,” “code,” and “username” nodes as 
shown below. Use care to insert the expression “ ” 

EXACTLY as shown – syntax errors will render the AD-Authenticator inoperable until they are corrected.

3. This change will make disabled users completely invisible to the AD-Authenticator. Any card/code assigned 
to that user may be reused by another user.
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NOTE: If the disabled account is later re-enabled, the AD-Authenticator will return one of the users with 
the matching card/code and will not be able to distinguish between the two. It is recommended that a 
user’s card/code values be cleared before their account is disabled. When an Active Directory user account 
is disabled, it will be invisible to AD-Authenticator operations and behave as follows:

For card authentication:

● Attempting to look up the user in the AD-User-Editor will result in a "User not found." error.

● Previously enrolled users will appear in the DB-User-Editor and can be modified. Regardless of any 
modification there, the disabled user will still be unable to authenticate or enroll a card.

● Attempting to enroll a new card will result in a "The credentials you supplied are not correct." error.

● Attempting to authenticate a card that was previously enrolled to a now disabled user will result in an 
"Unknown card." error. If enrollment is permitted, the user will be prompted to enroll the card but 
attempts to enroll it to a disabled user will result in the "The credentials you supplied are not correct." 
error as stated above. The card can, however, be enrolled by another user whose account is not 
disabled. This can cause issues if the original account is later re-enabled because the card will now be 
assigned to multiple user accounts.

For code authentication:

● Attempting to lookup the user in the AD-User-Editor will result in a "User not found." error.

● Previously enrolled users will appear in the DB-User-Editor and can be modified. Regardless of any 
modification there, the user will still be unable to authenticate or enroll a card.

● Attempting to authenticate a code that was previously assigned to a now disabled user will result in 
an "Unknown code." error.

● A disabled user’s code can be reassigned to another user whose account is not disabled through 
either the AD-User-Editor or MyCode pages. This can cause issues if the original account is later re-
enabled because the code will now be assigned to multiple user accounts.

15.14 Resetting XT devices
When in the Devices tile, you can right-click on a device to display a drop-down menu:

Reboot device to restart an XT device.

Click Reset to factory settings to remove all configurations on an XT device.
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15.15 Post installation tasks
As a best practice, after configuring your HP AC installation, you should backup the configuration so that it can be 
easily recovered if needed.

1. Go to the Settings tile.

2. Under the File menu select Export Setting....

3. Save the file. When complete you will get an export successful message.

4. Go to the Database Tools and choose Backup Database. The database stores the admin console 
configuration and the login rights for the admin console.

15.16 Enabling CORS on FutureSmart devices
If CORS is enabled on any of the FutureSmart devices than the following is required to be done in the device's 
Embedded Web Server:

● If using Secure Pull Print Express, add the server name to the CORS Trusted Sites list. See the device’s 
documentation for instructions.

● If using Job accounting and tracking is required, make sure the Job Accounting server is listed in the CORS 
Trusted Site list.

● If using Secure Pull Print Enterprise, make sure "localhost" is listed in the CORS Trusted Sites list.
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15.17 User rights not being enforced
When configuring user rights for access to device functions, if the user is able to access a restricted function 
check the following:

1. In the device's EWS ensure that the function is controlled by HPAC-DRA or HPAC-IRM and that the guest 
user is locked out (displays a lock icon).

2. In the IRM tile > DB User Editor you can search on the user and under the rights column it should show 1's 
(permitted access) or 0's (not permitted access).

3. In the AD User Editor (IRM tile) check the rights for the individual user. Checked means that the user has 
access, unchecked means they will be forbidden access.

15.18 Reinstalling HP OPS
To reinstall OPS, the OPS certificates need to be deleted before reinstall as the certificate created by the new 
installation will not override the previous certificate.

1. On the HP AC server, open Microsoft Management Console. Go to File and select Add/Remove Snap-in….
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2. From the Available snap-ins section, select Certificates and then click Add.

3. For Certificates snap-in, select My user account and click Finish.
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4. Add another Certificate snap-in.

5. In the Certificates snap-in window, select Computer account and click Next.

6. When prompted, select Local Computer. Click Finish and OK.
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7. Under Console Root, select Certificates-Current User > Trusted Root Certification Authorities > Certificates. 
Delete the OPS certificate.

8. Under Console Root, select Certificates (Local Computer) > Trusted Root Certification Authorities > 
Certificates. Delete the OPS Certificate.
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9. Go to Program Files > HP > HP Access Control folder and delete the OPS certificate.

10. Open Internet Information Services (IIS) Manager and select local machine. In the center pane, double-click 
Server Certificates
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11. Select the OPS certificate and choose Remove.

12. Launch the HP AC configuration utility. Delete the text in the Certificate field and click Apply.

13. Remove the OPS certificate from all configured devices:

● For HP FutureSmart and non-FutureSmart devices, go to the device’s Embedded Web Server and 
navigate to Security > Certificate Management. Remove the OPS certificate.

● For HP OfficeJet Pro devices, go to the Embedded Web Server and select Network > Certificates. 
Remove the OPS certificate.
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14. Run the OPS installer from Program Files > HP > HP Access Control > Misc folder, and run opssetup.exe as 
an administrator.

15.19 Changing the drive where HP AC Enterprise stores pull print 
jobs

If you want to store pull print jobs in a different location other than the C drive, perform the following steps.

1. After the installation is finished, stop the HP AC SPP Enterprise service.

2. Move the \spoolroot folder and subfolders to the new local drive. This cannot be a network share or 
mounted drive.

3. Open the \bin\vpsstart.ini file and enter the new location on the SERVROOT line.

4. Save the file and restart the service after the folder has been moved.

15.20 Configure a user account to logon as a service without 
interactive logon rights

Complete the following procedure to configure a domain user with the ability to “logon as a service”, and to deny 
their ability to perform an interactive logon.

1. Launch Active Directory Users and Computers.
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2. Right-click Users, navigate to New and then select User.

3. Enter the information for the new, service-only user and click Next.
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4. Enter a password. Make sure both User must change password at next logon and Account is disabled are 
both unchecked. Make sure User cannot change password and Password never expires are both checked. 
Click Next.
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5. Confirm entries by clicking Finish.

6. Launch the domain Group Policy Management Editor by typing “gpme.msc” at the Start menu. Double-click 
the Default Domain Policy entry in the Domains, OUs and linked Group Policy Objects section.
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7. Under Default Domain Controllers Policy, expand Computer Configuration, Policies, Windows Settings, 
Security Settings, and Local Policies. Click User Rights Assignment. On the Policy list (on the right side of 
the page), scroll down to Deny logon locally.
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8. Double-click Deny log on locally. Make sure Define these policy settings is checked. Click Add User or Group.
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9. Enter the fully qualified username of the service user. It might be helpful to use the Browse button to locate 
the user. Click OK.
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10. Click OK to accept changes.
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11. On the Policy list, scroll down to and double-click Log on as a service.

570 Chapter 15   Best practices and troubleshooting



12. Enter the fully qualified username of the service user. Click OK.

The user for use only as a service is now properly configured.
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Once the user is configured, give the user access to the SQL Server. These steps require that the optional 
Microsoft “SQL Server Management Studio” be installed:

1. Launch the SQL Server Management Studio. Expand Security, right-click Logins and select New Login.

2. Create a new login with the “restricted rights” user.

NOTE: Make sure the service only account is a local admin on the HPAC server.
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16 Appendix A: Network ports and firewalls

16.1 Secure Pull Print Server ports

Port Inbound 
(to Server)

Outbound 
(to another)

Description Used for

TCP 25 SMTP or TCP 
587 TLS

 ✓ Outgoing email notifications 
(optional)

(only required if email notifications are used)

HP Access Control server to mail server. Using 
587 will encrypt the mail. Used to send emails 
for Job Accounting, IPM notifications, Pull Print 
notifications, and Device Analysis scans.

TCP 80 HTTP  ✓ Print device configuration ● Configuration data for multivendor 
devices

● For configuration of HP devices. Initial 
communication with HP devices is via 
HTTP and is automatically switches to 
HTTPs

TCP 80 HTTP ✓  Delegate/Group Printing (optional) (only required if using Delegate/Group Printing 
- HP AC Enterprise only)

For the HP AC Print Client to connect to the HP 
AC Pull Print Server and check the delegate and 
group print options.

TCP 110 POP3/995 
SSL or 142 IMAP/993 
SSL

 ✓ Pull Printing for email messages 
(optional)

(only required if mobile printing is used)

Allows users to email jobs for pull printing 
either over POP3 or IMAP. Default port for POP3 
is 110, but can be encrypted using 995. Default 
port for IMAP is 142, but can be encrypted 
using993. Choice is dependent on what the 
customer is using.

TCP 139, 145

UDP 137, 138

✓  Windows shared queues (optional) (only required if using Windows shared queues)

Needed for Windows shared queues in the HP 
AC Server to be reachable from Client PCs to 
submit print jobs.

UDP 161 SNMP ✓ ✓ Print Devices configuration ● Non-FutureSmart device agent 
configuration

● Device discovery SNMP data

TCP 443 HTTPS ✓  Job list and job retrieval from print 
devices

Used for job list and job print / delete request 
for pull printing to HP AC Server from Print 
devices.

TCP 443 HTTPs ✓  Job list and job retrieval from 
mobile devices (optional)

(only used when retrieving pull print jobs 
through mobile devices)

Used for job list and job print / delete request 
for pull printing to HP AC Server from mobile 
devices.
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TCP 443 HTTPs  ✓ Print device configuration Configuration data for HP devices, including HP 
OfficeJet Pro X, and licensing for other 
platforms.

TCP 443 HTTPs  ✓ Client-based Pull Printing 
configuration

(only when using Client-based Pull Printing - HP 
AC Enterprise only)

During configuration, the HP AC Client 
application will connect to the HP AC Server to 
find some configuration parameters.

TCP 443 IPPS  ✓ Print job (optional) (only required when using IPPS to send jobs to 
print devices – HP AC Enterprise only)

Used by SPP Enterprise to send print jobs to 
devices using the IPP protocol over SSL, if that 
is the protocol chosen.

TCP 515 LPR ✓ ✓ Print job (optional depending on 
config option)

(HP AC Enterprise only)

This is the default port that SPP Enterprise will 
use for inbound LPD/LPR print jobs. Specifies 
the local TCP/IP port that SPP Enterprise will 
open for inbound LPD requests. This port 
number can be changed.

For outbound, depending on the protocol 
selection on the server, jobs are sent to the 
printer either to this port, or 631, or 9100.

TCP 631 IPP ✓  Print job (optional depending on 
config option)

(only required if print jobs are submitted to the 
HP Access Control server using the IPP protocol 
- HP AC Enterprise only)

Used for inbound IPP connections from the 
clients to the HP AC server.

TCP 631 IPP ✓ ✓ Roaming for Pull Printing (optional) (only used when Pull Print roaming is 
configured across multiple servers - HP AC 
Enterprise only)

Used for communication between servers for 
remote printing (roaming).

TCP 1433 SQL  ✓ HP Access Control server to SQL 
Server

Checking user alias with HP AC Express and for 
alias, groups, delegate jobs, and for the primary 
license server with the HP AC Enterprise. Port 
number is configurable and needs to match 
with SQL server settings.

TCP 2000

TCP 2001

 ✓ XT Device Controller configuration 
(optional)

(only used when the fleet has XT Device 
Controllers)

Configuration files sent from HP Access Control 
server to XT Device Controllers.

TCP 5500 ✓  Client-based Pull Printing (optional) (used only for Client-based Pull Printing - HP AC 
Enterprise only)

Used by the Client to send jobs metadata to the 
server

TCP 5501   Internal (HP AC Enterprise only)

Used by the Enterprise spooler for internal API 
requests. Port number is configurable.

TCP 5984   Internal (only used when the print fleet contains HP 
OfficeJet Pro X Print Devices)
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Internal on HP Access Control server and is 
used to get OfficeJet Pro X devices 
configuration stored in the CouchDB. Port 
number is configurable.

TCP 7501  ✓ Client-based Pull Printing (optional) (only required when Client-based Pull Printing 
is used - HP AC Enterprise only)

Used by the HP AC Pull Print Server to launch a 
print or delete command to the client for client-
based pull print jobs.

TCP 7627  ✓ Print Devices configuration (with HP 
FutureSmart firmware) (optional)

(only used when the print fleet contains HP 
FutureSmart Print Devices)

Configuration of FutureSmart devices from HP 
Access Control server.

TCP 8081 ✓  Print Devices configuration (HP 
OfficeJet Pro X)

(only used when the print fleet contains HP 
OfficeJet Pro X Print Devices)

Used for the configuration of HP OfficeJet Pro 
devices. When the device boots it will pull the 
configuration from the HP AC server from a 
web service that publishes this (OXPd Service). 
Port number is configurable.

TCP 9100  ✓ HP Access Control Server sending 
configuration and print jobs to print 
devices

● Device agent installation (non-HP devices)

● Device configuration

● Print jobs from the HP Access Control 
server to the print device (optional, 
depending on print protocol)

UDP 11000 ✓ ✓ XT Device Controller configuration 
(optional)

(only used when the fleet has XT Device 
Controllers)

Device discovery with SNMP for XT Device 
Controllers

TCP 50080 ✓ ✓ License information (optional) (only enabled when multi-server Enterprise 
license is configured)

Enterprise Licensing for HP AC Enterprise only. 
Used by Primary License server and Client 
License Server to exchange license information. 
Port is configurable but must be identical on 
the primary server and all client licensing 
servers.

16.2 Authentication Server ports

Port Inbound 
(to Server)

Outbound 
(to another)

Description Used for

TCP 389 LDAP  ✓ User credentials & details check to 
Active Directory/LDAP server 
(optional)

Authentication credentials and user details 
check from HP AC Server to an AD/LDAP server, 
in case LDAP is used. Port number is 
configurable and needs to match with AD/LDAP 
server settings.

TCP 443 HTTPS ✓  User credentials check to HP AC 
Server

HP Access Control Server from print devices 
and mobile devices. Authentication credentials 
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check from printing device or mobile device to 
HP AC Server.

TCP 636 LDAPS  ✓ User credentials & details check to 
Active Directory/LDAP server 
(optional)

Authentication credentials and user details 
check from HP AC Server to an AD/LDAP server, 
in case LDAP over SSL is used. Port number is 
configurable and needs to match with AD/LDAP 
server settings.

TCP 1433 SQL  ✓ User details check to SQL Server 
(optional)

Used to check user alias and delegate/group 
settings in the SQL database (off-server). Port 
number is configurable and needs to match 
with the SQL server settings.

16.3 Job Accounting and Intelligent Print management Server ports

Port Incoming 
(Server)

Outgoing 
(Server)

Description Used for

TCP 21 FTP or TCP 
80 HTTP

✓  Job Accounting in-device tracking 
for HP non-FutureSmart-based 
print devices (optional)

(only required for in-printer tracking in HP non-
FutureSmart-based print devices)

Print device to send tracking data to Job 
Accounting server or to intermediate tracking 
server.

TCP 21 FTP or TCP 
80 HTTP

✓  Job Accounting Client PC tracking 
(optional)

(only required for tracking at Client PCs)

Print device to send tracking data to Job 
Accounting server or to intermediate tracking 
server.

TCP 21 FTP or TCP 
80 HTTP or TCP 443 
HTTPS

✓  Job Accounting data consolidation 
across servers (optional)

(only required when tracking data is collected 
from other servers than the main Job 
Accounting Server)

For either Print Servers with a tracking agent, 
Pull Print servers for deleted/expired jobs or 
any other distributed tracking data collector, to 
send that data to the main Job Accounting 
server.

TCP 80 HTTP or TCP 
443 HTTPS

✓  Job Accounting in-Device tracking 
for HP FutureSmart print devices 
(optional)

(only required for in-printer tracking in HP 
FutureSmart print devices)

Print device to send tracking data to Job 
Accounting server or to intermediate tracking 
server.

TCP 80 HTTP ✓  Quota (optional) (only used with quota restrictions)

● HP printing devices to the quota web 
service in the HP Access Control Job 
Accounting server to check user’s quota 
balance for copy and digital sending (only 
when using quota for MFP copy and/or 
digital send)

● HP Access Control Print Client to the 
quota web service in the HP Access 
Control Job Accounting server to check 
the user’s quota balance for printing (only 
when restricting print quota at Client PCs).
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TCP 80 HTTP ✓  Allocation (optional) (only when using the Allocation Client)

Used by the Allocation client for PCs to check 
the allocation codes in the HP Access Control 
Job Accounting server.

UDP 161 SNMP ✓ ✓ SNMP tracking

(optional)

(only when using SNMP tracking through Direct 
Tracking Module)

From HP Access Control server to devices to 
connect to the device’s MIB for confirmation 
traps (DTM).

UDP 162 SNMP ✓ ✓ SNMP tracking

(optional)

(only when using SNMP tracking through Direct 
Tracking Module)

From HP printing device to Job Accounting 
server. Used by trap service to listen for print 
job completion. This port can be changed.

TCP 1433 SQL  ✓ Connection to external Job 
Accounting database (optional)

(only when using a SQL database in a different 
server than the Job Accounting one)

HP AC Job Accounting server will connect to the 
database to do the needed transactions when 
entering data or when creating a report and 
reading the data. Port number is configurable 
and needs to match with the SQL server 
settings.

16.4 Client PC and Mobile Devices Ports and Applications

Port Incoming 
(Client)

Outgoing 
(Client)

Description Used for

TCP 80 HTTP  ✓ Card Enrollment Application 
(optional)

(only for Administration PCs when card 
enrollment is manually done from a PC)

From the Enrollment application for PC to the 
HP Access Control server (AD-Authenticator). 
Can be configured as https if desired, using port 
443.

TCP 80 HTTP  ✓ Rules-based printing (IPM) 
(optional)

(only required if using IPM)

IPM print client to connect to IPM web services 
in IPM Server for print rules check.

TCP 80 HTTP  ✓ Delegate/Group Printing (optional) (only required if using Delegate/Group Printing 
- HP AC Enterprise only)

For the HP AC Print Client to connect to the HP 
AC Pull Print Server and check the delegate and 
group print options.

TCP 80 HTTP  ✓ Allocation (optional) (only required when using the Allocation Client)

Allocation client to connect to HP Access 
Control Server to check the possible Allocation 
codes.

TCP 139, 145

UDP 137, 138

 ✓ Windows shared queues (optional) (only when using Windows shared queues)
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Needed to connect to Windows shared queues 
in the HP AC Server from Client PCs to submit 
print jobs.

TCP 443 HTTPS  ✓ Mobile devices (optional) (only when using a mobile printing app)

Mobile printing app in the mobile device 
connecting to the HP AC Server for Kerberos 
authentication, job list, and job retrieval.

TCP 443 HTTPS  ✓ Client-based Pull Printing 
configuration (optional)

(only when using Client-based Pull Printing - HP 
AC Enterprise only)

During configuration, the HP AC Client 
application will connect to the HP AC Server to 
find some configuration parameters.

TCP 445 ✓  IPM notification (optional) (only when using IPM Desktop Notification 
Agent)

Named pipes from the HP AC Server to the 
client PC

TCP 445 ✓  HP AC Admin console web client 
(optional)

(only if using the web client version of the HP 
AC Admin Console)

Used for communication between the admin 
console web service to the admin console web 
client.

TCP 515 LPR  ✓ Sending Pull Print jobs to HP Access 
Control Server (optional)

(only for server-based Pull Printing when 
sending jobs from the Client to the HP AC Pull 
Print Server with LPR protocol - HP AC 
Enterprise only)

Sending pull print jobs through LPR from a 
Client PC with a local queue to the HP AC 
Server, in case this is the protocol chosen. This 
port number can be changed.

TCP 631 IPP  ✓ Sending Pull Print jobs to HP Access 
Control Server (optional)

(only for server-based Pull Printing when 
sending jobs from the Client to the HP AC Pull 
Print Server with IPP protocol - HP AC 
Enterprise only)

Sending pull print jobs through IPP from a 
Client PC with a local queue to the HP AC 
Server, in case this is the protocol chosen. This 
port number can be changed.

TCP 5500  ✓ PC client to HP Access Control 
Server (optional)

(only required when Client-based Pull Printing 
is used - HP AC Enterprise only)

Used by the HP AC Enterprise print client to 
transfer job metadata from client PCs to the HP 
AC server when using local job storage. The 
port number is configurable.

TCP 7501 ✓  Delete and print commands from 
Server to Client (optional)

(only required when Client-based Pull Printing 
is used – HP AC Enterprise only)

Used by the HP AC Pull Print Server to launch a 
print or delete command to the client for client-
based pull print jobs.

TCP 7515   Job transfer between components 
(optional)

(only required when Client-based Pull Printing 
is used – HP AC Enterprise only)
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Internal port used by the pull print queue for 
local job storage.

TCP 50101 ✓  Rules-based Printing (IPM) 
(optional)

(only required when using IPM Desktop 
Notification)

Print policy notification (IPM) with the IPM 
Desktop Notification Agent.

TCP 50102 ✓  Rules-based Printing (IPM) 
(optional)

(only required when using IPM Opt-in/Opt-out 
rules)

Opt-in/Opt-out notification from the HP Access 
Control server to the client

16.5 Print device ports

Port Incoming 
(Print 
device)

Outgoing 
(Print 
device)

Description Used for

TCP 21 FTP or TCP 
80 HTTP

 ✓ Print Devices to HP Access Control 
Job Accounting Server (optional)

(only required for in-printer tracking in HP non-
FutureSmart-based print devices)

Print device to send tracking device to Job 
Accounting server or to intermediate tracking 
server.

TCP 80 HTTPS

TCP 443 HTTPS

✓  Configuring Print Devices Configuration data from server to printer

TCP 80 HTTP or TCP 
443 HTTPS

 ✓ Pull Print jobs metadata and 
commands (optional)

(only when using Pull Printing)

Job list inquiry and job accounting data (unless 
SSL is configured)

UDP 161/UDP 162 ✓ ✓ Print devices configuration Printer Discovery during the configuration.

TCP 443 HTTPS  ✓ Authentication (optional) (only when using authentication)

Authentication data exchanged with HP AC 
Server

TCP 443 HTTPS ✓  Pull Print jobs (optional) (only when using Pull Printing)

Sending pull print jobs from the HP AC Server 
(for server-based pull printing) or from the 
client (for client-based pull printing) (used 
depending on the print protocol chosen).

TCP 515 LPR ✓  Pull Print jobs (optional) (only when using Pull Printing)

Sending pull print jobs from the HP AC Server 
(for server-based pull printing) or from the 
client (for client-based pull printing) (used 
depending on the print protocol chosen).

TCP 7627 ✓  HP Access Control server to print 
devices (optional)

(only for FutureSmart devices)

Configuration of HP FutureSmart devices by the 
HP AC Server configuring the Print Devices.

TCP 8081  ✓ Configuration (optional) (only for OfficeJet Pro X devices)
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Configuration of OfficeJet Pro X devices, pulled 
by the OfficeJet Pro X device.

TCP 9100 ✓  Configuration Printer configuration by HP AC Server.

TCP 9100 ✓  Print jobs (optional) (only when using Pull Printing)

Sending pull print jobs from the HP AC Pull Print 
Server (for server-based pull printing) or from 
the client (for client-based pull printing) (used 
depending on the print protocol chosen).

16.6 Firewall
To establish reliable connections between the server and devices, it is highly recommended to turn off the 
Windows Firewall on the HP Access Control server.

However, if the firewall cannot be turned off, perform ONE of the following steps to establish stable 
communication with devices:

● Allow the server to accept inbound packets from devices that have passed through the firewall by changing 
the World Wide Web Services properties

1. On the HP Access Control server, go to Control Panel > Windows Firewall > Advanced Settings > 
Inbound Rules.

2. Right-click World Wide Web Services (HTTP Traffic-In) and select Properties.

3. In the Advanced tab under Edge traversal, select Allow edge traversal. Click OK.

● Allow the server to accept inbound packets from devices that have passed through the firewall by changing 
the Spooler Service properties.

1. On the HP Access Control server, go to Control Panel > Windows Firewall > Advanced Settings > 
Inbound Rules.
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2. Right-click File and Printer Sharing (Spooler Service — RPC)

3. In the Advanced tab under Edge traversal, select Allow edge traversal. Click OK.

● Disable the HTTP keep-alive response header to force new connections to be established between the 
server and devices.

1. Open Internet Information Services (IIS) Manager and go to the local machine > Sites > Default Web 
Site.

2. Double-click HTTP Response Headers.

3. In the Actions page on the right, click Set Common Headers
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4. Unselect Enable HTTP keep-alive and click OK.
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17 Appendix B: Remote SQL Server requirements

17.1 HP Access Control (HP AC) Job Accounting Remote SQL Server
If the remote SQL Server is running SQL 2005 or a later version, the database must be created using a SQL login. 
The setup will not create a SQL login for HP AC Job Accounting, and a trusted connection will be used with named 
pipes. The Job Accounting Agent must be started with a domain account to connect to the remote database.

If the remote server is running SQL 2000 version, either Windows or SQL authentication can be used to create 
the database. The setup will not create a SQL login for Job Accounting, and a trusted connection will be used with 
named pipes. The Job Accounting Agent must be started with a domain account to connect to the remote 
database.

17.2 Database access when HP Access Control (HP AC) Job 
Accounting is installed using a remote SQL Server

When the Job Accounting database is installed on a remote server, the database connection must be configured 
for the following activities:

● To allow Job Accounting to process job accounting files.

● To allow the end user to connect to the Job Accounting website to schedule and view reports.

Two methods are available to connect to the remote database: Windows Authentication and SQL Authentication.

17.2.1 Using Windows Authentication (default)

When Windows authentication is used, anonymous authentication must be enabled in IIS using a Windows 
account with database access to the Job Accounting database. The Job Accounting Agent service must be started 
with the same account.

1. Create a Windows account with dbo access to the Job Accounting database.

2. Log onto the Job Accounting application server using your new Windows account login information (Step 1, 
above).

3. From your desktop, navigate to Start > All Programs > HP Access Control, and click Configuration Utility.

4. Go to the Options tab and select Database Server.

5. Select Windows authentication.

6. Unselect Local System account.

7. Enter the Windows account user and password (created in step 1) to replace ‘Local System'. This login will 
be used to start the HP AC Job Accounting Agent service and for Anonymous Authentication in IIS.

8. Select Enable IIS anonymous authentication.

9. Select Restart services after update.
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17.2.2 Using SQL Authentication

When SQL authentication is used, the SQL password will be stored non-encrypted in the HP AC Job Accounting 
Agent service configuration file (Agent.exe.config). The HP AC Job Accounting application will store the SQL 
password encrypted in the registry.

1. Create a SQL user and password on the remote SQL Server and give this account dbo access to the HP AC 
Job Accounting database.

2. From your desktop, navigate to Start > All Programs > HP Access Control, and click Configuration Utility.

3. Go to the Options tab and select Database Server.

4. Select SQL Authentication and enter the SQL login and password you created above (Step 1).

5. Un-select Use Local System account.

6. Enter a Windows domain user account and password to replace 'Local System'. This login will be used to 
start the HP AC Job Accounting Agent service. This step is required for Active Directory connection and if 
polling mode is selected. This login does not require any access to the database.

7. Unselect Enable IIS anonymous authentication.

8. Select Restart services after update.

17.2.3 Common steps for Windows and SQL authentication

Common steps for Windows and SQL authentication include the following:

1. Click Test connection. If any errors are reported for the database connection or HP AC Job Accounting Agent 
login, verify that the login has access to the database and credentials to start a service.

2. Click Update. A series of popup messages displays:

● Database connection updated successfully

● Service login changed successfully

● ApplicationPool created successfully

● IIS anonymous authentication changed successfully

● Agent configuration updated successfully

● Quota web service configuration updated successfully

● Report server configuration updated successfully

● Report manager configuration updated successfully

● HP AC Job Accounting Agent service restarted

● w3svc service restarted

● HP AC Job Accounting Agent service restarted

3. Log on to HP AC Job Accounting and run a simple report.
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18 Appendix C: Installing and configuring HP AC 
on the Scanjet Enterprise 8500

18.1 Overview
This section provides the steps necessary to install and configure the HP AC agent to utilize card or code 
authentication on the HP Scanjet 8500 xx. The HP AC Admin Console utilizes port 9100 to install and configure 
the solution. Previous generations of Scanjets had supported port 9100, however, this port is no longer 
supported on the SJ 8500, and an alternate method of installation and configuration was required. This section 
outlines the steps to install and configure HP AC on an individual basis.

NOTE: This configuration does not support Scan to Home Folder workflow.

Prerequisites

● Verify the password has been set in the EWS.

● It is suggested, but not required, to perform a partial disk clean.

CAUTION: Stored information and settings may be lost when performing a partial disk clean. 

● Open the printer EWS and check for a valid certificate. The example below is pointing to a certificate 
installed on an HP MFP.

18.2 Installing the Agent
1. Go to the device EWS > General tab > Solution Installer page.
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2. Click Choose File, browse to the location of where the HP AC Agent is stored, and select the HP AC Agent 
BDL file. Then click the Install button.

NOTE: The current build is HPAC-SPPE-Agent-XXXXXXXX-FutureSmart-10.bdl. Please note that this may 
change, so it is important that you have the most current version. 

3. After the HP AC Agent file is successfully installed, Intelligent Rights Management Manger (IRM) displays 
under the Installed Solutions section.

18.3 Configuring the Agent
1. Go to the device EWS > Security tab > Access Control (HPAC IRM) page.
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2. Under the Authenticators section, select the HPAC - IRM Server checkbox. Then click Update. You will notice 
that the solution is not licensed. The following steps will address licensing the product.

3. In the printer’s URL, append the following "?page=services" and hit enter. Your URL string should now look 
like the example below:
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4. In the License Service URI field, enter the following:

https://HPAC serverIP or DNS/licensews/license.asmx 
In the Authentication Service URI field, enter the following:

https://HPAC server IP or DNS/AD-Authenticator/AD-Authenticator.asmx 
Click Apply.

5. Powercycle the device and review the Access Control (HPAC IRM) page to ensure the settings have not 
changed.
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6. Check to see the license is now valid. There should be no error message displayed at this time.

7. Go to the Security tab > Access Control page. Configure the Network Folder application to use HP AC – IRM 
Server as the Sign In Method. Remember to press Apply after changing the setting.

8. Install the reader and configure your Scan to Folder as required.

NOTE: If you change the authentication method in IRM, make sure to go to the https://serverIP/hp/
device/Solution.AccessControl.Jedi.WebSetup/Index?page=services page and click 
Apply to reapply the IRM settings. 
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